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Preface

This redbook is unique in its detailed coverage of Lotus Domino Server Release 
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This redbook examines, in detail, the installation and administration of Lotus 
Domino Server Release 4.6 in the RS/6000 AIX operating system environment. 
We have also documented AIX functions, commands, and scripts which can 
greatly help the administrator who is new to the AIX or UNIX world.

This redbook is intended to help the technical professional to install and 
administer Lotus Domino Server installations where one or more of the Lotus 
Domino Servers is running on an RS/6000 AIX operating system platform. It also 
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that support personnel will find informative. 
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Chapter 1.  Introduction

This redbook should help with installing and administering a Lotus Domino Server 
on an AIX platform with clients using different operating system platforms. This 
publication will discuss our experiences working with Lotus Domino Server 
Release 4.6 and Notes Workstation Release 4.6 software.

In this chapter, we will briefly explain the functions of Lotus Domino Server 
Release 4.6 and Lotus Client Release 4.6. The hardware and software used to 
write this redbook is also described.

1.1  What is Lotus Domino Server and Notes Workstation?

Lotus Domino Server and Notes Workstation is a client/server environment that 
allows users (or clients) to communicate securely over a local area network or 
telecommunications link, and create and/or access documents residing on a 
shared computer (or server). With Lotus Domino Server and Notes Workstation, 
people can work together regardless of their software or hardware platform or 
technical, organizational, or geographical boundaries.

Notes Workstation combines an application development environment, a 
document database and a sophisticated messaging system, giving you the power 
to create custom applications for improving the quality of everyday business 
processes in areas such as product development, customer service, sales and 
account management. At its most basic level, Notes Workstation is a document 
database, serving as a repository for both textual and other information, for 
example, images, presentations, and spreadsheets. Lotus Domino Server and 
Notes Workstation provide the ability to distribute this information throughout an 
enterprise via replication - yet only those who need to see the information have 
access to it. In short, the intent is to improve Communication, Coordination and 
Collaboration across any enterprise.

Two primary components compose this solution:

  • Lotus Domino Server

– Provides services to Notes Workstation users and other Lotus Domino 
servers, including storage and replication of shared databases and mail 
routing. The Lotus Domino Server can run on PCs under OS/2, Windows 
NT. It can also run as a NetWare Loadable Modules (NLM), or under UNIX 
systems, such as IBM AIX, HP-UX and Sun Solaris.

– TCP/IP (Transmission Control Protocol/Internet Protocol), IPX/SPX 
(Internetwork Packet eXchange/Sequenced Packet eXchange), IMAP 
(Internet Message Access Protocol), LDAP (Lightweight Directory Access 
Protocol), NNTP (News Network Transfer Protocol), HTTP (Hyper Text 
Transfer Protocol), POP3 (Post Office Protocol), SSL (Secure Socket 
Layer), and SMTP/MIME MTA (Simple Mail Transfer Protocol) network 
protocols are supported for Lotus Domino Server Release 4.6 running on 
AIX.

  • Notes Workstation

– Communicates with one or more Lotus Domino Servers, providing the 
interface that allows a Lotus Notes user to access shared databases and to 
read and send mail. The Notes Workstation can run under OS/2, Windows 
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95, Apple’s System 7 and on UNIX graphical workstations such as 
Xstations.

Shared databases exist on Lotus Domino Servers. Users place icons 
representing individual databases (for example, the mail file, bulletin boards, and 
documentation databases) on their workstations in their individual workspaces. 
By selecting an icon, a user can open a database to perform such actions as 
accessing an existing document or creating a new document. Users also can 
maintain local (non-shared) databases and replicate these databases so that 
users always have access to the latest version of a document. Replication is the 
process of synchronizing multiple copies of a database so the information is the 
same on multiple servers.

1.2  What’s New in Lotus Domino Server and Notes Client R4.6?

Lotus has continually enhanced the Notes and Domino products over the past 
year. The 4.6 Release of Lotus Domino adds many new features, and now 
supports many industry standards for networking protocols, e-mail and the Web.

1.2.1  Administration
Use the Administration Process to complete the following administrative tasks:

  • Server setup and administration.
  • Browser-based administration tool.
  • Enhanced NT integration.
  • New protocol support.
  • Create mail files during setup.
  • Upgrade users and servers to hierarchical naming.
  • Rename users.
  • Recertify users and servers.
  • Delete users, servers, and groups.
  • Add resources to and delete them from the Public Address Book when these 

actions are initiated in the Resource Reservations database.
  • Set the Master Address Book field in the Public Address Book to enable 

directory assistance.
  • Create replicas of multiple databases.
  • Enable password checking during authentication.
  • Add servers and remove servers to and from a cluster.
  • Move databases from a cluster server.
  • Create search site databases that allow users to search multiple databases for 

information.
  • At the remote server console, select from a list of commands to run and 

display the remote server response live.
  • Include default databases and Internet security settings in a User Setup 

Profile.
  • Use the Collector, a new task, to collect statistics for multiple servers, the 

Collector task needs to run only on the collecting server.

The Administration Process can only complete these tasks if the IDs in your 
organization are hierarchical.

In addition to these tasks that you initiate, the Administration Process also 
automatically copies a server’s public key to its server record when you start the 
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server if the public key is not already there. It also places the servers build 
number in the Server Document. The Administration Process can do these two 
tasks in a flat or hierarchical environment.

1.2.2  Performance Features
  • Release 4.6 supports partitioned servers on UNIX and Windows NT operating 

systems.

  • Graphic translations from .GIF (Graphical Interchange Format) to .JPEG (Joint 
Photographic Experts Group).

1.2.3  Internet Features
  • Integrated SMTP/MIME MTA
  • Native IMAP Mail Protocol Support
  • Native LDAP Directory Protocol Support
  • Native NNTP Internet News Protocol Support
  • SSL 3.0 Internet Security Protocol Support
  • HTML Support
  • Support for HTTP version 1.1
  • New templates:

  • Web mail NNTP discussion
  • Document library -- Notes & Web

  • Lotus Domino and Notes include support for the CAPI-compliant native port 
driver for the ISDN communication standard.

1.2.4  Mail, Calendar, & Scheduling
  • Quickly send a message, address a meeting invitation, or launch a Web page 

from a user’s contact list.

  • New Calendar entry which creates a new calendar entry which contains the 
full text of the e-mail.

1.2.5  Advanced Server Features
Server Failover Lotus Domino clusters provide failover protection for 

business-critical applications and servers.

Dynamic Load Balancing Lotus Domino server workload balancing ensures 
that heavily used servers are able to pass requests 
to other servers and that work is evenly distributed 
across the cluster.

Server Partitioning Server Partitioning allows multiple servers to be 
hosted on a single machine.

Billing Services Usage tracking and billing allows customers to track, 
compile, and analyze system usage.

1.2.6  Application Development
  • Powerful Notes objects, such as Navigators and Views, available to Web 

browsers through menu choices.
  • Added support for multiple buttons on a page and ability to use images as 

buttons.
  • Support for circular hotspots in Navigator design.
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  • Added database property to force Web users to use Secure Socket Layer.
  • Customizable default information/message text box.
  • Preview pages using leading Web browsers.
  • Menu options to insert HTML code into pages.
  • Computed text creation of on-the-fly content.
  • Insert HTML Anchor links and Horizontal rules.
  • Import graphics as page background.
  • Optionally treat view and page results as pure HTML.
  • Set HTML attributes for pages and fields.
  • Support for Java 1.1 virtual machine.
  • Develop capability to run Java agents on the server.
  • A Java application programming interface to the Lotus Domino Object 

Services.
  • Lotus Notes Designer for Domino is a design client for developing Lotus 

Domino applications.
  • Notes Global Designer offers these benefits:

  • Makes it easier to customize applications for specific countries or 
languages.

  • Minimizes localization costs and time frames by separating the 
development and translation processes.

  • Lets users deploy Lotus Domino applications simultaneously worldwide in 
users’ native languages.

  • Gives multilingual users a choice of the language they want to work in.
  • Enables maintenance of multiple language versions of applications with 

virtually no additional overhead.

1.2.7  Database Management Features
  • Bi-directional replication automatically distributes and synchronizes 

information and applications across geographically dispersed sites.

1.2.8  Document Authoring Features
  • A simple checkbox to hide design elements, and even text, depending on 

which client is accessing the application.
  • A designer can specify different behaviors on a database open for Web and 

Notes users.
  • Preview pages using a Notes client or leading Web browsers.
  • Over 20 new LotusScript classes, events, and enhancements.

1.2.9  Ease-of-Use Features
  • New database template designs including:

  • Discussion 4.6 for Web and Notes
  • Doc Library 4.6 for Web and Notes
  • Domino Samples: Registration
  • Domino Samples: FAQ
  • Domino Samples: Web Pages
  • Domino Samples: Sites 1-3
  • Domino Samples: Frames Template
  • Quick Start guide to a Web site

  • Enhanced Lotus SmartSuite and Microsoft Office integration.
  • Create mail with an alternate editor, such as MS Word or Lotus Word Pro.
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  • New contact Management features make using the Personal Address Book 
even easier.

  • Business card view shows all contact information at a glance.
  • Dynamic editing of Contact forms allows customized data entry.

1.2.10  Mail And Calendar Features
  • "Time Savers" options that help users quickly act on email.

  • Copy into a new calendar entry.
  • Add a new task to a to-do list.
  • Create a new group name.

  • Group list using the members of the e-mail To: and cc: fields.

1.2.11  Internet and Network Features
  • Users can access and explore the Web using the browser of their choice.

  • Release 4.6 enables users to manage the volume of Web pages that are 
stored locally for off-line access.

  • All previously existing Netscape Navigator or Microsoft Internet Explorer 
bookmarks can be easily imported into the Notes 4.6 Web Navigator for use 
from within Notes.

  • Both Lotus Domino 4.6 server and Notes 4.6 client include a CAPI (Common 
ISDN Application Programming Interface)-compliant native port driver for the 
integrated-services digital network (ISDN) communication standard.

  • Higher speed bandwidth than analog modem based solutions
  • Reliable end to end digital transmission
  • Quick connect times to better support LAN and TCP/IP protocols
  • Interpretability with other WAN (wide area network) services, such as X.25
  • Cost-effective solutions to private leased lines

1.2.12  Security Features
  • Securely share and route documents created with suite documents using built 

in workflow.
  • SSL 3.0 Internet Security Protocol Support.
  • User authentication.
  • Digital Signatures.
  • Flexible access control and encryption.
  • Enables users to extend intranet applications to customers and Business 

Partners.

1.3  What’s New in Lotus Domino Server and Notes Workstation R4.5?

After the very significant changes between Notes Release 3 and Notes Release 
4.1.x, Lotus again presents many new features with its Lotus Domino Server 
Release 4.5 and Notes Workstation Release 4.5, which are summarized in the 
following sections.

1.3.1  Administration
Use the Administration Process to complete the following administrative tasks:

  • Create mail files during setup.
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  • Delete mail files when you delete users.
  • Add scheduling resources to and delete them from the Public Address Book.
  • Enable directory assistance on servers.
  • Create replicas of multiple databases.
  • Enable password checking during authentication.
  • Add servers to and remove them from clusters.
  • Move databases from clusters.
  • Create search site databases that allow users to search multiple databases for 

information.
  • At the remote server console, select from a list of commands to run and 

display the remote server response live.
  • Include default databases and Internet security settings in a User Setup 

Profile.
  • Use the Collector, a new task, to collect statistics for multiple servers; the 

Collector task needs to run only on the collecting server.

1.3.2  Performance Features
Many of the performance improvements are directly applicable to running and 
administering multiple Lotus Domino Servers:

  • Create clusters of servers; so if one server is unavailable, users can 
automatically access a replica of a database on another server.

  • Use a database cache to allow quicker database access.
  • Use a mail delivery thread, separate from the Mail Router thread, that is 

dedicated to delivering mail on a server.
  • Set up additional threads for the Administration Process.

1.3.3  Security Features
  • Improve database security by encrypting documents with users' public 

encryption keys; for example encrypt a remote LAN service Connection 
document with administrators' public encryption keys so that only 
administrators can access the document and see the remote server password

  • Set an Execution Control List (ECL) through the User Preferences dialog box 
to limit the actions of other users' formulas or scripts that are run on the 
workstation

  • Use an Administration ECL to set a default ECL for user workstations

  • Enable or disable local enforcement of access control lists on multiple 
databases

  • Check for correct passwords during authentication, and optionally require 
password changes at specified intervals, and lock out IDs that may be 
compromised

1.3.4  Database Maintenance Features
  • Use the new Database Tools option in the administration control panel to 

manage several databases at once. You can add servers to and remove 
servers from clusters, select administration servers for databases, enforce a 
consistent access control list across replicas, create multiple replicas of 
databases, move databases from a cluster server, enable databases for 
multi-database searching, use a Notes ID to troubleshoot document problems, 
and enable and disable replication of databases.
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  • Create directories and links from within Notes.

  • Limit the size of full text indexes by limiting the number of numeric and date 
fields that are full text indexed in each database on a server or by specifying 
which numeric and date fields are full text indexed in a specific database.

1.3.5  Internet Features
  • Improved browser supporting HTML 3.
  • Lotus Domino Web Server.
  • Set up a Lotus Domino Server as an HTTP server and allow Web users to 

access Notes databases on the Lotus Domino Server.
  • Allow users to access the World Wide Web directly from Notes using the 

InterNotes Web Navigator.
  • Set up Internet connections to Lotus Domino Servers using the HTTP or 

SOCKS proxy protocol.
  • Set up a Notes POP3 server as a mail drop for POP3-compliant clients such 

as Netscape Navigator, Eudora Pro, and Microsoft Internet Explorer.

1.3.6  Mail, Calendar, & Scheduling
  • Upgrade users' mail files to use the new mail template, which allows users to 

schedule appointments as well as track other time-dependent events.
  • Receive a message when upgrading users' mail databases and workstations 

with the Upgrade Notification form in the Public Address Book that confirms 
the upgrade completed successfully.

  • Use the directory assistance feature, which uses a Master Address Book to let 
users easily address mail to users in multiple domains.

  • Automatically use a mail delivery thread, separate from the Mail Router 
thread, that is dedicated to delivering mail on a server.

  • Use the Free Time system to let users check the free time of others they invite 
to meetings.

  • Set up a Resource Reservations database to make available meeting 
resources, such as rooms and equipment.

1.3.7  Advanced Server Features
If you install the Lotus Notes Advanced Server license, you can now:

  • Create a cluster of servers; so if a server in the cluster is unavailable or being 
heavily used, users can automatically access replicas of its databases on 
another server in the cluster.

  • Set up a partitioned server to run multiple Lotus Domino Servers on one 
computer.

  • Use the Billing server task to track specific Notes activities for billing.

1.3.8  Application Development
Many of these new features also correspond to enhancements of the Notes client 
visible to the application developer and the end user. A short summary is 
presented here. Application developers can now:

  • Specify a database to open when Notes launches.
  • Display the preview pane and determine its location when users first open the 

database.
  • Determine whether Notes updates About and Using documents and the 

database icons when you refresh or replace the database design.
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  • Encrypt documents with someone's public encryption key, which allows you to 
secure information in a document without distributing private encryption keys.

  • Allow users with No Access or Depositor access to read documents that use a 
selected form or that appear in a selected view or folder in a database.

  • Allow users with No Access or Depositor access to create and modify 
documents that use a selected form in a database.

  • Use bitmaps as the background of a form.
  • Use the new date and time pop-ups in Date and Time fields in a layout region.
  • Use new Notes LotusScript classes, for example, NotesUIView and 

NotesTimer.
  • Use new @functions and @commands, for example, @CheckAlarms and 

FindFreeTimeDialog.
  • Run LotusScript agents from other agents.
  • Change the color and font of text in the programming pane.
  • Create script libraries, which let you easily reuse LotusScript programs in 

multiple programmable objects in a database
  • Perform operations on all documents in a database by attaching a formula or 

script to a database-level event.

1.3.9  Database Management Features
  • Create selective replication formulas for fields in a form, which lets you 

replicate the contents of only the fields you specify instead of all fields.
  • Allow only people with Manager and Designer access to view user activity in a 

database, people with Reader, Author, and Editor access cannot view user 
activity.

  • Create views that allow the Administration Process to update user and server 
names in the fields displayed in the view.

  • Quickly load images stored in documents by displaying information as Notes 
receives the information.

1.3.10  Document Authoring Features
  • Use special effects on text in a document, for example, use shadowed or 

embossed text.
  • Use new table border styles and change the background color of cells in a 

table merge and split cells in tables.
  • Embed Lotus Components or other OLE custom controls in documents.

1.3.11  Ease-of-Use Features
  • Detach all attachments in a document without highlighting each attachment.
  • Single click doclinks and hotspots in documents.
  • Automatically open a database you specify when you start Notes.
  • Specify a user ID for a location.
  • Create a full text index to search for information in multiple databases 

simultaneously.
  • You can set up a multi-database full text index on a server that others can use 

or on a workstation for your personal use.
  • Use the search bar to enter URLs for Web sites.
  • Use a hunt group Connection document to access a group of passthru servers 

using one telephone number.
  • You can also create a name for the hunt group so you can specify the name in 

Passthru Connection documents.
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1.3.12  Mail and Calendar Features
  • Create an appointment, event, or anniversary and store it in your calendar.
  • Set an alarm to remind you when the appointment, event, or anniversary 

occurs.
  • Schedule meetings and invite others to these meetings.
  • Respond to meeting invitations.
  • Schedule meetings and invite others to these meetings even when 

disconnected from a Lotus Domino server.

1.3.13  Internet and Network Features
  • Use the Web browser to store Web pages in a local Web Navigator database 

in addition to Web Navigator databases on the server.
  • Improved browser supporting HTML 3.
  • Use the search bar to enter URLs for Web sites.
  • Use Web Ahead to follow links automatically on a Web page.
  • Use Page Minder to keep track of changes to Web pages.
  • Use a Web Tour.

1.3.14  Security Features
  • Secure your workstation from potential problems by specifying who can run 

programs embedded in applications on your workstation.
  • Control the level of access that hosts running Java applets are allowed on 

your workstation.
  • Access an Internet server that uses the Secure Socket Layer.
  • Determine whether people can store forms in documents in a database.
  • Allowing the use of stored forms in documents can result in security problems.
  • Assign access levels to non-Notes users who gain access to a database, for 

example, using a Web browser.
  • Allow users with No Access or Depositor access to read, create, and modify 

documents in a database.

1.4  What’s New in Lotus Notes Release 4?

With Release 4 of Notes, Lotus had several goals. The new release contains 
enhancements to address the needs of many groups involved with Lotus Notes, 
including users, administrators, application developers, and managers. 
Specifically, the intent was to improve the user's satisfaction by lessening the 
complexity, making the system more intuitive and improving the mail interface 
and mobility support aspects. Another goal was to increase the value of Notes 
applications by providing more design capabilities and easier design facilities. 
The cost of ownership has been lowered by improving the scalability and 
robustness, while lessening the requirements for training, support, and 
administration.

There are many new features available in Notes Release 4. The workstation 
enhancements in Lotus Notes are significant in this release. They include a major 
redesign of the user interface, expanded capabilities for mobile users and the 
powerful LotusScript language.

This redbook will describe the installation, configuration, and administration 
scenario for Lotus Notes Release 4 in a UNIX environment, specifically IBM's 
version of UNIX, AIX. We used the Lotus Domino Server for AIX product and also 
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installed Notes Workstations for AIX, OS/2 Warp, and DOS/Windows 3.11. 
Please see Lotus Notes Release 4 in a Multiplatform Environment, SG24-4649, 
for more information on installing and administering Lotus Notes across a wide 
variety of operating system platforms.

In the next few sections, we list the new features that Lotus has incorporated into 
Release 4 and, where appropriate, explain how to access these functions.

1.4.1  Ease-of-Use Features
Lotus Notes Release 4 offers numerous ease-of-use features, including the ability 
to:

  • Update user preferences from a single dialog box. Choose File -> Tools -> 
User Preferences.

  • Preview a document in the preview pane. Choose View -> Document 
Preview.

  • Mark documents as read when you preview them. Choose File -> Tools -> 
User Preferences... to display the User Preferences dialog box and then 
check Mark documents read when opened in preview pane in the 
Advanced options section.

  • Use the InfoBox (usually fully qualified with the Notes entity, for example, 
Database Properties or Text Properties InfoBox) to obtain and change 
information on just about anything. For example, to view the properties of a 
document, right-click in the document and click on Document Properties.

  • Change or view more settings from the status bar:
  • See a list of recent messages issued by Notes.
  • See your level of access to a selected or open database.
  • See your current location and change your location if required.
  • Use a pop-up menu for selecting certain mail tasks.

  • If using Windows or UNIX, hide the horizontal scrolling bar to display more 
information in the view or preview panes. Choose View -> Show -> 
Horizontal Scroll Bar.

  • Double-click on a document in view mode to enter edit mode.
  • Use permanent pen to add comments to a document in a different color. 

Choose Text -> Permanent Pen.
  • Click on column headings to resort the view according to that column, if you 

see an upward or downward triangle.
  • Divide a view or a folder into panes (navigation, view, and preview) and 

specify the locations of the panes. Choose View -> Arrange Preview... to 
specify the locations.

  • Resize columns by dragging their borders.
  • Use private folders to store documents. Choose Create -> Folder.
  • Switch views using the navigation pane.
  • View an attached file in Notes even though you do not have the application to 

view it installed on your system.

1.4.2  Mail Features
The following mail features are new with Notes Release 4:

  • Improved mail template with action bars and folders.
  • A choice of many letterheads for your memos. Choose Actions -> Mail Tools 

-> Choose Letterhead....
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  • Create stationery for memos whose format and addressee list you want to use 
again. Choose Action -> Mail Tools -> Create Stationery.

  • A more user-friendly method of addressing mail using the Address... button 
on the New Memo screen.

  • Address memos using Notes' quick-addressing technology, where you start 
typing the name of the recipient, and Notes completes it for you if it can find 
the name in the Name and Address Book.

  • The ability to assign and track tasks (To Do Lists) using Notes mail. Choose 
Create -> Task.

  • Message creation that automatically includes a DocLink. Open the document 
for which you want to create the link and choose Create -> Mail -> Special -> 
Bookmark.

  • The ability to let recipients of your memo know the mood you were in when 
you sent the memo using mood stamps. Click Delivery Options... prior to 
sending your memo.

  • The ability to deter recipients from making public the content of your memo by 
having Notes disable the clipboard, printing and forwarding functions when the 
memo is delivered. Check Prevent copying from the Delivery Options dialog 
box.

  • The ability to view a discussion thread in your mail database. Choose 
Discussion Threads from the Navigation pane.

  • Senders can be added to your own Name and Address book either when you 
have a memo open, or when you have your mail database open. Select the 
memo(s) and choose Actions -> Mail Tools -> Add Sender to Address 
Book.

  • The ability to instruct Notes to reply to memos when you are out of the office. 
Choose Actions -> Mail Tools -> Out of Office....

  • Message archival from your mail database to a special database either on the 
server or on your own workstation. Click on Archiving from the Navigation 
pane and then click Setup Archive, if you have not already done so.

1.4.3  Mobile Features
Notes Release 4's new mobile features allow you to:

  • Create "locations" which store communication settings for the specific 
environment(s) that you use, for example, office and home. You can then 
choose your location when you log on, and all the communication settings 
come into effect. Select your Address Book and choose Create -> Location.

  • Call a passthru server and access multiple servers with the same phone call.
  • Use Help Lite while you are travelling. It contains information more specific to 

the mobile user and takes up less disk space than the original Notes Help 
database.

1.4.4  Document Authoring Features
The following document authoring features are new with Notes Release 4:

  • Add bullets to paragraphs. Highlight the text and choose Text -> Bullets.
  • Add numbers to lists. Highlight the text and choose Text -> Numbers.
  • Use the Text Properties InfoBox to change the form of text. Right-click on the 

highlighted text, and click Text Properties.
  • Create sections so that readers of your memo/document can collapse and 

expand the text as they need. Choose Create -> Section.
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  • Create links to views and documents. Choose Edit -> Copy As Link while in 
the document that you want to link to. Then, in the document/memo that you 
want to make the reference in, choose Edit -> Paste.

  • Create hotspots that either have pop-up text or take you to another link, 
perhaps in another database, or even on the Web. Choose Create -> Hotspot 
and then your choice of type of hotspot.

  • Include a selected font in a named paragraph style. Highlight the text that you 
want to save as a style and choose Text -> Text Properties. Click on the 
Style tab and then Create Style.

  • Assign named paragraph styles to a key and cycle through them. Highlight 
text and press F11 on your keyboard.

  • Format one or more rows or columns of a table by selecting them individually.
  • Display hidden characters. Choose View -> Show -> Hidden Characters.
  • If you have an international version of Notes, you can check the spelling in 

more than one language. Choose File -> Tools -> User Preferences... -> 
International then click on Spelling Dictionary.

1.4.5  Network Features
Notes Release 4's new network features allow you to:

  • Use the Web Navigator to browse the Web. See Chapter 9, “Lotus Domino 
and the World Wide Web” on page 217 for details.

  • More easily access, monitor, set up, and change port configurations.
  • Connect to a remote local area network service.
  • Trace a network connection; so if you cannot make a connection, you can see 

where the problem lies.

1.4.6  Printing Features
Notes Release 4's new printing features allow you to:

  • Specify a printer from the File Print dialog box. Choose File -> Print and then 
click Printer.

  • Specify multi-line headers and footers. Obtain the InfoBox for the document or 
database and click on the Printer tab.

  • Print a list of documents in a folder.

1.4.7  Replication Features
Notes Release 4's new replication features allow you to:

  • Replicate selected folders and views without having to specify a formula. See 
5.4, “Selective Replication” on page 136 for details.

  • Replicate databases using the replicator page which makes it easier to 
replicate databases in the background. Click on the Replicator tab on your 
workspace.

  • Shorten long incoming documents in a replica or remove old documents.
  • Display replica icons as a single stacked icon. See 5.3.4, “Creating the 

Replica on the Spoke Server” on page 134 for further information.

1.4.8  Search Features
Notes Release 4's new search features allow you to:

  • Search without indexing a database. Choose View -> Search Bar.
  • Add conditions to a search without having to write a formula.
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  • Name and save search formulas.

1.4.9  Security Features
Notes Release 4's new security features allow you to:

  • Keep local databases secure from unauthorized local or operating system 
access. Refer to 8.1.3, “Local Database Encryption” on page 190 for further 
information.

  • Restrict who can read selected documents in a database. Display the 
Document Properties InfoBox (Edit -> Properties...) and click on the Security 
tab - the one with the key as its icon. Uncheck All readers and above and 
specify the names of the people to whom you want to give access.

  • Create a new public key for your user ID and have Notes certify it.

1.4.10  Workspace Features
Notes Release 4's new workplace features allow you to:

  • Add or remove workspace pages. Choose Create -> Workspace Page to 
create and press Delete on your keyboard to remove.

  • Keep the workspace behind other windows while you work.
  • Compact your workspace file, freeing up the space that is no longer used. 

Choose Edit -> Properties... when on your workspace page, then click on the 
Information tab. Click % used. If the value returned is less than 85 percent, 
then click Compact.

  • Display the workspace in three dimensions. Choose File -> Tools -> User 
Preferences... then check Textured Workspace in the Advanced options 
section of the dialog box.

1.4.11  Application Development/Programming Features
The following programming/application development features are new with Notes 
Release 4. For further details on programming with Notes Release 4, refer to the 
redbook, Developing Applications with Lotus Notes Release 4, SG24-4618.

  • Agents, which allow you to use more powerful and predefined actions, such as 
Move to folder or Send document.

  • Forms and fields design features which allow you to:
  • Create forms with layout regions.
  • Display access-controlled sections in new ways.
  • Use subforms to store commonly used elements.
  • Write scripts which execute when an event happens.
  • Use new lookup features to generate lists for keywords, names, readers, 

and authors without writing formulas.
  • Allow author anonymity.
  • Control cursor location and field focus.
  • Design forms that open in edit mode.
  • Automatically merge replication conflicts into a single conflict document.
  • Test a form without leaving the design environment.
  • Create action bars in a form to automate user tasks in forms and subforms.
  • Create forms that display as dialog boxes.

  • LotusScript, an object-oriented, cross-platform, BASIC-compatible language.
  • New @functions such as @AllChildren and @URLOpen.
  • Execution of @functions in the order that they appear.
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  • Open Database Connectivity (ODBC) options that allow access to non-Notes 
databases.

1.4.12  Database Management Features
Notes Release 4's new Management features allow you to:

  • Analyze database statistics from one centralized location. Select the database 
and choose Edit -> Properties. Click on User Activity.

  • Create databases that can reach a maximum size. You can choose specific 
values up to 4 GB. Users will not be able to add any more documents to the 
database once it reaches this size.

  • Start background indexing; so you can create full text indexes in the 
background.

1.5  Available Platforms

The new release of Lotus Domino server elevates the standard for enterprise 
messaging, groupware, and Web application development servers. It is available 
on all Lotus Domino server platforms.

The following table is a summary of the various operating systems platforms that 
support Lotus Notes Release 4.6.

Table 1.  Available Platforms for Release 4.6

1.5.1  AIX
Environment(s): AIX V4.1.4, V4.2, and V4.3

Workstation: Yes

Server: Yes

Network protocols available on Workstation:

  • NetWare IPX/SPX
  • TCP/IP
  • X.PC (supplied with Lotus Notes software)

Network protocols available on Server:

Platform Domino Server Release 4.6 Notes Workstation Release 4.6

UNIX (AIX V4.1.5, AIX V4.2, V4.3,
HP-UX 10.01, Solaris 2.51, Solaris 2.6)

Yes Yes

OS/2 Warp Server V4.0 (32-bit) Yes Yes

OS/2 Warp Server 4 - Entry, Warp
Server 4 - Advanced, Warp Server 4
with SMP Feature

Yes Yes

Windows 95 Yes Yes

NetWare 4.1 Yes Yes

Windows NT Server 4.0 and 
Windows NT Workstation 4.0

Yes Yes

Macintosh System 7.5 Yes Yes
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  • NetWare IPX/SPX
  • TCP/IP
  • X.PC (supplied with Lotus Notes software)

Disk Space:

  • Installation or distribution directory: 200 MB minimum
  • Server data directory: 50 MB minimum
  • Workstation data directory: 40 MB minimum
  • Swap Space: 256 MB minimum
  • Additional databases and mail files: 300 MB minimum, 500 MB or greater 

recommended

Memory Requirements:

  • Lotus Domino Server on AIX: 64 MB RAM minimum

128 MB or greater recommended

  • Notes Workstation on AIX: 32 MB RAM minimum

64 MB or greater recommended

Patch Requirements:

Some of the base AIX V4.1 filesets must be updated to the following levels on 
AIX V4.1.4 to run Notes R4.6 for AIX. The PTF (program temporary fix) (U4xxxxx) 
numbers are provided as a reference when ordering these updates from your IBM 
Support Center. The updates can also be retrieved from the AIX Fixdist at 
http://service.boulder.ibm.com/rs6000

Table 2.  Patches for AIX V4.1.4

Patch Number (APAR/PTF) Synopsis Version Number

IX55384/U441186 bos.adt.include 4.1.4.4

IX62509 bos.adt.prof 4.1.4.21

IX58507/U444415 bos.net.tcp.client 4.1.4.16

IX62509 bos.rte.libc 4.1.4.19

IX62509 bos.rte.libc 4.1.4.14

IX55384/U441121 bos.rte.streams 4.1.4.2

IX59142/U444061 bos.rte.tty 4.1.4.13

IX55837/U441583 bos.sysmgt.serv_aid 4.1.4.5

IX60082/U444377 If installed, the following fileset needs to
be updated to the indicated level

bos.rte.up

4.1.4.17

IX60082/U444115 If installed, the following fileset needs to
be updated to the indicated level

bos.rte.mp

4.1.4.17
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Some of the base AIX V4.1 filesets must be updated to the following levels on 
AIX V4.1.5 to run Lotus Domino Server or Notes Workstation R4.6 for AIX. The 
APAR (authorized program analysis report) (IXxxxx) and PTF (U4xxxxx) numbers 
are provided as a reference when ordering these updates from your IBM Support 
Center:

Table 3.  Patches for AIX V4.1.5

IX55293/U440895 If installed, the following fileset needs to
be updated to the indicated level

bos.rte.security

4.1.4.2

IX57406/U443030 If installed, the following fileset needs to
be updated to the indicated level

devices.mca.8ef4

4.1.4.4

IX58009/U443421 If installed, the following fileset needs to
be updated to the indicated level

devices.mca.ffe1

4.1.4.8

U449238 xlC.rte

For Notes 4.1x and 4.5x, use:
For Notes 4.6, use:

3.1.3.0 or 3.1.4.0
3.1.4.4

IX60679/U445544 ipx.rte 4.1.4.10

IX61435/U447192 connect.protocols 4.1.4.7
(for AIX connections)

IX60634/U445530 connect.server.nwserve 4.1.4.8
(for AIX connections)

IX56814/U442705 connect.server.com 4.1.4.2
(for AIX connections)

Patch Number (APAR/PTF) Synopsis Version Number

U446706 X11.Dt.lib 4.1.5.2

U446812 bos.net.nfs.client 4.1.5.1

U446810 bos.rte.lvm 4.1.5.3

U446245 bos.adt.prof 4.1.5.1

U446855 bos.rte.man 4.1.5.2

U446244 bos.rte.libc 4.1.5.1

U445109 devices.isa_sio.sa.rte 4.1.5.1

U446761 bos.rte.tty 4.1.5.2

U446701 devices.pci.00100100.rte 4.1.5.1

U445116 devices.pci.00100f00.rte 4.1.5.1

U445081 devices.pci.14101800.rte 4.1.5.1

Patch Number (APAR/PTF) Synopsis Version Number
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Some of the base AIX V4.1 filesets must be updated to the following levels on 
AIX V4.2.1 to run Notes R4.6 for AIX. The PTF (U4xxxxx) numbers are provided 
as a reference when ordering these updates from your IBM Support Center. The 
updates can also be retrieved from the AIX Fixdist server at 
http://service.boulder.ibm.com/rs6000

Table 4.  Patches for AIX V4.2.1

U446247 devices.pci.14105400.X11 4.1.5.1

U446708 devices.pci.14105400.rte 4.1.5.2

U445070 devices.pci.14105e00.X11 4.1.5.1

U446745 devices.pci.14105e00.rte 4.1.5.2

U445032 devices.pcmcia.serial.com 4.1.5.1

U449238 xlC.rte

For Notes 4.1x and 4.5x use:
For Notes 4.6 use:

3.1.3.0 or 3.1.4.0
3.1.4.4

U446817 If installed, the following fileset needs to
be updated to the indicated level

bos.rte.mp

4.1.5.3

U446869 If installed, the following fileset needs to
be updated to the indicated level

bos.rte.up

4.1.5.3

U442271 ipx.rte 4.1.5.0

U447411 connect.server.com 4.1.5.3

U447415 connect.protocols 4.1.5.1

U447397 connect.server.nwserve 4.1.5.2

APAR IX72217 Required if using Yellow Pages for name
resolution

bos.rte.libc

Patch Number
(APAR/PTF)

Synopsis Version Number

U449238 xlC.rte

For Notes 4.1x and 4.5x use:
For Notes 4.6 use:

3.1.3.0 or 3.1.4.0
3.1.4.4

U448806 If installed, the following fileset needs to
be updated to the indicated level

bos.mp

4.2.1.0

Patch Number (APAR/PTF) Synopsis Version Number
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Some of the base AIX V4.3 filesets must be updated to the following levels to run 
Notes Release 4.6.2 for AIX. The PTF (U4xxxxx) numbers are provided as a 
reference when ordering these updates from your IBM Support Center. The 
updates can also be retrieved from the AIX Fixdist server at 
http://service.software.ibm.com/www/support/aix

Table 5.  Patches for AIX V4.3

Some of the base AIX V4.3.1 filesets must be updated to the following levels to 
run Notes Release 4.6.2 for AIX. The PTF (U4xxxxx) numbers are provided as a 
reference when ordering these updates from your IBM Support Center. The 
updates can also be retrieved from the AIX Fixdist server at 
http://service.software.ibm.com/www/support/aix

Table 6.  Patches for AIX V4.3.1

U448841 If installed, the following fileset needs to
be updated to the indicated level

bos.up

4.2.1.0

U454693 Needed to fix an NIS bug
bos.rte.control

4.2.1.8

U454696 Needed to fix an NIS bug
bos.rte.libs

4.2.1.8

U454662 Needed to fix an NIS bug
bos.rte.libc

4.2.1.10

U454703 Needed to fix an NIS bug
bos.adt.prof

4.2.1.12

U454713 Needed to fix an NIS bug
bos.rte.shell

4.2.1.10

APAR IX72217 Required if using Yellow Pages for name
resolution

bos.rte.libc

Patch Number
(APAR/PTF)

Synopsis Version Number

U453900 (APAR IX73966) Needed to fix an NIS bug
bos.adt.prof

4.3.0.4

U453844 (APAR IX73966) Needed to fix an NIS bug
bos.64bit

4.3.03

U453892 (APAR IX73966) Needed to fix an NIS bug
bos.rte.libc

4.3.0.4

Patch Number
(APAR/PTF)

Synopsis Version Number

U457132

Patch Number
(APAR/PTF)

Synopsis Version Number
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1.5.1.1  Lotus Domino Server on AIX - Supported Network Protocols
Lotus Domino Server on AIX runs with any of the following network protocols:

  • TCP/IP (comes with the AIX operating system)
  • X.PC (comes with both the Lotus Domino Server and the Notes Workstation 

software)
  • IPX/SPX

  • SPX support for AIX V4 is provided by the fileset ipx.rte, which is shipped 
on the AIX V4 Server CD, or by the SPX support in AIX Connections. The 
filesets for SPX support must be updated to the following levels for Notes 
R4.5:

Table 7.  AIX PTFs for SPX Support Data Directories 

  • For the latest AIX PTFs for SPX support data directories, please look at the 
Website http://www.lotus.com.

If you have AIX Connections installed, then AIX Connections (for AIX V4.1.4 or 
AIX V4.2) must be updated to the following levels: (Please note that AIX 
Connections is not required for SPX support. SPX support also comes with the 
AIX V4 Server code in the fileset ipx.rte.)

Table 8.  AIX Connections PTFs for SPX Support 

  • For the latest AIX Connection PTFs for SPX support on AIX version 4.3, 
please look into the website http://www.lotus.com.

You can use the following commands to see what level of the filesets, if any, you 
have installed:

lslpp -l ipx.rte

lslpp -l connect.*

1.5.2  OS/2 Warp (32-bit)
Server Environment(s): OS/2 Warp, Warp Connect, OS/2 2.11 SMP, OS/2 Warp 
Server

Workstation Environment(s): OS/2 Warp, Warp Connect

AIX Server Version PTF Number Fileset Level

AIX V4.1.4 U445764 ipx.rte 4.1.4.11

AIX V4.2 U446067 ipx.rte 4.2.0.3

PTF Number Fileset Level

U445778 + IX62795 connect.protocols 4.1.4.6

U445530 connect.server.newserve 4.1.4.8

U442705 connect.server.com 4.1.4.2

Domino Advanced Services clusters and partitioned server configurations do 
not support the IPX/SPX protocol in Release 4.6.1a. At this time, Lotus does 
not plan to provide IPX/SPX network support for future releases of these 
features.

Important Note
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Workstation: Yes

Server: Yes

Network protocols available on Server:

  • TCP/IP
  • AppleTalk (Not with Warp Server 4 with SMP Feature)
  • Banyan VINES (Not with Warp Server 4 with SMP Feature)
  • NetBIOS
  • NetWare IPX/SPX
  • X.PC (supplied with Lotus Notes software)

Network protocols available on Workstation:

  • TCP/IP
  • Banyan VINES
  • NetBIOS
  • NetWare IPX/SPX
  • X.PC (supplied with Lotus Notes software)

Memory Requirement:

  • Lotus Domino Server 32 MB RAM minimum, 48 MB or greater recommended
  • Notes Workstation 8 MB RAM minimum, 12 MB or greater recommended

Disk Space - Server:

  • Additional databases and mail files: 300 MB minimum, 500 MB or greater 
recommended

  • Disk Swap Space: 16 MB

Disk Space - Workstation:

  • 30 MB minimum, 40 MB or greater recommended

1.5.3  Windows 95 (32-bit)
Environment(s): Windows 95 (32-bit)

Workstation: Yes

Server: No

Network protocols available on Workstation:

  • Banyan VINES
  • NetBIOS
  • NetWare IPX/SPX
  • TCP/IP
  • X.PC (supplied with Lotus Notes software)

Network protocols available on Server:

  • Banyan VINES
  • NetBIOS
  • TCP/IP
  • X.PC (supplied with Lotus Notes software)

Memory Requirement:
20 Lotus Domino Release 4.6 on IBM RS/6000



  • Notes Workstation 16 MB minimum, 24 MB or greater recommended

1.5.4  Windows NT (32-bit)
Server Environment(s): Windows NT Server Release 3.51 and 4.0

Workstation Environment(s): Windows NT Workstation Release 3.51 and 4.0

Workstation: Yes

Server: Yes

Network protocols available on Server:

  • AppleTalk
  • Banyan VINES
  • NetBIOS
  • NetWare IPX/SPX
  • TCP/IP
  • X.PC (supplied with Lotus Notes software)

Memory Requirement:

  • Windows NT (32-bit) Server: 48 MB minimum, 64 MB or greater recommended
  • Windows NT (32-bit) Workstation: 16 MB minimum, 24 MB or greater 

recommended

1.6  Our Lotus Domino Server and Notes Workstation Environment

We have installed and set up Lotus Domino Servers and Notes Workstations in 
an environment with many different operating systems and networking protocols. 
Throughout the rest of this book, we will be explaining our installation in great 
detail. The following figure shows the various Lotus Domino Servers, Notes 
Workstations, and networking protocols which we have used.
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Figure 1.  Lotus Domino Servers and Notes Workstations Environment in Our Lab
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Chapter 2.  Installing a Lotus Domino Server

This chapter outlines how to install a Lotus Domino Server. It also lists the system 
requirements for the AIX version of the Lotus Domino Server and contains helpful 
tips for a successful installation.

2.1  Hardware and Software System Requirements

The following information specifically relates to the installation of the Lotus 
Domino Server on AIX. AIX is IBM’s implementation of the UNIX operating 
system.

The Lotus Domino Release 4.6 Server on AIX requires the following hardware, 
software, and disk space:

  • An IBM RS/6000 running IBM AIX Version 4.1.4, 4.2, 4.3 or greater
  • Minimum of 128 MB of RAM required
  • Minimum of 256 MB of paging space required
  • 200 MB of hard disk space for the installation directory (/usr/domino/lotus)
  • 42 MB to 113 MB disk space for data directories

See Table 9, for specific details on the disk space requirements for the data 
directories.

Table 9.  Disk Space Requirements 

Note: Disk space for Lotus Notes Data Directories and binaries may differ 
depending on the features you select to install and upon your specific 
requirements.

  • 300 MB or larger additional hard disk space for Lotus Notes databases (.NSF 
files) and mail files (a separate disk is best for performance reasons)

  • Graphic display supported by IBM AIX Version 4.1.4, 4.2, or 4.3
  • Mouse
  • Printer supported by IBM AIX Version 4.1.4, 4.2, or 4.3 (optional)
  • Modem (only if you plan to dial into the Lotus Domino Server)

Data Directories Disk Space ($HOME/notesr4)

User Data Files 1 MB

Advanced Services Data Files 1 MB

Domino Server Data Files 24 MB

Notes Workstation Data Files 17 MB

Help Lite Database 11 MB

Help Database 46 MB

Documentation Databases 12 MB

Domino Partition Server 1 MB

TOTAL 113 MB + 200 MB (/usr/domino/lotus) = 313
MB
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2.1.1  Lotus Domino Servers
Lotus Domino Server software has currently been certified to run on the following 
operating system platforms:

  • AIX V4.1.4 or AIX V4.2
  • HP-UX 10.01
  • NetWare 3.12, NetWare 4.1
  • IBM OS/2 Warp Server V4 (Entry, Advanced, and with SMP feature) and OS/2 

Warp Connect
  • Sun Solaris 2.5 and 2.5.1 (SPARC, UltraSPARC)
  • Microsoft Windows 95
  • Microsoft Windows NT Server 3.51 and 4.0, Microsoft Windows NT 

Workstation 3.51 and 4.0

2.1.2  Notes Workstation Clients
Notes Workstation Client software has currently been certified to run on any of 
the following operating system platforms:

  • AIX V4.1.4 or AIX V4.2
  • HP-UX 10.01
  • Sun Solaris 2.5 and 2.5.1 (SPARC, UltraSPARC)
  • IBM OS/2 Warp V3, Warp V4, and Warp Connect
  • Apple Macintosh System 7.5
  • Microsoft Windows 95
  • Microsoft Windows NT Workstation 3.51 and 4.0

2.2  Preparing the Environment for the Installation

The steps for preparing for the installation are listed below. If you are installing 
Lotus Notes on multiple hosts, you must perform all these steps on each of the 
target hosts.

1. Log onto the AIX machine as the root user.

2. Check that /usr/sbin is in your default path. Many of the AIX system 
commands that we'll be using to set up the machine are found in /usr/sbin.

Type in the command echo $PATH to see if /usr/sbin is in your default path.

If /usr/sbin is not in your default path, you can add it to your default path by 
editing the PATH statement in /etc/environment.

3. Check to see if there is enough space on an existing volume group for the 
installation code. You will need about 200 MB for the installation code in 
/opt/lotus. You can either use space within an existing volume group, for 
example, rootvg, or you could create a new volume group, for example called 
dominovg. This new volume group could then contain all your Lotus Domino 
related files. 

Creating a new volume group would allow for easier backup/recovery or 
migration to a different server. In case of a hardware failure or server upgrade, 
you would simply export the volume group, put the disk on another machine, 
and import the volume group again.

To see if you have enough space on an existing volume group, type the 
command lsvg <volume_group>. To check the rootvg, type lsvg rootvg (Figure 
2).
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Figure 2.  lsvg rootvg (Free Space: 1140 megabytes = 4 x 285)

2.2.1  Create a New Volume Group for the Lotus Domino Server Binaries
If you don’t want to create a new volume group for the installation code, you can 
skip to 2.2.2, “Create the Logical Volume for the Lotus Domino Server Binaries” 
on page 26.

To create a new volume group to contain the installation software, type in the 
command smitty mkvg to display the Add a Volume Group screen (Figure 3).

Figure 3.  Add a Volume Group Screen

In our example, we are calling our volume group, dominovg, and we are creating 
it on our hard disk called hdisk1. Depending on the size of your hard disk, you 
may have to specify another (larger) physical partition size.

VOLUME GROUP:   rootvg                   VG IDENTIFIER:  00612519a6ebe256
VG STATE:       active                   PP SIZE:        4 megabyte(s)
VG PERMISSION:  read/write               TOTAL PPs: 515 (2060 megabytes)
MAX LVs:        256                      FREE PPs: 285 (1140 megabytes)
LVs:            12                       USED PPs:       230 (920 megabytes)
OPEN LVs:       11                       QUORUM:         2
TOTAL PVs:      1                        VG DESCRIPTORS: 2
STALE PVs:      0                        STALE PPs:      0
ACTIVE PVs:     1                        AUTO ON:        yes
MAX PPs per PV: 1016                     MAX PVs:        32

 Add a Volume Group

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
  VOLUME GROUP name                                  [dominovg]
  Physical partition SIZE in megabytes                4                           
* PHYSICAL VOLUME names                              [hdisk1]                    
  Activate volume group AUTOMATICALLY                 yes                         
    at system restart?
  Volume Group MAJOR NUMBER                          []                           
  Create VG Concurrent Capable?                       no +
  Auto-varyon in Concurrent Mode?                     no +
  
  

    
    
    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              
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2.2.2  Create the Logical Volume for the Lotus Domino Server Binaries
In AIX, it is a better practice to create a logical volume and then add the journaled 
filesystem on this logical volume. By following this procedure, we can place the 
logical volume and the filesystem at the desired portion of the hard disk, thus 
improving the system performance.

The following steps and screens will show you how we created the logical volume 
for the Lotus Domino Server binaries.

Type smitty mklv to display the Add a Logical Volume screen (Figure 4).

Figure 4.  Add a Logical Volume Screen for Entering Volume Group Name

Select the name of the volume group in which you want to place this logical 
volume. In our example, we select the volume group name dominovg.

Create the logical volume for the installation software. In our example, we 
named it noteslv, size: 200 MB.

 Add a Logical Volume

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* VOLUME GROUP name                                  [dominovg]

F1=Help              F2=Refresh           F3=Cancel            F4=List
F5=Reset             F6=Command           F7=Edit              F8=Image
F9=Shell             F10=Exit             Enter=Do                    
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Figure 5.  Add a Logical Volume Screen 

The placement of data on the disk affects its performance. The closer the data is 
to the center of the disk the better. This alleviates the problem of disk arm travel. 
Since your Lotus Domino binaries are read only and only accessed when starting 
the server or the workstation, you can keep them at the edge of the disk.

2.2.3  Create the Logical Volume for Lotus Domino Server Databases
The following steps and screens will show you how we created the logical volume 
for the Lotus Domino Server Databases:

1. Type smitty mklv to display the Add a Logical Volume screen (see Figure 6 on 
page 28).

 Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
  Logical volume NAME                                [noteslv]                  
* VOLUME GROUP name                                   dominovg                    
* Number of LOGICAL PARTITIONS                       [50]                         
  PHYSICAL VOLUME names                              [hdisk1]                    
  Logical volume TYPE                                []
  POSITION on physical volume                         edge                       
  RANGE of physical volumes                           minimum                     
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []                           
    to use for allocation
  Number of COPIES of each logical                    1                           
    partition
  Mirror Write Consistency?                           yes                         
  Allocate each logical partition copy                yes                         
    on a SEPARATE physical volume?
  RELOCATE the logical volume during                  yes                         
    reorganization?
  Logical volume LABEL                               []
MAXIMUM NUMBER of LOGICAL PARTITIONS               [512]

  Enable BAD BLOCK relocation?                        yes                         
  SCHEDULING POLICY for reading/writing               parallel                    
    logical partition copies
  Enable WRITE VERIFY?                                no                          
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]                
[BOTTOM]
    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              
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Figure 6.  Add a Logical Volume Screen to Enter Volume Group Name

Select the name of the volume group in which you want to place this logical 
volume. In our example, we selected the volume group name dominovg.

2. Create the logical volume for the installation software. In our example, we 
named it notesdatalv, size: 140 MB.

Figure 7.  Add a Logical Volume Screen

 Add a Logical Volume

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* VOLUME GROUP name                                  [dominovg] +

F1=Help              F2=Refresh           F3=Cancel            F4=List
F5=Reset             F6=Command           F7=Edit              F8=Image
F9=Shell             F10=Exit             Enter=Do                    

 Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
  Logical volume NAME                                [notesdatalv]
* VOLUME GROUP name                                   dominovg
* Number of LOGICAL PARTITIONS                       [35]                         
  PHYSICAL VOLUME names                              [hdisk1]                   
  Logical volume TYPE                                []
  POSITION on physical volume                         center +
  RANGE of physical volumes                           minimum                     
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []                           
    to use for allocation
  Number of COPIES of each logical                    1                           
    partition                  
  Mirror Write Consistency?                           yes                         
  Allocate each logical partition copy                yes                         
    on a SEPARATE physical volume? 
  RELOCATE the logical volume during                  yes                         
    reorganization?                                                            
  Logical volume LABEL                               []                        
MAXIMUM NUMBER of LOGICAL PARTITIONS               [512]

  Enable BAD BLOCK relocation?                        yes                         
  SCHEDULING POLICY for reading/writing               parallel                    
    logical partition copies
  Enable WRITE VERIFY?                                no                          
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]                
[BOTTOM]
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The placement of data on the disk affects its performance. The closer the data 
is to the center of the disk the better. This alleviates the problem of disk arm 
travel. 

2.2.4  The File System for the Lotus Domino Server Binaries
If you don’t use the default directory where Lotus Notes installs the software 
(/opt/lotus), the install program creates symbolic links from /opt/lotus to the install 
directory that you specify. The final directory name of the path must be lotus.

In AIX, we need to create a file system to contain the installation binary code 
which is copied from the CDROM to the hard disk on your AIX system. The 
following steps and screens will show you how we created this file system on the 
logical volume.

1. Create a file system for the installation software. In our example, we called it 
/usr/domino, size: 200 MB.

  • Type smitty crjfslv to display the Add a Journaled File System on a 
Previously Defined Logical Volume screen (see Figure 8).

Figure 8.  Add a Journaled File System on a Previously Defined Logical Volume

  • When you select Add a Standard Journaled File System by pressing the 
Enter key, the screen, as shown in Figure 9, is displayed.

 Add a Journaled File System on a Previously Defined Logical Volume

Move cursor to desired item and press Enter.

  Add a Standard Journaled File System
  Add a Compressed Journaled File System
  Add a Large File Enabled Journaled File System

              
F1=Help              F2=Refresh           F3=Cancel            F8=Image
F9=Shell             F10=Exit             Enter=Do                    
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Figure 9.  Add a Standard Journaled File System Screen

  • Press Enter to create the filesystem.

2. Mount the filesystem just created for the Lotus Domino Server Binaries. In our 
example, it is named /usr/domino.

  • mount /usr/domino

2.2.5  The File System for the Lotus Domino Server Databases

1. Create the file system for the Lotus Domino Server databases. In our 
example, we called it /server1, size: 140 MB.

  • Type smitty crjfslv to display the Add a Journaled filesystem on a 
Previously Defined Logical Volume screen (see Figure 10 on page 31).

 Add a Standard Journaled File System 

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* LOGICAL VOLUME name                                 noteslv                   
* MOUNT POINT                                        [/usr/domino]
  Mount AUTOMATICALLY at system restart?              yes                        
  PERMISSIONS                                         read/write                  
  Mount OPTIONS                                      []                           
  Start Disk Accounting?                              no                          
  Fragment Size (bytes)                               4096                        
  Number of bytes per inode                           4096                        
  Allocation Group Size (MBytes)                      8                           
    
    

    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              

You do not have to create a separate file system for the Lotus Domino Server 
databases. This is an optional step. If you choose not to create a file system for 
the Lotus Domino Server databases, by default, the setup process will put the 
Lotus Domino Server databases in the notes userid's $HOME/notesr4 
directory, that is, /home/notes/notesr4.

If you do choose to create a file system for the Lotus Domino Server 
databases, for best performance, you should use disk-striping technology for 
this file system.

Note
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Figure 10.  Add a Journaled File System on a Previously Defined Logical Volume

  • When you select Add a Standard Journaled File System by pressing the 
Enter key, the screen, as shown in Figure 11, is displayed.

Figure 11.  Add a Standard Journaled File System Screen

  • Press Enter to create the filesystem.

2. Or, create a striped file system (for best performance results) and mount it.

Disk striping is a technique for spreading the data in a logical volume 
across several disk drives in such a way that the I/O capacity of the disk 
drives can be used in parallel to access data on the logical volume.

Obviously, at least two physical drives are required. The drives used 
should have little other activity when the performance-critical sequential I/O 
is taking place. Some combinations of disk adapter and disk drive will 

 Add a Journaled File System on a Previously Defined Logical Volume

Move cursor to desired item and press Enter.

  Add a Standard Journaled File System
  Add a Compressed Journaled File System                
  Add a Large File Enabled Journaled File System      

  

F1=Help              F2=Refresh           F3=Cancel            F8=Image        
F9=Shell             F10=Exit             Enter=Do                              

 Add a Standard Journaled File System 

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* LOGICAL VOLUME name                                 notesdatalv              
* MOUNT POINT                                        [/server1]
  Mount AUTOMATICALLY at system restart?              yes                        
  PERMISSIONS                                         read/write                  
  Mount OPTIONS                                      []                           
  Start Disk Accounting?                              no                          
  Fragment Size (bytes)                               4096                        
  Number of bytes per inode                           4096                        
  Allocation Group Size (MBytes)                      8                           
    
    

    
    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              
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require dividing the workload of a striped logical volume between two or 
more adapters.

For example, to create a striped logical volume in the volume group 
dominovg called notesdatalv, with 35 logical partitions, and with a stripe 
size of 64 KB across hdisk1, hdisk2 and hdisk3:

1. Type mklv -y notesdatalv -S 64K dominovg 35 hdisk1 hdisk2 hdisk3

2. Type crfs -v jfs -d notesdatalv -m /server1 -A yes -p rw -t no -a 
frag=4096 -a nbpi=4096 -a compress=no

3. Mount the filesystem just created for the Lotus Domino Server Databases, in 
our example, it is named /server1:

mount /server1

4. Create an AIX group account for Lotus Notes by issuing the command:

mkgroup -A notes

5. Create an AIX user account for ownership of the Lotus Notes software by 
issuing the command:

mkuser pgrp=notes groups=’staff, notes’ home=/server1 gecos="Lotus Notes 
User" notes

6. Define a password for user notes by issuing the command:

pwdadm notes

7. Change ownership of the Lotus Notes /usr/lpp/lotus and /notes file systems 
by issuing the command:

chown -R notes.notes /usr/domino

chown -R notes.notes /server1

8. To mount the CD-ROM type:

mount -r -v cdrfs /dev/<device_name> <cd_mount_point>

An example of this is the command

mount -r -v cdrfs /dev/cd0 /cdrom

where:

<device_name> is cd0 and <cd_mount_point> is /cdrom

If the <cd_mount_point> does not exist, you can create it by using the command 
mkdir <cd_mount_point>, for example, mkdir /cdrom.

2.2.6  Setting Up a Local Area Network (LAN)
The following sections describe the setup steps for a local area network (LAN).

For more information on disk striping, please refer to Chapter 14, 
“System Performance Considerations” on page 385

Note

Refer to 6.3.2, “Distributing the UNIX Installation Kit” on page 157 to see 
how to mount the installation kit using NFS.

Note
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2.2.6.1  Setting Up a TCP/IP Network
You should have basic knowledge of TCP/IP and also be familiar with the naming 
conventions of a TCP/IP network, or ask the administrator for the correct 
parameters for hostname, network address, netmask, and so on.

1. Check to see if the following software is installed by using the command:

lslpp -l bos.net.* | pg:

2. For AIX V4.1.4:

bos.net.tcp.client   4.1.4.16       TCP/IP Client Support

3. For AIX V4.2:

bos.net.tcp.client   4.2.0.6        TCP/IP Client Support

4. For AIX V4.3.1:

bos.net.tcp.client 4.3.1.0 TCP/IP Client Support

5. Enter smitty tcpip.

6. Select Minimum Configuration & Startup and press Enter.

7. Select the correct Network Interface (token ring, Ethernet, or others) and 
press Enter.

In the Minimum Configuration & Startup screen (see Figure 12), you must 
enter the configuration information. Here, for example, is the information for a 
token-ring adapter.

Figure 12.  Minimum TCP/IP Configuration for Token Ring Sample

2.2.6.2  Setting Up a Network Using IPX/SPX
If your network uses the IPX or SPX protocols, you will need to perform the 
following to insure that you have the correct setup for installing the Lotus Domino 
Server on AIX.

 Minimum Configuration & Startup

   To Delete existing configuration data, please use Further Configuration menus

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* HOSTNAME [ah1610d.itsc.austin.ibm.co>
* Internet ADDRESS (dotted decimal) [9.3.1.113]
  Network MASK (dotted decimal) [255.255.255.0]
* Network INTERFACE tr0
  NAMESERVER
           Internet ADDRESS (dotted decimal) [9.3.1.74]
           DOMAIN Name [itsc.austin.ibm.com]
  Default GATEWAY Address [9.3.1.74]
  (dotted decimal or symbolic name)
  RING Speed [autosense]                  +
  START Now yes +
    
    

F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              
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1. Check to see if the following software is installed by using the command:

lslpp -l ipx.* | pg

2. For AIX V4.1.4:

ipx.rte                    4.1.4.11        IPX and SPX Protocol Stacks

3. For AIX V4.2:

ipx.rte                    4.2.0.3         IPX and SPX Protocol Stacks

4. For AIX V4.3.1:

ipx.rte                    4.2.1.0 IPX and SPX Protocol Stacks

5. Edit the /etc/netware/NPSConfig file and change the 
internal_network=<number> and the adapter information.

Ask the administrator for the correct value for the lan_1_network value. In our 
example, shown in Figure 13, lan_1_network = "10000045".

Please be sure that the value of the lan_1_network value matches the other 
system’s lan_1_network value in the same domain.

For example, using a token-ring adapter the /etc/netware/NPSConfig (Figure 
13 on page 35) might look like:
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Figure 13.  NetWare NPSConfig File

6. Kill processes /sapd and /npsd and then restart them with the korn shell script 
/etc/rc.netware or reboot the system to start IPX/SPX support.

/*
 *   COMPONENT_NAME: NETWARE
*
 *   (C) COPYRIGHT International Business Machines Corp. 1992,1993
 *   All Rights Reserved
 *   Licensed Materials - Property of IBM
 *   US Government Users Restricted Rights - Use, duplication or
 *   disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
 *
 *   @(#)36 1.18  src/netware/aix/etc/netware/NPSConfig, netw_admin, netware420,
 9613T 3/9/94 13:42:28
 */
/* * Novell Protocol Suite (NPS) configuration/tunables file.
 *
 * "adm/etc/NPSConfig.SRC 1.7 (Novell) 8/14/91"
 */

/*      General configuration. */
nvt_server_name = "PORTABLE"    /*      Set the NVT server name */

track_on = inactive             /*      Track on active on startup */

spx = active                    /* have architecture daemon open spx AND
                                uncomment spx driver in /etc/netware.conf */
nvt = inactive                  /* have architecture daemon open nvt AND
                                uncomment nvt driver in /etc/netware.conf */
sap = active                    /* have architecture daemon start the 
                                Service Advertising Protocol */
netbios = inactive              /* have architecture daemon open netbios AND
                                Note: NetBios is not supported in the current
                                      version of AIX. */ 

netbios_shim = "nbix"

nvt_getty_entry = "unused"
nvt_init_level = 23
nvt_spawns = 10
nvt_line_disc =  

sap_standard_out = "/dev/console"
sap_error_out = "/var/netware/sap.error"
sap_reply_delay = 200

priority = 15           
capture_utility = inactive              /*      default is inactive */

internal_network = "00000045"

lan_1_adapter = "/dev/dlpi/en"
lan_1_adapter_type = "ETHERNET_DLPI"
lan_1_ppa = 0
lan_1_if_name = "en"
lan_1_frame_type = "ETHERNET_II"
lan_1_module = "NULL"
lan_1_network = "10000045"
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2.3  Starting the Installation

The following steps and screens will take you through the installation of the Lotus 
Domino Server on AIX.

1. If /opt doesn’t exist, type mkdir -m 755 /opt.

2. Change directory to <cd_mount_point>/<on_cd_path>, where <on_cd_path> 
is either unix or UNIX, depending on your system’s CD-ROM driver. For 
example, cd /cdrom/unix.

3. Type ./install and press Enter (you must still be the root user) to install the 
code. You will see the Lotus Notes Release 4.5 Installation Welcome screen 
(Figure 14).

Figure 14.  Installation Welcome Screen

4. Press the Tab key to continue to the next screen (Figure 15 on page 37).

Make sure the directory /opt exists; otherwise the installation will fail.

Note

Remove all files from /opt/lotus and also the links to /opt/vim and /opt/lotus if 
you want to completely reinstall Lotus Notes.

Note

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
 
    Welcome to the Lotus Notes Install program.
 
 
    Type h for help on how to use this program.
    Press TAB to begin the installation.
 
 
-------------------------------------------------------------------------------
    Type h for help
    Type e to exit installation
    Press TAB to continue to the next screen.
-------------------------------------------------------------------------------
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Figure 15.  Lotus Domino Server Installation Welcome Screen

5. Press the Tab key to continue to the next screen, as shown in Figure 16 on 
page 38, where you will be asked to read and accept the Lotus Notes 
Software Agreement.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
 
    In order to proceed with the installation of the Lotus Domino Server 
    and/or the Notes Workstation, you must read and agree with the 
    terms and conditions of the Lotus Notes Software Agreement.

    Press TAB to read the Lotus Notes Software Agreement.

 
-------------------------------------------------------------------------------
    Type e to exit the Install program.
    Press ESC to return to the previous screen
    Press TAB to continue to the next screen.
-------------------------------------------------------------------------------
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Figure 16.  Lotus Notes Software Agreement

6. Press the TAB key (or any other key) until you reach the screen shown in 
Figure 17.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
                     LOTUS NOTES SOFTWARE AGREEMENT

IF YOU DO NOT AGREE WITH THESE TERMS AND CONDITIONS, 
DO NOT INSTALL THE SOFTWARE.

1. USE

You  may use the Lotus software products  (individually and collectively, the 
"Software"), in the quantities purchased, provided you abide by the terms 
and conditions of this Agreement.  In addition, you may make one (1) archival 
copy of the Software.

FOR TRIAL USE:

You may evaluate the Software for a period of ninety (90) days (the "Trial 
Period").  If you wish to continue using the Software, you must purchase a 
copy of the Software during the Trial Period in order for your continued use 
of the Software to be legal. Multiple Trial Periods are prohibited.

Software acquired for evaluation during a Trial Period is provided on an "AS 
IS" basis. Lotus makes no warranty, representation, promise or guarantee, 
either express or implied, statutory or otherwise, with respect to the 
>>> Press any key to continue <<<
.
.
.
.
.
9.  MORE INFORMATION: Should you have any questions concerning this Agreement 
or Lotus’ software use policies, write to Inside Sales and Service, Lotus 
Development Corporation, 55 Cambridge Parkway, Cambridge, MA  02142, or, in 
the United States, call 1-800-343-5414.

IF YOU DO NOT AGREE WITH THE ABOVE TERMS AND CONDITIONS, DO NOT
INSTALL THE SOFTWARE.
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Figure 17.  Acceptance of the Terms of the License Agreement

7. The default value on this screen is [No]. Press the Spacebar to change the 
value to [Yes] and then press the Tab key to accept the setting and display 
the next screen (Figure 18).

8. The default value on Figure 18 is to Install the [Notes Workstation]. Press the 
Spacebar to change the value to Install the [Domino Server]. When you install 
the Lotus Domino Server, the workstation code is also installed.

Figure 18.  Install Lotus Domino Server or Workstation Screen

9. Press the Tab key to accept the setting of [Domino Server] and to display the 
next screen, as shown in Figure 19 on page 40.

The next few screens refer to Lotus Domino Advanced Services. Lotus 
Domino Advanced Services is a separately licensed feature which includes 
Lotus Domino server clusters, partitioned servers, and usage tracking. These 
features are available only if you have purchased the Lotus Domino Advanced 
Services license.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
 
    You may proceed with the installation only if you agree to the 
    terms and conditions of the Lotus Notes Software Agreement.
 
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Do you agree to the terms of the license agreement ?  [Yes]

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
 
    Do you want to install the Notes Workstation or Domino Server ?
 
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Install the [Domino Server    ]
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Figure 19.  Install Lotus Domino Advanced Services Screen

The default value for the previous screen, Figure 19, is [No]. If you have 
purchased the license for Lotus Domino Advanced Services, press the 
Spacebar to change the setting to [Yes]. Then press the Tab key to accept 
that setting and go to the next screen (Figure 20).

If you do not have the license for Lotus Domino Advanced Services, you 
should press the Tab key to accept the setting of [No]. The next screen 
displayed is shown in Figure 22 on page 41.

Figure 20.  Lotus Domino Advanced Services Installation License Verification Screen

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================

    A Domino Advanced Services license enables you to extend your 
    Domino server configuration to include three advanced features.

    Do you have a Domino Advanced Services license 
    and want to install these features ?

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Install Domino Advanced Services ?  [Yes]

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================

You have chosen to install Advanced Services on your Domino Server.

These features include Domino server clusters, partitioned servers, and 
usage tracking, and are available only if you have purchased the Domino 
Advanced Services license.

Please verify that you have purchased this license before you continue.  
You can verify your purchase by examining your Lotus Notes software package.
If the package includes the "Domino Advanced Services" label, select Yes 
when prompted to continue this install.

If you are uncertain, or your organization has not purchased the special 
Domino Advanced Services license, you are not entitled to continue 
this install.

If you want to purchase the license, visit our Web site (http://www.lotus.com)
for product information and a local sales number.

Press the Escape key to go back to the previous screen
  or
Press the Tab key to continue...
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Figure 21.  Lotus Domino Advanced Services License Acceptance Screen

If you have purchased the Lotus Domino Advanced Services license, then 
press the Tab key to accept the setting of [Yes] and proceed to the next 
installation screen.

The next screen is applicable only if you are installing on a Sun Solaris 
system. The default setting on this screen is [Yes]. Since we are installing 
Lotus Domino Server on an AIX system, you must change this setting to [No] 
by pressing the Spacebar to display [No] and then pressing the Tab key to 
proceed to the next screen.

Figure 22.  Sun Solaris Server Installation Question

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 

    Domino Advanced Services are only available to those 
    who have purchased a special license.

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Have you purchased the special Domino Advanced Services license ?  [Yes]

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================

    Note: The answer to this question will only affect installations 
    to Sun Solaris systems.

    In order for Domino server tasks to execute as threads in a 
    single process, the process file descriptor limit needs to be 
    raised.  This requires that the server have root privileges. 
    After changing this limit, the server no longer runs as root.

    Select below whether to enable setuid-root operation
    for the Notes server on Sun Solaris.

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Install the server for Solaris setuid-root ?  [No ]
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The next screen, shown in Figure 23, asks if you want to install the optional 
documentation. We recommend that you install the optional online 
documentation on the Lotus Domino Server.

Figure 23.  Install the Optional Online Documentation

The next installation screen, shown in Figure 24 on page 43, asks whether the 
Lotus Domino Server software will be installed on the system which will be 
running the Lotus Domino Server.

If you install the software to be a network resource, you can use the Lotus 
Notes software on other computers over the network. You will need to specify 
the operating systems of the computers which will use the installed software.

If you install the software to be a network resource, other computers can use it 
to run Lotus Notes by making the installed software available at /opt/lotus. You 
do this using UNIX filesystem sharing. For example, you could use Network 
File System (NFS) and export the filesystem.

Press the Tab key to accept the Lotus recommendation.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
 
    Do you want to install the optional online documentation ?
 

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Install optional online documentation ?  [Yes]

Lotus strongly recommends that the Lotus Domino server run on the system 
that you install it on, that is, that you do not use it as a network resource.

Note 
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Figure 24.  Install the Software for Use on the Destination Host Screen

Now you are asked if you want to install to one computer or more than one 
computer. See 2.3.1, “Installing on Multiple Hosts” on page 49 if you want to 
install on multiple hosts. Press the Tab key to take the default setting and 
install on only one computer as shown in Figure 25.

Figure 25.  Install on One Computer Screen

The next screen, shown in Figure 26 on page 44, indicates the hostname of 
the machine on which you want to install the software. By default, it will be the 
host name of the machine on which you are executing the Installation 
program. Press the Tab key to accept this default setting or the Enter key to 
edit the setting and change the hostname.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    You can install the software for use on the destination host(s), or
    to be a network resource for use by other hosts.
 
    Caution: Lotus strongly recommends that the Domino server software be
    installed for use on the hosts that are to run the server.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Install [the software for use on the destination host(s)]

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
 
    Do you want to install to one computer, or to more than one computer ?
 
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Install to [one computer          ]
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Figure 26.  Destination Host Name for the Installation Code

10.Press the Tab key, and the next screen (Figure 28) asks for the directory 
name where the Lotus Notes software will be installed. The default installation 
directory is /opt/lotus.

Figure 27.  Default Destination Path for the Installation Code

11.Press Enter to change this default installation directory to the directory 
defined in the file system created for Lotus Domino Server binaries 
(/usr/domino), as shown in Figure 28 on page 45. 

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    When installing to one computer, you can install to either the local
    or a remote host.  You do not have to install the software to the 
    computer on which you are running the Install program.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current destination hostname :noteserv.itsc.austin.ibm.com

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    The destination path is where the Install program installs the 
    Notes files.  The Install program automatically adds "lotus" to the path.
 
-------------------------------------------------------------------------------
Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current destination path :/opt/lotus
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Figure 28.  Destination Path for the Installation Code

12.Press Enter to go to the next screen.

Figure 29.  Current Destination Path Screen

13.Notice that the directory name lotus has been automatically added in the 
filesystem /usr/domino.Press Enter if you want to change the directory.

14.Press the Tab key, and specify the installation owner (Figure 30 on page 46). 
If the default had been accepted, this value should be notes.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    The destination path is where the Install program installs the 
    Notes files.  The Install program automatically adds "lotus" to the path.
 
-------------------------------------------------------------------------------
    Press ENTER to retain the current setting
      or
    Type a new setting and press ENTER.
-------------------------------------------------------------------------------

Current destination path :/opt/lotus

>>> New destination path :/usr/domino

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    The destination path is where the Install program installs the 
    Notes files.  The Install program automatically adds "lotus" to the path.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current destination path :/usr/domino/lotus
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Figure 30.  Specifying the Installation Owner

15.Press the Tab key, and specify the installation group ID which will own the 
installed software (Figure 31). Again, if the defaults had been accepted, this 
value should be notes.

Figure 31.  Specifying the Group ID for the Installed Software

16.Press the Tab key to display the confirmation screen for the specified 
parameters (Figure 32 on page 47).

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    The installation user ID is the UNIX system user ID
    that will own the installed software.
 
    Enter an existing UNIX system user ID.

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current installation owner user ID :notes

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    The installation group ID is the UNIX system group ID
    that will own the installed software.
 
    Enter an existing UNIX system group ID.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current installation owner group ID :notes
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Figure 32.  Interview Completion Screen

17.Pressing the Tab key will start the verification that leads to the final 
installation. Figure 33 shows the screen capture from an installation of a Lotus 
Domino Server on AIX.

18.Check that the configuration settings are correct.

Figure 33.  Validate Configuration Settings

19.If the configuration settings are correct, press Tab to continue.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================

    Your configuration of the Install program is complete.

    By continuing, the Install program first verifies that it can perform 
    the installation(s) as specified.  If there are no errors,
    the Install program prompts you to proceed.

 
-------------------------------------------------------------------------------
    Type e to exit the Install program.
    Press ESC to return to the previous screen
    Press TAB to continue to the next screen.

Configuration Summary...

Install to single host:            noteserv.itsc.austin.ibm.com

Destination path:                  /usr/domino/lotus

Installation type:                 Run on Destination

Product options selected:          Notes Workstation
                                   Domino Server
                                   Domino Advanced Services
                                   Documentation

Server on Solaris setuid-root:     No

Installation owner user Id:        notes
Installation owner group Id:       notes

The configuration settings must now be validated, checking that
installation as specified may proceed for each destination.
This may take a while depending on the configuration.
Once completed, confirmation will be required to proceed
with the installation(s)...

Press the Tab key to continue, or the Escape key to reconfigure...
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Figure 34.  Configuration Settings Validated Successfully

20.Press the Tab key to actually start the installation.

Validating hostnames...
  Ok.

Validating general configuration...
Ok.

Validating configuration for host noteserv.itsc.austin.ibm.com...
WARNING: The operating system version 4.3.1.0 on this host is newer than
         the most recent directly supported version 4.3.
Otherwise Ok.

There are pre-installation validation warnings for all specified hosts.
Installation can still proceed.

End Install Configuration Validation - Fri Jul 24 15:01:41 CDT 1998
**********************************************************************

Validation log appended to /var/tmp/notes_install_config_validation.log

You may now continue with the installation, or reconfigure your selections.
Press the Tab key to continue, or the Escape key to reconfigure...
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Figure 35.  Installation Completed Successfully

2.3.1  Installing on Multiple Hosts
If you only want to install the Lotus Domino Server on a single host, you can skip 
this section and continue with 2.4, “Setting Up the Lotus Domino Server on AIX” 
on page 51.

To install Lotus Notes to multiple hosts in a single installation run, you must first 
specify the hostname of each destination host in a hostlist file. You can 
change/edit the hostlist file during the installation.

You must still be logged in as the root user.

1. Our destination hosts for our installation are: ah1610d and ah1610c. Write the 
hostnames in a file named /tmp/notes_install_hostlist (Figure 36), one 
hostname for each line.

Figure 36.  Hostlist File: /tmp/notes_install_hostlist

**********************************************************************
Begin Installation - Fri Jul 24 15:04:09 CDT 1998
Lotus Notes Release 4.6.1c

Installing to host noteserv.itsc.austin.ibm.com...
  "Notes Workstation" for IBM AIX
  "Domino Server" for IBM AIX
  "Domino Advanced Services" for IBM AIX
  "Documentation"
  "Notes Workstation Resources" for IBM AIX
  "Common Data Files"
  "Common Data Files Resources"
  "Domino Server Resources" for IBM AIX
  "Domino Advanced Services Resources" for IBM AIX
  "Advanced Services Data Files"
/opt/lotus is already configured.
Support for VIM applications is already configured correctly
  at /opt/vim/lib/ibmpow.
Done.

The installation(s) completed successfully.

Important: Be sure to logout as root before running Notes.
Running Notes or the Domino Server as root is not supported.

End Installation - Fri Jul 24 15:31:31 CDT 1998
**********************************************************************

Installation log appended to /var/tmp/notes_install.log

ah1610d.itsc.austin.ibm.com
ah1610c.itsc.austin.ibm.com
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2. Create a new line in the file /.rhosts on ah1610c and on all other installation 
target hosts:

<install_host> root

<install_host> is the host you are running the installation process on.

For example, the file /.rhosts on ah1610c contains the line

ah1610d.itsc.austin.ibm.com root

3. Change permission of /.rhosts by issuing the following command:

chmod 700 /.rhosts

4. In Figure 25 on page 43 press the Spacebar to toggle the setting to Install 
to [more than one computer] (Figure 37).

Figure 37.  Install to More Than One Computer

5. Press the Tab key to display the next screen (Figure 38 on page 51). This 
screen lets you select the hostlist file.

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
 
    Do you want to install to one computer, or to more than one computer ?
 
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Install to [more than one computer]
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Figure 38.  Specifying the Hostlist File

6. Press the Tab key to display the next screen (Figure 39). This screen lets you 
escape to a shell if you want to change the hostlist file.

Figure 39.  Editing the Hostlist File

7. Press the Tab key, and the installation will continue with the screen shown in 
Figure 27 on page 44.

2.4  Setting Up the Lotus Domino Server on AIX

After you successfully install Lotus Domino, you must complete the notes setup 
program. During the notes setup program, Lotus Domino copies the server files 

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================
 
    To install to more than one computer, you are now asked to specify
    the path of a hostlist file. The hostlist file must contain the 
    hostnames of each computer on which you are installing Notes, 
    one name per line.  The hostlist file may be created before starting 
    the Install program, or you can create or edit the list after
    specifying the path of the hostlist file.
 
-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press ENTER to edit a setting.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

Current hostlist filename :/tmp/notes_install_hostlist

===============================================================================
                   Lotus Notes Release 4.6.1c Installation
===============================================================================

    Specified hostlist filename: /tmp/notes_install_hostlist
 
    If you need to create or edit the hostlist, you can escape to a shell.
    When you are finished, exit the shell to return to the Install program.

-------------------------------------------------------------------------------
    Type h for help.
    Type e to exit the Install program.
    Press ESC to return to the previous screen.
    Press the Spacebar to change the setting until you get the one you want.
    Press TAB to accept a setting and continue to the next screen.
-------------------------------------------------------------------------------

>>> Do you want to escape to a shell or continue ? [Escape to a shell]
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into the server data directory and creates the default server configuration file 
notes.ini.

To provide maximum performance and reduced network dependencies, the data 
directory should reside locally on your server as the default.

Below are the steps for setting up Lotus Domino Server on an AIX machine:

1. You must be on a graphical workstation.

2. If you are on an Xstation, don’t forget to export the right DISPLAY variable, for 
example, DISPLAY= ah1610d.itsc.austin.ibm.com:0.0; export DISPLAY. Write 
access to the X-Host is required. For example, you could type the command:

xhost +<machinename>

where <machinename> is the name of the machine where you are running the 
Lotus Domino Server. In our example, we would type the command:

xhost +ah1610d

3. Log in as user notes.

4. You need to add two directories to the PATH statement in .profile in the home 
directory. The first directory is the one where the notes.ini file resides. This is 
usually $HOME/notesr4. The second directory you should add to the PATH 
statement is /opt/lotus/bin, as shown here:

PATH=/usr/bin:/etc........:$HOME/notesr4:/opt/lotus/bin

5. If you are using CDE, please comment out the last line:

DTSOURCEPROFILE=true

in .dtprofile.

6. Change the directory to /opt/lotus/bin.

The notes setup program automatically starts the first time you type the 
command notes.

7. Type ./notes.

Figure 40.  Lotus Notes Setup Warning Screen

If you need to rerun Lotus Notes setup, you can do so by typing ./notes -u 

NOTE
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8. At the time of writing this redbook, Lotus Domino Server version 4.6.1 is not 
certified on AIX version 4.3.1 by Lotus Corporation. It is expected to get 
certified soon. Click on the OK button to continue with the installation.

Figure 41.  First Setup Screen for Lotus Domino Server with Advanced Services

If you have a license for Advanced Services, as we have, then you would want 
to select Advanced Services Data Files on the list of options. Your Lotus Notes 
Setup screen would then look like Figure 41.

In case you do not have the license for Advanced Services, please do not 
select Advanced Services Data Files from the list of options. Your Lotus 
Notes Setup screen would then look like Figure 42 on page 54.
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Figure 42.  First Setup Screen for Lotus Domino Server without Advanced Services

9. Select the menu items on the Lotus Notes Setup screen (Figure 41) and click 
on the Install button. (See an explanation of these items in 2.4.1, “Lotus 
Notes Setup Options” on page 55.) After you have finished the setup, the 
following screen (Figure 43 on page 55) will appear.
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Figure 43.  End Setup Screen for AIX

10.Click on the Quit button, as shown in Figure 43. The server setup program will 
start up now, as explained in 2.5, “Server Setup Program” on page 56.

2.4.1  Lotus Notes Setup Options
The following is the description for each of the setup options that you can select 
to install, as shown in Figure 41.

User Data Files: These files identify you and how you installed Lotus Notes on 
your host. By default, the setup program selects this option for you.

Domino Partitioned Server: This option allows you to partition your server. If 
you install this option, the setup program automatically installs the workstation, 
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Lotus Domino Server, and Domino Advanced Services. Select this option if you 
want to run one to six Lotus Domino partitioned servers on one computer.

Advanced Services Data Files: Installation of these files will provide you with 
the Advanced Server features, which include clustering, partitioned servers, and 
billing.

Domino Server Data Files: These files contain the program, data and template 
files needed to run the Lotus Domino Server program. These files are a superset 
of the Notes Workstation Data Files. These files (along with the User Data Files) 
are the minimum that a Lotus Domino Server needs to run.

Notes Workstation Data Files: These are necessary to run Lotus Notes as a 
workstation only. These files (along with the User Data Files) are the minimum 
that a Notes Workstation needs to run. If you are installing a Lotus Domino 
Server, the setup program automatically installs the workstation data files.

Help Lite Database: Select this option to install the Lotus Notes help database 
that provides context-sensitive information about most Lotus Notes features. If 
you are installing Lotus Notes on a server, you should install this feature so that 
workstation users can have access to this database. Help Lite is a part of the 
Help Database; so you do not need to install both.

Help Database: Select this option to install the Lotus Notes help database that 
provides complete documentation on Lotus Notes end-user features, as well as 
documentation on managing databases, creating applications and using 
LotusScript in Lotus Notes. If you are installing Lotus Domino on a server, you 
should install this feature so that workstation users can have access to this 
database.

Documentation Databases: These are databases that provide complete 
documentation on installing, administering, and upgrading to the new release of 
Lotus Notes. If you are installing Lotus Domino on a server, you should install this 
feature so that workstation users can have access to the documentation.

2.5  Server Setup Program

After you successfully installed Lotus Domino and ran the notes setup program, 
you must complete the server setup program. The server setup program starts 
immediately after the notes setup program. Please familiarize yourself with the 
following terms:

  • Domino Server ID: Each Lotus Domino Server has a unique name that is 
maintained in its own ID file. Lotus Notes creates the server ID automatically 
during first server setup.

  • Notes user ID: Each Lotus Notes user has a unique name that is maintained 
in its own ID file. Lotus Notes creates the user ID automatically when you 
register new users.

  • Notes organization certifier ID: Each Lotus Notes domain has an 
organization certifier ID (cert.id). You use the organization certifier ID to create 
and certify additional organization unit certifiers and to register servers and 
users.
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  • Public Address Book: Each Lotus Notes domain has a Public Address Book. 
The Public Address Book contains, among other documents, a Server 
document for each server and a Person document for each user. In addition, 
you can create Group documents to establish relationships among servers 
and users for mailing and security purposes and create Connection 
documents to schedule data transfers among servers.

2.5.1  Starting the Server Setup Program
The server setup program must be completed before working with Lotus Notes. If 
you exit the setup before it completes, it will restart the next time you start Lotus 
Notes.

The following screen will appear after clicking on the Quit button, as shown in 
Figure 43 on page 55:

Figure 44.  Starting Lotus Notes

2.5.2  Setting Up the First Server in Your Organization
1. On the Lotus Notes Server Setup screen (Figure 45 on page 58), select The 

First Domino Server, if this is the first server you are setting in your 
organization or if you are creating a new domain. If this is an additional server 

If you want to redo the server setup, type notes -u 

Note
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in your organization, then you should go to 2.5.3, “Setting Up an Additional 
Server in Your Organization” on page 65.

Figure 45.  First Setup Screen 

Click on the forward arrow (>) to go to the next screen, as shown in Figure 46.
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Figure 46.  Second Setup Screen

This screen is used to select a setup method. In case you choose the Quick 
and Easy setup, you should later edit the notes.ini file to add the server task 
entries. In our example, we have selected Quick and Easy Setup option, as 
shown in Figure 46. You can refer to 2.5.3, “Setting Up an Additional Server in 
Your Organization” on page 65 in which we have selected Advanced Setup 
option so that you are familiar with this setup option also.

2. Click on the forward arrow (>) to go to the next screen, as shown in Figure 47.
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Figure 47.  Third Setup Screen

This screen is used to select the Server audience in addition to Lotus Notes 
users. You can select the options that meet your requirements.In our example, 
we have selected the Web Browser option, as shown in Figure 47.

3. Click on the forward arrow (>) to go to the next screen, as shown in Figure 48.
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Figure 48.  Fourth Setup Screen

This screen displays the system administration settings. Some of the fields 
such as Domain Name and Server Name are filled out based on the system 
hostname. The password fields are randomly generated and can be changed 
by selecting the desired field and typing over it. Enter your own password and 
don’t forget that the Lotus Domino passwords are case-sensitive. For help, 
click on the blue labels.

Enter the Organization Name. If necessary, change the pre-filled Domain 
Name and Certifier Name. The Certifier Name becomes part of the 
hierarchical name of the Servers. It is recommended that the Organization 
Name and the Certifier Name are the same.

Domains are often confused with certificates. The confusion arises because 
most organizations use their company name for their domain and the company 
name also appears in their certificates.

Certificates and domains are two entirely separate concepts. A domain is a 
logical collection of servers. The servers can be running on multiple networks 
at multiple sites including international sites. Users within a domain can use 
different certificates, operating systems, and naming schemes. Certificates 
are used for authentication and are a security measure. Domains have nothing 
to do with security. It is possible to protect servers from one another within a 
single domain. You can change a Domain Name without recertifying users and 
servers, or recertify users and servers without changing the Domain Name. It 
is a good practice to create one domain for your production data servers, one 
domain for your application developers, at least one test domain (three, if you 
are building an inter-enterprise applications), and an external domain.
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Server names are visible to the user and should provide some clue as to the 
data stored on that particular server. If you are using TCP/IP, your server 
name should be identical to your TCP/IP hostname. If you do not want the 
server name to be the same as your machine’s network name (hostname), you 
must enter an alias name into the /etc/hosts file. 

For example, if the hostname was ah1610d and the Domain Server name was 
noteserv, then you must add the following entry to /etc/hosts file, as shown in 
Figure 49.

Figure 49.  Host File /etc/hosts

We recommend that you either make the Lotus Domino server name and the 
TCP/IP host name the same or make an alias for the Lotus Domino Server 
name in the TCP/IP Domain Name Server(s) (DNS). This will save you from 
updating the /etc/hosts file on every Notes Workstation client machine running 
TCP/IP.

If the hostname is a fully qualified name, change the Server Name field to the 
short TCP/IP name.

Enter the administrator’s first name and last name in the appropriate fields and 
enter your own Administrator Password.

4. Click on the Edit button to go to the next screen, as shown in Figure 50.

Figure 50.  Edit Screen (for Making Changes)

# Internet Address      Hostname        # Comments
127.0.0.1               loopback localhost      # loopback (lo0) name/address
9.3.1.241 ah1610d.itsc.austin.ibm.com        noteserv
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This screen allows you to make changes in any of the fields shown on this 
screen and gives you an option to create new Certifier ID, Server ID, and 
Administrator ID or use the existing IDs. 

5. Click on the OK button to go to the next screen, as shown in Figure 51.

Figure 51.  Fourth Setup Screen (Updated)

This screen allows you to review the information you entered.

6. Click on the Finish button to go to the next screen, as shown in Figure 52.

Figure 52.  Time Zone Setup Screen

This screen allows you to select your time zone. In our example, we have 
selected the Central Standard Time as our time zone.

7. Click on the OK button to go to the next screen, as shown in Figure 53 on 
page 64.
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Figure 53.  Congratulations!

This screen shows the successful completion of setting up of your Lotus 
Domino Server. Please ensure to write down the Certifier password and 
Administrator password as written in this screen. You have three choices to 
select from:

  • Exit to Workspace -- The local Notes Workstation for AIX is now running 
and you can use it for administration.

  • Launch Domino Server -- You can start the new server.

  • Register Users -- You can start to register Lotus Notes Users.

8. Click on any one of these buttons to end the Lotus Domino Server Setup. In 
our example, we selected the Exit to Workspace option, and the next screen 
was displayed, as shown in Figure 54 on page 65.
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Figure 54.  Password Verification Screen

Please ensure that you note the passwords.

9. Click on Yes button. Since we had selected the Exit to Workspace option 
earlier, we exited to the workspace.

2.5.3  Setting Up an Additional Server in Your Organization
Once you have your first Lotus Domino Server up and running, you may want to 
add additional servers within your organization. The following steps will take you 
through this procedure.

When you press Quit button on the screen, shown in Figure 43 on page 55, the 
screen, as shown in Figure 55 on page 66, is displayed.
Installing a Lotus Domino Server 65



Figure 55.  First Setup Screen for Additional Server

1. First, you must create a Lotus Notes user ID on your existing server for the 
new servers you will be installing (see 4.1, “User Registration” on page 95).

2. Select Additional Domino Server on the screen, as shown in Figure 55, 
since your primary server already exists.

3. Click on the forward arrow (>) to go to the next screen, as shown in Figure 56 
on page 67.
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Figure 56.  Second Setup Screen for Additional Server

This screen is used to select a setup method. In this example, we have 
selected the Advanced Setup option. Since, in the First Domino Server 
Setup, we had selected the Quick and Easy Setup option, for the Additional 
Server Configuration, we have selected the Advanced Setup option to 
familiarize you with this option also.

4. Click on the forward arrow (>) to go to the next screen, as shown in Figure 57 
on page 68.
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Figure 57.  Third Setup Screen for Additional Server

Check the boxes for the server tasks that you need:

  • HTTP for Web Server

  • IMAP, LDAP, POP3 and SMTP MTA for Internet Mail packages

  • NNTP for Internet Newsgroup Services.

5. Click on the forward arrow (>) to go to the next screen, as shown in Figure 58 
on page 69.
68 Lotus Domino Release 4.6 on IBM RS/6000



Figure 58.  Fourth Setup Screen for Additional Server

This screen displays the system administration settings.

Enter the name of the new server. By default, this field is filled out based on 
the system hostname. You can edit this field, if you want to. If you do not want 
the server name to be the same as your machine’s network name (hostname), 
you must enter an alias name into the /etc/hosts file.

Enter the location of the Domain Address Book from which the additional 
server will get the address book. Also select the connection protocol between 
the additional server and the source of Domain Address Book location.

6. If on the Third Setup Screen for Additional Servers (Figure 57 on page 68), 
you selected some Internet tasks (HTTP, IMAP, and so forth), you must click 
on the Add Proxies button to configure the proxy server.
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Figure 59.  Proxy Server Configuration

The screen shown in Figure 59 is displayed when you configure a proxy server 
by clicking on the Add Proxies button on the Fourth Setup Screen for 
additional Servers (Figure 58 on page 69).

To access the Internet from this server, you should use the proxy and/or 
SOCKS servers of your organization. Ask your system administrator for the 
names or the IP addresses of these servers.

7. Type the proxy and/or SOCKS server names and ports in the appropriate 
fields and click on the OK button.

8. Click on the Finish button to go to the next screen, as shown in Figure 60 on 
page 71.
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Figure 60.  Entry Screen for Server’s ID Filename

9. Enter the directory name and the Server’s ID file name and click on the OK 
button to go to the next screen, as shown in Figure 61 on page 72.
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Figure 61.  Congratulations!

This screen shows the successful completion of setting up of your Additional 
Domino Server. You have three choices to select from:

  • Exit to Workspace -- The local Notes Workstation for AIX is now running and 
you can use it for administration.

  • Launch Domino Server -- You can start the new server.

  • Register Users -- You can start to register Lotus Notes users on the new 
server.

10.Click on any one of these buttons to end the Lotus Domino Server Setup. In 
our example, we selected Exit to Workspace option to end the setup 
program.

2.6  Setting Up Network Protocols

After you have successfully installed Lotus Domino on AIX using a local area 
network, you may want to install more than one network protocol on an AIX Lotus 
Domino Server. In any case, you will need to follow the final settings steps.
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2.6.1  Setting Up an Additional Network Protocol
In our scenario, we are installing more that one network protocol on an AIX Lotus 
Domino Server:

1. To set up the additional network on AIX, please refer to ef!EF.

2. Log in as user notes.

3. Shut down the Lotus Domino Server if it is running. (This step is very 
important. The Lotus Domino Server must be down before you can 
successfully add another network protocol.)

4. Start the Notes Workstation by typing the command notes.

5. Choose File -> Tools -> User Preferences.

6. Select the Ports icon (Figure 62).

Figure 62.  Select Additional Network Protocol

7. Click on the appropriate network protocol and click on Port Enabled.

8. Click on OK.

2.7  Final Settings

You must perform the following steps before you start the server for the first time:

1. Start the Workstation as user notes with the command notes.

2. Select File -> Tools -> Server Administration.

3. Select Servers -> Servers View.

4. Select the server in the selection list and click on Edit Server.

5. Click on Network Configuration and change the Port to TCPIP or SPX.
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Figure 63.  Network Configuration Screen

6. Click on the Save and Close button to save these settings and close this 
screen.

7. Log out and log back in as user notes.

8. Start the server with the command: server.

If you use multiple network protocols, add an additional line, as shown in 
Figure 63 on page 74

Note
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Chapter 3.  Installing a Notes Workstation

This chapter outlines how to install and set up Lotus Notes for the AIX client.

3.1  Installation of Lotus Notes R4.6 Workstation on AIX

For system requirements, refer to section 2.1, “Hardware and Software System 
Requirements” on page 23.

3.1.1  Preparing the Environment for the Installation
The steps for preparing for the installation are listed below. If you are installing 
Lotus Notes on multiple hosts, you must perform all these steps on each of the 
target hosts.

1. Log onto the AIX machine as the root user.

2. Check that /usr/sbin is in your default path. Many of the AIX system 
commands that we'll be using to set up the machine are found in /usr/sbin.

Type in the command echo $PATH to see if /usr/sbin is in your default path.

If /usr/sbin is not in your default path, you can add it to your default path by 
editing the PATH statement in /etc/environment.

3. Check to see if there is enough space on an existing volume group for the 
installation code. You will need about 150 MB for the installation code in 
/opt/lotus. You can either use space within an existing volume group, for 
example, rootvg, or you could create a new volume group, for example, called 
dominovg, specifically for the binary installation code.

Creating a new volume group for the binary code would allow for easier 
backup/recovery or migration to a different client. In case of a hardware failure 
or server upgrade, you would simply export the volume group, put the disk on 
another machine, and import the volume group again.

To see if you have enough space on an existing volume group, type the 
command lsvg <volume_group>. To check the rootvg, type lsvg rootvg (see 
Figure 64).

Figure 64.  lsvg rootvg (Free Space: 1140 megabytes = 4 x 285)

VOLUME GROUP:   rootvg                   VG IDENTIFIER:  00612519a6ebe256
VG STATE:       active                   PP SIZE:        4 megabyte(s)
VG PERMISSION:  read/write               TOTAL PPs: 515 (2060 megabytes)
MAX LVs:        256                      FREE PPs: 285 (1140 megabytes)
LVs:            12                       USED PPs:       230 (920 megabytes)
OPEN LVs:       11                       QUORUM:         2
TOTAL PVs:      1                        VG DESCRIPTORS: 2
STALE PVs:      0                        STALE PPs:      0
ACTIVE PVs:     1                        AUTO ON:        yes
MAX PPs per PV: 1016                     MAX PVs:        32
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3.1.2  New Volume Group on the Workstation for the Installation Software
If you don’t want to create a new volume group for the installation code, you can 
skip to 3.1.3, “The Logical Volume on the Workstation for the Installation 
Software” on page 77.

To create a new volume group to contain the installation software, type in the 
command smitty mkvg to display the Add a Volume Group screen (Figure 65):

Figure 65.  Add a Volume Group on the Workstation Screen

In our example, we are calling our Volume Group, dominovg, and we are creating it 
on our hard disk called hdisk1. Depending on the size of your hard disk you may 
have to specify another (larger) physical partition size.

 Add a Volume Group

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
  VOLUME GROUP name                                  [dominovg]
  Physical partition SIZE in megabytes                4                           
* PHYSICAL VOLUME names                              [hdisk1]                    
  Activate volume group AUTOMATICALLY                 yes                         
    at system restart?
  Volume Group MAJOR NUMBER                          []                           
  Create VG Concurrent Capable?                       no +
  Auto-varyon in Concurrent Mode?                     no +
  
  

    
    
    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              
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3.1.3  The Logical Volume on the Workstation for the Installation Software 
In AIX, it is a better practice to create a logical volume and then add the journaled 
filesystem on this logical volume. By following this procedure, we can place the 
logical volume and the filesystem at the desired portion of the hard disk, thus 
improving the system performance.

The following steps and screens will show you how we created the logical volume 
for the Installation software:

1. Type smitty mklv to display the Add a Logical Volume screen (Figure 66).

Figure 66.  Add a Logical Volume on the Workstation Volume Group Name Screen

2. Select the name of the Volume Group in which you want to place this logical 
volume. In our example, we select the volume group name dominovg.

3. Create the logical volume for the installation software. In our example, we 
named it noteslv, size: 160 MB.

 Add a Logical Volume

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* VOLUME GROUP name                                  [dominovg]

F1=Help              F2=Refresh           F3=Cancel            F4=List
F5=Reset             F6=Command           F7=Edit              F8=Image
F9=Shell             F10=Exit             Enter=Do                    
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Figure 67.  Add a Logical Volume on the Workstation Screen 

The placement of data on the disk affects its performance. The closer the data is 
to the center of the disk the better. This alleviates the problem of disk arm travel. 
Since your Lotus Domino binaries are read-only and only accessed when starting 
the server or the workstation, you can keep them at the edge of the disk.

3.1.4  Create the Logical Volume for the User Database
The following steps and screens will show you how we created the logical volume 
for the user data. 

1. Type smitty mklv to display the Add a Logical Volume screen (see Figure 68 
on page 79).

 Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
  Logical volume NAME                                [noteslv]                  
* VOLUME GROUP name                                   dominovg                    
* Number of LOGICAL PARTITIONS                       [40]                         
  PHYSICAL VOLUME names                              [hdisk1]                    
  Logical volume TYPE                                []
  POSITION on physical volume                         edge                       
  RANGE of physical volumes                           minimum                     
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []                           
    to use for allocation
  Number of COPIES of each logical                    1                           
    partition
  Mirror Write Consistency?                           yes                         
  Allocate each logical partition copy                yes                         
    on a SEPARATE physical volume?
  RELOCATE the logical volume during                  yes                         
    reorganization?
  Logical volume LABEL                               []
MAXIMUM NUMBER of LOGICAL PARTITIONS               [512]

  Enable BAD BLOCK relocation?                        yes                         
  SCHEDULING POLICY for reading/writing               parallel                    
    logical partition copies
  Enable WRITE VERIFY?                                no                          
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]                
[BOTTOM]
    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              
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Figure 68.  Add a Logical Volume on the Workstation to Enter Volume Group Name

Select the name of the volume group in which you want to place this logical 
volume. In our example, we select the volume group name dominovg.

2. Create the logical volume for the installation software. In our example, we 
named it wsdatalv, size: 80 MB.

Figure 69.  Add a Logical Volume on the Workstation Screen

 Add a Logical Volume

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* VOLUME GROUP name                                  [dominovg] +

F1=Help              F2=Refresh           F3=Cancel            F4=List
F5=Reset             F6=Command           F7=Edit              F8=Image
F9=Shell             F10=Exit             Enter=Do                    

 Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
  Logical volume NAME                                [wsdatalv]
* VOLUME GROUP name                                   dominovg
* Number of LOGICAL PARTITIONS                       [20]                         
  PHYSICAL VOLUME names                              [hdisk1]                   
  Logical volume TYPE                                []
  POSITION on physical volume                         center +
  RANGE of physical volumes                           minimum                     
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []                           
    to use for allocation
  Number of COPIES of each logical                    1                           
    partition                  
  Mirror Write Consistency?                           yes                         
  Allocate each logical partition copy                yes                         
    on a SEPARATE physical volume? 
  RELOCATE the logical volume during                  yes                         
    reorganization?                                                            
  Logical volume LABEL                               []                        
MAXIMUM NUMBER of LOGICAL PARTITIONS               [512]

  Enable BAD BLOCK relocation?                        yes                         
  SCHEDULING POLICY for reading/writing               parallel                    
    logical partition copies
  Enable WRITE VERIFY?                                no                          
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]                
[BOTTOM]
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The placement of data on the disk affects its performance. The closer the data is 
to the center of the disk the better. This alleviates the problem of disk arm travel. 
So we chose to place the user data at the center of the disk.

3.1.5  Create and Mount the File System on the Workstation
If you don’t use the default directory where Lotus Notes installs the software 
(/opt/lotus), the install program creates symbolic links from /opt/lotus to the install 
directory that you specify. The final directory name of the path must be lotus.

In AIX, we need to create a file system to contain the installation binary code 
which is copied from the CDROM to the hard disk on your AIX system. The 
following steps and screens will show you how we created this file system on the 
logical volume.

1. Create a file system for the installation software. In our example we called it 
/usr/domino, size: 160 MB.

  • Type smitty crjfslv to display the Add a Journaled File System on a 
Previously Defined Logical Volume screen (Figure 70).

Figure 70.  Add a Journaled File System on the Workstation

  • When you select Add a Standard Journaled File System by pressing the 
Enter key, the screen, as shown in Figure 71, is displayed.

 Add a Journaled File System on a Previously Defined Logical Volume

Move cursor to desired item and press Enter.

  Add a Standard Journaled File System
  Add a Compressed Journaled File System
  Add a Large File Enabled Journaled File System

              
F1=Help              F2=Refresh           F3=Cancel            F8=Image
F9=Shell             F10=Exit             Enter=Do                    
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Figure 71.  Add a Standard Journaled File System on the Workstation Screen

  • Press Enter to create the filesystem.

2. Mount the filesystem just created for the installation software. In our example, 
it is named /usr/domino.

  •mount /usr/domino

3.1.6  The File System for the User Database on the Workstation

1. Create the file system for the User Database. In our example, we call it 
/home/michael/notesr4 , size: 80 MB.

  • Type smitty crjfslv to display the Add a Journaled filesystem on a 
Previously Defined Logical Volume screen (Figure 72 on page 82).

 Add a Standard Journaled File System 

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* LOGICAL VOLUME name                                 noteslv                   
* MOUNT POINT                                        [/usr/domino]
  Mount AUTOMATICALLY at system restart?              yes                        
  PERMISSIONS                                         read/write                  
  Mount OPTIONS                                      []                           
  Start Disk Accounting?                              no                          
  Fragment Size (bytes)                               4096                        
  Number of bytes per inode                           4096                        
  Allocation Group Size (MBytes)                      8                           
    
    

    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              

You do not have to create a separate file system for the User Database. This is 
an optional step. If you choose not to create a file system for the User 
Database, by default, the setup process will put the User Database in the Lotus 
Notes userid's $HOME/notesr4 directory.

If you do choose to create a file system for the User Database, for best 
performance, you should use disk-striping technology for this file system.

Note
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Figure 72.  Add a Journaled File System on the Previously Defined Logical Volume

  • When you select Add a Standard Journaled File System by pressing the 
Enter key, the screen, as shown in Figure 73, is displayed.

Figure 73.  Add a Standard Journaled File System on the Workstation Screen

  • Press Enter to create the filesystem.

2. Mount the filesystem just created for the Lotus Domino Server Databases, in 
our example, it is named /home/michael/notesr4:

  • mount /home/michael/notesr4 

3. Create an AIX group account for Lotus Notes by issuing the command:

mkgroup -A notes

4. Create an AIX user account for ownership of the Lotus Notes software by 
issuing the command:

 Add a Journaled File System on a Previously Defined Logical Volume

Move cursor to desired item and press Enter.

  Add a Standard Journaled File System
  Add a Compressed Journaled File System                
  Add a Large File Enabled Journaled File System      

  

F1=Help              F2=Refresh           F3=Cancel            F8=Image        
F9=Shell             F10=Exit             Enter=Do                              

 Add a Standard Journaled File System 

Type or select values in entry fields.
Press Enter AFTER making all desired changes.
  
                                                        [Entry Fields]
* LOGICAL VOLUME name                                 wsdatalv                 +
* MOUNT POINT                                        [/home/michael/notesr4]
  Mount AUTOMATICALLY at system restart?              yes                        
  PERMISSIONS                                         read/write                  
  Mount OPTIONS                                      []                           
  Start Disk Accounting?                              no                          
  Fragment Size (bytes)                               4096                        
  Number of bytes per inode                           4096                        
  Allocation Group Size (MBytes)                      8                           
    
    

    
    
F1=Help              F2=Refresh           F3=Cancel            F4=List         
F5=Reset             F6=Command           F7=Edit              F8=Image        
F9=Shell             F10=Exit             Enter=Do                              
82 Lotus Domino Release 4.6 on IBM RS/6000



mkuser pgrp=notes groups=’staff, notes’ home=/home/notes gecos="Lotus 
Notes User" notes

5. Define a password for user notes by issuing the command:

pwdadm notes

6. Change ownership of the Lotus Notes /usr/lpp/lotus and /notes file systems 
by issuing the command:

chown -R notes.notes /usr/domino

chown -R notes.notes /home/michael/notesr4

7. To mount the CD-ROM type:

mount -r -v cdrfs /dev/<device_name> <cd_mount_point>

An example of this is the command

mount -r -v cdrfs /dev/cd0 /cdrom

where:

<device_name> is cd0 and <cd_mount_point> is /cdrom

If the <cd_mount_point> does not exist, you can create it by using the command 
mkdir <cd_mount_point>, for example mkdir /cdrom 

For setup of the network (LAN), please refer to 2.2.6, “Setting Up a Local Area 
Network (LAN)” on page 32.

For installation of Lotus Notes R4.5 Workstation on AIX, please refer to 2.3, 
“Starting the Installation” on page 36.

As shown in Figure 18 on page 39, press the SpaceBar to change the installation 
option from [Domino Server] to [Notes Workstation].

3.1.7  Setting Up the Lotus Notes R4.6 Workstation on AIX
After you successfully installed the Notes Workstation, you must complete the 
Notes setup program for every user on this system who wants to use the Notes 
Workstation. During the Notes setup program, Lotus Notes copies the necessary 
files into the data directory. By default this directory is $HOME/notesr4, where 
$HOME is the environment variable specifying the home directory of the user. 
The Notes setup program also creates the default Lotus Notes configuration file 
called notes.ini and places it in $HOME.

Below are the steps for setting up the Notes Workstation on the AIX workstation:

1. You have to be on a graphical workstation.

2. If you are on an Xstation, check that you have the right DISPLAY variable, for 
example: DISPLAY=ah1610d.itsc.austin.ibm.com:0.0; export DISPLAY (You also 
must have write access to the X-Host, for example, through the command:

xhost +<machinename>).

To provide maximum performance and reduce network dependancies, the data 
directory should reside locally on your workstation.

Note
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Repeat the following steps for each new user on the system.

1. Log in as root user.

2. Check if there is enough space in the home directory for your personal 
databases (minimum free space > 5 MB / user), in case you choose to place 
the user databases in their home directories, by issuing the following 
command:

df -k $HOME

In our example, we have created a separate filesystem 
(/home/michael/notesr4) for placing the user database.

3. Expand the file system /home in case you decide to place user databases in 
the /home filesystem, if necessary, by issuing the following command: chfs -a 
size=+<number_of_512_byte_blocks> /home. This command increases the size of 
the /home file system by <number_of_512_byte_blocks>.

4. Create a personal user, if one doesn’t already exist. For example, create a 
user michael by issuing the command:

mkuser groups=’staff, notes’ gecos="Lotus Notes User" michael 

5. Define the password for user michael by issuing the command:

pwdadm michael

6. Log in as your predefined user, for example, michael.

7. Add the data directory and /opt/lotus/bin to the PATH statement in .profile in 
the home directory:

PATH=/usr/bin:/etc.........:$HOME/notesr4:/opt/lotus/bin:

8. If you are using CDE, please comment out the last line in .dtprofile:

DTSOURCEPROFILE=true

9. Change the directory to /opt/lotus/bin.

The Lotus Notes setup program automatically starts the first time you type the 
command notes

10. Type ./notes.

If you plan to the Notes Workstation on the same machine as the server or if 
you plan to run multiple Notes Workstations on the same machine, then 
please refer to 6.4, “Environment Variables” on page 168.

Note

If you need to rerun Lotus Notes setup, you can do so by typing ./notes -u

 Note
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Figure 74.  Warning message screen

11. Lotus Domino Server Release 4.6.1 is not certified on AIX 4.3.1 by Lotus 
Corporation. Beginning with Release 4.6.2, the Lotus Notes Client and 
Domino Server for IBM AIX 4.3 is a certified and supported platform. Although 
not certified at this time, AIX 4.3.1 is a supported platform. Click on the OK 
button to continue with the installation.
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Figure 75.  Lotus Notes Setup Screen

12. Select the options on the Lotus Notes Setup screen (Figure 75) that you want 
to install and click on the Install button. 

Lotus Notes Help Lite should be installed if you plan to use Lotus Notes 
remotely.

Lotus Notes Release 4 Help is not necessary since this database is 
accessible from a server.
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After you have finished the setup, as shown in Figure 75 on page 86, the 
following screen (Figure 76) will appear:

Figure 76.  Information Screen

13. Click on the OK button since this has been done in Step 7 on page 84.

Figure 77.  Lotus Notes Setup Status Screen

14. Click on Quit at the Lotus Notes Setup Status screen (Figure 77).
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3.1.8  Workstation Setup Program
This section covers the workstation setup program that must be completed before 
Lotus Notes can be run properly. You must complete the workstation setup 
program before working with Lotus Notes. If you exit the setup before it 
completes, the setup program will restart the next time you start Lotus Notes.

The following screen will appear after clicking on the Quit button of the Lotus 
Notes Setup Status Screen (Figure 77 on page 87):

Figure 78.  Starting Lotus Notes

Users must be registered on the Lotus Domino Server before you continue the 
workstation setup. That is, a personal account must be generated on the Lotus 
Domino Server by the Lotus Notes administrator before you run the Notes 
Workstation setup program on the clients. See 4.1, “User Registration” on page 
95, for more information.

Note

If you want to redo the workstation setup, type the command

notes -u

Note
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Figure 79.  Notes Workstation Configuration Screen

1. Select the type of connection you have to your Lotus Domino Server in the 
panel shown in Figure 79.

2. If your Lotus Notes user ID was supplied to you in a file, click on the button on 
this screen and see 3.1.8.1, “Lotus Notes User ID Supplied to You In a File” on 
page 91, for additional details.

3. Click on OK.

4. The next screen, Network Workstation Setup (Figure 80), is a key panel for the 
installation of Lotus Notes Workstation.

Figure 80.  Network Workstation Setup Screen

5. Type your full user name exactly as your Lotus Notes administrator gave it to 
you.
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6. Type the full name of your home server exactly as your Lotus Notes 
administrator gave it to you.

7. Select the correct network protocol your workstation uses to connect to Lotus 
Domino Servers.

8. Click on OK to display the User Password Entry Screen (Figure 81).

Figure 81.  User Password Entry Screen

9. Enter the password for the workstation user, shown in Figure 81, defined by 
the Lotus Notes administrator in the Public Name and Address Book.

10. Click on OK to display the Time Zone Setup screen (Figure 82).

This name may not be the same as your AIX user name.

 Note

If the home server name differs from the hostname (TCP/IP configuration) 
of the server, you have to add an entry in the file /etc/hosts. Please refer to 
2.5.2, “Setting Up the First Server in Your Organization” on page 57.

 Note
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Figure 82.  Time Zone Setup Screen

11. Choose the time zone from the Time Zone Setup panel (Figure 82) and check 
Observe Daylight Savings Time... if appropriate.

12. Click on the OK button.

Figure 83.  Setup Complete

13. Click on the OK button on the Setup Complete screen, as shown in Figure 83, 
to end the setup.

The Notes Workstation for AIX is now running.

3.1.8.1  Lotus Notes User ID Supplied to You In a File
If your Lotus Notes user ID has been supplied to you in a file, when you see the 
Notes Workstation Setup screen, Figure 84, you should click on the appropriate 
button near the bottom of the screen.
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Figure 84.  Notes Workstation Configuration Screen
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By default, Lotus Notes will look in your $HOME directory for any .id files and will 
list all those that it finds. If there is more than one, then select the one you want to 
use. In case the user’s .id file is found in the $HOME directory, you will get an 
option of copying the user’s .id file from the $HOME directory to their data 
directory ($HOME/notesr4). Allow the system to copy the .id file to their data 
directory.

In our example we selected the user’s id file, mbrown.id and selected the user’s 
data directory /home/michael/notesr4. Click on OK on the User ID Entry screen, 
as shown in Figure 85.

Figure 85.  User ID Entry Screen

The rest of the installation proceeds from the Enter Password screen, as shown 
on Figure 81 on page 90, and continues until the installation has been completed.
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Chapter 4.  User and Server Registration

This chapter covers some aspects of registering Lotus Notes users and Servers. 
For additional information about registration and other administrative tasks, refer 
to the Lotus Notes Administrator’s Guide.

4.1  User Registration

Before you can install and set up Lotus Notes users for your Lotus Domino 
Servers, you must first set up an ID for each user in the Public Address Book. You 
perform this task by registering each user with the appropriate certifier, which 
creates an ID with the appropriate certificates. To make the setup of users more 
efficient, you can create user setup profiles to set the default workstation settings, 
set up a default workstation Execution Control List (ECL) for workstation data 
security, and customize the installation.

Before you can install and set up Lotus Notes on workstations, you must first 
create new users by registering them. You will need the following information to 
register new users:

  • A copy of the Certifier ID file with the necessary password
  • Full user name and home server name
  • Lotus Notes administrator's password, if there is one

When you register a new user, Lotus Notes does the following:

  • Creates a user.id file for the new user
  • Creates a Lotus Notes user document in the Name and Address Book
  • Optionally creates the user's mailbox

The registration server must be available on the network, and you must have 
access to the server and at least Author access in the Public Address Book. In 
4.4, “Giving Access to Address Book Database” on page 116, you learn how to 
give this access to a user. In 4.5, “Giving Access to the Certifier ID File” on page 
118, you will find some suggestions about the Certifier ID file.

4.1.1  Certification Log
After you install your first Lotus Domino Server, you should create a Certification 
Log (certlog.nsf) to record all your certification and registration tasks. When you 
add servers and users to Lotus Domino, the Certification Log maintains a record 
of how you registered the servers and users, including information about the 
certifier ID you used. In addition, you need the log if you plan to use the 
Administration Process to rename, recertify, or upgrade servers and users.

The Certification Log stores a document containing the following information for 
each registered server and user:

  • Name, license type, and ID number of the server or user
  • Date of the certification and expiration
  • Name, license type, and ID number of the certifier ID used to create or 

recertify the ID

To view this information, from the administration panel, click the System 
Databases icon and choose Open Certification Log or choose File -> Database 
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-> Open, and choose Certification Log (this will only work if it has already been 
created). The log contains views by certifier name, user name, and expiration 
date.

The Certification Log also includes the Updates Status view, which contains 
messages describing the results of the recertification requests that the 
Administrations Process is processing.

4.1.2  Creating the Certification Log
To create the Certification Log:

1. Log on to system as user notes.

2. Choose File -> Database -> New.

3. Select the name of the server you are using to register users in the Server 
box.

4. Enter Certification Log in the Title box.

5. Enter certlog.nsf in the File Name box.

You must name this file certlog.nsf.

6. Click Show Advanced Templates, select Certification Log as the template, 
and then click OK.

7. Choose File -> Database -> Access Control, and assign Editor access to all 
administrators who register users and servers and recertify IDs.

4.1.3  Registering New Lotus Notes Users
To register a new Lotus Notes user, do the following:

1. Log on to the AIX system as the Lotus Notes administrator, or with your own 
Lotus Notes user ID if you have the necessary access rights and roles, and 
run the Lotus Notes client by executing the command: notes

2. Choose File -> Tools -> Server Administration... from a Lotus Notes client 
screen to display the Server Administration screen (Figure 86).

You can log in as any user that has at least Author access and the role 
UserCreator for the Lotus Notes Name and Address Book. 

Note
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Figure 86.  Server Administration

3. Select a home server for the new user, for example, ah1610a/IBM Corp.

4. Click on the People button and select Register Person from the pop-up 
menu.

5. On the next prompt, click on the Yes button if you have purchased a user 
license.

6. If you are not using the Lotus Domino Administrator workspace, you may be 
asked to choose a Certifier ID file. You can choose the cert.id file.

The Lotus Notes client remembers the last used ID file and prompts you for 
its password. If you need to select a different Certifier ID file, click on 
Cancel at the password prompt.

Note
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7. When the Enter Password screen appears, enter the case-sensitive required 
password, then click on OK.

Figure 87.  Register Person

8. After you type in the correct password, the Register Person screen (Figure 87) 
will appear.

a. Select Registration Server.... Specify the name of the server where the 
new person record will be added to the Public Address Book.

(Optional) If the local server is not the registration server, click 
Registration Server and select the server that registers all users and click 
OK.

b. Click on Certifier ID..., select the Certifier ID file, and type in the 
administrator’s password.

(Optional) To select a different certifier ID, click Certifier ID and press 
Enter. Enter the Certifier ID password and click OK.

c. The North American security type is the default selection for the North 
American version only. Select International only if you will be using this ID 
on a computer with the International Release of Lotus Notes. In the 
International Release of Lotus Notes, there is no choice other than an 
International security type.

d. Change the Certificate expiration date as needed.

e. Click on Continue....

To change the expiration date, enter the date in mm/dd/yy format in the 
certification expiration date field.

Note
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Figure 88.  Register Person - Basics

9. The Register Person Basics screen (Figure 88) will appear.

a. Type the user’s first name, last name and, if applicable, the middle initial in 
the appropriate boxes. If you want a period after the middle initial, be sure 
to add one. Lotus Notes does not add the period automatically. The IBM 
Global Notes Architecture specifies the standard that no period will be used 
after the middle initial.

b. Enter a case-sensitive password.

c. Enter a minimum password length for this ID if desired.

d. If you want Internet users to have authenticated access to the Lotus 
Domino Server, select Set Internet Password to set an Internet password 
in the Person document. This field is automatically selected if you select 
the Other Internet, POP, or IMAP mail types. This password is the one you 
entered in the Password box in Step 9.c. The Internet password in the 
Person document is set as your Lotus Notes password. The Internet 
message storage field is set to Internet. If you select Other Internet, POP, 
or IMAP, you can supply an Internet supply an Internet address for the user 
(for example, michael@braegen.com).

e. Choose the type of license you purchased.

Lotus Notes has three types of licenses. See the Lotus Notes Deployment 
Guide for more information on license type.

f. Select a user profile if you have defined one.

Lotus Notes Release 4.6 provides a method for customizing the 
registration of multiple users in an organization at one time with a group 
user profile. This user profile contains default information on database, the 
mail domain, passthru servers, and remote servers for a group of users. 
See section 4.1.4, “Creating a User Profile” on page 101 and the Lotus 
Notes Installation Guide for Servers published by Lotus, for additional 
information.
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Figure 89.  Register Person - Mail

10. Click on the Mail icon to go to the Register Person Mail screen (Figure 89).

a. In the Mail type box, select the mail program you want for this user.

b. If you select Lotus Notes, enter the name of the user’s mail file and select 
whether you want to create the mail file now or during the Setup program. 
The default name of the mail file is the first character of the first name, 
followed by the last name.

c. If you select cc:mail or Other VIM Mail, enter the user’s complete 
forwarding address.

d. If you select Other Internet, POP, or IMAP (depending on the mail server) 
in the Home server box, select or enter the name of the server that stores 
the user’s mail file.
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Figure 90.  Register Person - Other

11. (Optional) Click on the Other icon to type in additional information about the 
user for the Public Address Book (Figure 90).

a. In the Comment box, enter any information you want stored in the user’s 
Person document in the Public Name and Address Book.

b. Enter the user’s location, for example, an office location.

c. Enter the local Lotus Domino administrator’s name, if desired.

d. Select In Address Book or In a file or both to indicate how you want to 
store the user’s ID file. If you store the ID in a file, click Set ID file, specify 
the file name and path, and double click. If you do not select an ID storage 
type, a Lotus Notes ID is not created unless the mail type is Notes Mail.

e. Enter the unique organization for the user. This is useful only if you have 
two people with the same name in the same organizational unit to uniquely 
identify the person.

12. Click Next and repeat the steps to register more than one user.

13. Click Previous to view the previous user; click Delete to delete the user.

14. Click Register to register the user(s).

15. You will be asked if you want to register another user. Select No to terminate 
the registration process.

4.1.4  Creating a User Profile
You can create a Setup Profile to configure workstation default options for users. 
Create a Setup Profile in the Public Address Book and specify an Internet 
browser, how Web pages should be retrieved, a default passthru server, 
databases to add to the workspace, default remote servers, Java Applet security 
options, proxy configuration settings, and secondary NDS (Notes Domain Server) 
and TCP/IP servers. Use profiles to set up batches of users who have the same 
default settings. For example, you create user IDs and set up workstation 
defaults for your sales force, who can access the same remote server and need 
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the same databases on their desktop. Create a profile called Sales with these 
options and use it to create these users. You can create multiple profiles.

1. Open the Public Address Book.

2. Open the Setup Profile view.

3. Click on Add Setup Profile.

4. Enter the name for the profile that describes the group. You can use any of 
these characters for the name: A - Z, 0 - 9, &, -, _, ’, /, (ampersand, dash, 
period, space, underscore, apostrophe, forward slash). Do not use \ 
(backslash) or any other characters, because this can cause unexpected 
results.

5. Select an Internet Browser and select where you want users to retrieve and 
store Web pages.

6. To add one or more databases to users workspaces automatically, copy 
database links to the setup profile. To perform this step, select a database and 
choose Edit -> Copy as a link -> Database Link. Then, in the Database links 
field in the setup profile, choose Edit -> Paste.

7. Enter the name and the phone number of a default passthru server to 
automatically set up a passthru server for users.

8. Enter the names and phone numbers of the remote dialup servers to 
automatically create connection records for the servers in the user’s Personal 
Address Books.

9. (Optional) Enter the names and addresses of secondary TCP/IP and DNS 
Lotus Domino name servers.

10. (Optional) Select default Java Applet security options and default proxy 
configuration options.

11. Choose File -> Close and click Yes to save your changes.

4.1.5  Installing Lotus Notes Clients
You will need the following information to install Lotus Notes clients:

  • The full user name followed by a slash and the organization name, for 
example, Dianne Smyth/IBM Corp.

  • The user ID, as a file on a disk or as a file in the Name and Address Book.

  • The user ID's temporary password.

  • The full home server name followed by a slash and the organization name, for 
example, ah1610a/IBM Corp.

4.1.6  Registering Multiple Users From a File
Registering users from a text file lets you decide on options and then go through 
the setup process with the Administration Control panel only once. You can 
generate lists of users from existing lists to save time. For example, you copy a 
human resources list of employees in one group and use this list to create a text 
file to create user IDs for employees.

All users in a registration file must be registered with the same certifier. You must 
create a separate text file for each organizational unit (OU) certifier you will use.
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To perform this task, you must be an Administrator with the UserCreator role or 
have Editor access in the Public Address Book on the registration server.

Last Name; [First Name]; [Middle Initial]; [Organizational Unit];
[Password]; [ID File Directory]; [ID File Name];
[Home Server Name]; [Mail File Directory];
[Mail File Name]; [Location];
[Comment]; [Forwarding Address];
[Profile name]; [Local Administrator]

4.1.7  Examples of Registering a Group of Users
Example 1: Text file specifying last names and passwords
Stenmark;;;;password1 
Kapur;;;;password2
Kunde;;;;password3
Smyth;;;;password4

Example 2: Text file specifying complete names, home servers, and
user setup profiles
Stenmark;Andreas;J;;password1;;;MARKETING/IBM;;;;;;Marketing Profile
Kapur;Sanjay;;;password2;;;SALES/IBM;;;;;;Sales Profile
Kunde;Hans;J;;password3;;;MARKETING/IBM;;;;;;Marketing Profile
Smyth;Alison;;;password4;;;SALES/IBM;;;;;;Sales Profile

Example 3: Text file specifying more information for each user
Stenmark;Andreas;J;;password1;C:\USERID;AJSTENMARK.ID;MARKETING/IBM;MAIL;ASTEN
MARK;Marketing;#45738;;Marketing Profile;Michael White
Kapur;Sanjay;;;password2;C:\USERID;SKAPUR.ID;SALES/IBM;MAIL;JKAPUR;Sales;#6893
2;;Sales Profile;Chris Benn
Kunde;Hans;J;;password3;C:\USERID;HJKUNDE.ID;MARKETING/IBM;MAIL;HKUNDE;Marketi
ng;#89647;;Marketing Profile;Michael White
Smyth;Alison;;;password4;C:\USERID;ASMYTH.ID;SALES/IBM;MAIL;ASMYTH;Sales;#1937
5;;Sales Profile;Chris Benn

4.1.8  Registering Multiple Users from a Text File
The parameters for each line in a text file (in the order you must enter them) are:

1. Last Name

(Required) Use to specify a last name.

2. First Name

(Optional) Use to specify a first name. Lotus Notes uses the person’s name for 
the ID file name. For example, the ID file name for a user called Craig Keller 
will be ckeller.id. You may need to include the user’s first name to avoid 
duplicate ID file names. If you attempt to register two users with the same 
name, you will get an error message when registering the second one. You 
must use the ID File Name field to avoid this error.

3. Middle Initial

(Optional) Use to specify a middle initial. Include a period if desired. Avoid 
duplicate ID file names.

4. Organizational Unit

(Optional) For hierarchical naming, use to add another level to a name to 
distinguish between two users with the same name, certified by the same 
certifier.
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5. Password

(Required) The password is required if you use a minimum password length 
when registering the users (the default length is eight characters) or if you 
store the IDs in the Public Address Book (one character or more is required).

6. ID File Directory

(Optional) Use to store an ID in a specific directory in addition to or instead of 
as an attachment in the Public Address Book. You must create the directory 
before doing the registration. For this parameter to take effect, during 
registration you must select the "In directory" option for storing the user ID; 
the text file parameter overrides the default ID directory shown in the 
registration dialog box.

7. ID File Name

(Optional) Use to specify a name on an ID. This field applies only if you are 
storing an ID in an ID file directory. If you do not specify a user ID file name, 
the name on the ID is based on the person’s name.

8. Home Server Name

(Optional) Use to specify a home server for a specific user that overrides the 
one you select during registration. If the server is hierarchical, specify its 
hierarchical name, for example, ah1610a/IBM Corp.

9. Mail File Directory

(Optional) Use to specify a mail file directory for a specific user that overrides 
the one you select during registration.

10. Mail File Name

(Optional) Use to specify a name for a mail file. If you do not use this 
parameter, the name is based on the person’s name if the person uses Lotus 
Notes Mail.

11. Location

(Optional) Use to add descriptive information about the user that appears in 
the Person document. If someone addresses mail to this user and there is 
another user with the same name, Lotus Notes displays the location to help 
the sender distinguish the two users.

12. Comment

(Optional) Use to add an identifying comment to a Person document in the 
Public Address Book.

13. Forwarding Address

If all of these users use other Internet mail, you must specify a 
forwarding/Internet address to ensure that mail reaches these users. Type the 
full route to each user, for example, mwhite@braegen.com. Rather than 
specifying the forwarding address in the text file, you can edit the Forwarding 
address field in each Person document after registering the users.

14. Profile Name

(Optional) Use to specify a User Setup Profile for a user. Enter the name of the 
User Setup Profile. This parameter overrides for a specific user a User Setup 
Profile you specified during registration.

15. Local Administrator
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(Optional) Use to specify a local administrator to allow a person with Author 
access to the Public Address Book, but without the UseModifier role to modify 
the users’ Person documents. A local administrator specified in the text file 
overrides one you specified in the registration dialog box.

After you have created a file with all the necessary information for multiple users, 
you should now do the following steps:

1. Log in as the Lotus Notes administrator and run the Lotus Notes client with the 
command: notes

2. Choose File -> Tools -> Server Administration... from the Lotus Notes 
Workspace screen to get the Server Administration screen (Figure 86 on page 
97).

3. Select a home server for the new user, for example, ah1610a/IBM Corp.

4. Click on the People button and select Register From File... from the pop-up 
menu.

5. You will be asked if you have purchased a license for the users. If you have 
purchased all the licenses, then click on the Yes button.

6. If you are not using the Lotus Administrator workspace, you may be asked to 
choose a Certifier ID file. You can choose the cert.id file.

7. When the Enter Password screen appears, enter the case-sensitive required 
password, then click on OK.

8. After you type in the correct password, the Register Person screen (Figure 87 
on page 98) will appear.

1. If the registration server is not the local server, click Registration Server, 
select the server that registers all new users, and click OK.

2. To select a different certifier, click Certifier ID, select the Certifier ID file, 
and press Enter. Enter the certifier password and click OK.

3. The North American security type is the default selection for the North 
American version of Lotus Notes. Select International only if you will be 
using this ID on a computer with the International Version of Lotus Notes. 
In the International release of Lotus Notes, the only choice for security type 
is International.

4. Change the Certificate Expiration Date as needed. Enter in the date as a 
mm/dd/yy format.

5. Click on Continue.

You can log in as any user that has at least Author access in the Lotus 
Notes Name and Address Book.

Note

The Lotus Notes client remembers the last used ID file and prompts you for 
its password. If you need to select a different Certifier ID file, click on 
Cancel at the password prompt.

Note
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Figure 91.  Choose Text File with Person Information

9. The Choose Text File with Person Information screen (Figure 91) will appear. 
Select the directory and the users’ information files you have created and then 
click on the OK button.

Figure 92.  Register People from Text File - Basics

10. The Register People from Text File Basics screen (Figure 92) will appear.

a. Enter a minimum password length for the IDs if desired.

b. Choose the type of license type you purchased.

c. Select a user profile if you have defined one.
106 Lotus Domino Release 4.6 on IBM RS/6000



Figure 93.  Register People from Text File - Mail

11. Click on the Mail icon to go to Register People from Text File Mail screen 
(Figure 93).

a. In the Mail type box, select the mail program compatible with the 
information you entered in the input file.

If you select Lotus Notes, enter the name of the user’s mail file and select 
whether you want to create the mail file now or during the Setup program. 
The default name of the mail file is the first character of the name, followed 
by the last name.

If you select POP or IMAP (depending on your mail server), select Set 
Internet password to set an Internet password in the Person document. 
This password is the one you entered in the Password box in Step 10a. 
The Internet password in the Person document is set as your Lotus Notes 
password. The Internet message storage field is set to Internet.

Select or type the name of the server that stores the user mail databases in 
the Home Server box.
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Figure 94.  Register People from Text File - Other

12. Click on the Other icon to type in additional information about the users 
(Figure 94).

a. Select In Address Book or In directory to indicate how you want to store 
the Lotus Notes user ID files. If you want to store the IDs in a directory, 
click Set ID Directory to specify the directory name.

b. Enter the local Lotus Notes administrator’s name, if desired.

13. Click on Register to register the users.

14. You can see status messages in the bottom of the workspace screen.

15. If there are errors, a pop-up screen alerts you. You can see the errors on the 
Lotus Domino Server log.

16. Finally, you will see a screen with the number of created users.

4.1.8.1  Registering Users From a UNIX Password File
If you want to register all your UNIX users, you can create a shell script to convert 
the user information from the /etc/passwd file to a Lotus Notes input file. Here is a 
simple example:
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Figure 95.  Shell Script to Convert a UNIX Password File

This script converts the password file, as shown in Figure 96, into the Lotus 
Notes input file shown in Figure 97. It only converts the lines with 
non-administrative users (user IDs greater than 199) and with user names that 
are not null (gecos field not null). It also forces the ID File Name and the Mail File 
Name to be the same as the login name to avoid duplicate ID File Names.

Figure 96.  UNIX Password File

Figure 97.  Lotus Notes Input File to Register Users

4.2  Registering Web Users

As an administrator, you need to set up two types of Web, NNTP, and LDAP 
users: anonymous users and users who want to authenticate with a server.

#!/bin/ksh
# @(#) converts /etc/passwd to a Lotus Notes registration file
# Usage: convpasswd <passwd_file> <notes_file>
# It only converts users with userid >= 200

if [[ $# != 2 ]]
then
  echo "Usage: $0 <passwd_file> <notes_file>"
  exit 1
fi

awk -F: ’($3 >= 200) && ($5 != "") {
  total = split ($5, NAME, " ");
  INITIAL = total>2 ? sprintf("%s",substr(NAME[2],1,1)) : "";
  printf ("%s;%s;%s;;password;;%s.id;;;%s.nsf;;%s;;\n",
          NAME[total], NAME[1], INITIAL, $1, $1, $5)
  }’ $1 >| $2

root:!:0:0:The powerful system administrator:/:/bin/ksh
sys:!:3:3::/usr/sys:
uucp:!:5:5::/usr/lib/uucp:
morg:!:200:201:Morgan Smyth:/home/morg:/bin/ksh
erin:!:202:202:Erin L Smyth:/home/erin:/bin/ksh
mich:!:203:209:Michael Donald White:/home/mich:/bin/ksh
chri:!:204:215:Chris Benn:/home/chri:/bin/ksh
...

Smyth;Morgan;;;password;;morg.id;;;morg.nsf;;Morgan Smyth;;
Smyth;Erin;L;;password;;erin.id;;;erin.nsf;;Erin L Smyth;;
White;Michael;D;;password;;mich.id;;;mich.nsf;;Michael Donald White;;
Benn;Chris;;;password;;chri.id;;;chri.nsf;;Chris Benn;;
...
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4.2.1  Anonymous Users
If you want to access the server anonymously, you do not have to create Person 
documents for them. However, you need to ensure that anonymous users can 
access the server and databases on the server. 

4.2.2  Allowing Anonymous Users
You can set up anonymous access on a server so users and servers can access 
the server even if the server can’t authenticate them. The method you use to set 
up anonymous access depends on whether you are setting up access for Lotus 
Notes users and Lotus Domino servers or Internet and intranet users.

1. Create an entry called Anonymous in the database access control list (ACL) of 
the databases on the server and assign the appropriate access level, typically 
Reader access, unless it is an interactive database then you would assign 
Author access. If you don’t add Anonymous as an entry in the ACL, users and 
servers accessing the server anonymously are given the Default access.

2. Do one of the following:

  • From the Administration panel, click Servers and choose Servers View.

  • From the Web Administration tool, click Server and then Server.

3. Open the Server document for the server in the Public Address Book and do 
one of the following:

  • If you setting up anonymous access for Lotus Notes users and Lotus 
Domino servers, in the Security section, select Yes in the Allow anonymous 
connections field. If there are any entries in the Access Server field in the 
Restrictions section of the Server document, add Anonymous to this field.

  • If you are setting up anonymous access for Internet and intranet users, in 
the Internet Port and Security Configuration section, select Yes in the 
Anonymous field in the column for the protocol.

4. Set up the database access control list to allow access by anonymous users.

5. Save the document.

6. Shut down and restart the server for the changes to take effect.

If the administrator does not allow anonymous access, all anonymous users 
receive an "authorization failure" message when they access the server. If you 
set up basic password authentication on the server, the users are prompted for a 
user password before this message occurs. The Anonymous setting in the Server 
document overrides individual database access controls for anonymous users.

If both Name & Password and Anonymous are selected for an Internet protocol, 
and you set up the database access control list to allow anonymous access, 
users connect using anonymous access. The server does not ask users for a 
name and password even if the user is set up for basic password authentication.

If Client certificate and Anonymous are selected for SSL, Lotus Domino first 
checks for a client certificate and if that fails, allows the client to access the 

POP3 and IMAP do not support Anonymous access.

Note
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database using anonymous access, if you set up the database access control list 
to allow anonymous access.

4.2.3  Authenticated Users
If you want users to enter a name and password when accessing the server or 
use client authentication with Secure Socket Layer (SSL), you must create a 
Person document for the user. You do not have to register Web, NNTP, or LDAP 
users. They do not require a Lotus Notes ID or mail file unless you are setting up 
a Web user for Web Mail. You can just create the Person document directly in the 
Public Address Book and enter information about the users’ name, password, 
and SSL certificate.

1. Do one of the following:

  • From the Web Administration tool, click Users and click People.

  • From the Administration Control Panel, select People and choose People 
View.

2. Click Add Person.

3. Enter the user’s first name, middle initial (optional), and last name in the First 
Name, Middle Initial, and Last Name fields.

4. Enter the users full name in the User name field. This is the user name the 
user enters when trying to access a database on the server.

5. Enter the user’s password in the Internet password field. This will 
automatically be encrypted when you save the document.

6. (Optional) Enter additional information about the user in the Work and Home 
sections.

7. Save the document.

8. Do one of the following:

  • From the Web Administration tool, click Server -> Server.

  • From the Administration Control panel, click Servers and choose Servers 
View.

9. Select one of the following:

  • In the Internet Protocol and Security Configuration section, under TCP/IP, 
Name & Password, select Yes in the column for the protocol for which you 
want to require a name and password for basic password authentication.

  • In the Internet Protocol and Security Configuration section, under SSL 
Name & Password, select Yes in the column for the protocol for which you 
want to require a name and password for SSL clients.

10. Save the document.

11. Set up the database access control list (ACL) for the databases on the server.

Two settings on the database ACLs control the Internet and Intranet access: 
The ACL entry and the Maximum Internet name & password access on the 
Advanced panel of the ACL.

The name on the database access control list used to authenticate the user is 
used to determine form, document, and section access for each of these 
database components. The server uses the same method as Lotus Notes and 
Lotus Domino users to secure access to these database components.
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You must set up SSL, anonymous access to servers, and basic password 
authentication before database ACLs take effect.

Set up the database ACL as follows:

  • Add the user name from the Person document to the ACL and assign 
access.

  • Add the entry Anonymous, and set it and Default access to No Access.

  • If you don’t set these entries to No Access, they take precedence over the 
individual user name.

  • If the users are connecting over TCP/IP set the Maximum Internet name & 
password access to the maximum level allowed, even if the name listed 
individually has more access. If the individual entry has less access than 
the Maximum Internet name & password access, then the access for the 
individual entry takes precedence.

12.(Optional) If you want to further secure information in the Internet password 
field, select the documents in the view, choose Actions -> Upgrade to More 
Secure Internet Password Format, and click Yes.

4.3  Registering Additional Servers

Before you install additional servers, you must register them. Registration is how 
you add servers to Lotus Domino by creating IDs stamped with the appropriate 
certificates. The server registration process creates a Server document in the 
Public Address Book and creates a server ID.

When you register servers, you should know your company’s naming scheme. 
The naming scheme helps you know which certifier to use when you register 
each new server. In addition, you must have access to each certifier that you are 
using and you must know each certifier ID password.

The registration server, that is, the server from which you register other servers, 
must be up and running on your network. To register servers from your 
workstation, you must have access to the registration server and have at least 
Author access to the Public Address Book with the appropriate role 
ServerCreator in the access control list of the Public Address Book.

When you register a server, Lotus Domino does the following:

  • Creates a server ID for the new server and certifies it with the certifier.

  • Creates a Server document for the new server in the Public Address Book and 
enters the administrator name in the Administrators field of the Server 
document.

  • Encrypts and attaches the server ID to the Server document in the Public 
Address Book and saves the ID on a disk or to a file on the server.

  • Adds the server name to the LocalDomainServers group in the Public Address 
Book.

  • Creates an entry for the new server in the Certification Log (CERTLOG.NSF), 
if you created it.

To install additional Lotus Domino Servers in the same domain, you have to 
register them on an existing server. Then, you can install and set them up.
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Registering additional servers is a task normally performed by the Lotus Notes 
administrator. You will need the following information to register an additional 
server:

  • A copy of the Certifier ID file and the corresponding password

  • Server name

  • Lotus Notes administrator's password

4.3.1  Registering New Lotus Domino Server
1. Log in as the Lotus Notes administrator and run the Lotus Notes client with the 

command: notes

2. Choose File -> Tools -> Server Administration... from the Lotus Notes 
Workspace screen to get the Server Administration screen (Figure 86 on page 
97).

3. In the Administration screen, as shown in Figure 86 on page 97, click on the 
Servers button and choose Register Server... from the pull-down menu.

4. If you have purchased a server license, click Yes.

5. If you are not using the Lotus Administrator Workspace, you may be asked to 
choose a Certifier ID file. You can choose the cert.id file.

To change which certifier is used for registering the server, click Certifier ID, 
select the Certifier ID, and press Enter.

6. Type the administrator's password and click OK.

You can log in as any user that has at least Author access and the 
ServerCreator role in the Lotus Notes Name and Address Book.

Note

The Lotus Notes client remembers the last used ID file and prompts you for 
its password. If you need to select a different Certifier ID file, click on 
Cancel at the password prompt.

Note
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Figure 98.  Register Servers

7. On the Register Servers screen (Figure 98):

a. If you are not at the server in which you want to register, click Registration 
Server, choose the server, and click OK

b. If you want to create a new entry in the Certification Log, click on Certifier 
ID..., select the Certifier ID file, and click on OK.

c. Choose a Security type: North American or International.

d. (Optional) To change the expiration date, enter the date in mm-dd-yy 
format.

e. Click on Continue....

Figure 99.  Register Servers - Basics

8. On the Register Servers Basics screen (Figure 99):
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a. Enter a unique server name of up to 79 characters. If you are running the 
UNIX version of the Lotus Domino Server, its name must be a valid TCP/IP 
name or alias.

b. If you want to register the server in a different domain from the one 
containing the registration server, enter the new domain name. The 
registration server’s Lotus Notes domain is the default value for the 
Domain field.

c. Enter the administrator’s name. If you also want to use the new server as a 
workstation for the administrator, then the administrator must have a 
user.id file on the registration server or in the Name and Address Book 
Database.

d. Consider setting the Minimum password length to 0. With a setting of 0, you 
will later be able to clear the password on the server ID, which will allow an 
automatic startup of the Lotus Domino Server after a reboot of the server 
machine.

Figure 100.  Register Servers - Other

9. Click Other to get the Register Servers Other screen (Figure 100):

a. In the Server Title box you can enter any information about the server.

b. In the Network box you can enter the server’s network name that is 
different than the default.

c. Change the local Lotus Notes administrator’s name as needed.

d. Select In Address Book or In file to indicate how you want to store the 
Server ID file. If you want to store the ID in a file, click Set ID file... to 
specify the file name.

10. Click Next and repeat the steps to register more than one server.

11. Click Previous to view the previous server, or you can click Delete to delete 
the server.

12. Click Register to register the server(s).
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13. You will be asked if you want to register another server. Select No to 
terminate the registration process.

4.3.2  Installing Lotus Domino Servers
You need the following information to install Lotus Domino Servers in the same 
domain:

  • The full server name followed by a slash and the organization name, for 
example, ah1610a/IBM Corp.

  • The Server ID, as a file on a disk or as a file in the Name and Address Book.

  • The Server ID's temporary password.

  • The full primary server name followed by a slash and the organization name, 
for example, noteserv/IBM Corp.

4.4  Giving Access to Address Book Database

Any user can create new users or register new servers if they have at least 
Author access to the Address Book Database and possess the correct roles. If 
you want to give this power to particular users, you have to trust them, for they 
will have access to modify your Address Book Database. Normally, this user will 
be another Lotus Notes administrator. Usually, only the administrator of the 
primary server needs to register users and other servers.

To give a user access to the database, you have to do the following:

1. Log in as the Lotus Notes administrator and run the Lotus Notes client by 
typing in the command: notes

2. Click with the right button on the Address Book Database icon. A pop-up 
menu will appear. Select Access Control....

3. Enter the administrator's password.
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Figure 101.  Access Control List

4. The Access Control List screen (Figure 101) will appear. If the user is not 
shown on the People, Servers, Groups box, click on the Add button and 
follow the steps outlined. If the user is shown on the list, go to step 5 on page 
118.

Figure 102.  Add User

a. On the Add User screen (Figure 102), click on the button beside the 
Person, server, or group field, this will give you a list of all people, groups 
and servers that are in the Public Address Book to choose from.
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Figure 103.  Names

b. Select the person you want to have access to the Address Book Database 
and click on the Add button. The name(s) you selected will appear in the 
Added box, as shown in Figure 103.

c. Click on the OK button.

d. You will be back at the screen shown in Figure 101 on page 117.

5. Select the user on the People, Servers, Groups box.

6. Select the type of access this user will have, for example, Editor. You can do 
this with the Access pull-down menu.

7. Select the user type, for example, Person Group. You can do this with the 
User type pull-down menu.

8. Select the specific access allowances and roles.

9. Click on the OK button.

4.5  Giving Access to the Certifier ID File

The easiest way to give users access to the Certifier ID file is to copy to their 
directories the cert.id file that is in the data directory of the Lotus Notes primary 
server. After copying the file, make sure the users have read and write 
permissions and/or ownership of the copied file.

The users now have access, but it is a security risk. This file must always be 
protected, and normally, only the administrator of the primary server should be 
able to access it. If more than one user needs to access this file, make sure that it 
remains in a secure place.

If all the users you want to have access to the cert.id file use the same UNIX host, 
you can set up a UNIX group with all of them, and set it up as a group cert.id file. 
Then, give group read and write permissions to the cert.id file. The users also 
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need permission to access and search the directory where the cert.id file is 
located.

In Lotus Notes Release 4.6, it is also possible to restrict access to an ID file 
further by requiring more than one password to use the ID file. With this 
additional security requirement, two or more people may be necessary before a 
cert.id is usable.

This is covered in more detail in 8.5.4.1, “Securing the Certifier ID” on page 200.
User and Server Registration 119



120 Lotus Domino Release 4.6 on IBM RS/6000



Chapter 5.  Connecting Lotus Domino Servers

In this scenario, as shown in Figure 1 on page 22, we attempt to connect our six 
AIX Lotus Domino Servers in such a way that mail routing and replication are 
enabled efficiently and transparently.

The first step in setting up connections between servers and domains is to design 
the network topology that will be used.

5.1  Choosing a Topology for Replication and Mail Routing

The topology that was chosen was a hub and spoke topology. With this method, 
the hub always initiates the request for replication. Connection documents for 
replication were created at the hub, and not at the spokes, to ease administration 
and maintenance.

Hub and spoke topology is the most efficient setup for Lotus Domino servers. The 
hub server replicates with each spoke server in turn according to the schedule 
you define. You can:

  • Install multiple protocols on hub servers to enable communication in 
organizations using more than one protocol. This places hub servers in 
multiple Lotus Domino named networks, another source of efficiency. Hub 
servers can connect multiple Lotus Domino named networks.

  • Bridge parts of a network, such as a LAN and a WAN, with a hub server.

  • Centralize administration of the Public Address Book by designing the hub 
with Manager access and the spokes with Reader access. Making changes in 
one replica (on the hub) synchronizes the spokes.

  • Designate hubs by role, for example, replication hubs and mail hubs.

  • Place server programs like Message Transfer Agents on hubs to make them 
easily accessible.

  • Use a hub to connect remote sites to your LAN or WAN.

Often, a single hub server and its spoke servers make up one Lotus Domino 
named network.

For our scenario, we created one hub in each domain with all servers (spokes) in 
that domain connected to the hub. Each domain hub was then a spoke of the 
main hub, thus fully connecting all the servers in the network.

The topology that we used as a base is shown in Figure 1 on page 22.

Notice that noteserv/ibm acts both as a domain hub for the ibm domain and also 
as the main hub, connecting all domains together. It has a dual role.

5.2  Mail Routing

This section discusses what needs to be set up for mail to be routed between 
servers in different domains and how to do the setup.
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5.2.1  Introduction to Mail Routing
For mail routing to occur between two Lotus Domino servers, you usually must 
create Connection documents that specify how and when the mail routing occurs. 
Connection documents are stored in the Public Address Book, and you should 
ensure that all Public Address Books have been replicated correctly.

In a connection document, both the Mail and Replication tasks are enabled by 
default. However, you can edit this setting and create separate Connection 
documents for each task. If the Mail task is enabled in the Connection document, 
Lotus Domino routes any pending mail during replication, in addition to routing 
mail at scheduled times.

How you connect servers for mail routing depends on whether the servers are in 
the same Lotus Domino named network and/or Lotus Domino domain:

  • To set up mail routing between two servers in the same Lotus Domino named 
network, you do not need to create a Connection document. Lotus Domino 
automatically routes mail between servers on the same Lotus Domino named 
network. A Lotus Domino named network is a group of Lotus Domino servers, 
that share a common LAN protocol and have the same Lotus Notes Network 
name in their Server documents in the Public Address Book in the Network 
Configuration section.

  • To set up mail routing between two servers that are in the same Lotus Domino 
domain but are on two different Lotus Domino named networks, you create 
two Connection documents, one in each direction, to ensure two-way 
server-to-server communication.

  • To set up mail routing between two servers in adjacent domains, you need a 
Connection document in the Public Address Book of each Lotus Domino 
domain.

  • To set up mail routing if the servers are in two different Lotus Domino domains 
that are connected by a third Lotus Domino domain, you create a Connection 
document to the adjacent Lotus Domino domain and a non-adjacent domain 
document in the Public Address Book. The adjacent Lotus Domino domain 
then has a document to your non-adjacent Lotus Domino domain and does the 
delivery to the destination Lotus Domino domain for you. Otherwise, every 
user needs to know the full delivery path if addressing mail to a non-adjacent 
Lotus Domino domain.

  • To set up mail routing between a Lotus Domino Server and a non-Domino 
server in a foreign domain, such as on the Internet, you create a Connection 
document and a foreign Domain document in the Public Address Book of your 
Lotus Domino domain.

5.2.2  Setting Up Mail Routing Connection Documents
Initially, there will be no Connection documents for routing mail to other domains. 
Any attempt to route mail across to another domain would result in error 
messages on the server.

In this section, we will describe how to set up mail routing between two different 
domains. To start, you must create Connection documents between two servers 
for which you want mail routing to take place.

Having logged on as the administrator for the main hub:
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1. Select the server’s Public Name and Address Book icon by clicking on it 
once with the left mouse button or from the Administration Control Panel, click 
System databases and choose Open Address Book or double click on the 
Public Address Book icon to open the database.

2. Once the Public Address Book is open, choose the Connection view from the 
navigator pane on the left side and click the Add Connection button at the top 
of the screen.

Figure 104.  New Server Connection for Mail Routing

We decided to create one Connection document for mail routing and one for 
replication. 

3. In the Basics section of the Connection document, select the type of 
connection and complete the remaining fields in the Basics section. These 
fields will vary on the type of connection you choose. In our case, for 
Connection Type, you chose Local Area Network from the drop down menu. 
Our Source Server was noteserv/ibm with the Source Domain ibm and our 
Destination Server was itsosmp/itso with the Destination Domain itso.
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The Basics section of the screen (as the name suggests) is trivial. Just make 
sure that the Source server name is fully qualified with the Source domain 
name.

4. Complete the Scheduled Connection section:

  • In the Schedule field, make sure ENABLED is selected.

Should you wish to disable the Connection document, select DISABLED 
from the pull-down of the Schedule field in the Scheduled Connection 
section of the screen.

  • In the Call at Times field, enter a range of times (for example 12:00 AM - 
2:00 AM) and or specify times (for example 12:00 AM, 3:00 AM) when you 
want the source server to connect to the destination server. Separate 
multiple specific times with a comma. The default is 8:00 AM to 22:00 PM.

  • (Optional) If you enter a range of times to connect, then in the Repeat 
Interval of field, optionally enter how soon after a successful connection 
the source server attempts to connect again. The default is 360 minutes.

  • In the Days of week field, enter the days of the week that you want the 
source server to connect to the destination server. The default is every day 
of the week.

5. In the Routing and Replication section:

  • In the Tasks field, make sure Mail Routing is selected.

  • In the Route at once if field, enter a value to determine the number of 
pending messages that force mail routing to occur. The default is 5.

  • In the Routing cost field, leave the default value of 1.

Lotus Domino uses routing costs to select the most efficient, least expensive 
way to route mail messages from one server to another. The Mail Router 
computes and stores information about these costs in its internal routing 
tables. If there is more than one possible route for mail to travel between the 
source server and the destination server, the Mail Router uses information in 
the tables to calculate a least-cost route to the destination.

Save the Connection document (press the Esc key on the keyboard and click 
on Yes in the Confirmation window to save the changes). On returning to the 
Workspace, make sure the Public Name and Address Book icon is selected, 
and select View -> Server -> Connections to see the Connection document 
in the Name and Address Book. Figure 105 shows the Connection document 
for noteserv/ibm to itsosmp/itso in the Public Name and Address Book.
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Figure 105.  Lotus Notes - Connection Document in Name & Address Book

The second server (the domain hub) in domain itso will also need a Connection 
document to the first server (the main hub) in domain ibm. Without it, users on 
that domain would not be able to send mail or reply to users on other domains 
through the main hub. The Connection document for the second server is shown 
in Figure 106.
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Figure 106.  Mail Routing Connection Document for Second Server

Now that the Connection documents are in place, we need to authorize the two 
servers to communicate with each other. This is done by using cross certificates.

5.2.3  How Cross Certification Works
Cross Certification at the Organization Level (Scenario 1)

The Braegen organization certifier (/braegen) cross certifies the IBM organization 
certifier (/ibm). The cross certificate issued by Braegen is stored in Braegen’s 
Public Address Book. The IBM organization certifier (/ibm) cross certifies the 
Braegen organization certifier (/braegen) and the cross certificate issued by IBM 
is stored in IBM’s Public Address Book. This allows all users and servers from 
Braegen to authenticate with IBM and vice versa.

Cross Certification at the Organizational Unit Level (Scenario 2)

The Braegen Group maintains a customer support server SUPPORT exclusively 
for use by external customers, one of which is Visual Concepts. The Braegen 
organizational unit certifier (/support/braegen/ca) cross certifies the Visual 
Concepts organizational unit certifier (/audio/visual/us), and the cross certificate 
issued by /support/braegen/ca is stored in Braegen’s Public Address Book. The 
Visual Concepts organizational unit certifier (/audio/visual/us) cross certifies the 
Braegen organizational unit certifier (/support/braegen/ca), and the cross 
certificate issued by /audio/visual/ca is stored in Visual Concept’s Public Address 
Book.
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This cross certification enables Michael White/audio/visual/US and Erin 
Smyth/audio/visual/us to authenticate with the server 
SUPPORT/support/braegen/ca. However, it does not allow all users to 
authenticate with the Braegen server PRODUCTION/DEV/braegen/ca.

5.2.4  Cross Certification and Authentication
Having set up the Connection document, the next step is to cross-certify the 
Certifier ID on the servers in the two Lotus Domino domains. For this, we will be 
following example 1: Cross Certification at the Organization Level. Without this 
cross certification in place, the Lotus Domino Servers will not route any mail.

The steps for cross-certifying certificates are as follows:

1. Server A creates a Safe Copy of its Certifier ID and makes this file available to 
Server B.

2. Server B cross-certifies the Certifier ID for Server A.

3. Server B creates a Safe Copy of its Certifier ID and makes this file available to 
Server A.

4. Server A cross-certifies the Certifier ID for Server B.

The next two sections, 5.2.4.1, “Creating a Safe Copy of the Certifier ID” on page 
127 and 5.2.4.2, “Cross Certifying the Certifier ID” on page 129 describe this 
process by using two servers, noteserv/ibm and itsosmp/itso, as examples.

5.2.4.1  Creating a Safe Copy of the Certifier ID
This section outlines how to create a Safe Copy of the Certifier ID file, with the 
assumption that there is no intermediary gateway in place for distributing the ID 
file by mail:

1. Select File -> Tools -> Server Administration... to display the Lotus Notes - 
Administration dialog box, as shown in Figure 86 on page 97.

2. Select the server that you want to administer and click Administration -> ID 
File... to display the Choose ID File to Examine dialog box, as shown in Figure 
107.

Figure 107.  Choose ID File to Examine
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3. Select the Certifier ID file for this server (usually cert.id) and click on OK.

4. Enter the password for the server on the Enter Password dialog box and click 
on OK (Figure 108).

Figure 108.  Enter Password

5. On the User ID <domain_name> dialog box (Figure 109), select the More 
Options icon and click on the Create Safe Copy... button.

Figure 109.  User ID Management Screen

6. On the Enter Safe Copy ID File Name screen that is presented (Figure 110), 
either accept the default or specify the name of the Safe Copy file in the File 
Name field. You can either save the file on diskette or on a drive that is shared 
with the server that you wish to connect to for mail routing.
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Figure 110.  Name of the Safe Copy ID File

7. Click on OK.

8. Tell the Safe Copy’s file name and location to the administrator of the server 
that you wish to cross-certify with.

5.2.4.2  Cross Certifying the Certifier ID
This section outlines how to cross-certify a Safe Copy of an ID file.

1. From the Notes Workspace, select File -> Tools -> Server Administration..., 
click on the Certifiers icon, and select Cross Certify ID File... to display the 
Choose Certifier ID screen (Figure 111).

Figure 111.  Choose Certifier ID Screen

2. Choose the server’s own Certifier ID file and click on OK.

3. Enter the password for the ID file (if required) and click on OK.
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4. On the Choose ID to be Cross-Certified dialog box (Figure 112), select the 
other server’s Safe Copy ID file (in this scenario, it’s noteserv.id) and click on 
OK.

Figure 112.  Choose ID to Cross-Certify Screen

5. (Optional) Change the expiration date of the certificate. The default is 10 
years.

6. (Optional) Click Certifier, select a different certifier to issue the cross 
certificate, and click OK.

7. On the Cross Certify ID dialog box (Figure 113), click on Cross Certify.

Figure 113.  Cross Certify

8. Enter the password for the ID file (if required) and click OK.

9. Click on No to exit the screen prompting for more ID files to be cross certified.
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5.3  Replication

This section discusses what needs to be set up for replication of databases to 
occur between servers and how to do the set up and customization for 
replication.

5.3.1  Introduction to Replication
Replication is the process of synchronizing documents from the same databases 
on different servers or workstations. The synchronization only works if the 
databases are replicas -- that is, they have the same replica ID, which is a unique 
number assigned to the database when it is created. You can keep multiple 
replicas of a single database on multiple servers. By using distributed replicas, 
users can access the same information on different networks, in different time 
zones, or in different countries, without having to access one centrally located 
database.

5.3.2  Creating the Connection Document for Replication
We will use a different Connection document for replication. To do this, follow 
these steps:

1. Double Click on the Public Name and Address Book to open it.

2. Choose Connections view from the Navigation Panel on the left.

3. Click on the Add Connection button at the top of the view.
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Figure 114.  Lotus Notes - New LAN Connection (for Replication)

4. Complete the Basics section of the document first, making sure that you 
specify the Source server field as the fully qualified name of the server that will 
act as the hub. In our scenario, this will be the AIX server noteserv/ibm.

5. In the Connection type field, select the type of network connection to be used 
(LAN, dial-up modem, Remote LAN service, or passthru server).

6. In the Routing and Replication section, select Replication only from the 
pull-down on the Tasks field, while keeping the Replication Type as Pull 
Push. (We want the hub to pull changes from the spokes and push changes to 
the spokes.)

7. (Optional) In the Replicate databases of Priority field, specify High, Medium 
& High, or Low & Medium & High. The default is Low & Medium & High.

8. (Optional) In the Files/Directories to Replicate field, you can specify to only 
replicate certain databases or directories of databases.

9. (Optional) Enter a time limit for the replication in the Replication Time Limit 
field.

10. The Scheduled Connection section of the document is where you specify 
when and how often replication should take place.
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11. When you have filled-in all the values, press Esc on your keyboard and 
answer Yes to save the document and return to your Workspace.

5.3.3  Required Authorizations in Server Document
The next step is for the spoke server to authorize the hub server to create replica 
databases. This is done by using the Create replica databases field in the spoke 
Server document.

To ease administration, it is recommended that a Lotus Notes Group be set up 
which lists all the resources allowed to create replicas on the server:

1. Double click on the Public Name and Address Book to open it. Choose the 
Group view from the Navigation panel on the left side and click on the Add 
Group button at the top of the view. When you have opened Group document, 
the screen, shown in Figure 115, will appear.

Figure 115.  Lotus Notes - New Group

Once the Group has been set up, we can update the Server document to 
authorize that Group to create replicas:

1. Select the Public Name and Address Book by clicking on it once. Select 
View -> Server Other... -> Server\Servers and click on OK to display a view 
of the servers.

2. Select the spoke server that will be replicated to, and click on the Edit Server 
button.

3. Click on > Restrictions. Your screen should now look like the one shown in 
Figure 116.
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Figure 116.  Updating Server Document for Replication Authorization

4. Tab down to the Create replica databases field, and type in the Lotus Notes 
Group name that you created for this use, or use the drop-down menu and 
select the Group from the Public Address Book.

5. Save the document and return to your workspace.

5.3.4  Creating the Replica on the Spoke Server
Replication only works when two servers have a database in common. For this 
reason, before scheduled replication can work, the hub server must create a 
replica of the database on the spoke.

If you wish to define replication settings for the database, such as specifying the 
documents or database features the replica can receive, then you must define 
those settings first. Refer to 5.4, “Selective Replication” on page 136 for details 
on what the settings are and how to define them.

Once the replication settings are in place, it is then possible to create the replica:
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1. Select the icon of the database that you want to replicate (by clicking on the 
icon once) and select File -> Replication -> New Replica... to display the 
New Replica <database_title> screen, as shown in Figure 117.

Figure 117.  Creating a New Replica of a Database

2. Type in the name of the spoke server (the server you want to replicate to) in 
the Server field, or select it, if available, from the pull-down menu.

3. Enter the title of the replica in the Title field and give the replica a name in the 
File name field. The name you specify in this field does not have to be the 
same as the name of the file on the source server. Lotus Notes recognizes 
replicas using the Replica ID. Refer to 5.4.2, “Database Replica IDs” on page 
141 for more information.

4. If you want to define the replication settings, click on Replication Settings.

5. If you want to encrypt the local copy of the database, click on the 
Encryption... key and specify how you want the database to be encrypted.

6. If you want the database to grow beyond the 1 GB default limit, click on the 
Size Limit... key and select a new value.

7. Select Immediately to create the replica on the destination server while also 
replicating the documents that the database holds. Or, if you want to create 
the replica now and wait for the normal replication process to replicate the 
documents, then select the Next scheduled replication radio button.

8. Select Copy Access Control List to copy the list from the source server to 
the destination server.

9. Click on OK.

10.Enter your password, if prompted, and click on OK.

The database will then be replicated to the spoke server where it can be added to 
the workspace by using File -> Database -> Open..., selecting the replica 
database, and then clicking on the Add Icon on the Open Database screen to 
add the icon to the workspace. Then click on Done.

If you get a message back saying that you are not authorized to update the 
server, restart the spoke server and then try creating the new replica again.
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If you have Stack Replica Icons selected from the View pull-down menu on the 
Notes Workspace and you open the replicated version that is on the hub server’s 
Workspace, Lotus Notes will stack that icon onto the local server icon. (This will 
only work if you click on the replicated version.)

Clicking on the downward arrow that’s present on the icon itself will enable you to 
select which version of the database you want to work with.

The prerequisites for replication are now in place:

1. Connection document on one of the servers

2. Authorization for creating replicas

3. Creating the new replica

The databases(s) can now be replicated according to the schedule in the 
Connection document. To replicate outside of this schedule or to force 
unscheduled replication, you can select File -> Replication -> Replicate....

5.4  Selective Replication

Selective replication formulas establish a set of criteria for a replicated document. 
For example, a replication formula can instruct the server to replicate only 
documents from a certain person, about a certain topic, or in a particular view or 
folder.

Database managers with authority to create replicas on other servers can 
centrally administer those replicas. (See 5.3.3, “Required Authorizations in 
Server Document” on page 133.)

It is important to remember that database managers of replicas on other servers 
can at any time bypass any replication settings that were defined centrally.

There are three steps that need to be completed for centralized replica 
administration. They are:

1. Select a destination/source server combination.

2. Specify the documents a replica can receive.

3. Select the database features that replicas can receive.

Each one of these three points is discussed here:

1. Select a destination/source server combination:

a. Right-click on the Database icon, and select Replication Settings.

b. On the Replication Setting screen, click on the Advanced icon. A dialog 
box similar to the one in Figure 118 will be displayed.

c. In the When computer field, enter the name of the server where the 
replica will be. If you can't find the server that you want from the pull-down 
for this field, click on the Computer icon on the far right-hand side of the 
field. From the Servers screen that appears, either type or select the name 
of the server you want. Click on OK to return to the Replication Settings 
dialog box.
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d. In the Receives from field, either select the source server from the 
pull-down, or click on the computer icon on the far right-hand side to either 
select or type the name of the server that you want.

Make sure that you have the source and destination servers specified in 
the correct order. The When computer server is the one which will receive 
the new replica and, perhaps, a subset of the information. The Receives 
from server is the one which stores the entire contents of the database, 
and it is also the server from which all other replicas of this database are 
administered.

Figure 118 shows the advanced settings for a new replica of a database 
that will be created on the destination server, noteserv/ibm and 
administered centrally from the source server, itsosmp/itso.

See step 2 on page 138 for information on how to Replicate a subset of 
documents and how to Select by formula.

See step 3 on page 139 for information on the Replicate incoming section 
of the dialog box.

Figure 118.  Advanced Settings for Replication

e. Select Fields to select the specific fields that the replica will receive. Click 
on the Define button to select whether you want to replicate All Fields or 
Custom. If Custom is selected, you can choose a subset of fields to 
replicate. See Figure 119 for an example of the list of fields you can choose 
to selectively replicate.
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Figure 119.  Replicate Selected Fields

Specify the documents that a replica can receive.

There are three main reasons why you may want to define only a subset of 
documents to be replicated:

  • To save disk space on destination servers

  • To save on time (and, therefore, cost) associated with replicating a 
database

  • To meet the requirement for making certain views and folders available at 
the destination server

2. To define a subset of documents, follow the steps below:

a. Right-click on the Database icon, and select Replication Settings....

b. On the Replication Settings screen, click on the Advanced icon and check 
Replicate a subset of documents.

c. If you want the destination server to receive only certain folders and/or 
views, then select the ones that apply from the list that is displayed. The 

If defining fields to replicate for the Public Name & Address book, you can 
select a third option - Minimal Address Book - which will send the smallest 
possible set of fields required to send Lotus Notes mail. This option is 
particularly useful for mobile Lotus Notes users.

Note
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specification for the subset of documents is only applicable to the 
destination/source server combination selected in the Replication Settings 
dialog box.

d. A replication formula is similar in concept to a view formula. You may use 
replication formulas to determine which documents a replica receives. 
Check Select by formula, having first checked Replicate a subset of 
documents.

You can then enter the formula that defines the subset of documents in the 
formula window (see Figure 120).

Note: The specification for the subset of documents is only applicable to 
the destination/source server combination selected in the Replication 
Settings dialog box.

Figure 120.  Selecting a Subset of Documents by Formula

The formula shown in the formula window of Figure 120 will only allow 
documents with the string "Red Book" in the Subject field of the database 
to be replicated.

You cannot use @DbLookup, @UserName, @Environment, or @Now in a 
replication formula.

Using @IsResponseDoc in a replication formula causes all response 
documents in a database to replicate, not just those that meet the selection 
criteria. To avoid this, use @AllChildren or @AllDescendants instead.

3. Select the database features that replicas can receive.

It is possible to tailor the following replication features:

a. Deselect Forms, views, etc. to prevent database design changes being 
sent to the replica.

b. Deselect Agents to prevent a database replica receiving agents.
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c. Select Replication formula to allow a replica to receive the selected 
replication settings.

Note: Steps a, b and c above are only relevant when the source server has 
Manager or Designer access to the replica as specified in the ACL of the 
replica database.

d. Deselect Access control list (ACL) to prevent a replica from receiving 
changes made to the ACL. This is only relevant if the source server has 
Manager access to the replica.

e. Select Deletions to allow a replica to act on deleted documents.

Documents will not be deleted from the replica database if:

1) Do not send deletions made in this replica to other replicas is 
checked in the Send panel of the Replication Settings dialog box 
(Figure 121) for the source server, or

Figure 121.  Replications Settings - Dialog Box

2) Deletions is not checked in the Advanced panel of the Replication 
Settings dialog box.

As a default, a replica will inherit all the database features with the exception of 
the replication formula.

 The features that you specify are only applicable to the destination/source 
server combination selected in the Replication Settings dialog box.

Note
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5.4.1  Features That Will Not Replicate
The following values must be tailored at the destination server and cannot be 
defined centrally:

  • Remove documents not modified in the last <number> of days.
  • Receive summary and 40 KB of Rich Text only.
  • Do not send deletions made in this replica to other replicas.
  • Do not send changes in database title and catalog information to other 

replicas.
  • Do not send changes in local security property to other replicas.
  • Temporarily disable replication.
  • Only replicate documents saved or modified after <date>.
  • CD-ROM publishing date.

5.4.2  Database Replica IDs
All replicas of a database have the same Replica ID. This ID distinguishes a copy 
from a replica. When Lotus Notes replicates, it checks for common databases 
using this Replica ID.

To check a Replica ID, click once on the icon for the database on the Workspace, 
select File -> Database -> Properties..., and then click on the Information tab 
(second tab) to display the Replica ID for the database (Figure 122).

Figure 122.  Replica ID

5.4.3  Access Control Lists and Replication
The determining factor on exactly what changes a replica receives is the Access 
Control Level given to the source server on the server where the replica database 
exists.

Everything is now in place for the central administration of the replica.

Note
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For example, the replica can only receive changes made to the design and 
formulas of the database if the source server has at least Designer access to the 
database.

Table 10 illustrates what is replicated according to the Access Level of the source 
server to the database replica.

Table 10.  Changes That Will Replicate 

Access Level Access Control
List (ACL)

Design &
Formula

Edited
Documents

New
Documents

Manager Yes Yes Yes Yes

Designer No Yes Yes Yes

Editor No No Yes Yes

Reader No No No No

Depositor No No No No

No Access No No No No
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Chapter 6.  Configuring Lotus Domino Servers on AIX

This chapter covers some Lotus Notes features related to the AIX system, for 
example, Lotus Domino Server startup and shut down and code distribution 
under Network File System (NFS). 

Several examples are presented throughout this chapter.

The following Lotus Domino Server configuration will be used for the examples:

  • The Lotus Domino software is installed in the file system /usr/domino.
  • The server is running as the AIX user notes and AIX group notes.
  • The notes user home directory is in another file system mounted on /server1. 

All the server data files will be in the directory $HOME/notesr4.

All the code and examples in this chapter were made assuming this configuration, 
and you will need to customize them to work properly in your environment. To do 
so, you will be required to know about administering AIX systems and Korn Shell 
scripts.

6.1  Lotus Domino Server Startup

This section covers the following topics:

  • How to start up the Lotus Domino Server manually from an AIX command line.
  • How to startup the Lotus Domino Server using a startup script.
  • How to start up the Lotus Domino Server on an AIX machine automatically at 

bootup.

6.1.1  Lotus Domino Server Startup from AIX Command Line
These are the steps to start up the Lotus Domino Server on an AIX machine and 
get a server console:

1. Log in as the notes user.

2. Type the command: server

3. You may need to type the Lotus Domino Server password.

This procedure will give you the server console on a screen or window. If you kill 
this screen, the server crashes; it won't respond to any requests. To recover from 
this situation, you have to kill all the servers and all their child processes and 
remove the corrupted shared memories and semaphores they created. Section 
15.3, “Cleaning Lotus Domino Processes” on page 418 contains an explanation 

The /usr/domino and the /server1 directories are mount points for two 
different file systems. The first one will be used for the Lotus software in 
general, and the second one is the home directory for the notes user. 

Note

If your notes.ini file is in your path, you don't need to type the Lotus Notes 
data directory. In our configuration, this directory is /server1/notesr4.

Note
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about killing these processes and removing corrupted shared memories and 
semaphores and contains a script to do it.

To run the server in the background, use the following command:

Figure 123.  Running the Lotus Domino Server in Background

The server output will be directed to the file nohup.out. You will have to type your 
Lotus Domino Server password. If your server doesn’t need a password, press 
Enter. If you wish to see the server output, you need to look into the nohup.out 
file. You can send commands to this server through the server remote console 
(see 6.2.2, “Shutting Down Lotus Domino Server on Remote Console” on page 
150).

The recommended way to start up a server is the startup script shown next.

6.1.2  Starting the Lotus Domino Server using a Startup Script
In case you wish to start the Lotus Domino Server in the background using a shell 
script, we give below the following two shell scripts to be executed for fully 
accomplishing the task.

6.1.2.1  Defining the Environment
This script defines essential parameters for use by the other scripts.

#!/bin/ksh
# Domino Application Server Environment Variable Script
# Licensed Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - env_domino
#
#      This script makes variable definitions that are common to 
#      the start_domino, stop_domino scripts
########################################################################
 
# This script is provided "As Is".
 
# Script Environment variables.

NOTES_USER=notes# AIX userid for this server
NOTES_PATH=/server1/notesr4# Path for server data directory
NOTES_SERVER=noteserv# Name of Domino Server
OUTPUT_LOG=/tmp/$NOTES_SERVER.log# Output file for server console
INPUT_FILE=$NOTES_PATH/$NOTES_USER.input# Input file for server console
PATH=$NOTES_PATH:/opt/lotus/bin:$HOME/bin:$PATH# Ensure PATH is set for scripts

6.1.2.2  Starting the Server
This script starts the server in the background, redirecting the console to 
$OUTPUT_LOG, and reading commands from $INPUTFILE. 

#!/bin/ksh -x
# Domino Server Start Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.

$ nohup /opt/lotus/bin/server <notes_data_directory> <<EOF &
> <Server_Password>
> EOF
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########################################################################
# Description - start_domino
#
# This is a server startup script to start the Domino Server in background      
# that gets command input from a file and pipes the output to another which
# can be monitored by administrators.
#
# The INPUT file allows any command to be issued to the Domino Server so
# this file should be treated accordingly ...hidden with the appropriate
# permissions to prevent unauthorized access to the server
########################################################################
 
# This script is provided "As Is".
 
# Set Script Environment variables.

. env_domino

# Script Logic

if ((‘id -u‘ == 0))
then
   print "Run the Domino Server as the $NOTES_USER user "
   exit
fi

#
# if you are using /etc/hosts for tcpip name resolution rather than a name 
# server or NIS, then uncomment the following line:     
#export NSORDER=bind,local,nis
# 

if [ ! -x /opt/lotus/bin/server ] ; then
     echo "Cannot access server command - exiting"
     exit 1
fi

if [ ! -d $NOTES_PATH ] ; then
     echo "Cannot access notes data directory - exiting"
     exit 1
fi

NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
if [[ -n $NOTES_RUNNING ]] ; then
     echo "Domino Server is already running - exiting"
     exit 1
fi

cd $NOTES_PATH
#
# Clean up if the Domino Server terminated abnormally earlier
#

rm -f ~notes.lck
mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print $2 }’ | awk ’{ 
print $1 }’‘ 
sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done

export Notes_SHARED_DPOOLSIZE=40000000
#
# For servers using Notes passwords,
# replace the previous line with the following two lines.
#
cat .secure_hidden_passwd > $INPUT_FILE
echo "show server" >> $INPUT_FILE

cp -p  $OUTPUT_LOG $OUTPUT_LOG.‘date +"%m%d%y_%H%M"‘
#cp -p  $OUTPUT_LOG $OUTPUT_LOG.backup
print "Starting Domino for AIX ($NOTES_SERVER)"
/opt/lotus/bin/server < $INPUT_FILE > $OUTPUT_LOG 2>&1 &
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6.1.3  Starting the Lotus Domino Server Automatically
To start up the Lotus Domino Server automatically after a reboot, you have to 
create an entry in the /etc/inittab file and a script to start up the server. In our 
example, the script is called start_domino, which is described in 6.1.2.2, “Starting 
the Server” on page 144. It will be in the directory /server1/bin. The output of the 
server will moved into /tmp directory.

Use the following procedure to implement our example: 

1. Log in as the notes user, and do the following:

  • Create a directory called bin

$ mkdir -m 700 /server1/bin

  • Move the file start_domino in the directory /server1/bin.

$ mv start_domino /server1/bin

2. Log in as root to do the following:

  • Create an entry in the /etc/inittab file for the Lotus Notes startup script

# /usr/sbin/mkitab "notes:2:once:/bin/su - notes -c 
/server1/bin/start_domino
# Domino Server Startup"

This is a one line command.

In the next boot, the Lotus Domino Server will be started up automatically. If you 
want to start up the server without rebooting the machine, as the notes user type:

$ nohup /server1/bin/start_domino &

This a simple example. You can change this sample program to customize your 
logs and directories.

6.1.4  Using the AIX alog Facility
The alog facility of AIX can be used to maintain the server log messages. The 
alog command creates and maintains fixed-sized, circular log files. It makes it 
easier to maintain the size of the log file.

If you want to remove this entry from /etc/inittab, use the command 
below. This is a one line command.

# /usr/sbin/rmitab "notes:2:once:/bin/su - notes -c 
/server1/bin/start_domino
# Domino Server Startup"

Note
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To use the alog command, you must:

  • Create a log file definition in the Software Service Aids Attributes Object Class 
(SWservAt) of the host's Object Data Manager (ODM).

  • Modify the startup script to use the alog command.

The script configure.alog (Figure 124 on page 148) creates a log file definition 
(file name /server1/log/server.alog, file size 512 KB) and creates the inittab entry 
to start up the server.

It first tries to remove the old definitions, if there are any, with the odmdelete 
command. Then, it creates the log file ODM definition. The log name is notes, the 
file name is /server1/log/server.alog, and the file size is 512 KB.

After that, it removes any inittab entry that begins with Notes (take care to not 
destroy your inittab) and creates the inittab to call the script 
/server1/bin/startup.alog.

To use the alog facility, you need to have at least AIX 4.1.5, and the 
bos.rte.serv_aid fileset must be installed in the system. Without this, the alog 
facility won't work properly with Lotus Notes. You can use the command:

lslpp -l | grep bos.rte.serv_aid

to check if the fileset is installed in your system.

You also can run the following test to ensure that your alog version will work 
properly with Lotus Notes:

1. Run the command:

alog -f /tmp/test.log

2. Type some words and press Enter. The alog command echoes your input.

3. Suspend the alog command by pressing Ctrl-Z (stop signal).

4. Run the command:

alog -f /tmp/test.log -o

5. If it shows what you've typed, it is working. If it shows only what you've 
typed when you finish the previous alog command (you have to put it in the 
foreground again and press Ctrl-D), it won't work with Lotus Notes. The 
reason for this is that it outputs the messages to the log file only when its 
standard input is finished.

Note
Configuring Lotus Domino Servers on AIX 147



Figure 124.  Script to Configure Automatic Start Up (configure.alog)

The new script, startup.alog, is shown in Figure 125 on page 149. The difference 
is that this script redirects the standard output to the alog command instead of to 
the log file. Note that the server messages will appear in the host console. If you 
don’t want this, redirect the alog standard output to /dev/null. You need to put the 
password of the user notes in the file named ~/bin/.notes.

#!/bin/ksh
#@(#) Configures Automatic Notes Startup.
# Script startup must be in ~notes/bin/startup

if [[ ‘/bin/id -u‘ != 0 ]]
then
  echo "Error: you must be root..." >&2
  exit 1
fi

LHOME=~notes
LOG=$LHOME/log/server.alog
SIZE=524288

# Deletes previous old odm for the log notes...
echo "Deleting previous ODM entries..."
/bin/odmdelete -o SWservAt -q ’attribute=alog_type AND deflt=notes’
/bin/odmdelete -o SWservAt -q attribute=notes_logname
/bin/odmdelete -o SWservAt -q attribute=notes_logsize
/bin/odmdelete -o SWservAt -q attribute=notes_logverb

# Define in ODM an alog for Domino Server with size 512K
echo "Defining new ODM entries..."
/bin/cat <<EOF | /bin/odmadd
SWservAt:
    attribute="alog_type"
    deflt="notes"
    value="notes"
SWservAt:
    attribute="notes_logname"
    deflt="$LOG"
    value="$LOG"
SWservAt:
    attribute="notes_logsize"
    deflt="$SIZE"
    value="$SIZE"
SWservAt:
    attribute="notes_logverb"
    deflt="1"
    value="1"
EOF

# Delete old inittab entries...
ENTRY=‘/bin/awk -F: ’$1 == "notes" {print}’ /etc/inittab‘
if [[ -n $ENTRY ]]
then
  echo Removing inittab entry: $ENTRY
  /usr/sbin/rmitab "$ENTRY"
fi

# Create the new one...
echo Creating inittab entry...
/usr/sbin/mkitab "notes:2:once:/bin/su - notes -c $LHOME/bin/startup.alog \
# Domino Server Startup"
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Figure 125.  Script to Start Up a Lotus Domino Server (startup.alog)

To view the log contents, use the command:

$ alog -tnotes -o

You also can use smit, run: smit alog_show, type: notes in the Alog TYPE field and 
press Enter (Figure 126). Press Enter again, and you’ll have the log file.

Figure 126.  Show an Alog File

To change the file name, or the log size, run: smit alog_change. Then type notes in 
the Alog TYPE field and press Enter (Figure 127 on page 150). To change the file 
name, type the new one in the Alog File NAME field. To change the file size, type 
the new one in the Alog File SIZE field. Note that if you change the file size, the 
prior log messages will be erased.

#!/bin/ksh
#@(#) Starts up Lotus Domino Server...
#
. /etc/environment | /bin/alog -tnotes > /dev/console

NOTESPATH=/opt/lotus/bin
export PATH=$NOTESPATH:~/notesr4:$PATH
export LANG=C

echo "----------------------> ‘date‘ <----------------------" | \
   /bin/alog -tnotes > /dev/console
$NOTESPATH/server < ~/bin/.notes 2>&1 | \
   /bin/alog -tnotes > /dev/console &

 Show an Alog File

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Alog TYPE                                           notes
  Alog File NAME                                     [/server1/log/server.alog]  /

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 127.  Change / Show Characteristics of an Alog File

6.2  Lotus Domino Server Shut Down

This section covers the following topics:

  • How to shut down the Lotus Domino Server on server console.
  • How to shut down the Lotus Domino Server on remote console.
  • How to shut down the Lotus Domino Server using AIX commands.
  • How to shutdown the Lotus Domino Server using a shell script.

6.2.1  Shutting Down Lotus Domino Server on Server Console
If you have the Lotus Domino Server console on a screen, just type the 
command exit or quit. It may take 10 seconds or more for the server to shut 
down.

6.2.2  Shutting Down Lotus Domino Server on Remote Console
Another way to shut down the server is to use the remote console from the 
Lotus Notes administrator workspace. Start the administrator workspace and:

1. Choose File -> Tools -> Server Administration... from the Lotus Notes 
Workspace screen to get the Server Administration screen (Figure 128 on 
page 151).

 Change / Show Characteristics of an Alog File

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Alog TYPE                                           notes
  Alog File NAME                                     [/server1/log/server.alog]  /
  Alog File SIZE                                     [524288]                  #
  VERBOSITY                                          [1]                       #

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 128.  Lotus Notes - Administration

2. Choose the server you want to shut down and click on the Console button.
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Figure 129.  Remote Server Console

3. On the Remote Server Console screen (Figure 129), you can change the 
server you want to shut down. Enter the command quit or exit in the Server 
Console command box.

4. Click on the Send button.

5. Enter the Lotus Notes administrator password, if asked.

6. The system warns you that you won’t be able to restart the server from the 
remote console. If you want to shut down the server, click on the Yes button.

7. The Server response box will show the following message when the server no 
longer responds:

Figure 130.  Server Response

8. Click on the Done button.

COMMAND SENT: quit
Remote system no longer responding
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6.2.3  Shutting Down Lotus Domino Server Using AIX Command
On the operating system level, log into the server as user notes, then you can use 
the command, server -q to shut down the Lotus Domino Server (assuming the 
directory containing the installation binaries, /opt/lotus/bin, is already in your 
PATH statement).

6.2.4  Shutting Down Lotus Domino Server Using Shell Script
In case you wish to stop the Lotus Domino Server using a shell script, we give 
below the following two shell scripts to be executed for fully accomplishing the 
task.

6.2.4.1  Defining the Environment
This script defines essential parameters for use by the other scripts.

#!/bin/ksh
# Domino Application Server Environment Variable Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - env_domino
#
#      This script makes variable definitions that are common to 
#      the start_domino, stop_domino scripts
########################################################################
 
# This script is provided "As Is".
 
# Script Environment variables.

NOTES_USER=notes# AIX userid for this server
NOTES_PATH=/server1/notesr4# Path for server data directory
NOTES_SERVER=noteserv# Name of Domino Server
OUTPUT_LOG=/tmp/$NOTES_SERVER.log# Output file for server console
INPUT_FILE=$NOTES_PATH/$NOTES_USER.input# Input file for server console
PATH=$NOTES_PATH:/opt/lotus/bin:$HOME/bin:$PATH# Ensure PATH is set for scripts

6.2.4.2  Stopping the Server
This script is used to stop a running server properly. If the server does not 
respond anymore, the script kills the server processes and cleans up system 
resources.

You can use the remote console to send other commands to a server. Refer to 
Appendix B in the Lotus Notes Administrator’s Guide for additional information 
on server commands.

Note

If the server is not responding, you have to kill (with -9 signal) all the servers 
and theur child processes. You also have to clean the shared memory and 
semaphores used by the notes user. The script in 15.3, “Cleaning Lotus 
Domino Processes” on page 418, describes how to kill notes processes and 
clean shared memory and semaphores.

Note
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#!/bin/ksh -x
# Domino Server Stop Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - 
#
# This is the script to STOP the Domino Server which has been started using
# the corresponding script (start_domino).
# The script attempts to QUIT the server gracefully and waits 2 minutes.
#
# If Domino Server has not shut down by then, the plug is yanked.
# Depending on your environment, you may want to change this time-out period.
########################################################################
 
# This script is provided "As Is".
 
# Set Script Environment variables.

. env_domino

# Script Logic

print "Stopping Domino for AIX ($NOTES_SERVER)"
print " ... waiting for shutdown to complete"
echo " quit " >> $INPUT_FILE
#
#
#
count=0
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
while [[ -n $NOTES_RUNNING ]] ; do
sleep 10
count=‘expr $count + 1‘
echo " ... waiting "$count"0 seconds"
#
# Terminate Domino Server if still running
#
if [ $count -eq 13 ] ; then
   echo "Domino Server is still running after 2 minutes"
   echo " ... now for the ungraceful method"
   for i in ‘ps -fu $NOTES_USER | grep lotus | grep -v grep | awk ’{ print $2 }’‘; do
     kill -9 $i
   done
   mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
   sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
   for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
   for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done
   echo "Domino Server ($NOTES_SERVER) TERMINATED"
   exit
fi
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
done
#
echo "Domino for AIX ($NOTES_SERVER) shutdown completed"

6.3  Lotus Domino and NFS

This section covers how to use the Network File System (NFS) to share the Lotus 
Notes installation kit files (the Lotus Notes CD-ROM), share the Notes 
workstation software files, and distribute the client’s Notes data directories.

Using remote directories for the Lotus Notes servers is not recommended. With 
NFS, you may have performance problems due to the use of the network. Beyond 
the performance problems, you have an availability problem. When the NFS 
server goes down, the Lotus Domino Server stops working until the NFS server 
becomes available again.
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For the clients, there are the same problems, but there are some advantages:

  • When sharing the Notes workstation software files, you reduce the disk space 
usage on the clients.

  • When sharing the Lotus Notes installation kit files, you don't need to have a 
CD-ROM physically installed on each host. This is also useful for installing 
servers, because these files are used only in the installation of the Notes 
workstation software files.

  • When distributing the client's Lotus Notes data directories, you have an easier 
way to back up the client's files and save some client's disk space. But most 
importantly, if you use a distributed environment, with the machines sharing 
the same users, this is the easiest way to make a Lotus Notes client available 
to the whole environment.

6.3.1  Combined Lotus Domino Server and Note Client Hosts
In Figure 131 on page 156, you can see a diagram of a UNIX host used as both a 
Lotus Domino Server and a Lotus Notes client. It follows the server conventions 
from the beginning of this chapter.

To use NFS, the bos.net.nfs.server fileset must be installed on the host that will 
export its file systems, and the bos.net.nfs.client fileset must be installed on the 
machine that will mount servers' file systems. It's a good idea to install both of 
them.

Run the command:

lslpp -l bos.net.nfs.server

to see if the server fileset is installed, and run the command:

lslpp -l bos.net.nfs.client

to check the client fileset.

Install both filesets if they aren't installed. 

To use NFS correctly, you need a way to resolve all the host names and 
addresses. This can be achieved by using the Domain Name Server (DNS), by 
using Network Information System (NIS), or by using a consistent /etc/hosts file 
in all hosts.

Note
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Figure 131.  Lotus Domino Server Unix Host

The principal components of the figure are:

UNIX Lotus Domino Server and Workstation Software
Located in the file system /usr/domino, it is used to run the server and all 
the clients that can exist in this host.

Server’s Home Directory
In our example, it is on the file system /server1. It contains the server’s 
Notes data directory (/server1/notesr4), the user profile, the scripts 
directory, and so on.

Server’s Notes Data Directory
Located in the directory /server1/notesr4, it contains the server.id, 
user.id, notes.ini, Lotus Notes databases, templates, mail files, and so 
on.

Jose’s Home Directory
This is the directory for the AIX user jose. It is located in the directory 
/home/jose.

Jose’s Notes Data Directory
Located in the directory /home/jose/notesr4, it contains all the notes files 
for Jose’s Notes client.

Mary’s Directories
The AIX user mary, like the AIX user jose, has her own home directory, 
Mary’s home directory (/home/mary), and her own Lotus Notes data 
directory (/home/mary/notesr4).

In Figure 132 on page 157, you can see a diagram of a UNIX host used as a 
Lotus Notes client. This host has only the Notes workstation software installed 
locally. You don’t need to install the Lotus Domino Server software in this host. 
The client’s directories are such that they are in the UNIX server host. This host 
will access its Lotus Notes server using a network protocol (TCP/IP or SPX).

Unix 
Workstation Software

/usr/domino

Server’s Home Directory
/server1

Server’s Notes
Data Directory
/server1/notesr4

Jose’s
Data Directory

/home/jose/notesr4

Jose’s
Home Directory

/home/jose

Mary’s
Home Directory

/home/mary

Mary’s
Data Directory

/home/mary/notesr4

Lotus Domino Server &
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Figure 132.  Lotus Notes Client UNIX Host

We can say that the installation process of the Lotus Notes software has two 
major steps:

1. Creating the UNIX Lotus Notes software from the distribution CD-ROM. At the 
end of this step, you have the /opt/lotus/bin file system. This step has to be 
done only once for each host, and after that, you won’t need the CD-ROM.

2. Creating the Lotus Notes data directory. This is done when you run the notes 
command for the first time. At the end of this step, you have the users’ notesr4 
directory. This is the Lotus Notes setup procedure that has to be done at least 
once for each server and each client. After that, you use both the /opt/lotus/bin 
and the notesr4 directories to run the Lotus Domino Server or client 
workstations.

Now you have different choices on how to distribute over the network:

  • The Installation Kit to install other clients or server hosts. The target hosts 
need to access this kit once for the first step of the installation.

  • The UNIX Lotus Notes software to client hosts. These hosts will have to 
access the file server whenever its users run the Notes workstation. With 
these clients, you won't need to perform the first step of the installation.

  • The users' Notes data directories. You can make the user's Notes workstation 
available over the network.

6.3.2  Distributing the UNIX Installation Kit
When you want to install the Lotus Domino Server and workstation software on a 
Lotus Domino Server host, or the Notes workstation software on a client host (the 
first major step of the installation), you need the UNIX Installation Kit available on 
a file server on the network.

Workstation Software
Unix Notes

/usr/domino/lotus

Home Directory
/home/michael

Michael’s

Michael’s Notes
Data Directory

/home/michael/notesr4

Ruby’s
Home Directory

/home/ruby

Ruby’s Notes
Data Directory

/home/ruby/notesr4
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The Lotus Notes installation program can run on the file server to install multiple 
remote hosts, or you can mount the Installation Kit directory from the file server 
host on the host you want to install.

Figure 133.  Distributing the Lotus Notes AIX Installation Kit

The file server may have the Installation Kit on CD-ROM or copied to a file 
system on its hard disk. If the Installation Kit is on a hard disk, the installation 
process will be faster, and you will have your CD-ROM unit available for other 
purposes.

In Figure 133, there is a file server with the Installation Kit exported and other 
hosts that mount it.

6.3.2.1  Copying the UNIX Installation Kit
If you decided to use a file system, you first have to copy the Lotus Notes 
CD-ROM to the hard disk. To copy it, log in as root, and do the following:

1. The Lotus Notes Release 4.6 CD-ROM has about 390 MB of data. Create the 
/notescd file system using smitty crjfs; then select the volume group you 
want, and the menu on Figure 134 will be shown. Enter the information in bold.

File Server

AIX Installation
Kit Directory
/cdrom or
/notescd

Notes Server Host    Notes Client Host

In our example, the CD-ROM is mounted over the /cdrom directory. The 
/notescd contains a copy of the CD-ROM on the hard disk. You can choose one 
of them to export.

You can choose names other than /cdrom or /notescd for these directories. 
Just change them to your directories by using the commands in the following 
sections.

Note
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Figure 134.  Add a Journaled File System

2. Mount the new file system: mount /notescd.

3. Remove the setgid bit from the /notescd permissions: chmod g-s /notescd.

4. Mount the CD-ROM: mount -r -v cdrfs /dev/cd0 /cdrom. The /cdrom directory 
must exist before you issue this command. You can be using a CD-ROM 
device other than /dev/cd0.

5. Run the commands below to copy the CD-ROM:

# cd /cdrom
# tar cvf - . | ( cd /notescd ; tar xvf - )

Or run the Lotus Notes for UNIX Distribution Copy utility:

# /cdrom/unix/copydist /notescd

It is recommended that you use the utility, which copies the files and checks 
them.

6.3.2.2  Exporting UNIX Installation Kit
To make the Installation Kit directory available to NFS mounts, be sure to have 
the NFS filesets installed in your machine, log in as root and:

1. If you never used NFS in this host, run the command /usr/sbin/mknfs -B. This 
starts NFS.

2. Run smitty mknfsexp and complete the fields as shown in Figure 135, or use 
the command:

# /usr/sbin/mknfsexp -d /notescd -t ro -B

Change the /notescd directory to /cdrom if you want to export the CD-ROM.

                          Add a Journaled File System

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Volume group name                                   rootvg
* SIZE of file system (in 512-byte blocks)           [780000]                  #
* MOUNT POINT                                        [/notescd]
  Mount AUTOMATICALLY at system restart?              yes                     +
  PERMISSIONS                                         read/write              +
  Mount OPTIONS                                      []                       +
  Start Disk Accounting?                              no                      +
  Fragment Size (bytes)                               4096                    +
  Number of bytes per inode                           4096                    +
  Compression algorithm                               no                      +

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 135.  Add a Directory to Exports List

6.3.2.3  Mounting the UNIX Installation Kit
Now, you can mount the Installation Kit directory on the hosts you want to install. 
For example, suppose that the file server host is called filserv, and the machine 
you want to install is called ah1610d. You have to log in as root on ah1610d and 
mount the Installation Kit directory from filserv. Perform the command:

# mount filserv:/notescd /mnt

to temporarily mount the Installation Kit over /mnt. Of course, you can choose 
another directory as the mount point, and you have to change /notescd to /cdrom 
if you have exported the CD-ROM directory.

After that, type in the command: cd /mnt/unix and continue with your normal 
installation procedure. See Chapter 2, “Installing a Lotus Domino Server” on page 
23, for the server installation, and Chapter 3, “Installing a Notes Workstation” on 
page 75, for the client installation.

6.3.3  Distributing the Lotus Notes Software Directory
In the example on Figure 136 on page 161, Michael’s and Ruby’s workstations 
don't have the /opt/lotus/bin file system installed. Instead of doing the first step of 
the Lotus Notes installation, you can mount a file system from a remote server 
that has the Notes Workstation installed on it. In our example, this file system will 
be called /noteswrk. In the file server, you have to install the Notes Workstation 
software to serve as a network resource.

                        Add a Directory to Exports List

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* PATHNAME of directory to export                    [/notescd]                /
* MODE to export directory                            read-only               +
  HOSTS & NETGROUPS allowed client access            []
  Anonymous UID                                      [-2]
  HOSTS allowed root access                          []
  HOSTNAME list. If exported read-mostly             []
  Use SECURE option?                                  no                      +
* EXPORT directory now, system restart or both        both                    +
  PATHNAME of alternate Exports file                 []

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 136.  Distributing the Lotus Software Directory

For example, suppose that the File Server in Figure 136 is called filserv, 
Michael’s workstation ah1610d, and Ruby’s workstation ah1610c. Both ah1610c 
and ah1610d mount filserv’s file system, /noteswrk, over its local /opt/lotus.

To implement this example, you must:

1. Install the client workstation to serve as a network resource on /noteswrk on 
filserv.

2. Export /noteswrk.

3. Mount /noteswrk on ah1610c and ah1610d.

4. Create a link for the VIM applications on mars and earth.

The file server doesn't need to be the Lotus Domino Server or run any Lotus 
Notes applications. For performance reasons, it is recommended that you use 
different servers, one host to be the Lotus Domino Server, another to be the file 
server. But you can use a host as file server and Lotus Domino Server. In this 
case, the configuration would be like that shown in Figure 137 on page 162. Note 
that the server local clients use the /opt/lotus/bin file system to run the 
workstations.

File Server (filserv)

Unix Notes Workstation
Software

for Exporting
/noteswork

Michael’s
Home Directory

Michael’s Notes
Data Directory

Ruby’s
Home Directory

Ruby’s Notes
Data Directory

Michael’s Workstation (ah1610d) Ruby’s Workstation (ah1610c)
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Figure 137.  Distributing the Lotus Domino Software Directory from a Server

6.3.3.1  Installing the Notes Workstation Software
Before installing the Notes Workstation software, it’s recommended that you 
create a new file system to hold this software. With Lotus Notes Release 4.6, 
installing Notes Workstation for AIX code without the documentation requires 
approximately 160 MB of disk space.

To create a file system called /noteswrk:

1. Run smit crjfs

2. Select the Volume Group you want to create the file system and press Enter.

File Server/Notes Server (filserv)

AIX Lotus Notes Software
usr/domino/lotus

Jose’s
Home and Data

Directories

Servers
Home and

Data
Directories

Mary’s
Home and Data

Directories

AIX Notes Workstation Software
for Exporting /noteswrk

Michael’s
Home Directory

Michael’s Notes
Data Directory

Ruby’s
Home Directory

Ruby’s Notes
Data Directory

Michael’s Workstation (ah1610d) Ruby’s Workstation (ah1610c)

1. Run all commands below as root on the file server.

2. If you want to reinstall the Notes Workstation Software on a previous file 
system, remove all its files and perform the installation.

Note
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3. Complete the Add a Journaled File System menu, as shown in Figure 138, 
and press Enter.

Figure 138.  Add a Journaled File System

4. Mount the file system: mount /noteswrk

5. Run the command: chmod g-s /noteswrk

Now, you must install the Notes Workstation software on this file system. Mount 
the Lotus Notes UNIX Installation Kit from the network (as described in 6.3.2.3, 
“Mounting the UNIX Installation Kit” on page 160) or from the CD-ROM (as 
described in step 4 on page 159).

Now, you have to run the Lotus installation script:

1. Change the directory to where you mounted the Installation Kit. If the install 
script is present on this directory, run it with the command ./install or change 
to the directory UNIX, and run the install script.

2. Press Tab to display the second screen.

3. Press the Spacebar to select the installation of the Notes Workstation 
software. Press Tab again to display the next screen.

4. Now you have to press the Spacebar to select to install the software on a 
network resource. Press Tab to display the next screen.

5. The script explains that you have to select the hardware platforms you want to 
use. Press Tab to begin the selection.

Note: By default, all platforms are selected (a Yes is displayed). To select No, 
you have to press the Spacebar.

6. It asks for IBM AIX; press Tab to confirm this selection.

7. It asks for Sun Solaris/Sparc; press the Spacebar to deselect it and press Tab 
to display the next selection.

8. Finally, it asks for Hewlett-Packard HP-UX; press the Spacebar to deselect it 
and press Tab to display the next screen.

                          Add a Journaled File System

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Volume group name                                   rootvg
* SIZE of file system (in 512-byte blocks)           [320000]                 
* MOUNT POINT                                        [/noteswrk]
  Mount AUTOMATICALLY at system restart?              yes                     
  PERMISSIONS                                         read/write              
  Mount OPTIONS                                      []                       
  Start Disk Accounting?                              no                      
  Fragment Size (bytes)                               4096                    
  Number of bytes per inode                           4096                    
  Compression algorithm                               no                      

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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9. Press Tab to accept that you want to install to only one computer. The next 
screen will be displayed.

10. Press Tab to accept the current destination hostname and to display the next 
screen.

11. Now, you have to change the destination path to your new file system. Press 
Enter, type /noteswrk, and press Enter again to install to the file system you 
have created. Then, the script sets a new destination path to /noteswrk/lotus. 
Press Tab to display the next screen.

12.I f you don’t want to install the optional documentation, press the Spacebar. 
Press Tab to display the next screen.

13. Change the installation owner user ID to the user bin. Press Enter, then type 
bin. Press Enter again, and press Tab to display the next screen.

14. Change the installation owner group ID to the group bin. Press Enter, then 
type bin. Press Enter again and press Tab to display the next screen.

15. Press Tab again, and you will see a configuration summary similar to the one 
shown in Figure 139. Make sure that you selected the correct destination path, 
platforms, user ID, and group ID.

Figure 139.  Installation Script Configuration Summary

16. Pressing Tab again validates the configuration settings.

17. If everything is correct, press Tab to begin the installation. If it is not, correct 
the errors display and you must redo the configuration.

Steps 13 and 14 are very important. You have to change the user ID and the 
group ID to a user ID and a group ID that is the same on all machines where 
you will mount the /noteswrk file system. If you don’t, when mounting over 
NFS, a normal user on the client host that has the same user ID number as 
the user you selected on the file server will have owner access to these 
files. The same applies to the group ID. For example, if on the server the 
user notes (ID 201) owns the files under /noteswrk, and on a client host 
there is a normal local user called john with ID 201, the user john will own 
these files on the client host and will be able to change them.

Note

Begin Installation - Tue Aug 11 12:11:28 CST 1998

Configuration Summary...

Install to single host: filserv.itsc.austin.ibm.com
Destination path:                  /noteswrk/lotus

Installation type:                 Network Fileserver
Platforms specified:               IBM AIX
                                   Sun Solaris/Sparc

Product options selected:          Workstation
Installation owner user Id:        bin
Installation owner group Id:       bin
164 Lotus Domino Release 4.6 on IBM RS/6000



18.It installs the software that you selected and finishes.

6.3.3.2  Exporting the Notes Workstation File System
After you create the /noteswrk directory, you have to export it so that the clients 
will be able to use it. To run the following commands, you need to have root 
access to the file server (filserv).

To export the /noteswrk directory, run: smitty mknfsexp. The smit menu shown in 
Figure 140 is displayed. You have to specify the PATHNAME of the directory to 
export and HOSTS & NETGROUPS allowed client access fields. You can also 
run the command:

# /usr/sbin/mknfsexp -d /noteswrk -t rw -c ’ah1610c ah1610d’ -B

Figure 140.  Add a Directory to Exports List

6.3.3.3  Configuring the Lotus Notes Client Host
On the clients ah1610c and ah1610d, you can mount filserv’s /noteswrk/lotus 
directly over /opt/lotus directory. Run, as root: smitty mknfsmnt to display the 
following menu, shown in Figure 141 on page 166, and complete the fields that 
are highlighted.

 Add a Directory to Exports List

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* PATHNAME of directory to export                    [/noteswrk]              /
* MODE to export directory                            read-write              +
  HOSTS & NETGROUPS allowed client access            [ah1610c ah1610d]
  Anonymous UID                                      [-2]
  HOSTS allowed root access                          []
  HOSTNAME list. If exported read-mostly             []
  Use SECURE option?                                  no                      +
* EXPORT directory now, system restart or both        both                    +
  PATHNAME of alternate Exports file                 []

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

Don't export a read/write file system without specifying the HOSTS & 
NETGROUPS allowed client access field. If you do that, you can have some 
security problems because everyone with access to your IP network will be 
able to access this file system.

Note
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Figure 141.  Add a File System for Mounting

You also must create a directory and a link in order to support the VIM 
applications. As root, type the following:

# mkdir -m 755 -p /opt/vim/lib
# ln -s /opt/lotus/notes/latest/ibmpow /opt/vim/lib/ibmpow

After that, you can run the Notes Workstation on the client hosts. Michael and 
Ruby will be able to run their Notes Workstations.

6.3.4  Distributing the Clients Data Directories
If you have the Lotus Notes clients data directory on a file system of a file server, 
you have an easier way to back up the clients files, and you save some clients 
disk space. But most importantly, if you use a distributed environment (all users 
can access all hosts with the same login and home directory), this is the easiest 
way to make a notes client available to the whole environment. Such a setup 
does reduce performance and availability, however.

The example in Figure 142 on page 167 shows a file server that contains the 
UNIX Notes Workstation software directory (/noteswrk) and the Clients Home and 
Data Directories (/home). It exports both file systems to the workstation’s hosts. If 
all the hosts have the same AIX users, Michael will be able to log in on Ruby’s 

 Add a File System for Mounting

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
* PATHNAME of mount point                            [/opt/lotus]              /
* PATHNAME of remote directory                       [/noteswrk/lotus]
* HOST where remote directory resides                [filserv]
  Mount type NAME                                    []
* Use SECURE mount option?                            no                      +
* MOUNT now, add entry to /etc/filesystems or both?   both                    +
* /etc/filesystems entry will mount the directory     yes                     +
   on system RESTART.
* MODE for this NFS file system                       read-write              +
* ATTEMPT mount in foreground or background           background              +
  NUMBER of times to attempt mount                   []                        #
  Buffer SIZE for read                               []                        #
  Buffer SIZE for writes                             []                        #
  NFS TIMEOUT. In tenths of a second                 []                        #
[MORE...19]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

Some examples of distributed environments that can be used are the 
Distributed Computer Environment (DCE), Network Information Service (NIS), 
or Andrew File System (AFS). We will not discuss how to set up or how to work 
with these environments in this redbook.

Note
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workstation and access his UNIX home directory and his Lotus Notes data 
directory. The same applies to Ruby.

Figure 142.  Distributing the Clients Data Directories

The /noteswrk directory and the /home directory do not need to be in the same 
file server. In this case, we are using the /home file system as the home file 
system for the AIX users and to hold the Lotus Notes data directories. If you 
want, you can have two different file systems. We won’t discuss this case here.

See 6.3.3, “Distributing the Lotus Notes Software Directory” on page 160, it 
explains how to distribute the /noteswrk directory. To distribute the /home 
directory, you have to follow the same steps. Remember, all of them must be 
done as root. Suppose, again, that the file server in Figure 142 is called filserv, 
Michael’s workstation ah1610d and Ruby’s workstation ah1610c.

After you have created a large enough /home file system on filserv, you have to 
export it. Run the command:

# /usr/sbin/mknfsexp -d /home -t rw -c ’ah1610c ah1610d’ -B

 
File Server (filserv)

AIX Lotus Notes Software
/noteswrk

Clients Home & Notes Data Directories

/home

Michael’s Workstation (ah1610d) Ruby’s Workstation (ah1610c)

In this example, Michael’s home directory is /home/michael. Michael’s Lotus 
Notes data directory is /home/michael/notesr4. Both directories will be in the 
/home file system

Note
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or use smitty mknfsexp to get the menu shown in Figure 140 on page 165. 
Change the PATHNAME of the directory to export field to /home.

If you have a local /home file system on ah1610c or on ah1610d, after you mount 
the /home file system from filserv, you won’t be able to access your local file 
system until you unmount the remote one. It’s a good idea to move the data and 
the local users to somewhere else (to a file system called /local, for example) and 
remove the local /home file system. Please be careful when removing a file 
system.

To change the mount point of the local /home file system to /local, for example, 
run the commands below as root. Note that the /local file system must not exist. If 
you fail to unmount the /home directory, the next reboot of the machine will solve 
the problem.

To mount the remote /home file system, run: smitty mknfsmnt to display the menu 
shown in Figure 141 on page 166. Change the PATHNAME of the mount point 
and the PATHNAME of the remote directory to /home.

6.4  Environment Variables

Some of the important variables required for the environment settings are 
described below:

Please be very careful while performing these steps. You can mix up the file 
system and/or user configuration of your machine.

# chfs -m/local /home
# umount /home
# mount /local

You can edit the /etc/passwd file to change the local users’ home directory 
definition (if you have local users). Change the /home/<username> fields to 
/local/<username>. If you don’t want to edit the /etc/passwd, run the command: 
chuser home=/local/<username> <username> for each local user that you want to 
move, except the root and the administrative users.

If you want to remove the /home file system and its data enter the following:

# umount /home
# rmfs /home

If you fail to unmount the /home file system, try to finish all processes that can 
be completed using this file system. If you can’t do this, ask AIX not to mount 
this file system after the reboot. Reboot by typing the following:

# chfs -Ano /home
# shutdown -Fr

After the reboot, run the command: rmfs /home.

Note
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6.4.1  Notes_SHARED_DPOOLSIZE
The Notes_SHARED_DPOOLSIZE value is automatically set to: ((Total System 
RAM in bytes) / 2) / 7. The objective of this setting is to use not more than 50 
percent of the Total System RAM for the shared memory and to keep the total 
number of shared memory segments required at seven or less. You can override 
this value by issuing the following command from your shell:

export Notes_SHARED_DPOOLSIZE=(New value in bytes)

For example:

export Notes_SHARED_DPOOLSIZE=4000000

If the number of shared memory segments used in your system exceeds 7, then 
increase the Notes_SHARED_DPOOLSIZE setting. AIX allows a maximum of 10 
shared memory segments.

6.4.2  NSORDER
In case you are not running either Domain Name Service (DNS) or Network 
Information Services (NIS) to provide name resolution for your network, and 
instead are using local /etc/hosts file on each machine, then you must have the 
environment variable NSORDER set for either the Lotus Domino Server or Notes 
Workstation to be able to resolve names using the local /etc/hosts file. This 
variable is set as follows:

export NSORDER=local,bind,nis

This variable specifies the order in which the operating system searches for 
addresses for name resolution, specifying that the local (/etc/hosts) is to be 
searched before attempting to contact NIS for name resolution. You can set this 
variable and place the given line within the .kshrc file in the home directory for the 
user ID being used to run the Lotus Domino Server/Notes Workstation so that the 
variable is set each time the user logs in to the network.

6.4.3  DEBUG_ENABLE_CORE
If you want the Lotus Domino Server to generate a core file in the event of a fatal 
error, set this environment variable by issuing the following command from the 
shell: 

export DEBUG_ENABLE_CORE=1

The default behavior is not to generate a core file.
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Chapter 7.  Setting Up Printers

This chapter outlines how to install and set up printers on AIX for use on Lotus 
Notes.

7.1  Installation and Setup of Printers on AIX

This chapter is only a short description on how to set up and install a printer on 
AIX. For more detailed information, please refer to the AIX V4.1 Installation Guide 
(SC23-2550), the AIX 4.2 Installation Guide(SC23-1924), AIX V4.3 Installation 
Guide (SC23-4112), or the AIX V4.3 Guide to Printers and Printing (SC23-4130).

To each physically attached printer, different Virtual Printer Queues with different 
initial sequences (PS, PCL, ASCII, and so on) can be attached.

In this way, you can print to the same physical printer with different printer modes 
using different printer queues.

7.1.1  Add/Configure a Local Attached Printer
To add a local printer complete the following steps:

1. Log in on the local system as the root user.

2. Check if the Printer Backend printers.rte is already installed. (You don’t need it 
for printing to a remote host.) Type lslpp -l printers.*.

3. Enter smitty mkpq to make a printer queue.

4. Select Add a Printer/Plotter and press Enter to get to the screen shown in 
Figure 143.

Figure 143.  smitty’s Add a Local Print Queue

5. Select Printer Attached to Local Host (Figure 143) and press Enter.

                               Add a Print Queue

    Move cursor to desired item and press Enter.  Use arrow keys to scroll.

      # ATTACHMENT TYPE      DESCRIPTION
        local                Printer Attached to Local Host
        remote               Printer Attached to Remote Host
        xstation             Printer Attached to Xstation
        ascii                Printer Attached to ASCII Terminal
        hpJetDirect          Network Printer (HP JetDirect)
        file                 File (in /dev directory)
        other                User Defined Backend

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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Figure 144.  smitty’s Select Printer Type

6. Select the Printer Type (Figure 144) and press Enter.

Figure 145.  smitty’s Printer Type

7. Select the printer you want to install (Figure 145) and press Enter.

                                  Printer Type

    Move cursor to desired item and press Enter.

      Bull
      Canon
      Dataproducts
      Hewlett-Packard
      IBM
      OKI
      Printronix
      QMS
      Texas Instruments
      Other (Select this if your printer type is not listed above)

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next

                                  Printer Type

    Move cursor to desired item and press Enter.

    [TOP]
      ibm2380      IBM 2380 Personal Printer II
      ibm2380-2    IBM 2380 Plus printer (Model 2)
      ibm2381      IBM 2381 Personal Printer II
      ibm2381-2    IBM 2381 Plus printer (Model 2)
      ibm2390      IBM 2390 Personal Printer II
      ibm2390-2    IBM 2390 Plus printer (Model 2)
      ibm2391      IBM 2391 Personal Printer II
      ibm2391-2    IBM 2391 Plus printer (Model 2)
      ibm3812-2    IBM 3812 Model 2 Page Printer
      ibm3816      IBM 3816 Page Printer
      ibm4019      IBM 4019 LaserPrinter
    [MORE...43]

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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If the dedicated printer device driver is not installed, you will see the following 
screen (Figure 146):

Figure 146.  smitty’s Printer Support Not Installed

a. Press Enter.

b. Press F4 to get to the Installation Device Selection list.

c. Select the correct installation device and press Enter.

d. Press F4 to get to the Software Installation Selection list.

e. Mark the printer(s) you want to install with F7 and press Enter.

f. Accept the default settings and press Enter.

g. Pass the warning Are You sure? by pressing Enter.

h. If the installation process succeeds, press F10 to exit smit.

i. Repeat the first steps, while referring to 7.1.1, “Add/Configure a Local 
Attached Printer” on page 171.

                         Printer Support Not Installed

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Software to support the printer you selected
  is not installed.  Press Enter to install
  printer support software packages.

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 147.  smitty’s Printer Type and Interface

8. Select the Printer Interface the printer is attached to (Figure 147) and press 
Enter.

Figure 148.  smitty’s Parent Adapter

9. Select the serial port the printer is attached to (Figure 148) and press Enter.

                                  Printer Type

    Move cursor to desired item and press Enter.

    [MORE...11]
      ibm4029      IBM 4029 LaserPrinter
      ibm4037      IBM 4037 LP printer
      ibm4039      IBM 4039 LaserPrinter
      ibm4070      IBM 4070 IJ printer
      ibm4072      IBM 4072 ExecJet
   --------------------------------------------------------------------------
                               Printer Interface

    Move cursor to desired item and press Enter.

      parallel
      rs232

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next

                                  Printer Type

    Move cursor to desired item and press Enter.

    [MORE...11]
      ibm4029      IBM 4029 LaserPrinter
      ibm4037      IBM 4037 LP printer
      ibm4039      IBM 4039 LaserPrinter
      ibm4070      IBM 4070 IJ printer
      ibm4072      IBM 4072 ExecJet
   --------------------------------------------------------------------------
                                 Parent Adapter

    Move cursor to desired item and press Enter.

      sa0 Available 01-J0 Standard I/O Serial Port 1
      sa1 Available 01-K0 Standard I/O Serial Port 2

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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Figure 149.  smitty’s Add a Print Queue

10.Fill in the names of the new printer queues you want to add for the preselected 
printer, also the baud rate, and so on, or accept the defaults (Figure 149).

11.Press Enter.

12.After successful installation, exit smit with F10.

13.On return to the prompt, enter: lpstat (Figure 150).

Figure 150.  Output of Command lpstat

7.1.2  Add/Configure a Remotely Attached Printer
If an AIX host with a locally attached printer already exists and you want to use 
this system as a printer server, you should take the following steps:

1. Log in on the remote server host as root user (you can also use the command: 
telnet <hostname>).

                               Add a Print Queue

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
  Description                                         IBM 4029 LaserPrinter

  Names of NEW print queues to add
     ASCII                                           [l_asc]
     GL Emulation                                    []
     PCL Emulation                                   [l_pcl]
     PostScript                                      [tomps]

  Printer connection characteristics
*    PORT number                                     [s2]                     +
     BAUD rate                                       [9600]                   +
     PARITY                                          [none]                   +
     BITS per character                              [8]                      +
     Number of STOP BITS                             [1]                      +
     FLOW CONTROL to be used                         [dtr]                    +
     Printer TIME OUT period (seconds)               [600]                    +#
     STATE to be configured at boot time              available               +
[BOTTOM]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

Queue   Dev   Status    Job Files              User         PP %   Blks  Cp Rnk
------- ----- --------- --- ------------------ ---------- ---- -- ----- --- ---
l_asc   lp0   READY
l_pcl   lp0   READY
tomps   lp0   READY

To remove printer queues, type: smitty rmpq

Note
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2. Get a list of all available printer queues with the command: lpstat (Figure 
151).

Figure 151.  Output of lpstat on Remote Host

3. Add the client’s hostname to the /etc/hosts.lpd file to provide the client the 
printer access to the server.

4. Exit the remote host (and log in to the local system as root user).

5. Enter: smitty mkpq.

6. Select Printer Attached to Remote Host (Figure 152) and press Enter.

Figure 152.  smitty’s Add a Remote Print Queue

7. If you use the AIX printer subsystem, select Standard processing (Figure 
153) and press Enter.

lpstat on remote host
Queue   Dev   Status    Job Files              User         PP %   Blks  Cp Rnk
------- ----- --------- --- ------------------ ---------- ---- -- ----- --- ---
ps      @prt3 READY
ps      ps    READY
cps     @prt3 READY
cps     cps   READY
ps3825  ps382 READY
ps3825  ps382 READY
ps3825  dev2  READY
asc3825 asc38 READY
asc3825 asc38 READY
asc3825 dev2  READY
os2asc  lan   READY
os2ps   os2   READY
lab1ps  @prt3 READY
lab1ps  lab1p READY
lab1asc @prt3 READY
lab1asc lab1a READY
psdup   hp@pr READY
ps4019  p@tx2 READY

                               Add a Print Queue

    Move cursor to desired item and press Enter.  Use arrow keys to scroll.

      # ATTACHMENT TYPE      DESCRIPTION
        local                Printer Attached to Local Host
        remote               Printer Attached to Remote Host
        xstation             Printer Attached to Xstation
        ascii                Printer Attached to ASCII Terminal
        hpJetDirect          Network Printer (HP JetDirect)
        file                 File (in /dev directory)
        other                User Defined Backend

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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Figure 153.  smitty’s Add a Print Queue

8. Fill in the new queue name you want to add, the hostname of the dedicated 
printer server and also the name of the queue on the remote printer server you 
want to add to your local printer subsystem (Figure 154).

9. Press Enter.

Figure 154.  smitty’s Add a Print Queue

10.After a successful setup, exit smit with F10.

11.On return to the prompt, enter: lpstat (Figure 155).

                               Add a Print Queue

    Move cursor to desired item and press Enter.  Use arrow keys to scroll.

   --------------------------------------------------------------------------
                            Type of Remote Printing

    Move cursor to desired item and press Enter.

      Standard processing
      Standard with NFS access to server print queue attributes
      Local filtering before sending to print server

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next

                       Add a Standard Remote Print Queue

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* Name of QUEUE to add                               [tomps]
* HOSTNAME of remote server                          [itsosmp]
* Name of QUEUE on remote server                     [ps]
  TYPE of print spooler on remote server              AIX Version 3 or 4      +
  DESCRIPTION of printer on remote server            [My New PS_printer]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 155.  Output of Command lpstat on Local Host

7.2  Setting Up AIX Printers in Lotus Notes

1. Start Lotus Notes by typing: notes.

2. Open any database.

3. Highlight the document.

4. Choose File -> Print... (or press Ctrl+P).

Figure 156.  File -> Print

5. Click on Printer... (Figure 156).

Queue   Dev   Status    Job Files              User         PP %   Blks  Cp Rnk
------- ----- --------- --- ------------------ ---------- ---- -- ----- --- ---
tomps   @itso READY
tomps   ps    READY
ps      ps    READY
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Figure 157.  Printer Setup

6. Click on Connect... (Figure 157).

Figure 158.  Choosing a Port

7. Choose the Port that the printer will use to connect.

8. Click on OK or New depending on if you would like to use an existing port or 
add a new one.(Figure 158). In this instance, we chose New to add a new 
port.

If you press the Printer button and no printer is already installed, you will 
get the following error message:

Unable to read printer configuration file.
Personal:/notes/.Xpdefaults or
System:/opt/lotus/notes/<version>/common/Xp/Xpdefaults.
Check file permissions and [devices] section
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Figure 159.  Add Printer

9. To replace a port rather than add a new one, select the port you want to 
replace.

10.To replace or add a port in the Port Name field, enter the name of the new 
port, for example, newport=printercommand.

11.In the Description field, enter in a description for the port. For example in the 
Port Name field we entered newport=printercommand, where newport is the 
alias for the port and printer command is a system printer command. For 
example, type printer_on_floor1=lp -d HPlaserjet3 in the description field.

12.Click on Add/Replace (Figure 159).

Figure 160.  Define New Port

13.Click on OK or click on New to define another new port.(Figure 161).
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Figure 161.  Select Port to be Edited

14.Repeat steps 10 on page 180 to step 13 on page 180 for all the queues you 
want to add.

Figure 162.  Remove a Printer Queue

15.To remove unnecessary printer queues, click on the Connect... button, shown 
in Figure 161 on page 181, to open the Ports screen and select the queue and 
click on Delete (Figure 162).

16.Click on OK

17.To add a new printer, choose the printer from the list of printers and a port.
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Figure 163.  Add Printer

18.Click on OK (Figure 163).

19.Repeat step 18 on page 182 for all printers you want to add.

Figure 164.  Remove Selected Printer

20.To remove printers, select the printer and click on Remove (Figure 164).

21.Click on Close.

22.To adjust any paper issues or printing preferences, click on Setup... and make 
the adjustments.

There is no indicator that the Add operation was OK.

Note
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Figure 165.  Save/Apply Printer

23.Click on OK (Figure 165).

7.3  Create a Site-Specific System Printer Setup File

After you have added appropriate printers and port information as described in 
section 7.2, “Setting Up AIX Printers in Lotus Notes” on page 178, you must 
do the following:

  • Save an original copy of the 
/opt/lotus/notes/<version>/common/Xp/Xpdefaults file.

  • Copy the $HOME/.Xpdefaults file, which Xprinter will have now created, to the 
/opt/lotus/notes/<version>/common/Xp/Xpdefaults file.

7.4  Maintenance of an AIX Printer Subsystem

This section explains how to change and maintain the printer subsystem on AIX. 
You can give the printer-handling permission to any user you want; so you must 
not be the root user to maintain the AIX printer subsystem.

7.4.1  Give a User the Right to Maintain the AIX Printer Subsystem
To maintain the AIX printer subsystem, you must have root permission or be a 
member of the group printq.

To add the group printq to the user notes, follow these steps:

The system printer setup file should only have Read permission.
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1. Log in as root.

2. Type: smitty chuser.

3. Enter user name, or F4 to select user from the list and press Enter.

Figure 166.  smitty’s Change User Characteristics of User notes

4. Add printq to Group SET (Figure 166) and press Enter.

7.4.2  Useful Printer Commands
You can also maintain the printer subsystem by using smitty.

  • The command lpstat will list the actual printer queues and all running printer 
jobs (Figure 167).

Figure 167.  Output of Command lpstat with Running Print Jobs

  • The command qcan -P<QueueName> -x <JobNumber> will cancel print jobs in the 
printer queues. For example:

– To cancel job number 752 on whichever printer the job is on, enter:

qcan -x 752

– To cancel all jobs queued on printer tomps, enter: 

qcan -X -Ptomps

  • The command qadm -D<printer/queue> will bring down the appropriate printer.

                    Change / Show Characteristics of a User

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
* User NAME                                           notes
  User ID                                            [223]                     #
  ADMINISTRATIVE USER?                                true                    +
  Primary GROUP                                      [notes]                  +
  Group SET                                          [notes,staff,printq]     +
  ADMINISTRATIVE GROUPS                              [                       +
  Another user can SU TO USER?                        true                    +
  SU GROUPS                                          [                       +
  HOME directory                                     [notes]
  Initial PROGRAM                                    [usr/bin/ksh]
  User INFORMATION                                   [Lotus Notes User]
  EXPIRATION date (MMDDhhmmyy)                       [
  Is this user ACCOUNT LOCKED?                        true                    +
  User can LOGIN?                                     true                    +
[MORE...30]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

Queue   Dev   Status    Job Files              User         PP %   Blks  Cp Rnk
------- ----- --------- --- ------------------ ---------- ---- -- ----- --- ---
l_asc   lp0   READY
l_pcl   lp0   READY
tomps   lp0   RUNNING   752 /tmp/notesfile.ps  notes         0 76   738   1   1
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  • The command qadm -U<printer/queue> will bring up the appropriate printer. You 
will need this command after a queue went down because of printer problems.

  • The command qadm -X will cancel all print jobs immediately.

7.5  Understanding the Xpdefaults Printer Setting of Lotus Notes

When a user prints a document, Xprinter looks for printer setup information in the 
.Xpdefaults file in the user's home directory. If that file does not exist, Xprinter 
reads the system printer setup file, 
/opt/lotus/notes/<version>/common/Xp/Xpdefaults, for information.

About the .Xpdefaults file:

The Xprinter distribution contains a system printer setup file:

  • System: /opt/lotus/notes/<version>/common/Xp/Xpdefaults
  • Personal: $HOME/.Xpdefaults

The .Xpdefaults file is divided into sections, and section names are enclosed 
in brackets.

Within a section, entries are formatted such as:

keyword=data

The following is an example of an .Xpdefaults file:

If the user does not have an .Xpdefaults file and changes any printer setup 
information, Xprinter creates a $HOME/.Xpdefaults file for the user that 
includes the changes.

The information in the user's $HOME/.Xpdefaults file controls the options that a 
user has in the various printing-related dialog boxes when printing from Lotus 
Notes. To ensure that users can successfully print, administrators should 
create a useful, site-specific system printer setup file.

Since Xprinter will use the system printer setup file for users who lack a 
$HOME/.Xpdefaults file, it is important that the system file contains appropriate 
information for the site's printers.

Important Note
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Figure 168.  Xpdefaults File

In the example shown in Figure 168, the default printer file follows the device 
keyword in the [windows] section.

The default printer is an IBM 4029 printer in PostScript mode.

IB4029A1 is the name of the PPD file to use when printing to that particular type 
of printer, as specified in the [devices] section.

The last parameter for the device keyword, myfirst, is the print command from 
the [ports] section to spool the output file to the printer. The [devices] section 
contains a list of all printers that are configured on the system.

The port aliases, such as myfirst, are configured by the user to reflect 
system-specific configurations.

[windows]
device=IB4029A1,PostScript,myfirst

[other-devices]

[Xprinter,PostScript]
Filename=xprinter.eps
Scale=1.00
Copies=1
Orientation=Portrait
PageSize=Letter
DPI=300

[Xprinter,PCL5]
Filename=xprinter.pcl
Scale=1.00
Copies=1
Orientation=Portrait
PageSize=Letter
DPI=300

[Xprinter,PCL4]
Filename=xprinter.pcl4
Scale=1.00
Copies=1
Orientation=Portrait
PageSize=Letter
DPI=300

[IB4029A1,PostScript,myfirst]
Scale=1.00
Copies=1
PaperTray=Upper
PageSize=Letter
Orientation=Portrait
DPI=300

[ports]
FILE:=

l_asc=lp -d l_asc
l_pcl=lp -d l_pcl
tomps=lp -d tomps
myfirst=lp -d tomps
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However, the reserved alias FILE: indicates that output is sent to a file.

The [IB4029A1,PostScript,myfirst] section shows that the default printer 
parameters are a scale factor of 1.00, one copy, upper paper tray, letter size, 
portrait orientation, and 300 dots-per-inch resolution.
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Chapter 8.  Security and Lotus Domino

Security in Lotus Dominois a big and complex topic. The aim of this chapter is not 
to document how Lotus Domino internally deals with access and authorization 
issues but to highlight the areas where security can be applied and how to go 
about establishing the required security.

Lotus Domino provides functions to restrict or deny access at all levels, ranging 
from Lotus Domino domains and servers to individual databases and fields within 
a database.

8.1  User Security

There are many aspects of end-user security. The ones which will be covered in 
this section are:

  • User IDs and Passwords
  • Locking User IDs
  • Local Database Encryption

8.1.1  User IDs and Passwords
Lotus Domino uses ID files to secure access to servers. Every Lotus Domino 
Server and Lotus Notes user must have an ID. An ID is a unique binary file that 
identifies a legal Lotus Domino Server and Lotus Notes user. IDs are created at 
the time of user or server registration. An ID file contains:

  • The name of its owner.

  • A license number that indicates that the owner is legal and specifies whether 
the owner can run the North American or International edition of Lotus Domino 
or Lotus Notes. You can’t change a license number associated with a specific 
public key.

  • A public key and a private key.

  • At least one certificate from a Certifier ID. A certificate is an electronic stamp 
added to a user ID or server ID. This stamp is generated using the private key 
of a Certifier ID that verifies that the name of the owner of the ID is correctly 
associated with a specific public key.

  • (Optional) One or more encryption keys, created and distributed by users that 
allow users to encrypt and decrypt fields in a document.

If the owner of an ID creates a password for it, the password generates a key that 
encrypts most of the data on the ID.

8.1.1.1  Securing the User ID File
Each user should protect their ID file from unauthorized use because it is the key 
to their data, and in addition, the data that has been made available to them. 
They can do this in the following ways:

  • By restricting access to their ID file. Refer to 8.7.4, “UNIX File Permissions” on 
page 212 to see how to restrict access to the ID file in a UNIX environment.

  • By password protecting the ID file using a secure password. The best 
passwords to use are those that contain a mixture of numbers and letters and 
are in mixed case.
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8.1.1.2  Backup of the User ID File
Since the user ID file contains the private encryption keys and certificates for a 
user, any loss or damage to the file would be a disaster for the user concerned.

Without a user ID, the user cannot access servers. Even if users obtain new IDs, 
the users can never read messages and other data that they encrypted with the 
lost ID.

Users should always ensure that they have a backup copy of their user ID file.

In addition, the Lotus Domino administrator can set up a special Lotus Notes 
user, which requires multiple passwords to gain access. User ID files can then be 
stored in the mail file and can be retrieved in case they are corrupted or if 
passwords are forgotten. (For more information, see the Escrow Agent entry in 
the online Lotus Domino Administration Help database.)

8.1.2  Locking User IDs
By locking a user ID, any connections that the authorized user had to Lotus 
Domino Servers are dropped, and any request to access them again will require 
that the appropriate password be entered for the ID file.

IDs can be locked either manually or automatically.

8.1.2.1  Manual Locking
Users should always remember to lock their user ID when they leave their 
workstation unattended so that unauthorized users do not gain access to any 
servers that the legitimate user was connected to.

It is possible to lock the user ID by either pressing F5 on the keyboard or by 
selecting File -> Tools -> Lock ID.

8.1.2.2  Automatic Locking
Users can define an inactivity time period when their user ID is automatically 
locked.

This is possible through selecting File -> Tools -> User Preferences... to display 
the User Preferences dialog box and then specifying a time in the Lock ID after 
[number] minutes of inactivity field.

8.1.3  Local Database Encryption
Users can encrypt local databases to prevent unwanted access by anyone who 
gains unauthorized access to the workstation or anyone who makes a copy of the 
database through the operating system layer.

If users forget their passwords for their IDs, their IDs are of limited use. They 
will still be able to perform some local work, but they will not be able to open or 
read encrypted data or authenticate with any servers. To restore full 
functionality, users must obtain (if available) backup copies of the ID that do 
not have password protection. Otherwise, you must re-register the user.

Note
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To encrypt a database:

1. Left-click on the Database icon to select it.

2. Select File -> Database -> Properties....

3. On the Properties screen that is displayed, click on Encryption... to display 
the Encryption screen (Figure 169).

Figure 169.  Encrypting a Local Database

4. Select Locally encrypt this database using and select an encryption level.

5. The For value defaults to your own user ID. If you want to encrypt the 
database for another person or group, click on the For button and select a 
person or a group from the Names screen.

6. Click on OK.

Unauthorized users will receive the following message when they try to access 
the locally encrypted database:

Figure 170.  Not Authorized Message for Locally Encrypted Database
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8.2  About Workstation Data Security

The User Preferences box allows users to secure their workstations through the 
Execution Control List (ECL). The ECL can limit the actions of another user’s 
formula or scripts that run on a workstation, including limiting:

  • Access to the file system
  • Access to the current database
  • Access to environment variables
  • Access to databases of other applications
  • Access to external programs
  • Ability to send mail
  • Ability to read databases other than the current one
  • Ability to modify databases other than the current one
  • Ability to export data
  • Access to the workstation Security ECL

To access the ECL, you must first open the User Preferences box. To do this 
choose File -> Tools -> User Preferences. 

Once this dialog box appears on the screen click on the Security Options... 
button and the following screen, shown in Figure 197, will appear.

Figure 171.  User Preferences ECL

Before you register users you should set up a generic ECL for user workstations 
by editing the Administration ECL. After you have registered the users, you can 
modify the ECL to make it more user specific. To do this follow the steps below:

1. Open the Public Address Book.

2. Choose Actions -> Edit Administration ECL.
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3. Select -Default- and then select default access levels. Any signature not 
specified in the ECL is given the -Default- access. Typically, you allow only 
minimal default access.

4. Select -No Signature- and then select access levels to determine the access 
allowed when there is no signature or when a signature cannot be verified a 
signature. Typically, you allow only minimal access.

5. To add a name, click Add, and enter the name of a person, server, or group. 
Click OK.

6. Deselect one or more levels of workstation access for the specified name, as 
the default is everything is selected.

7. Repeat steps 5 and 6 to add more names.

8. To change a name, select the name, click Rename, enter the new name, and 
click OK.

9. To delete a name, select the name and click Remove.

10.To let users modify the ECL on their workstations, select Allow user to 
modify.

11.Click OK.

You can also make changes to the ECL after you have registered all the users by 
sending them a mail message with the changes made to the ECL. To do this 
follow the steps below:

1. Address a memo to the users whose ECLs you want to update.

2. Add a button to the memo that executes this formula:
@RefreshEcl (server, database, name)

3. Describe the purpose of the memo and instruct the users to click the button.

4. Mail the memo.

  • The first null parameter in the formula means that you’re not selecting a 
specific server to draw the ECL changes from; instead, the changes are drawn 
from the users’ home server. Therefore, you should make sure the Public 
Address Book with the new Administration ECL has replicated throughout the 
domain before sending the memo.

  • When a user clicks the button in the memo, the Administration ECL is merged 
into the user’s existing workstation ECL; any entries in the Administration ECL 
are added to the user’s ECL, but any entries the user has customized remain.

8.3  Remote User Security

Security may be required if sensitive or company confidential information is being 
transmitted across insecure telephone lines through a modem. Lotus Notes 
passwords are not a problem area because they are already encrypted before 
they are sent to the server for validation.

Lotus Notes can be configured so that data transmitted to and from a remote user 
is automatically encrypted. Encryption should be enabled at the port rather than 
at the user level so that the data is encrypted bidirectionally. This will slow down 
the transfer, but with a fast modem, the degradation is negligible.

To enable encryption for the modem port:
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1. Log in as the Lotus Domino administrator and select File -> Tools -> User 
Preferences... to display the User Preferences screen.

2. Click on the Ports icon.

3. Select the communications port for modem communications and select the 
Encrypt network data check box.

4. Click on OK.

8.4  Mail Security

Lotus Notes mail can be secured by:

1. Encryption

The memo will be encrypted when sent and decrypted by Lotus Notes when 
the recipient opens the memo. The encryption/decryption is transparent to the 
user, but it needs access to the recipients public key either in the Public or the 
Personal Name and Address Book.

There are three ways to encrypt mail:

Encrypting Outgoing Mail
This method ensures the sender that only the recipient of a message can read 
it while the message is in transit or stored in intermediate mail boxes or in the 
recipients mail file.

Encrypting Saved Mail
This method allows users to encrypt drafts of unsent messages and messages 
saved after sending.

To set up encrypting outgoing and saved mail messages, in the User 
Preferences box, choose File -> Tools -> User Preferences and select the 
options you would like to use.

Figure 172.  Encrypting Outgoing and Saved Mail
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Encrypting Incoming Mail
This method ensures recipients of messages that only they can read the 
messages sent to them. Encrypting incoming messages prevents 
administrators or users with unauthorized access to mail servers from reading 
messages.

To encrypt incoming mail messages, in the Public Address Book, open the 
Person document of the user that wishes to encrypt incoming mail messages 
and in the Misc section, next to the Encrypt incoming mail, change the 
default from No to Yes, and save the document, as shown in Figure 173.

Figure 173.  Encrypting Incoming Mail

Signing

Signing stamps the memo with the name of the author and the date and time 
of the signature. It doesn’t prevent the memo from being read enroute, but if 
the contents are tampered with, the recipient will know about it.

When the recipient opens the signed memo, the signature will be displayed in 
the message box. An example is shown below:

Signed by Al Jamal/itso on 08/11/98 03:13:50 PM, according
to /itso.

Here is an overview of how Lotus Notes uses electronic signatures:

1. Lotus Notes generates a 128-bit fingerprint of the data being signed and 
then encrypts the scrambled fingerprint with the private key of the author of 
the data.

2. Lotus Notes attaches the encrypted fingerprint to the data.

3. Lotus Notes attaches the signer’s public key and certificates to the data.

4. When someone accesses the signed data, Lotus Notes verifies that the 
signer has a common certificate ancestor with and from a certifier that the 
reader trusts. If so, Lotus Notes attempts to decrypt the signed data using 
the public key that corresponds to the private key with which the data was 
signed.
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5. If decryption is successful, Lotus Notes indicates who signed the message. 
If decryption is not successful, Lotus Notes indicates that it could not verify 
the signature. Unsuccessful decryption may indicate that the data has been 
tampered with and/or that the sender does not have a certificate trusted by 
the reader. This might happen, for example, when a user receives mail 
from a user in another company and that user doesn’t have a cross 
certificate.

A signature can be verified as long as the two IDs have a certifier in common, or 
Lotus Notes finds a cross certificate between some level of the two IDs.

The signing and encryption of a memo are enabled from the Delivery Options 
screen which is displayed when Delivery Options... is clicked from the New 
Memo screen shown in Figure 174. The default can be set by selecting File -> 
Tools -> User Preferences... in the Mail section.

Figure 174.  Delivery Options for Lotus Notes Memo

8.5  Server Security

The following aspects of server security will be discussed in this section:

  • Restricting Physical Access to Lotus Domino Servers
  • Restricting Access to Lotus Domino Server Consoles
  • Server Access Control Lists
  • Certification

8.5.1  Restricting Physical Access to Lotus Domino Servers
It is crucial to restrict access to the workstation which is running the Lotus 
Domino Server program by locking it in an air-conditioned room to which only 
authorized Lotus Domino administrators have access. If need be, the keyboard 
and mouse can be removed to stop the casual intruder from gaining access to the 
system. The server can then be administered from the remote console.

Besides restricting physical access to the server, it is probably best to allow only 
the necessary administrative people to log into the server on the operating 
system level. All other users should be able to access the server only through the 
Lotus Notes clients on other machines.
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8.5.2  Restricting Access to Lotus Domino Server Consoles
You can provide additional security by providing a keyboard lock password and 
by using the Notes Set Secure <password> command on the server console.

This command restricts access to the following commands to only those people 
who know the password that was used when the Set Secure command was 
issued:

  • Load

  • Tell

  • Exit

  • Quit

  • Set Configuration

Restricted access to these commands is removed when the Set Secure 
<password> command is issued again.

It's possible to change the password by issuing the Set Secure <old_password> 
<new_password> command.

8.5.3  Server Access Control Lists (SACL)
SACLs are specified in the Server Document in the Public Name and Address 
Book, and they control access to the server.

To see the SACL for a server:

1. Double-click on the icon for the Public Name and Address Book.

2. Select the Server/Servers view, if it is not already selected, to display a list of 
servers in the domain.

3. Click on the Server document that you want to work with, and either press 
Ctrl+E or click on the Edit Server button to display the Server document in 
edit mode (Figure 175).

4. Click on Restrictions to display the SACL for this server (Figure 175 on page 
198).
Security and Lotus Domino 197



Figure 175.  Server Document in Edit Mode

The meanings of the fields within this section are described here:

  • Only allow server access to users listed in this Address Book.

Selecting Yes prevents users and servers not listed in the Public Name and 
Address Book from accessing the server. Note that you may have to restart 
the server for the change to take effect.

Users who are not listed in the Public Name and Address Book will receive the 
following message when trying to gain access to the server:
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Figure 176.  Restricted Access to Server - Error Message

  • Access server

Allows users, servers, and groups listed in this field to access the server. If 
this field is blank, all certified users can access the server.

  • Not access server

Denies access to users, servers, and groups listed in this field. Use this to 
deny access to people who have left the company and who still have their IDs. 
For example, create a group called Terminations and add people leaving the 
company to this group.

  • Create new databases

Allows users, servers, or groups specified in this field to create databases on 
the server. If this field is blank, all certified users can create new databases.

  • Create replica databases

Allows users, servers, or groups specified in this field to create replica 
databases. If this field is blank, only the person working at the server machine 
can create replica databases.

  • Administer the server from a browser

Allows users or groups specified in this field to use the web based 
Administration Tool from a browser.

  • Access this server

Allows users, servers, and groups listed in this field to access this server as a 
passthru destination. If this field is blank, all users can access this server as a 
passthru destination.

  • Route through

Enter the names of users, servers, and groups whom you want to allow to use 
this server as a passthru server. If the Route through field is blank, no users 
and servers can use this server as a passthru server. Note that the Access 
server and Not access server fields have no bearing on passthru users. Any 
users or servers listed in the Route through field can use the server as a 
passthru server, regardless of whether or not they are also included in the 
Access server or Not access server fields.

  • Cause Calling
Security and Lotus Domino 199



Enter the names of users, servers, and groups allowed to call other servers 
while routing through this server. If this field is blank, no one can use the 
server to call other servers.

  • Destinations allowed

Enter the remote servers that this server may route to through passthru. If this 
field is blank, every server can be routed to.

8.5.4  Certification
When a server is created or a user is registered, a Certifier ID is used to certify 
the server or user ID. The certifier that is used must be secured.

8.5.4.1  Securing the Certifier ID
It is important to secure the Certifier ID for any organization (especially the 
top-level organizational certifier that is used to certify organizational units, 
servers, and users) by assigning multiple passwords to the ID file. You can 
secure any ID file this way, not just the Certifier ID.

If security of the Certifier ID is compromised, all organizational units, servers, and 
users will have to be recertified with a new certifier.

The first step is to decide how many people will be required to be given a 
password to the ID file and who those people are.

Once they have been identified, the following procedure can be used to set 
multiple passwords for the ID file:

1. Select File -> Tools -> Server Administration... to display the Lotus Domino 
- Administration panel.

2. Select the server that you want to administer.

3. Click on the Certifiers icon, and select Edit Multiple Passwords....

4. Choose the Certifier ID (or any other ID file), and click on OK to display the 
Edit ID File Password List dialog box.

5. Type the number of passwords required to access the chosen ID file in the At 
least [number] passwords are required to access this ID field.

If you change the entries in these SACLs, a restart of the server is 
necessary to make the changes active. Therefore, it is advisable to enter 
group names instead of user names. If you have, for example, the group 
Terminations in the Not access server field and you add a user who left the 
company to this group, access to the server will be denied immediately 
without restarting the server.

Note

IBM Corporation's Global Notes Architecture, dated November 1995, 
recommends four passwords with any two being present for access to the 
Certifier ID.

Note
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6. Each administrator should then:

a. Type their name (this does not have to be their Lotus Notes user name) in 
the Authorized user field.

b. Type their password in the New password field.

c. Verify their password in the Confirm password field.

d. Click on Add.

7. Once all authorized users have been added, click on OK to return to the Lotus 
Domino - Administration screen.

Figure 177.  Edit ID File Password List - Completed

8.6  Secure Socket Layer (SSL)

SSL security is based on certificates used by both client and server. Lotus 
Domino uses the X.509 format for SSL certificates, which is currently the most 
widely-recognized certificate format. This allows servers and clients with 
certificates created by Lotus Domino certificate applications to exchange 
certificates easily between Lotus Domino and other applications.

Certificates contain a public key, a name, an expiration date, and a digital 
signature. Client certificates are stored in browsers, and server certificates are 
stored in files called key ring files. A key ring file is a binary file that is protected 
by a password and stores one or more certificates on the server’s hard drives. 
Public and Private keys are a unique pair of mathematically-related keys that are 
used to initiate SSL-encrypted transactions.

The link that allows a server and client to communicate is a Certification Authority 
(CA). Like a mutual friend, a CA vouches for the identity of a server and client by 
issuing certificates stamped with the CA’s digital signature and including the CA’s 
trusted root certificate in the key ring file. The digital signature ensures the client 
and the server that both the client certificate and the server certificate can be 
trusted. If the client and server can identify the digital signature on the certificate, 
then a secure SSL session can be established. Otherwise, the client and server 
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cannot authenticate each other, and the session cannot be established. Clients 
and servers identify digital signatures by comparing them against the trusted root 
certificate in their key ring files.

A CA can be an external, commercial certifier or an internal certifier that you 
establish at your organization using Lotus Notes and Lotus Domino. External and 
internal CAs create both server and client certificates.

You can use SSL for the following tasks:

  • Web Server (HTTP server task)
  • Server Web Navigator (Web server tasks)

  • Network News Transfer Protocol (NNTP server task)
  • Post Office Protocol (POP3 server task)
  • Internet Messaging Access Protocol (IMAP server task)
  • Lightweight Directory Access Protocol (LDAP server task)

You must set up SSL and configure the Lotus Domino Server before Lotus 
Domino secures the transactions.

SSL offers the following security benefits:

  • Privacy
Data is encrypted to and from clients, so privacy is ensured during 
transactions.

  • Message Validation
An encoded message digest accompanies data to detect any message 
tampering.

  • Server Authentication
The server certificate accompanies messages to assure the client that the 
server identity is authentic.

  • Client Authentication
The client certificate accompanies messages to assure the server that the 
client identity is authentic. Client authentication is optional and may not be a 
requirement for you organization.

8.6.1  Enabling SSL on a Server
You can enable SSL on a server using one of two methods:

1. Enable SSL for a server only. This secures transactions, validates messages, 
and authenticates server identity, but does not authenticate client identity. You 
can control access to databases on the server by user name if you set up an 
Internet password for the user in the Person document and use basic 
password authentication.

To enable SSL for servers only:

  • The servers must have certificates from an internal or external Certification 
Authority (CA).

  • The clients must have the servers CA certificate marked as a trusted root.

You cannot authenticate client certificates with the Server Web Navigator.

Note
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2. Enable SSL for clients and servers. This method secures transactions, 
validates messages, and authenticates both the server and client identities. 
You can set database access control using individual client user names.

To enable SSL for clients and servers, in addition to the steps above:

  • The clients must have certificates from an internal or external CA.
  • The servers must have the client’s CA certificate marked as a trusted root.
  • The clients must have the server’s CA certificate marked as a trusted root.
  • Every client must have a Person document in the Public Address Book that 

contains the SSL public key certificate.

8.6.1.1  Server Certificate Administration
The Server Certificate Administration application (certsrv.nsf) lets you request 
server certificates from either an internal or external Certification Authority (CA) 
and manage your server certificates in a key ring file. 

The Server Certificate Administration application lets you:

  • Create the server certificate and key ring file, which holds your server 
certificate.

  • Send a request to a CA to sign the server certificate. 
  • View requests that you submitted to CAs.
  • Add a CA certificate as a trusted root to the server certificate.
  • View information about certificates in the key ring file.
  • Control client access to servers by adding or removing trusted root certificates 

from the key ring file.
  • Create a self-certified certificate for testing purposes.

The screen shown in Figure 178 on page 204 is the navigator screen for the 
Server Certificate Administration application. There are four steps involved with 
setting up SSL for your server and to use these steps you must be running Lotus 
Domino Release 4.6.1.
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Figure 178.  Server Certificate Administration Navigator Screen

The first step in enabling SSL is to create a key ring. Once the key ring is created, 
a public/private keypair is automatically generated and stored in the key ring. To 
create a key ring, click on the first step on the navigator screen Create Key Ring.
204 Lotus Domino Release 4.6 on IBM RS/6000



Figure 179.  Create Key Ring

Once you have filled out all the information that is required, click on the Create 
Key Ring button on the bottom of the screen.

  • This step creates a password-protected file on the server’s hard drive that 
holds the server certificate and trusted roots.

  • A summary screen appears next with all the parameters you specified, 
signifying that the key ring has been created.

  • Click on the OK button, which will bring you back to the navigation screen 
where you will then choose the next step, which is Create Server Certificate 
Request. A certificate is required for the public key in the key ring you 
created. Use the following form, shown in Figure 180 on page 206, to create 
the certificate request.
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Figure 180.  Creating a Server Certificate Request

Before you move on from this step, you should have already chosen a Certificate 
Authority that will provide you with a certificate that will verify your identity.

Be sure to read the documentation provided by your CA that will specify how to 
send your request, whether it be through e-mail or copy and paste it into their 
Web site.

Once you have completed all the required fields in the form, click on the Create 
Certificate Request button at the bottom of the screen (Figure 180) and your 
certificate request will be created.

When the screen appears be sure to copy the bottom portion of the screen to 
your clipboard, as this information is what the external certificate will use to verify 
your identity. To copy this, highlight the section starting with BEGIN NEW 
CERTIFICATE REQUEST all the way down to END NEW CERTIFICATE 
REQUEST. Once this text is highlighted, click with the right mouse button and 
choose copy from the menu. After you have completed this click the OK button, 
which will prompt you for the password (Figure 181 on page 207) that you 
entered in the first setup screen and then bring you back to the navigation screen.

  • Browse to the Certificate Authority application on the CA Web site. If you are 
using Microsoft Internet Explorer, make a TCP/IP connection to the server. 
Internet Explorer does not allow you to accept site certificates into your 
browser. If you are using Netscape, it is recommended that you connect to the 
Certificate Authority application using SSL.

  • If you are using Netscape, accept the site certificate in your browser using the 
instructions provided by the browser software.
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  • Click on Request Server Certificate.

  • Enter your name, e-mail address, phone number, and any comments to the 
CA.

  • Paste your certificate in the dialog box and click Submit Certificate Request.

Figure 181.  Password Prompt

After you have entered the password, choose the third step from the navigation 
screen.

Figure 182.  Install Trusted Root Certificate
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The external CA that you choose will provide you with their certificate contents 
that you will copy and paste into the Certificate form clipboard field; this is what 
your server will use to verify the external CAs identity. When you have pasted the 
contents of the clipboard into the Certificate form clipboard field, click on the 
Merge Trusted Root Certificate into Key Ring button at the bottom of the 
screen, and again, you will be prompted for another password, as shown in 
Figure 181 on page 207. Enter the password and proceed to step four from the 
navigation screen.

This step adds the CA’s certificate as a trusted root to the server key ring file so 
the server trusts certificates signed by this CA.

Figure 183.  Merge Certification into Key Ring

This final step adds the signed certificate from the CA to the server’s key ring file. 
The last step in configuring your server to use SSL is to edit the server document 
in the Public Address Book.

1. Open the Public Address Book.

2. Choose the Servers view.

3. Double click on the server that you want to enable SSL transactions.

4. Select the Internet Port and Security Configuration section.

5. In the SSL protocol Version field, select one of the following:

This setting applies only to NNTP, IMAP, LDAP, and POP3 connections.

Note
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  • V2.0 only - Allow only SSL 2.0 connections.

  • V3.0 handshake - Attempts an SSL 3.0 connection. If this fails and the 
requestor detects SSL 2.0, it then attempts to connect using SSL 2.0.

  • V3.0 only - Allows only SSL 3.0 connections.

  • V3.0 and V2.0 handshake - Attempts a SSL 3.0 connection, but starts with 
a SSL 2.0 handshake, which displays relevant error messages. Makes an 
SSL 3.0 connection if possible.

  • Negotiated - (default) Attempts an SSL 3.0 connection. If this fails, 
attempts to connect using SSL 2.0. Use this setting only if you are having 
connection problems due to incompatible protocol versions.

6. In the SSL key file field enter the name of the key ring file that the server uses.

7. In the column for the protocol for which you enable SSL, select Enabled in the 
SSL port status field and, if necessary, change the SSL port number.For 
example, to enable SSL for the Lotus Domino Web server, select Enabled in 
the SSL port status field in the Web column.

8. Make sure the client has the server CA certificate marked as a trusted root, 
and the server has the client CA certificate marked as a trusted root.

9. Make sure the client has a certificate issued from an internal or external CA 
and that the client has a Person document with their public key certificate in 
the Public Address Book.

10.In the Internet Port and Security Configuration section, in the column for the 
protocol for which you want to enable SSL, select Yes in the Client certificate 
field.
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Figure 184.  Server Document - Port and Security Configuration Section

11.Close and save the document.

12.You may have to restart the server for the changes to take effect.

8.7  AIX Security

There are many aspects of AIX security. Just a few of them will be highlighted in 
this section:

  • UNIX Passwords
  • UNIX File Permissions
  • NFS Export Security

8.7.1  Security Concepts
User Accounts

  • Each user has a unique name, ID, and password.
  • File ownership is determined by user ID
  • The ownership is usually the user that created the file, but ownership can be 

transferred by root.
  • Default users:
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root Super user
adm, sys, bin IDs that own system files but cannot be used for login

Groups

  • Users who need to access the same files can be placed in a single group.
  • Group ID gives an extra level of file ownership.
  • Default groups:

system Administrators
staff Ordinary users

The security of the system is based on a user being assigned a unique name, 
user ID (UID), and password. When the user logs in, the UID is used to validate 
all requests for the access.

When a file is created, the UID associated with the process that created the file is 
assigned to the file. Only the owner or root can change the access permissions.

Users that require shared access to a set of files are placed in groups. A user can 
belong to multiple groups. Each group has a unique name and Group ID (GID). 
The GID is also assigned to a file when it is created.

8.7.2  UNIX Passwords
Don't use trivial passwords. There are public domain programs available on the 
Internet that can crack the passwords. Any word that can be found in dictionaries 
is a trivial password.

Try to protect your password file. Avoid using the Network Information System 
(NIS) as your login method. With NIS, you make the password file available to 
everyone on your network.

If the root password is known by too many people, no one can be held 
accountable. The root password should be limited to a single system 
administrator. The fewer people who know the root password the better. The 
same goes for user notes. Try to limit the amount of people who know this 
password as well.

Attempts to become root through su can be investigated. Successful and 
unsuccessful attempts might be logged by the audit system.

8.7.3  Security Logs
  • /var/adm/sulog

The sulog file is an ASCII text file that can be viewed with the commands more 
or pg. In the file, the following information is recorded: date, time, system 
name and login name. The file also records whether or not the login attempt 
was successful (it indicates a successful login by a + and a failed login by a -).

  • /var/adm/wtmp and /etc/utmp
The /etc/utmp file contains a record of users logged into the system, and the 
/var/adm/wtmp file contains connect-time accounting records. To obtain 
information from either file, use the who command with the file name. The who 
command normally examines the /etc/utmp, but you can specify either one of 
the named files as arguments to the command.
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  • /etc/security/failedlogin
The last command can also be used to display, in reverse chronological order, 
all previous logins and logoffs still recorded in the /var/adm/wtmp file. The 
/var/adm/wtmp file collects login and logout records as these events occur and 
holds them until the records are processed by the accounting commands.

For example:

last root Displays all the recorded logins and logoffs by the user root.
last reboot Displays the time between reboots of the system.

8.7.4  UNIX File Permissions
The files on the /usr/domino/lotus file system, the Lotus Software System, have to 
be available to all the users that need to run the Lotus software. The default 
permissions are secure enough.

The notes user home directory must be accessible only by the notes user. You 
don't want a user to copy a confidential database to their directory. Some files 
that are critical are the user.id, notes.ini, cert.id, and server.id. If they aren't 
password protected, you must ensure that only the notes user has the access to 
them.

To protect the notes home directory, log in as notes and run the command:

$ cd ; chmod -R go-rwx

To change the ownership of files and directories, log in as the current owner of 
the file or directory, in this case it would be user root, and run the command chown. 
For example:

# ls -l
-rw-r--r--   1 root     system         0 Aug 14 16:48 myfile 
# chown ausres12 myfile
# ls -l
-rw-r--r--   1 ausres12 system         0 Aug 14 16:48 myfile 

To change the group of the files or the directory, log in as the current owner of the 
file or directory, in this example it would be user ausres12 and run the command 
chgrp. For example:

$ ls -l
-rw-r--r--   1 ausres12 system         0 Aug 14 16:48 myfile 
$ chgrp notes myfile
$ ls -l
-rw-r--r--   1 ausres12 notes          0 Aug 14 16:48 myfile 

To change both owner and group at the same time, log in as the current owner of 
the file, in this example it would be user root, and run the command chown but with 
different arguments. For example:

# ls -l
-rw-r--r--   1 root     system         0 Aug 14 16:48 myfile 
# chown ausres12.notes myfile

Use the command above with caution. It follows the links and may change 
something that you don't wantchanged.

Note
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# ls -l
-rw-r--r--   1 ausres12 notes          0 Aug 14 16:48 myfile 

Use the umask command to force the permissions of the new files. Put the 
following line in the notes user’s .profile file:

umask 077

You also have to protect the UNIX users’ Lotus Notes data directory. This can be 
done in the same manner as explained for the server’s data directory in 8.7.4, 
“UNIX File Permissions” on page 212.

8.7.5  File System Security
All file system objects (including files, directories, special files, link files, symbolic 
link files, and pipes) have security mechanisms associated with them. The most 
commonly used is the access control list (ACL), but the following additional ways 
of controlling file security can be used:

Base ACLs Specifies the permissions for the owner, group, and others. 
These permissions are controlled through the chmod 
command. 

Extended ACLs Provides finer access control than the base ACLs. 

Status of Extended ACLs
The extended ACL must be enabled for a file system object; 
otherwise, the extended ACL is ignored.

Owner ID This is the user ID of the owner of the file system object. Only 
this user ID has the permissions granted for the owner of the 
object.

Group ID This is the ID of the group associated with the object. Only 
members of this group have the permissions granted for the 
group associated with the object.

Sticky bit If the sticky bit is set for a directory, only the owner of the 
directory or the owner of a file can delete or rename a file 
within that directory. This can be set with the t flag with the 
chmod command.

TCB bit If the TCB bit is set for a file system object, it identifies that 
object as part of the Trusted Computing Base (TCB).

umask The umask environment parameter specifies the default 
permissions for any file or directory created.

Status of the file system
A file system can be mounted with read/write or read-only 
permissions.

Follow these guidelines when dealing with file system objects:

  • In general, do not use extended ACLs. For most systems, base ACLs are 
sufficient for administration. If you do need the extra security control provided 
by extended ACLs, use them only when necessary and in an organized 
manner. Maintaining relevant entries in many extended ACLs can become 
very time-consuming. Also, do not use extended ACLs at all if you are in a 
heterogeneous network because they are only recognized by AIX systems.
Security and Lotus Domino 213



  • Use the sticky bit on directories where everyone has write permissions. For 
example the /server1/notesr4/mail directory for Lotus Domino.

  • Protect user .profile files with 740 permissions.
  • Do not let users have write access to system directories.
  • Do not change permissions on any files or directories installed as part of the 

system. Changing those permissions affects system integrity.

8.7.6  Validating the User Environment
The commands pwdck, usrck, and grpck can be executed by root or any user in the 
security group to clean up after a change to the user configuration. Because they 
run with root permissions, they give administrative users the ability to make 
necessary changes to the /etc/security/passwd file in a controlled way, without 
knowing the root password.

The usrck command verifies the validity of the user definitions in the user 
database files by checking the definitions for ALL the users or for the users 
specified by the user parameter. You must select a flag to indicate whether the 
system should try to fix erroneous attributes.

All the options for pwdck, usrck, and grpck are as follows:

-n reports errors but does not fix them.
-p fixes errors but does not report them.
-t reports errors and asks if they should be fixed.
-y fixes errors and reports them.

8.7.7  Documenting Security Policy and Setup
  • Identify the different types of users and what data they will need to access.
  • Organize groups around the type of work that is to be done.
  • Organize ownership of data to fit with the group structure.
  • Set SVTX on shared directories.
  • Remember that UNIX/AIX has no concept of application ownership.

AIX security in itself only controls access to the system and it’s files and 
directories. Once an additional application (for example, Lotus Domino) is 
installed, you must further the application security by using tools within Lotus 
Domino. This last function cannot be provided for by AIX.

8.7.8  NFS Export Security
When using NFS, never export a read-write file system, without restricting the 
hosts’ access. You have to specify the hosts that are allowed to mount the file 
system. If you don't, all the hosts connected to your IP network will be able to 
mount your file system. This might be your LAN, your company or possibly the 
entire Internet, depending on your site’s setup.

You have to pay attention to the groups and user numbers of your file system 
while exporting it. If you are exporting a file system with files owned by a regular 
user, ensure that, on the machines that mount this file system, the same user 
exists with the same user ID.

For example, an NFS server exports a file system with files owned by a user with 
user ID 210. A host mounts this file system and has another local user with the 
same ID. This local user will own these files and will be able to do anything with 
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them. This means, of course, that you must trust the remote host completely. A 
user with root access to the remote host could easily create users with UID’s 
matching those on the exported file system, and thereby, gain read or write 
access to the files.

8.7.9  AIX Security Checklist
The following list is intended to serve as a basic reminder of the most important 
things to keep in mind when trying to secure your AIX server. It is not a detailed 
list, however; AIX security is a very large topic, and we can only begin to scratch 
the surface in this redbook. Don’t believe that this list tells you everything that you 
need to know about AIX security, because it doesn’t. Also, when designing 
secure AIX servers, new issues will appear, as well as new methods to deal with 
those new issues. Keep this in mind and you are well on your way to achieve AIX 
security awareness.

  • Keep your servers and server consoles physically protected (locked away) 
and restrict access to as few people as possible.

  • If you are on the Internet, set up router filters or firewalls to minimize the 
number of services accessible from outside your domain.

  • Examine carefully services offered by inetd and the portmapper. Eliminate any 
that aren't explicitly needed. A Lotus Domino Server will probably need a 
minimum of AIX services; most can be disabled. Use an inetd wrapper if you 
can, if, for no other reason, than to log the sources of connections to your 
host. This will help you to detect and prevent network attacks.

  • Protect your root account as well as you can. Restrict root access to one or 
very few persons.

  • Disable root network logins.

  • Don't run NIS unless it's absolutely necessary. Use NFS as little as possible.

  • Never export NFS filesystems unrestricted to the world. Specify fully-qualified 
host names when exporting. Export file systems read-only when possible.

  • Fortify and protect Lotus Domino Servers. Don’t allow any regular AIX user 
accounts on these hosts. If you need an AIX server where many users will use 
the Lotus Notes client, set up a separate server for that task.

  • Use shadow passwords and the password restriction parameteres in AIX to 
disallow poor passwords. Enable password check methods to ensure good 
user passwords. Disable or delete unused/dormant system or user accounts.

  • Force users to change their passwords every once in a while. Don’t overdo it 
however. If users need to change their passwords too often, they tend to write 
them down instead of memorizing them. The root password is an exception to 
this rule. Change it often and make sure it is safe.

  • Install all AIX security patches as soon as possible on all of your hosts.

  • Eliminate trust relationships unless there is an absolute need for it. Create a 
cron job to remove .rhosts files that have not been authorized.

  • Check your log files regularly. They are your key to uncovering any attempts to 
compromise system security.

  • Use all available tools that can help you check your system. There are many 
good tools in the Public Domain that you can use for free.
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  • Keep abreast of current literature and security tools; communicate to others 
about security problems and incidents. Read security newsgroups and 
subscribe to the various security mailing lists on the Internet. You can find a 
subscription Web page at http://www.rs6000.ibm.com/resource/maillist.html.

There are many resources on the Web on AIX security. We can’t list all of them 
here, but a very good starting point for finding information is 
http://www.ers.ibm.com/security-links/index.html.
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Chapter 9.  Lotus Domino and the World Wide Web

The Internet connects millions of people together in a global work and recreation 
domain. The development of the World Wide Web (WWW) has significantly 
changed the way people communicate, exchange information, and do business. 
Lotus Domino allows the seamless integration of the World Wide Web with the 
proven Lotus technology. This provides a way for users to organize, share, 
collaborate, and integrate information in a secure environment, both for Lotus 
Notes clients and Web browsers.

Before Lotus Domino was available, Lotus InterNotes Web Publisher was the 
only way to publish Lotus Notes databases to the World Wide Web, but it has 
been static publishing. However, Lotus announced in July 1997 that InterNotes 
Web Publisher will no longer be developed beyond the 4.0 release. As a result, 
this redbook is focussing on the WWW capabilities of Lotus Domino, based on 
Lotus Domino Release 4.6.1. 

Lotus Domino provides integrated solutions that seamlessly merge Lotus Notes 
and the Internet. Specifically, these solutions are:

Lotus Domino Web Server
Internet users with any Web browser can access information on Lotus 
Domino servers. 9.1, “Lotus Domino Server” on page 217 provides the 
information to setup and administer a Lotus Domino site.

Lotus Domino Virtual Server - multihomed Web server on one server
If you want to maintain separate sites without installing different 
systems or using different partitions, you can set up virtual servers for 
which a single Lotus Domino Web server can host several Web sites. 
9.2, “Lotus Domino Virtual Server” on page 235 describes the basic 
tasks.

Lotus Domino Server Web Navigator and Personal Web Navigator
With these integrated WWW browsing facilities, users can navigate 
the Internet even without a direct Internet connection or a separate 
browser. See 9.3, “Web Navigator” on page 242 and 9.4, “Server Web 
Navigator” on page 249 for details.

Web administration tool (Lotus Domino Server administration with a web browser)
You can setup your Lotus Domino server to be administered by a Web 
browser client. See 9.5, “Server Web Administration Tool” on page 259 
for more detailed information.

Support for various Internet protocols
For information regarding the various internet protocols, such as 
POP3, IMAP and others, see Chapter 10, “Connectivity and Internet 
Communications” on page 265.

9.1  Lotus Domino Server

Lotus Domino is a server technology that transforms Lotus Notes into an Internet 
application server. Lotus Domino brings together the open networking 
environment of Internet standards and protocols with the powerful application 
development facilities of Lotus Notes, providing you with the ability to rapidly 
develop a broad range of business applications for both Internet and intranets.
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Using Lotus Domino, you can build applications which leverage access control to 
databases, views, pages, forms, and even fields. This allows you to present 
information or commands differently to different users, though all the information 
resides within one database or application.

Lotus Domino extends a rich set of Lotus Notes features for Web application 
development, such as:

  • Lotus Notes databases offer a programmable content store.
  • Full-text search capabilities, with automatic indexing.
  • Integrated application development.
  • Messaging and workflow.
  • Enterprise integration.
  • Lotus Notes replication.

Lotus Domino lets you develop interactive Web applications that:

  • Deliver dynamic content based on time, user identity, user access level and 
client type.

  • Host collaborative applications such as threaded discussions.
  • Extend the reach of RDBM (Relational Database Manager) systems to the 

Web.
  • Streamline and automate business processes with workflow applications.

Lotus Domino also offers a rich framework for securing Web applications, for 
example:

  • Lotus Domino leverages the Lotus Notes Access Control model to provide a 
framework for securing Web applications.

  • The Lotus Notes Public Address Book, for managing Web users as individuals 
or in user groups.

  • Sample registration application, which automates creating user accounts.
  • Database Access Control List for controlling access rights to information from 

the database down to the field level.
  • Roles-based assigning of access rights to information.
  • Lotus Domino supports Basic Web Authentication.
  • Secure Sockets Layer (SSL) support for server authentication and encryption 

of data in secured sessions.

9.1.1  How the Lotus Domino Web Server Works
This section provides a brief technical overview of how Lotus Domino works. 
Figure 185 shows the main components working together:

1. Lotus Domino Server, performing classical Lotus Notes Server functions

2. HTTP Server, performing the handling of HTTP requests

3. Lotus Domino Engine, performing the dynamic conversion of Lotus Notes 
databases and documents into HTML on request of the HTTP server

The HTTP server can serve both dynamically generated pages and static 
contents (HTML) and CGI (Common Gateway Interface) programs as any other 
Web server. You do not have to have a different server for static pages.

Note
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Let’s take a closer look on how the process works:

Figure 185.  Lotus Domino Server Components

A Web client will direct a HTTP request to the Lotus Domino HTTP server. The 
Lotus Domino HTTP server examines the URL (Uniform Resource Locator) in the 
incoming request and determines if the request is for an item in a Lotus Notes 
database or if it's for a plain HTML file (located in the AIX file system).

If the request is for an HTML file, Lotus Domino acts just like any other HTTP 
server and serves the file to the Web client. When the request is for something in 
a Lotus Notes database, Lotus Domino interacts with the Lotus Notes database 
to serve the information to the Web client or to put information from the Web 
client into the Lotus Notes database.

Lotus Domino automatically translates Lotus Notes constructs, such as 
navigators, views, documents, and links, into HTML for display in the Web client. 
For example, Lotus Notes links and action buttons become URLs in the Web 
client. You simply develop your Web application in Lotus Notes, and Lotus 
Domino does the rest. Lotus Domino supports extensions that enable Web clients 
to explore Lotus Notes functionality. For example, to open a database, the URL 
might have an extension as in: http://notes.net/lbytes.nsf?OpenDatabase.

For Lotus Domino system requirements on RS/6000 please refer to the Lotus 
Domino release notes. You could also use the sizing tools available to you if you 
are a member of the POWERNET program (http://powernet.rs6000.ibm.com). In 
general, you should consider at least a few points:

  • Bandwidth of server’s (TCP/IP) network connection, depending on the number 
of clients and amount of data retrieved per request (for example, small text 
compared to large images).

  • Percentage of dynamically generated pages versus static pages; of course, 
CPU load and memory requirements will increase if more pages have to be 
created dynamically in a given time.

  • Provide diskspace for static pages, logfiles, and paging, as required.

  • Integration with other applications (for example, relational databases) on 
dynamically building pages; impact on CPU and memory.
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9.1.2  Specify HTTP Settings for the Lotus Domino Web Server
Whether you specified to start the http Task at the setup of the server, or later 
during standard administration tasks, the following steps have to be performed:

1. Double click on the Public Name and Address Book icon.

2. Select the View -> Server\Servers to display the list of server documents.

Figure 186.  List of Server Documents

3. Select the server document that you want to define as the Lotus Domino Web 
server and click on Edit Server.

4. Click on HTTP Server section.

5. Modify each of the paragraphs in that section to accommodate your needs. 
There are 11 paragraphs you may wish to modify. For most entry fields, you 
will get context help by pointing with the mouse to the field name and keeping 
the left button pressed. A few of them, which we considered important, 
especially for Lotus Domino on AIX, are described below.

9.1.2.1  Basics and Mapping
Figure 187 includes the most important settings on setting up a HTTP server. 
Normally, you can leave the hostname blank to use the TCP/IPs hostname. Our 
example shows the setting if there are multiple http Tasks on one system (for 
example, on a partitioned Lotus Domino server). To prevent getting errors as 
specified in 15.12, “Errors at Startup of http Task” on page 426, you would enter a 
fully qualified hostname, as shown, and set Bind to host name to Enabled.

It is strongly recommended to change settings in the server document within 
the NAB. Do not edit the files http.cnf and domino.cnf directly as you might be 
used to from earlier versions or other Web servers. After making changes, stop 
the http task and start it again.

Note
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The DNS lookup should normally be disabled, because performance of server 
degrades when looking up the DNS name for each connecting client.

The number active threads value could be increased if you have a powerful SMP 
(Symmetric Multi-Processing) system and heavy HTTP traffic. It is basically a 
tuning parameter, telling how many threads are available for answering requests.

The Mapping section defines the directories for keeping static HTML files, icons, 
and CGI programs, as well as the Home URL. HTML directory, Icon directory and 
CGI directory are relative to the server’s data directory. You might want to enter 
fully qualified paths if you would like a different location. CGI URL path and Icon 
URL path refer to URLs, not to file systems.

If Home URL is specified, someone entering http://ah1610f in their browser 
would get this Home URL. Adding /?Open to this URL gives the inventory of all 
databases available on the server contacted. This is equivalent to the File -> 
Database -> Open in Lotus Notes.
If you would like to open a certain database by default, you could enter 
(readmes.nsf is used as an example) /readmes.nsf?OpenDatabase instead.

If you would like to start with a static HTML file, you must leave Home URL blank 
and enter the filename into the field Default home page.

Figure 187.  HTTP Settings: Basics and Mapping

9.1.2.2  Cache Settings
You can specify certain settings for disk cache and memory cache as shown in 
Figure 188. The settings for disk cache are mostly self-explanatory and can be 
adjusted as required. Garbage collection runs after the specified interval or when 
the Maximum cache size is reached and cleans the cache with a least frequently 
used algorithm.

Specifying a URL that begins with a / (slash) will cause Lotus Domino to 
return the information in that URL directly to the browser. The browser will 
still display http://ah1610f/ as the URL. Modify the field Home URL to just 
?Open and the browser will change the URL shown in its location field.

Hint
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The meaning of the memory cache settings cannot be retrieved by the context 
help in the server document; so here is a short description. You might also want 
to take a look at the helpadmn.nsf installed with the server documentation on your 
system.

Maximum cached commands
Lotus Domino must convert some HTTP server commands, such as 
OpenDatabase and OpenView, to HTML before the server can process the 
commands. This conversion process takes time. This field specifies 
how many commands you want to store in memory; so the next time a 
user issues the server command, it is immediately available.

Maximum cached (database) designs
When a user opens a database, Lotus Domino must complete a 
procedure that maps the design element names to an identification 
number. This mapping procedure takes time. Use this field to specify 
how many elements you want to store in memory.

Maximum cached users
After a user successfully authenticates with a server, Lotus Domino 
stores in memory the user’s name, password, and the list of groups to 
which the user belongs. Use this field to increase the number of users 
for whom Lotus Domino stores this information. You should clear the 
cache for a user periodically using the Cached user expiration field 
to force user to authenticate again.

Figure 188.  HTTP Settings: Cache

9.1.2.3  Logging Settings
There are couple of logging options you may want to set on the server. The fields 
Access log and Error log are not longer used since Lotus Domino 4.6. As there is 
nothing special for AIX, but most definitions are related to the question of how to 
administer and control a Web server, there are no details provided here. You 
might want to log on to a Lotus Domino database instead of to flat files. If you do, 
you should enable Domlog.nsf. Keep in mind that the log database has to have 
that name (domlog.nsf).
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Figure 189.  HTTP Settings: Logging

9.1.2.4  Timeouts, Character Set, and Conversion/Display Settings
These settings are well explained within the contextual help of the server 
document. They may be adjusted to suit your needs.

Figure 190.  HTTP Settings: Timeouts, Character Set, and Conversion/Display

Input Timeout 
defines the time a client can take to send requests to the server after 
connecting.

Output Timeout
defines the time the server can take to send output to clients.

CGI Timeout 
defines the time a CGI program may take to finish. After the specified 
time, the server sends a warning message to the program and 
terminates it after an additional five minutes.

Image conversion format:
GIF and JPEG are available.

Interlaced Rendering
describes the way an image is presented on loading.
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Default lines per view page
defines the number of lines the Lotus Domino server displays for a 
notes view by default.

Maximum lines per view page
limits the lines per notes view displayed by the server.

Maximum search results limit
limits the results returned after a search.

Default Character set group
defines the character set used to display text to browsers; depending 
on the group set, you may have a additional choice for a special 
character set. 

9.1.3  Specify Internet Port and Security Settings for the Web Server
The Lotus Domino Web Server allows you to open your Lotus Notes system to 
Web users, while still protecting the information with a powerful array of security 
features.

There are a couple of options to restrict or grant access to the HTTP services 
provided by the Lotus Domino server. Some of the security features you might 
consider for Web users are:

  • Registration of Web users in the Public Address Book in addition to Lotus 
Notes clients.

  • Decide how to handle anonymous users.
  • Adding optional encryption to HTTP transactions by activating the Secure 

Sockets Layer (SSL) at the server.

Basically, you may enable or disable ports which are used for accessing the 
server, and you may choose between common authentication mechanisms. The 
place to do this is in the section Internet Port and Security Configuration in the 
server’s document in the Public NAB (Name and Address Book). This chapter 
briefly describes the setup of these options.

For an overview of SSL, see Chapter 8, “Security and Lotus Domino” on page 
189. For an example on how to test SSL, see 9.1.7, “Sample SSL Setup Session” 
on page 231. For a discussion on how to restrict access to Web users based on 
Lotus Domino security features, see 9.1.6, “Restricting Access to the Lotus 
Domino Web Server” on page 230.

9.1.3.1  SSL Settings
As you may see in Figure 191, you have to provide a SSL key file, and to make a 
decision whether to accept expired SSL certificates or not. Take a look at the 
information in parentheses for the SSL protocol version. The key file has to be 
created as described in the Lotus Domino documentation. For testing purposes, 
we created a SSL key file selfcert.kyr by using the Server Certificate 
Administration database certsrv.nsf on the server ah1610f. The default key file 
name is keyfile.kyr.
224 Lotus Domino Release 4.6 on IBM RS/6000



Figure 191.  SSL Settings in Server Document

9.1.3.2  Internet Port Configuration
This section defines which ports are used for pure TCP/IP connections and SSL- 
enabled connections. You may decide here whether anonymous connections and 
password authorized connections are allowed. Disabling anonymous users forces 
everybody who connects to this server to present a valid user name and http 
password. Disabling password authorized access would prevent access for every 
database, which can not be read by default. For the port numbers, well-known 
ports are specified in the server document by default. You would not change that 
without a specific requirement.

Remember to restart the http task after making changes in that section. A sample 
SSL setup session is shown in 9.1.7, “Sample SSL Setup Session” on page 231. 
That example uses the parameters shown in Figure 191 and Figure 192.

Figure 192.  Internet Port Configuration for HTTP in Server Document

9.1.4  Starting and Stopping the Lotus Domino Web Server
There are two ways to start the Lotus Domino Web server:

  • To start it manually, enter the command load http at the Lotus Domino server 
console.

  • To start it automatically at server start-up, modify the ServerTasks variable in 
the notes.ini file adding the keyword value of http.
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To get statistics for the Lotus Domino server, enter the commands show tasks and 
show domino at the servers console, show stat net gives network related statistics. 
Below are a few examples of what you would see:

The following screen shows an excerpt from sh tasks. Note the HTTP Web 
server.

The command show domino results to all settings for the http task which are 
currently set. Thereby, you can verify whether the settings in the NAB are active. 
You also get some access statistics. The next screen shows only a small excerpt 
to provide an idea of the information available.

If you modify the notes.ini file while the Lotus Notes Server is running, you 
must shut down the server and restart it for your changes to take effect. Also if 
you are changing settings in the HTTP Server section as described above, you 
have to restart your http Task.

Note

> sh stat net
NET.Log.ah1610f/ibm.UnwrittenEntries = 2
NET.TCPIP.BytesReceived = 7,671,136
NET.TCPIP.BytesSent = 3,784,090
NET.TCPIP.Sessions.Established.Incoming = 120
NET.TCPIP.Sessions.Established.Outgoing = 10
NET.TCPIP.Sessions.Limit = 65535
NET.TCPIP.Sessions.LimitMax = 65535
NET.TCPIP.Sessions.LimitMin = 10
NET.TCPIP.Sessions.Peak = 4
NET.TCPIP.Sessions.Recycled = 0
NET.TCPIP.Sessions.Recycling = 0

> sh tasks
Lotus Domino   Server (Release 4.6.1c (Intl) for UNIX) 29/07/98 17:56:27

Server name:            ah1610f/ibm - Partition on itso smp
Server directory:       /ah1610f/notesr4
Partition number:       2
Elapsed time:           1 day 02:31:19
Transactions/minute:    Last minute: 0; Last hour: 16; Peak: 872
Peak # of sessions:     2 at 28/07/98 19:11:27
Transactions:           17301
Shared mail:            Not enabled
Pending mail:  0        Dead mail:  0

      Task                 Description

 Database Server      Perform console commands
 Database Server      Listen for connect requests on TCPIP
 Database Server      Idle task
 Database Server      Idle task
 Database Server      Idle task
 HTTP Web Server      Ready
 Billing              Idle
 .
.
.
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9.1.5  Accessing the Lotus Domino Web Server from a Browser
After you’ve completed installation, specified your configuration settings, and 
started Lotus Domino, you should access the Lotus Domino Web server using a 
Web browser to verify that the installation procedure was successful.

1. Make sure the Lotus Domino server is up and running, and the http task is 
active.

2. In the Web browser’s location box, enter the host name you specified in the 
server record. For example to access our Lotus Domino Web server ah1610f 
you would enter http://ah1610f.itsc.austin.ibm.com.

3. The result should look similar to the next figure, if you did not change the 
Home URL. (http://ah1610f.itsc.austin.ibm.com results in 
http://ah1610f.itsc.austin.ibm.com/?Open and displays the selection of all 
databases on the server; we specified only ?Open as the Home URL to see 
browsers location field change.)

4. If you attempt to access a database from a Web browser for which the default 
access is No Access (for example, your mail file) you will be prompted for a 
user ID and password to authenticate with the Lotus Domino server.

> sh stat domino 
Domino.BuildName = Release 4.6.1c (Intl)

  Domino.BuildNumber = Release 4.6.1c (Intl)
  Domino.BuildPlatform = AIX
  Domino.BuildVersion = Lotus-Domino Release 4.6.1c (Intl)
  Domino.Cache.Command.Count = 0
...
Domino.Cache.User.MaxSize = 64

...
Domino.Config.ActiveThreads.Max = 40

...
Domino.Config.Cache.Size.Max = 50
  Domino.Config.Directory.CGI = /ah1610f/notesr4/domino/cgi-bin
  Domino.Config.Directory.HTML = /ah1610f/notesr4/domino/html
...
Domino.Config.WelcomePage = default.htm

  Domino.Requests.Per1Day.Peak = 2
  Domino.Requests.Per1Day.PeakTime = 07/29/98 15:56:00
  Domino.Requests.Per1Day.Total = 2
  Domino.Requests.Per1Hour.Peak = 2
  Domino.Requests.Per1Hour.PeakTime = 07/29/98 15:51:00
  Domino.Requests.Per1Hour.Total = 0
  Domino.Requests.Per1Minute.Peak = 2
  Domino.Requests.Per1Minute.PeakTime = 07/29/98 15:51:00
  Domino.Requests.Per1Minute.Total = 0
  Domino.Requests.Per5Minute.Peak = 2
  Domino.Requests.Per5Minute.PeakTime = 07/29/98 15:51:00
  Domino.Requests.Per5Minute.Total = 0
  Domino.Requests.Total = 2
  Domino.StartTime = 07/29/98 15:50:55
  Domino.Threads.Active.Peak = 1
  Domino.Threads.Peak.Time = 07/29/98 15:50:56
  Domino.Threads.Peak.Total = 40
  Domino.Threads.Total = 40
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Figure 193.  Sample Web Browser Connection to a Lotus Domino Server
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9.1.6  Restricting Access to the Lotus Domino Web Server
You may have wondered while playing around with the Web browser, as shown in 
Figure 193 on page 229, that you can read every database. That happens 
because the Internet Port Configuration section in 9.1.3.2, “Internet Port 
Configuration” on page 225 stated under Authentication options: Anonymous: 
Yes. Based on that you have two possibilities:

1. For each database where you do not want read access for an anonymous 
Web user, you have to change the ACL as shown in the example below:

Figure 194.  ACL with User Anonymous

2. If you want to generally prevent anonymous users from accessing your Web 
server, but allow authorized users to connect to the server, you must set 
Anonymous to No as shown below in the server document in the NAB. But 
remember: This setting needs a restart of the http task to be enforced. In 
general, grant anonymous users Reader access for an information database 
or Author access for an interactive database, unless there is a specific 
security concern. Any Web users who access a database are classified as 
anonymous when they aren't prompted for a name and password.

For SSL, you would have to disable anonymous access in the same way as for 
pure TCP/IP. This enables you to specify your security settings in greater 
detail.
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Figure 195.  Disabling Anonymous Users from Accessing the Server.

In either case, after disabling anonymous access, a user connecting with a 
browser to your Web server would get a prompt like this, asking the user for 
authorization:

Figure 196.  Disabling Anonymous Users from Accessing the Server.

To access the server in this case, you need either an Internet password for an 
already registered Lotus Notes user in the user’s document in the Public Address 
Book, or you could register an Internet only user with an Internet password; these 
users would have a document in the NAB, too.

9.1.7  Sample SSL Setup Session
The next screen shots provide an example how the certificate for testing 
purposes can be created and how the secure connection from a Web browser 
may be enabled.
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1. First of all, start the administration Notes client on the server you want to 
create the test key file.

2. Open the Server Certificate Admin database in local mode.The database is 
automatically created during server setup (Figure 197).

Figure 197.  Server Certificate Database

3. After closing the About document, click on the Create Key Ring with 
Self-Certified Certificate selection (Figure 198).

Figure 198.  Create Key Ring Selection

4. Enter the required information. Be sure to write down the password and enter 
the fully qualified hostname. Also be sure to enter the correct file name.

Only the most important screens have been captured for this redbook. If you 
should try to reproduce the steps, please take this into consideration. Missing 
screens are mentioned in the accompanying text.

Note
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Figure 199.  Self-Certified Certificate

5. Click on the Create Key Ring with Self-Certified Certificate button (see 
Figure 199).

6. Follow the directions on the next screens, mainly confirmation of what has 
happened.

7. Close the Server Certificate Admin database.

8. Be sure the server document in the public NAB contains the entries of Figure 
191 on page 225 and Figure 192 on page 226 and restart the http Task.

9. Open a Web browser on a system which is able to access the Lotus Domino 
Server over TCP/IP; the browser must support SSL by design.

10.Connect through https://ah1610f.itsc.austin.ibm.com:443 to the Lotus 
Domino server.

11.You will get the following notification, if you work with Netscape Communicator 
4.04:
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Figure 200.  New Site Certificate Screen

12.Accept by clicking NEXT> as long as required and follow your browser’s 
instructions to accept the certificate.

13.If everything went well, you should get the Home URL of your Lotus Domino 
Server, but now in secure mode. The encryption symbol in the lower left 
corner should have changed. In our example the lock symbol is closed now 
(see Figure 201 on page 235).

For a production environment on the Internet, you would have to get a certificate 
from a Certificate Authority; see 8.6, “Secure Socket Layer (SSL)” on page 201, 
for more information.
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Figure 201.  SSL Secured Browser

9.2  Lotus Domino Virtual Server

The previous section focused on how to do the basic setup for a single HTTP 
server. By doing that, you would have to set up either a separate system for each 
Lotus Domino server, or you could place several Lotus Domino partitions on one 
system, each having its own server name and IP address. For more information 
how to set up partitions, refer to 11.3, “Partitioned Servers” on page 337.

However, before you proceed to read about the details, you should keep a few 
points in mind:

  • You can configure each site in Lotus Domino with its own IP address, Home 
URL, Default home page, and HTML, CGI, and icons directories, but the Lotus 
Domino data directory structure is the same for all virtual servers. To configure 
the virtual server, use the Lotus Domino Configuration database (domcfg.nsf).

This chapter describes how to do the basic setup for an Lotus Domino Virtual 
Server (sometimes it is also called multihoming, as one Web server provides 
services for different sites), but it will not describe the process of designing a 
complete Website. This would be beyond the scope of this redbook. You might 
want to refer to another redbook, SG24-2183, "Developing Web Applications 
Using Lotus Notes Designer for Lotus Domino 4.6" for information on designing 
a Website and web applications.

Note
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  • You cannot use Secure Sockets Layer (SSL) if you are setting up multiple 
sites on one server. You can require users to enter their names and 
passwords using basic password authentication over TCP/IP.

  • Before configuring the virtual server settings in Lotus Domino, you must set up 
the network connections for each virtual server. Each virtual server must have 
its own separate, permanent numeric IP address. It is not sufficient to have 
multiple names mapped to the same IP address.

In our example, we used one RS/6000, assigned three TCP/IP addresses to its 
network interface, and configured a virtual server, as described below.

9.2.1  Network Setup
Assume the basic IP setup has already be done, using the network interface tr0. 
Now you have to add additional IP addresses to be used by your virtual server. 
That has to be done by ifconfig commands, which may be placed into the file 
/etc/rc.net to be automatically activated on system start-up. The screen shot 
below refers to this setup. The network interface tr0 now has three IP addresses.

Figure 202.  Network Setup

You may now proceed with the Lotus Domino configuration.

9.2.2  Configuring domcfg.nsf
Assume the Lotus Domino server ah1610f/ibm has already been setup; as 
described earlier, it already acts as a HTTP server, and you would like to extend 
its capabilities to a be a virtual server:

1. First, change the settings in the server’s document in the NAB to comply to the 
restrictions for a virtual server:

  • HTTP: Clear the hostname and disable binding (see Figure 203 on page 
237).

# hostname
itsosmp
# host itsosmp
itsosmp.itsc.austin.ibm.com is 9.3.1.27
#/usr/sbin/ifconfig tr0 inet 9.3.1.71 netmask 255.255.255.0 alias
#/usr/sbin/ifconfig tr0 inet 9.3.1.85 netmask 255.255.255.0 alias
# netstat -i
Name  Mtu   Network     Address            Ipkts Ierrs    Opkts Oerrs  Coll
lo0   16896 link#1                            4049     0     4049     0     0
lo0   16896 127         localhost             4049     0     4049     0     0
lo0   16896 ::1                               4049     0     4049     0     0
tr0   1500  link#2      10.0.5a.c9.7c.f1    468252     0   315434     0     0
tr0   1500  9.3.1       itsosmp.itsc.aust   468252     0   315434     0     0
tr0   1500  9.3.1       ah1610f.itsc.aust   468252     0   315434     0     0
tr0   1500  9.3.1       ah1610g.itsc.aust   468252     0   315434     0     0
# 
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Figure 203.  HTTP Server Settings for Virtual Server

  • Internet Port and Security: disable SSL and allow anonymous browsers for 
access (it eases testing, and you normally would allow any browser to 
connect to your site).

Figure 204.  Internet Port and Security Settings for Virtual Server

2. Open the admin notes client on the Lotus Domino server and create the 
database domcfg.nsf locally, using the template domcfg.ntf. Later, you can 
open it from another authorized client on the server, but at creation time, it 
should be done locally. We named the database Virtual Server (see Figure 
205).

Figure 205.  Creation of Database domcfg.nsf
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3. Open the database from your Lotus Notes client

Figure 206.  Virtual Server Administration Database

4. Select Create->Virtual Server from the action bar.

Figure 207.  Creating Documents in the Virtual Server Database

5. Edit the document as required. Our example uses one of the three site 
database samples provided by Lotus, which are automatically installed in the 
subdirectory sample in the servers data directory. 
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Figure 208.  Virtual Server Definition

6. Proceed with all the sites you wish to set up. We set up three sites, using the 
databases sample/site1v46.nsf, sample/site2v46.nsf, and sample/site3v46.nsf; 
each database has been mapped to one of the three IP addresses. If you 
would like to, you may also provide Mapping directories and URLs for each 
site within the virtual server document.

7. In the same way, you can also create documents for mapping error messages, 
mapping a URL to a directory, mapping a URL to a URL, or redirecting a URL 
to another URL (see Figure 207 on page 238). Figure 209 shows an example 
for an URL Redirection. If someone browses to http://9.3.1.71/ibm, they will 
be redirected to http://www.rs6000.ibm.com.

Figure 209.  Redirecting a URL on a Virtual Server
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8. The next two figures show the resulting Virtual Server view and URL 
Redirections view, defining our small virtual server.

Figure 210.  Resulting Virtual Server View

Figure 211.  Resulting URL Redirections View

9. After finishing the configuration, stop your http Task and restart it. 

10.Connect with a Web browser to the virtual servers you have set up (in our 
example, itsosmp, ah1610f, and ah1610g, as shown in Figure 202 on page 
236). You should get results shown in Figure 212, Figure 213, and Figure 214:
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Figure 212.  Result for the First Virtual Server

Figure 213.  Result for the Second Virtual Server
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Figure 214.  Result for the Third Virtual Server

9.3  Web Navigator

The Web Navigator is a feature of Lotus Notes Release 4.x, which allows you to 
access information on the Internet. The Web Navigator integrates the 
components of a Web browser with the capabilities of Lotus Notes. It allows two 
different ways to comfortably access and explore the exciting world of the 
Internet.

  • Personal Web Navigator - you can access the Web in a personal way through 
a local Web Navigator database on your Notes Workstation that is connected 
to the Internet.

  • Sever Web Navigator - you can access the Web in a collaborative way through 
the central Web Navigator database that resides on the InterNotes server (a 
Lotus Notes Server connected to the Internet). See 9.4, “Server Web 
Navigator” on page 249, for more information.

9.3.1  Personal Web Navigator
The Personal Web Navigator provides you with easy access to information on the 
Internet right from your Notes Workstation, which is connected to the Internet. 
This database acts as a repository for Internet documents and files that have 
been retrieved by you. The Personal Web Navigator is your own personal 
database for surfing the Internet.

The Notes Workstation:

  • Maintains either a direct (dial-modem or leased line) or proxy connection to 
the Internet.

  • Runs the TCP/IP network protocol (this is a requirement).
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  • Stores the perweb45.ntf and perweb.nsf files; with Lotus Notes 4.6.1, the 
Personal Web Navigator database is automatically created upon client setup.

9.3.2  Setting Up the Personal Web Navigator
You can set up a Web Navigator database on your local Notes Workstation so 
that all Web pages are retrieved and stored in that local database. To set up the 
Personal Web Navigator:

1. Create a new Location document in your Personal Address Book. Select File 
-> Mobile -> Locations -> Add Location; you can also edit an existing 
location document and proceed with steps 4 - 7 below.

2. Select the Location type, for example, Local Area Network.

3. Give the location document a name by making an entry in the Location name 
field, for example, Office (local navigator).

4. From the Retrieve/open pages field, select from Notes workstation. This 
specifies that retrievals will be performed by the Notes Workstation and Web 
pages will be stored in the Personal Web Navigator database; unfortunately, 
frames are not yet supported.

Figure 215.  Settings for Location: Office (Local Navigator)

5. If a proxy is used, either enter your proxy settings, as shown above, or click 
the button next to the Web proxy field to enter your specific proxy settings (see 
Figure 216):

  • HTTP:

Enter the name, IP address of the proxy, and the port to access HTTP 
pages. Select the Use same proxy for Internet protocols  field if you 
want Lotus Notes to use the same HTTP proxy for FTP, Gopher, and 
SSL Security.

  • FTP:

Enter the name or IP address of the proxy and the port to access FTP 
pages.

  • Gopher: 
242 Lotus Domino Release 4.6 on IBM RS/6000



Enter the name or IP address of the proxy and the port to go through for 
Gopher pages through the proxy.

  • SSL Security 

Enter the name or IP address of the proxy and the port you want to go 
through for pages on Internet servers using SSL. 

  • SOCKS 

Enter the name or IP address of the proxy and the port.

  • Notes RPC 

This field is used for all Notes-to-Notes communication over the 
Internet, for example, if you want to connect to a Lotus Notes Server 
over the Internet.

  • No proxy for these hosts or domains 

You can bypass the proxy to access certain domains on the Internet (or 
to access your internal intranet domain). Enter the names of the hosts 
and domains you want to access without going through the proxy. (You 
cannot use the IP address in this field; you need to use the name.) 
Separate multiple entries with commas or carriage returns. You can use 
wildcard (*) characters, for example, *.lotus.com or www.*.com.

If you enter multiple proxies, the SOCKS setting has a higher priority than 
HTTP, and Lotus Notes RPC (Remote Procedure Call) has a higher priority 
than SOCKS.

Figure 216.  Proxy Settings for Personal Web Navigator

6. Save your location document and exit.

7. Make sure your location document is active.

8. Choose File -> Open URL  from the action bar of your Lotus Notes Workspace 
and enter the URL for a Web page, for example: http://www.ibm.com/.
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Lotus Notes opens the browser window of the Personal Web Navigator 
database and retrieves the page from the proxy; every retrieved page is also 
stored in the Personal Web Navigator database itself (perweb.nsf) on your 
client for later off-line browsing. Unfortunately, the built in browser does not 
support frames nor Java Script.

Hint: To open the database to the view level from that point, click on the View 
Go Up Level Smarticon (you may need to exit Edit Mode to see this Smarticon 
by pressing Ctrl-E.

Figure 217.  Smarticon: Go Up Level

9. If you clicked on the Smarticon mentioned above, or if you open the Personal 
Web Navigator database manually, you will see a window like the one shown 
in Figure 218.

Figure 218.  Personal Web Navigator Database View
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9.3.3  Web Ahead - Automatically Following Links on Web Pages
Web pages usually contain URLs that point to other Web pages. You can run a 
background agent called Web Ahead that retrieves all the Web pages specified 
by the URLs on a particular Web page and saves all the resulting Web pages in 
your database to read later. You can set the agent to retrieve the URLs several 
levels down from the page you specify.

Web Ahead only runs while your Notes workstation is running.

9.3.3.1  Enabling the Web Ahead Agent
To enable the Web Ahead agent (you only need to do this once):

1. Choose File -> Tools -> User Preferences. When the Basics section is 
selected, there will be an Advanced Options box shown. In the Advanced 
Options box, select Enable scheduled local agents.

2. Open the Personal Web Navigator database by double clicking on the 
Personal Web Navigator database icon.

3. Select Actions -> Internet Options....

4. In the Web Ahead agent preferences section, enter the number of levels of 
pages you want the agent to preload. You can select a value between 1 and 4, 
we selected 2.

Figure 219.  Web Ahead Agent Preferences

5. Click on the Enable Web Ahead button (this button only appears if you have 
not yet enabled the agent in this database).

6. In the Choose Server To Run On dialog box, choose Local and click on OK.

7. Click on OK on the Enabled Background Agents dialog box.

8. Confirm the following messages by clicking OK.

9. Press Esc and select Yes to save your changes.

10.Restart your workstation.

9.3.3.2  Running the Web Ahead Agent
To run Web Ahead on a Web page:

1. Double click on the Personal Web Navigator database icon.

You could also choose to retrieve the Web pages, not from a Notes 
Workstation, but with another browser installed on your system (to be specified 
in the location document on the client). This would allow you to browse pages 
with frames, but the pages would not be stored in the Personal Web Navigator 
database, inhibiting all the features described below.

Note
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2. Select any Web page and drag it into the Web Ahead folder.

The Web Ahead agent runs immediately.

9.3.4  Managing Database Size (perweb.nsf)
To keep the size of your database under control, you can purge the database 
based on options you specify in the Internet Options document. To specify purge 
options:

1. Double click on the Personal Web Navigator database icon.

2. Select Actions -> Internet Options....

3. In the Database purge options section, specify one of these purge options:

  • Reduce full pages to links if not read within: Lotus Notes deletes the 
contents of the page after the specified number of days, but saves the URL 
so you can still see the page in the database views.

  • Remove pages from database if not read in: Lotus Notes deletes the 
entire page from the database if it has not been read within the number of 
days you specify.

  • Disable: Disables the purge options.

Figure 220.  Database Purge Options

4. Check Warn me when the database exceeds box and select a database size 
if you want Lotus Notes to warn you by displaying a message box when the 
database exceeds a certain size.

5. Press the Enable Housekeeping button.

6. Press Esc and select Yes to save your changes.

9.3.5  Using Page Minder to Keep Track of Changes to Web Pages
You can also run a background agent called Page Minder that closely watches a 
particular Web page and notifies you when the contents of that page change. 
Keep in mind that Page Minder only runs while your Notes Workstation is running.

9.3.5.1  Enabling the Page Minder Agent
To enable the Page Minder agent (you only need to do this once):

1. Choose File -> Tools -> User Preferences and select Enable scheduled 
local agents (if you have not done it before).

2. Open the Personal Web Navigator database icon by double clicking on the 
Personal Web Navigator database icon.

3. Select Actions -> Internet Options....

4. In the Page Minder agent preferences section, fill out these fields:
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  • Search for updates every: Choose how often you want the agent to check 
to see if the page contents have changed. You can choose Hour, 4 Hours, 
Day, or Week.

  • When updates are found: Specify how you want to be alerted that the 
page changed. Choose Send me a summary to send a message notifying 
you that the page has changed. Choose Mail the actual page to send the 
recently updated Web page.

  • Send to: Specify the name of the person to alert when the page content 
changes (as found in the Lotus Notes NAB).

5. Click on the Enable Page Minder button next to the agent. (Note that this 
button only appears if the agent is not already enabled.)

6. In the Choose Server To Run On dialog box, choose Local and click on OK.

Figure 221.  Page Minder Agent Preferences

7. Click on OK in the Enable Background Agents dialog box.

8. Press Esc and select Yes to save your changes.

9.3.5.2  Running the Page Minder Agent
To run Page Minder on a Web page:

1. Double click on the Personal Web Navigator database icon.

2. Select any Web page and drag it into the Page Minder folder.

The Page Minder agent runs based on the times you selected in the Internet 
Options document.

You can run the Page Minder agent and Web Ahead agent on pages from 
authenticated servers where you are required to supply a user name and 
password before you can gain access to the page. Similarly, you can run the 
agent through an authenticated proxy server where you have to supply a user 
name and password to gain access to the Internet.

As long as you have successfully retrieved the page during your current Lotus 
Notes session, Notes stores your user name and password in a field on the 
Web page and pulls it from there when it runs the agent. For security purposes, 
if you run this agent on authenticated servers or through authenticated proxy 
servers, you should encrypt your database so that the field is not visible to 
others.

Note
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9.4  Server Web Navigator

The Server Web Navigator provides you with easy access to information on the 
Internet through a Lotus Notes Server (the InterNotes server) connected to the 
Internet. This database acts as a repository for Internet documents and files that 
have been retrieved by you or other users. You can also use this database as an 
easy entry point for exploring the Internet. The Server Web Navigator is a 
collaborative database where you and your coworkers can explore the Internet 
together.

The Server Web Navigator:

  • Maintains either a direct or proxy connection to the Internet.
  • Runs the TCP/IP network protocol.
  • Runs the Web Navigator server task.
  • Stores the template pubweb45.ntf and Navigator database web.nsf (you can 

change the file name of the Server Web Navigator database).

One advantage of using the database on the Lotus Notes Server is that only one 
computer, the InterNotes server, needs to be connected to the Internet to give 
multiple Lotus Notes users access to the Web. The Lotus Notes clients retrieve 
pages from the Server Web Navigator database by accessing this database, not 
the WWW. A Lotus Notes environment can have multiple InterNotes servers, 
each with its own separate database, so that users can explore the Web from 
several different databases.

9.4.1  Setting Up the Server Web Navigator
The following example guides you through the setup of the Server Web 
Navigator. Our host to provide the Server Web Navigator database is 
ah1610c/ibm. It will retrieve Web pages by using the proxy proxy.austin.ibm.com. 
All Lotus Notes users are registered on server noteserv/ibm. Depending on your 
type of Internet connection, you may have to specify different settings. But the 
basic order of steps to conduct remains the same.

9.4.1.1  Creating the Server Web Navigator Database
At the Lotus Domino Server console, enter load web; that will automatically create 
the Server Web Navigator database on the first time. The output will look similar 
to this:

This step has enabled server ah1610c/ibm to provide Server Web Navigator 
services.

9.4.1.2  Modifying the User Server’s Entry in the Public NAB
If a user tries to access the Server Web Navigator, the Lotus Notes client will look 
up the server first in the user’s NAB. If it does not find the information, it will 

> load web
> 30/07/98 18:46:10     WEB(1): InterNotes(R) WEB Retriever starting for
’ah1610c/ibm’...
30/07/98 18:46:10     WEB(1): Creating InterNotes database ’web.nsf’, using
template ’pubweb45.ntf’
30/07/98 18:46:22     WEB(1): Creating InterNotes Navigator administration
options for server ’CN=ah1610c/O=ibm’
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check the Public NAB of the user’s mail server. Therefore, change the server 
document in NAB for the appropriate mail server (in our example, noteserv/ibm):

1. Open the Public Name and Address Book with admin rights.

2. Select Server\Servers to display the list of server documents.

3. Select the server document for noteserv/ibm and click on Edit Server.

4. Click on Server Location Information and enter the fully qualified name of 
the server where InterNotes is installed in the InterNotes server field (Figure 
222).

Figure 222.  Servers

5. Press Esc and click on Yes to save your changes.

Now every user can access the Server Web Navigator without modifications in 
their own address book.

9.4.2  Connecting the Server Web Navigator to the WWW
In our example, we need to update the server document of our Server Web 
Navigator server to tell the server to use a proxy server for its page retrieval:

1. Edit the Server document in the public NAB (for ah1610c/ibm).

2. Click on Proxy Configuration and modify the settings as required:

Figure 223.  Proxy Configuration

9.4.2.1  (Re-)starting the Web Retrieval Task
This server task is required for the InterNotes Server Web Navigator so that 
pages on the Web can be retrieved and viewed. To start this task either enter: 
load web at the InterNotes server console or add it to the list of ServerTasks in the 
notes.ini file of the InterNotes server (this will start the task every time you start 
the Lotus Notes Server). Remember to restart it after changing configuration 
settings (tell web quit, load web). If you would like to modify the more advanced 
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settings of the Web Retrieval Task, you should read the next section, 9.4.3, 
“Specifying Web Retrieval Settings” on page 251.

9.4.3  Specifying Web Retrieval Settings
You could also specify additional settings related to the retrieval services the 
Server Web Navigator server should offer. To specify settings related to the Web 
retrieval process running on the Server Web Navigator server:

1. Double click on the Public Name and Address Book icon.

2. Select Server\Servers to display the list of server documents.

3. Select the server document of the server the Server Web Navigator runs on, 
and click on Edit Server. All users who have this server as their mail server 
will be able to gain access to the InterNotes server.

4. Click on the Web Retriever Management section to edit these settings.

Figure 224.  Web Retriever Management

  • Web Navigator database: Change this field if you want to rename the Server 
Web Navigator database file name.

  • Services: Choose the Internet services that you will allow users to access. 
The Web Navigator supports HTTP, FTP, HTTPS, Gopher, and Finger. The 
default allows access to HTTP, FTP, and Gopher services.

  • Concurrent retrievers: Enter the maximum number of users that can use the 
Web Navigator database concurrently. This number depends on the system 
configuration for your InterNotes server. If user access is slow because the 
number of users specified in this field is less than the number of users 
attempting to retrieve pages off the Internet, increase the number. (If users 
start more concurrent Web retrievals than you have specified in this field, 
Lotus Domino queues them and starts them as soon as it can.) The default is 
25.

  • Retriever log level: This field specifies whether messages should be logged 
by the Web Retriever to the server’s log.nsf database. Select None to send no 
messages, Terse to send minimal messages, and Verbose to send all 
messages to your log.nsf. The default is None.

  • Update cache: Lotus Domino stores retrieved Web pages in the Server 
Navigator database. You can specify how often you want Lotus Domino to 
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verify that these pages are still up to date or if they have to be reloaded from 
the Internet:

  • Never: To perform no verifications (this is the default).

  • Every time: To check each time you open a page already in the database.

  • Once per session: To check only one time per user session.

  • SMTP Domain: If you have an SMTP Gateway already installed, enter the 
foreign domain name of the gateway in this field; for use with the Lotus SMTP 
MTA, leave this blank.

9.4.3.1  Internet Site Access Control
You can control access to certain Internet sites by using the Deny Access and 
Allow Access fields in the Internet Site Access Control section shown in Figure 
224. Both lists work in conjunction with each other. A more specific setting 
overrides a generic setting using wildcards. If you should have identical settings 
in both fields, the Allow Access field takes precedence.

9.4.4  Customizing Basic Settings in the Administration Document
To edit the Administration document of the Server Web Navigator database 
perform the following steps:

1. Ensure you have proper access rights for the Server Web Navigator database; 
that means you should be manager of the database and have the role of the 
Webmaster. The example below shows that all members of the admingroup 
have the proper rights.

Figure 225.  ACL for Server Web Navigator Database

2. As a member of the admingroup, open the Server Web Navigator database 
on the server, not locally.
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3. Click on Database Views on the Home Navigator, open the All Documents 
view (the default view), and choose Actions -> Administration from the 
action bar. If you do not see this menu, you do not have the proper rights as 
Webmaster.

4. You will see the following form:

Figure 226.  Server Web Navigator Administration Form

5. You may now change the fields as desired. The meaning of the Enable Purge 
agent button, the Enable Refresh agent button and the Purge Agent settings is 
described in 9.4.5.2, “Keeping the Server Web Navigator Database Current” 
on page 255 and 9.4.5.3, “Managing the Size of the Server Web Navigator 
Database” on page 256. The other settings are described here:

  • In the Server Basics section, you can change the following settings:

  • InterNotes server name: This field should already contain the name of 
your InterNotes server. To change the name in this field, enter the 
hierarchical name of the InterNotes server where the Web Navigator 
database resides. This is a required field and is case sensitive.

  • Maximum database size: The maximum size in megabytes for the 
database. The default is 500 MB.
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  • Save author Information: Choose Yes to save the name of the user 
who retrieved the Web page from its Internet server into a field called 
Save_Author. Use the @Author function to create a view to display the 
name of the user (or server) that retrieved the Web page. The default is 
not to save the author information.

  • Save HTML in Note?: Check this box to save the HTML source for Web 
pages in a field called HTMLSource. The default is not to save the 
source.

  • The HTML preferences sections contains font types for various elements 
and is self-explanatory.

Do not forget to save any changes you made.

9.4.5  Managing the Server Web Navigator Database
There are several administrative issues that you should be aware of when 
running the Server Web Navigator in a production environment. They are covered 
within this section.

9.4.5.1  Security for LotusScript Agents
To run any of the LotusScript agents for the Server Web Navigator (Refresh, 
Purge, and Averaging), the correct authorities must be given in the server 
document in the Public NAB. However, you will only need to do this once to use 
any of the Server Web Navigator agents. Follow the steps below to authorize the 
server to run the Server Web Navigator agents:

1. Edit the server’s entry in the Public Name and Address Book.

2. Click on Agent Manager and go to the Agent Restrictions section.

3. Enter the fully qualified name of your Webmaster (in our case, 
admingroup/ibm) in the fields, as shown below, since the Webmaster will run 
the agents as scheduled.

Figure 227.  Agent Manager

4. You may also modify the Nighttime Parameters section (Figure 228) to adjust 
to your system’s capacity and your maintenance window. Increase the values 
in the Max LotusScript/Java execution time field and in the Max % Busy before 
delay field; shown are the default values.
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Figure 228.  Nighttime Parameters

5. Save your changes to the server document and exit.

9.4.5.2  Keeping the Server Web Navigator Database Current
The Web pages that are held in the Server Web Navigator database are snap 
shots of the Web page when it was first viewed. As long as a page is accessed 
later by a user, it may be verified according to the Update Cache setting as 
described in 9.4.3, “Specifying Web Retrieval Settings” on page 251. But purging 
pages that are out of date or no longer accessed is also a concern. This may be 
done by enabling the Refresh agent. Since the Web is a dynamic environment, 
a Lotus Notes agent must run so that the database is refreshed.

1. Ensure you have set the agent restrictions according to 9.4.5.1, “Security for 
LotusScript Agents” on page 254.

2. Open the Server Web Navigator administration form, as described in 9.4.4, 
“Customizing Basic Settings in the Administration Document” on page 252.

3. Click on the Enable Refresh agent button.

4. Choose the Lotus Domino server the Server Web Navigator runs on in the 
Choose Server To Run On dialog box.

5. Save your changes and exit.

To change the time when the Refresh agent runs (default is 03.00 am), follow 
these steps:

1. Click on the Agents view on the Server Web Navigator screen to display the 
list of agents for this database.

2. Double click on the Refresh agent to display the Lotus Notes - Refresh - 
Agent screen.

3. Select Schedule to display the Schedule screen, as shown in Figure 229; as 
you may have noticed, you can change the schedule of the agent as well as 
the server it runs on. This setting cannot be changed from the administration 
screen anymore when initially set without checking the tiny checkbox at the 
bottom of the window shown here:
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Figure 229.  Refresh Agent Schedule

9.4.5.3  Managing the Size of the Server Web Navigator Database
The size of the Server Web Navigator’s database may be maintained by enabling 
the purge agent which will delete outdated documents:

1. Ensure you have set the agent restrictions according to Chapter 9.4.5.1, 
“Security for LotusScript Agents” on page 226.

2. Open the Server Web Navigator administration form as described in Chapter 
9.4.4, “Customizing Basic Settings in the Administration Document” on page 
224.

3. You may want to modify the Purge Agent Settings (Figure 226 on page 253):

  • Purge agent action: When Lotus Notes runs the Purge agent, you can 
specify whether you want Web pages deleted from the database or 
reduced. Reduced means that Lotus Notes deletes the contents of the 
page but saves the URL; so you can still see the page in the database 
Views. Choose the Delete page or Reduce page keyword depending on 
how you want the Purge agent to run. The default is Delete page.

  • Purge to what % of maximum size: Enter a percent of the maximum 
database size (specified in the Maximum database size in the Server 
Basics section) that you want the purge agent to reach. The default is 
60%.

  • Purge documents older than: Select the appropriate keyword to specify 
when to delete documents based on the number of days they have been in 
the database. The default is 30 days.

  • Purge documents larger than: Select the appropriate keyword to specify 
when to delete documents based on their size. The default is 512KB.

  • Purge Private documents: Select the checkbox to specify that the purge 
agent should delete documents that users have stored in their private 
folders. Leave the checkbox unchecked if you do not want private 
documents to be deleted by the Purge agent. The default is unchecked.
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4. To enable the Purge agent click on the Enable Purge agent action button 
(Figure 226).

5. Choose your Lotus Domino server the agent is going to run on from the 
Choose Server To Run On dialog box

To change the time when the Purge agent runs (default is 01.00 am), change the 
parameters in the Schedule screen, as shown in Figure 229 on page 256.

9.4.5.4  Creating the Top Ten List of Web Pages
The Averaging agent is used to collect the ratings users assign to Web pages and 
to compute the Top Ten Web pages.

1. Ensure you have set the agent restrictions according to Chapter 9.4.5.1, 
“Security for LotusScript Agents” on page 226.

2. Open the Server Web Navigator database.

3. Click on the Agents view and click on Averaging Agent.

4. Enter the name of the server where you want this agent to run in the Choose 
Server To Run On dialog box.

5. If you want to change the time when the agent runs, double click on the 
Averaging Agent entry and click on the Schedule button.

9.4.6  Providing Access to the Server Web Navigator Database
The default access values in the Web Navigator server database are:

  • Editor: allows users to fill out HTML forms, create recommendation 
documents, and create Web tours.

  • Administrator of the InterNotes server: Webmaster role, which allows access 
to the Web Navigator Administration document.

  • LocalDomainServers: Manager.
  • OtherDomainServers: No access.

9.4.7  Installing the Server Web Navigator for the Lotus Notes End User
Once the Server Web Navigator is up and running, the Lotus Notes client users 
may access it. The only step a user has to perform is to update its location 
document as follows:

During our tests with Lotus Domino 4.6.1 on AIX 4.3.1, the Purge agent had 
some problems. Apparently, the maximum database size specification in the 
port settings is misinterpreted. If you should need that function, perform 
sufficient tests and please check with Lotus support.

Note

So that all replica copies of the web.nsf share the same ACL, open the 
Advanced section of the ACL and check Enforce a consistent Access 
Control List across all replica copies of this database.

Tip
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Figure 230.  Client Location Document for Using Server Web Navigator

Remember, the specification of which Server Web Navigator to use has been 
made in the server document of the user’s Home/mail server.

Afterwards, the user may open an URL by selecting File->Open URL from the 
action bar of the Lotus Notes client. The page will be retrieved, and the Server 
Navigator Database is automatically added to the workspace.

Figure 231.  Server Web Navigator Database Icon

This database may be used by the client to retrieve URLs, to select information 
selectable on the (Home-) Navigator, as shown in the next figure, or to lookup 
pages already contained in the database by earlier retrievals.

To open Web pages from databases other than the Web Navigator database, you 
should change your user preferences (for example, if the user gets mail that 
includes a HTTP link):

1. Click on File -> Tools -> User Preferences to display the User Preferences 
dialog box.

2. In the Advanced options section (located in selection Basics), check the Make 
Internet URLs (http://...) into Hotspots.

3. Click on OK.
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Figure 232.  Server Web Navigator View

9.5  Server Web Administration Tool

During setup, Lotus Domino creates a database named webadmin.nsf, or if it 
should not exist for any reason, when the http Task starts. You can administer a 
Lotus Domino Server with a Web browser using that database. if you perform the 
following setup steps:

1. Add the names of the Lotus Notes users going to administer the server to the 
access control list (ACL) of webadmin.nsf as Managers with the ServerAdmin, 
ServerMonitor, and DatabaseAdmin roles.

2. Add the names of the Lotus Notes users going to administer the server to the 
Administer the server from a browser field in the Restrictions section of the 
server document in the Public NAB.

3. Add the names of the Lotus Notes users going to administer the server to the 
Run restricted LotusScript agents field in the Agent Manager section of the 
server document in the Public NAB.

4. Enter an Internet password in the Person documents of all the allowed 
administrators authorized in step one to three.

5. Setup the server you want to administer as a Web server, running the http 
server task, so you can access the Web Administration database and send 
commands to the server using a browser.
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6. If you would like to, you can further refine access to the Web Administration 
tool by allowing administrators to access only a subset of the available Web 
Administration commands by modifying the ACL.

The Web Administration tool uses the following server databases: the log file 
(log.nsf), Lotus Domino Web server log file (domlog.nsf), the Public Address 
Book (names.nsf), cascaded Public Address Books, listed in the NAMES= setting 
of the notes.ini file, the Database Catalog (catalog.nsf), Administration Requests 
(admin4.nsf), Statistics (statrep.nsf), and Lotus Notes Administration Help 
(helpadmn.nsf in the doc subdirectory). If one of these files does not exist on the 
server, the Web Administration tool does not display the command associated 
with the file. For example, if the Lotus Notes Administration Help file does not 
exist in the doc subdirectory, the Web Administration tool does not display the 
Help command.

The next figures show a few examples of what you might get by playing around 
after connecting to the server successfully. Explaining all the functions and 
screens of the Web administration module would go beyond the scope of this 
redbook. The best way to get familiar with it is to use it.

You will get information about the server disk space, as shown in Figure 233, by 
clicking on Monitoring, and then clicking on Disk Space (both buttons have a 
slightly different color in the figure because they have been pressed).

When entering your user ID in the Web browser authentication window, you 
have to enter your Common Name, or your fully qualified name, but not your 
shortname. For example, our administrative user has been named domino 
admin. He might authorize as domino admin/ibm or domino admin, but not as 
dadmin.

Note
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Figure 233.  Lotus Domino Web Administration Example: Server Disk Space

You will get information about the server statistics, as shown in Figure 234, by 
clicking on Monitoring, and then clicking on Statistics (both buttons have a 
slightly different color in the figure because they have been pressed).
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Figure 234.  Lotus Domino Web Administration Example: Server Disk Space

You will get information about the server’s mail router, as shown in Figure 235, by 
clicking on Monitoring, and then clicking on Mail (both buttons have a slightly 
different color in the figure because they have been pressed).
Lotus Domino and the World Wide Web 261



Figure 235.  Lotus Domino Web Administration Example: Mail Monitor

To get sufficient pending mails for testing purposes, you must stop the router task 
on the monitored server (tell router quit), then create lots of mail with a user on 
that server with a Lotus Notes application you may have, so that mail.box gets 
filled. Afterwards, start the router again. The number of messages pending you 
can see on the monitor depends on how quickly the router can deliver the 
messages. When this screen shot was taken, there were only two messages 
pending.

9.6  New WWW Features in Lotus Domino Release 4.6.1

The information in this section has been extracted from the Lotus Domino 
Release notes for your convenience

9.6.1  Improving Web Server Performance Using the Command Cache
In Release 4.6.1, Lotus Domino caches in memory pages that contain 
@functions, in addition to HTTP commands, databases, and user names. 
Previous releases of Lotus Domino did not cache pages that contained 
@functions, since many of the @functions made the pages too volatile for 
caching. The area of memory reserved for this type of cache is called the 
Command Cache.
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This feature is turned off by default in Lotus Domino. To turn on this feature, enter 
the following line in the NOTES.INI file on the Web server: 
DominoAnalyzeFormulas=1
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Chapter 10.  Connectivity and Internet Communications

Along with the explosion of the Internet in the mid-1990s, the World Wide Web 
started growing and became very popular. Up to this point, the Internet was 
mainly used for electronic mail and news. Electronic mail (or e-mail) is almost as 
old as networking itself. Writing notes to each other was one of the first things 
people with interconnected computers wanted to do. News can be seen as a 
variation of e-mail. Where e-mail usually is sent from one person to another, or 
from one person to a few, news allows you to send a message to "everyone". In 
this case, everyone means anyone who wants to read the message and has 
access to a news client.

Aside from the World Wide Web services described in Chapter 9, “Lotus Domino 
and the World Wide Web” on page 217, Lotus Domino Release 4.6 also provides 
mail, news, and directory services. Together with the Lotus Domino Web Server, 
this makes Lotus Domino a provider of all essential Internet services. These 
services are seamlessly integrated with Lotus Domino, and merge Lotus Domino 
and the Internet to allow Lotus Notes users full communication capabilities with 
the Internet and Internet users. Specifically, these solutions are:

Lotus Domino SMTP/MIME MTA
Lotus Notes users can send and receive Internet e-mail through an 
SMTP gateway.

Lotus Domino POP3 server
Lotus Domino servers can accept and distribute mail for a POP3 mail 
client.

Lotus Domino IMAP server
Lotus Domino servers can accept and distribute mail for an IMAP mail 
client.

Lotus Domino NNTP Server
Lotus Domino servers can act as servers for Usenet News, allowing 
Internet users access to newsgroups over the NNTP protocol.

Lotus Domino LDAP server
Through the Lotus Domino LDAP server, Lotus Domino can share its 
Public Address Book with Internet users with access to an LDAP 
client.

All of these protocols, except SMTP, can use the Secure Sockets Layer (SSL) to 
make an encrypted connection between the client and the server. Setting up the 
server tasks for these protocols to use SSL is very similar for all protocols. For 
details on setup, refer to section 8.6, “Secure Socket Layer (SSL)” on page 201.

It is also possible to use all the above protocols, again except for SMTP, in a 
partitioned environment (more than one Lotus Domino Server per host). There 
are more details on running the Lotus Domino Server and the Internet server 
tasks in a partitioned environment in section 11.3.6, “Considerations for Internet 
Server Tasks” on page 345.

10.1  SMTP

Mail over the Internet predominantly means mail through the Simple Mail 
Transport Protocol (SMTP). This open standard protocol transports plain text 
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messages only. The Multipurpose Internet Mail Extensions (MIME) standard adds 
the capabilities of sending more complex parts like pictures or sound, or using 
foreign font sets by a suitable encapsulation.

The SMTP MTA can translate messages from SMTP/MIME to Lotus Domino and 
vice versa, like a gateway. In addition, the Lotus Domino SMTP/MIME MTA can 
operate as a traditional Message Transfer Agent (MTA) when there is a 
requirement to relay messages, unconverted, from one SMTP MTA to another.

In cases, where SMTP is the only protocol available between two Lotus Domino 
environments, the MTA could be used to encapsulate Lotus Domino mail 
messages over the SMTP network. This provides high-fidelity transfer of Lotus 
Domino mail messages through an SMTP backbone.

The SMTP MTA can be activated as part of the Lotus Domino Release 4.6 
installation procedure, or activated separately at a later time. It uses documents 
in the Public Address Book for configuration and is managed from the Lotus 
Domino Server console.

It is not necessary to activate the SMTP MTA on each Lotus Domino Server in the 
domain. The MTA only needs to be activated on the server that actually runs the 
MTA, which can be one or more Lotus Domino servers depending on your 
configuration. If you want to be able to configure the MTA from other servers than 
the one it’s running on, then the Public Address Book design elements included 
with the MTA need to be replicated to the Public Address Books on these other 
servers.

Starting with Lotus Domino Release 4.6, the SMTP MTA is installed as part of the 
general installation procedure for the Lotus Domino Server. If you want to activate 
the SMTP MTA on Lotus Domino Release 4.6, you will find that it is already 
installed, and all that is missing is its configuration. In addition to what is required 
by the Lotus Domino Server, the SMTP MTA requires a minimum of 16 MB of 
additional memory; 32 MB or more is recommended. It will also need an 
additional minimum of 200 MB of disk space. For high volume mail environments, 
1 GB or more is recommended.

10.1.1  How the SMTP MTA Works
For the configuration of the SMTP MTA, an understanding of every detail of it may 
not be necessary, but some detail is provided here as a reference for 

Before you activate the Lotus Domino SMTP MTA, you must make sure that 
the sendmail daemon is deactivated on that system. The sendmail daemon is 
normally started at system startup time. To change this behavior, log in as user 
root on the SMTP MTA server and run the command chrctcp -d sendmail.

If the sendmail daemon is already running, you must either reboot your system 
after making the above changes, or shut down the sendmail daemon manually. 
You can check if it is active using the command lssrc -s sendmail. If the 
command reports the status as active, you can shut it down using stopsrc -s 
sendmail.

Note
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troubleshooting. For further details of the SMTP MTA, consult the SMTP MTA 
Administration Guide.

For an overview of the parts of the SMTP MTA, refer to the following figure:

Figure 236.  Overview of How the SMTP MTA Works

10.1.1.1  How Mail Travels from Lotus Domino to the Internet
1. A Lotus Notes user addresses a message to an SMTP address, for example, 

Joe@xyz.acme.com.

2. The Lotus Domino Mail Router identifies this as an SMTP address based on 
the syntax of the address and the Foreign SMTP Domain documents. It uses 
the Foreign SMTP Domain documents and Connection documents of 
Connection Type SMTP in the Public Address Book to determine the Lotus 
Domino Server running the appropriate SMTP/MIME MTA.

3. The Lotus Domino Mail Router then uses standard Lotus Domino routing 
techniques to route the message to the Lotus Domino Server running the 
SMTP MTA and into the database SMTP.BOX
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4. The Outbound Conversion Handler task polls SMTP.BOX at regular intervals 
for new messages, as configured in the Poll for new messages every: field on 
the Server document. When it finds a message, it converts it from Lotus Notes 
format to RFC822 (SMTP) format and writes it to the Outbound Work Queue 
(SMTPOBWQ.NSF). It also updates the message in SMTP.BOX to indicate 
that it is pending transmission.

5. The Outbound Session Controller reads the message from the Outbound 
Work Queue and notifies (or creates) an Outbound Session Handler task 
passing it the message ID. The Outbound Session Controller can launch up to 
three handlers by default; however, you can configure it to launch a maximum 
of eight handlers. If possible, the controller groups messages for the same 
host to reduce overhead.

6. The Outbound Session Handler retrieves the message from the work queue. It 
resolves the destination host to an IP address, opens a connection to the 
destination, and sends the message through the SMTP protocol driver. It then 
changes the state of the message in the Outbound Work Queue to Sent.

7. The Delivery Report Task removes the message from the Outbound Work 
Queue and SMTP.BOX. If the message experiences a temporary failure--for 
example, if the destination was unavailable -- the message will be requeued to 
be resent later. If the message experiences a permanent failure--for example, 
if the destination host is unknown or the user on that host is unknown -- the 
Delivery Report Task generates and sends a Non-delivery Report to the 
sender and removes the original message from the Outbound Work Queue 
and SMTP.BOX.

10.1.1.2  How Mail Travels from the Internet to Lotus Domino
The following explains how mail travels from the Internet to Lotus Domino:

1. The Inbound Session Controller task performs a passive listen on the 
well-known SMTP socket to respond to connection requests. When a 
connection request comes in, the Inbound Session Controller notifies (or 
creates) an Inbound Session Handler to process the message. The Controller 
can launch up to three handlers by default; however, you can configure it to 
launch a maximum of eight.

2. The Inbound Session Handler receives the SMTP message and writes it to the 
Inbound Work Queue (SMTPIBWQ.NSF) in RFC822 format.

3. The Inbound Message Conversion task reads the message out of the Inbound 
Work Queue. If the message is not addressed to a configured list of Internet 
domains in the Global Domain document(s), it passes the message on to the 
Outbound Work Queue to be sent to the correct destination. If the address is 
recognized, the address is converted to a Lotus Notes address. If the 
message is deliverable, it is converted to Lotus Notes format and placed in 
MAIL.BOX for the Lotus Domino Mail Router to deliver. If the message fails to 
be routed to a destination or fails conversion, the conversion task will indicate 
this in the message so that Delivery Report Task can take appropriate action.

4. The Delivery Report Task polls the Inbound Work Queue and deals with the 
message accordingly, either deleting it or placing a Non-Delivery Report in the 
Outbound Work Queue.
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10.1.2  Configuration of the SMTP MTA
The configuration of the SMTP MTA is done through documents in the Public 
Address Book:

  • Server document of the server running the SMTP MTA: (main configuration in 
the Internet Message Transer Agent (SMTP MTA) section)

– Specifies the SMTP Mail Routing task.

– Provides the relationship to the Global Domain.

– Control of logging and housekeeping.

– Conversion options for the message body.

– SMTP Transport configuration.

  • Global Domain document:

– Specifies the Lotus Domino domains which are members of the Global 
Domain.

– Specifies the Internet domain suffixes, for which the MTA is acting.

– Control of the conversion of the mail addresses.

  • Foreign SMTP Domain document:

– Specifies which outbound addresses are treated as Internet addresses.

– Specifies where to send it to through the corresponding SMTP Server 
Connection.

  • SMTP Server Connection document:

– Specification of source and destination.

– Route mail directly or via mail relay.

The correct setup of these documents in the Pubic Name and Address Book is 
necessary for starting up the SMTP MTA and is described in more detail in the 
following sections.

10.1.3  Foreign SMTP Domain
A Foreign SMTP Domain document is necessary for Lotus Domino to decide, 
which mail addresses should be sent to the SMTP MTA and which should be 
handled by Lotus Domino itself:

1. Create a Foreign SMTP Domain:

  • In the PAB, view Server/Domains and click on Add Domain.

  • Specify Foreign SMTP domain as Domain type.

2. Messages Addressed to: Internet Domain:

The Lotus Domino Mail Router routes outbound SMTP mail for the Internet 
Domain you specify here. The entry acts as a filter that passes all outbound 
SMTP mail matching the filter to the SMTP MTA mailbox (smtp.box) through a 
related Connection document, rather than a regular Lotus Notes mailbox. 
Wildcards like * are allowed as part of this entry, for example, an Internet 
domain of *.* passes all outbound mail with a period to right of the @ sign to 
smtp.box. A filter value of *.com enables the Lotus Domino Router to forward 
all outbound SMTP mail with .com as the last four characters to the right of the 
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last commercial @ sign in the address. Only one wildcard designation can be 
used in the Internet Domain field.

3. Should be routed to: Domain name:

Use this field to specify a hypothetical Domain name, in our example, 
InternetSMTP, for outbound SMTP mail. The name of this hypothetical domain 
is arbitrary, but it provides the relationship to the corresponding Connection 
document and must, therefore, exactly match the entry for Destination 
domain. So, through the specification of the Internet Domain in the Foreign 
SMTP domain record, Lotus Domino decides about which messages should 
be sent to SMTP. Through this Domain name, it can find the corresponding 
connection document, which in turn states to which MTA server and which 
database (normally smtp.box) the message should be routed.

4. Save and close this screen.

The example below shows the setup in our environment:

Figure 237.  Foreign SMTP Domain

10.1.4  SMTP Connection Document
The SMTP Connection document specifies how the SMTP/MIME MTA routes 
outbound mail to the MTA server. The MTA server in turn can route the mail 
directly to the Internet hosts or to a specified Internet relay host.

1. Create an SMTP Connection record:

  • Go into the PAB, view Server/Connections and click on Add Connection.

  • Specify SMTP as the Connection type.

2. Source server: This field should contain the hierarchical name of the Lotus 
Domino Server, in our example, ah1610g/ibm.

3. Destination Server: Put an (arbitrary) description here such as we did All 
Internet hosts.

4. Destination Domain: Enter here the hypothetical Domain name in the Foreign 
SMTP Domain document as Domain name. These must exactly match since 
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this name provides the link between both documents. In our example, 
InternetSMTP is used.

5. Relay host: If you want to use a mail relay host, you must enter its Internet 
network address here. You can enter the address in its numeric form 
(9.3.1.95) or by its name (ah1610b.itsc.austin.ibm.com). If you enter the 
Internet domain name of a relay host (ah1610b.itsc.austin.ibm.com), the 
SMTP MTA performs an extra DNS lookup to determine the IP address for the 
domain name. While entering an IP address avoids the extra DNS lookup, it 
may be an advantage to enter a domain name if the relay host has multiple 
MX (mail exchanger) records for reliability or for throughput considerations. 
Specifying an optional network address causes the SMTP MTA to establish an 
SMTP session with the relay host. When the SMTP MTA completes outbound 
mail transfer to the relay host, it is the responsibility of the relay host to 
determine the next-hop routing for the specified destination (Internet domain).

6. Verify that Scheduled Connection is Enabled. See Figure 238.

7. Save and Close this screen.

Figure 238.  SMTP Connection Document

10.1.5  Server Document
In the server document of the PAB for the server on which the SMTP MTA is 
running, as shown in Figure 239 on page 274 and Figure 240 on page 275, make 
at least the following changes:

1. In the Basics section, under Routing tasks, add the task SMTP Mail Routing.

2. In the Internet Message Transfer Agent (SMTP MTA) section edit/check at 
least the fields:

  • Global Domain Name
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Enter the name for the SMTP global domain -- for example, ITSOSMTP. 
The name of the domain is arbitrary, but is used to point to the 
corresponding Global Domain document and enables the MTA server to 
access the SMTP address conversion information stored in this document.

  • Fully qualified Internet host name

Enter the fully qualified Internet host name for the Lotus Domino Server 
that is running the SMTP MTA. This field identifies the MTA server as the 
initial routing point for inbound SMTP mail. For example, 
ah1610g.itsc.austin.ibm.com is a fully qualified Internet host name. The 
string ah1610g is the Internet host name (or an alias for it) and 
itsc.austin.ibm.com is the Internet domain. Each SMTP MTA server must 
have a unique, fully qualified Internet host name. SMTP systems use the 
name entered in this field to identify each other during handshaking and 
when creating the mail header. For example, MTAs generate a Received 
header line that specifies the fully qualified Internet host names for the 
message source and destination.

  • MTA work path

The MTA uses the working directory, for example, /server1/smtpwrk, that 
will be used as the location to create temporary files for attachments and 
encapsulations. Make sure that this working directory exists on the MTA 
server, otherwise, create it.

  • MTA administrator

Enter the name of an individual administrator or group of MTA 
administrators who will receive notification from the MTA when certain 
events take place, for example, when SMTP mail is designated dead. If you 
do not specify an MTA administrator, the MTA will not deliver any 
notifications, although dead mail and other notifications will still appear in 
the Lotus Domino Log (log.nsf) on the MTA server.

3. Check the settings of the other settings: the default is fine in most cases, but 
you might be interested in reviewing the following sections:

  • Log level:

The default is Normal, but in case of problems setting this to Informational 
or Verbose might help for diagnosis, which will produces many lines in the 
log for each transmission.

  • Header handling:

SMTP mail has all information of routing and such in SMTP headers 
prefixed to the mail. The default is to Store with Delivery Information, which 

It is strongly recommended that you comply with an important Internet 
SMTP convention by creating a Postmaster mail user in the Lotus Domino 
Public Address Book for the Domain in which the SMTP MTA resides. By 
creating a Postmaster, you derive the following benefits:

  • All inbound SMTP mail addressed to Postmaster requesting information 
or help goes to a central address.

  • All administrative notifications go to the same central address.

Note
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is probably the most practical since one can look at it if necessary, but the 
headers do not show up in the main body of the Lotus Notes mail as with 
Prepend to body of message.

  • Message content:

This important setting specifies the format for outbound mail to SMTP. The 
different options are:

Users without Lotus Notes (default)
Converts the message to a SMTP/MIME message.

Simple text only mail users
Converts the message to a simple-text, non-MIME message. 
You can only encode attachments to a message (specified in 
the server field Attachment encoding method) as UUencode or 
as None (8-bit).

Only Lotus Notes users
Encapsulates the message. (You must specify Base64 or 
QuotedPrintable as the attachment encoding method.)

Users with and without Notes
Sends a message with both converted and encapsulated. (You 
must specify Base64 or QuotedPrintable as the attachment 
encoding method.)

In most cases the default (Users without Lotus Notes) is probably the right 
choice since it converts your Lotus Notes mail for SMTP/MIME mail users 
with the highest possible fidelity, and also a remote Lotus Notes user will 
be able to see all your attachments (after a reconversion by another SMTP 
MTA).

If you are sending mail between different Lotus Domino domains without a 
Lotus Domino connection through SMTP (for example, the Internet) using 
SMTP MTA's on both sides, you can specify Only Lotus Notes users. In this 
case, all Lotus Notes messages will be converted and encapsulated so that 
they are sent and received with 100% fidelity. Users with and without Notes 
would be the most general setting since it combines the highest fidelity for 
SMTP/MIME users (as with Users without Lotus Notes) with the 100 
percent fidelity for Lotus Notes users (as with Only Lotus Notes users), but 
has the serious drawback that the mail volume is more than doubled since 
every piece of mail is essentially sent in two versions.

  • Message typeface & point size

Inbound SMTP mail will be converted into this typeface and point size. The 
default is Courier (monospaced) of point size 9.

This setting will be in effect for all messages converted by this SMTP 
MTA. It is however possible for the Lotus Notes mail user to specify 
encapsulation on a per mail basis: Open a new mail, select Actions - 
Special Options... and select the option Sending this Notes document 
to other Notes mail user(s) through the Internet.
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Use the Message Typeface field to specify a typeface style for inbound 
SMTP mail. The MTA converts mail messages to the specified typeface. 
Courier (monospaced) is the default.

For an explanation of all parameters, refer to the SMTP MTA Administration 
Guide.

An example of the respective parts in our environment of the server document of 
ah1610g/ibm is shown below:

Figure 239.  Internet Message Transfer Agent (SMTP MTA) (Screen 1 of 2)

Keep in mind that Internet mail users use fixed space fonts. If you select 
a proportional font here, parts of the mail (for example, a table) will 
probably not be aligned correctly.
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Figure 240.  Internet Message Transfer Agent (SMTP MTA) (Screen 2 of 2)

10.1.6  Global Domain Document
At least one Global Domain document must be set up:

1. Create a Global Domain document:

  • Open the PAB in view Server/Domain and click on Add Domain.

  • Under the Basics section, select Global Domain as the Domain type.

2. Assign the Global Domain name that was used in the server document. This 
name provides the link between the MTA server and the Global Domain 
document, but is otherwise arbitrary. In our case, this is ITSOSMTP.

3. Specify SMTP MTA in the field Global domain role.

4. Internet domain suffix: Enter a list of Internet domain suffixes for which you 
want to receive/convert incoming mail. In our environment we have set this to 
itsc.austin.ibm.com, which means that the SMTP MTA would try to deliver 
mail to a user joe@itsc.austin.ibm.com. Addresses with any other Internet 
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domain suffix will not be converted but the SMTP MTA will try to relay it 
through SMTP to the respective domain. It is possible to enter more than one 
domain in this field, which means that Lotus Domino will accept all of the listed 
domain names.

5. Save and close the Global Domain document.

To ensure that messages sent to these domains are routed to the Lotus Domino 
Server running the SMTP MTA, you must arrange for the Domain Naming Service 
(DNS) to map each of your Internet domain names to the IP address of your 
server, or to an MX record that names your server. The DNS typically requires 
one or more mail exchanger (MX) records that associate the Internet domain with 
one or more SMTP MTA servers. You might, for example, define an MX record 
that links an Internet domain to a primary SMTP MTA server, and another MX 
record that links the same Internet domain to a backup SMTP MTA server. When 
specifying an SMTP MTA server to the DNS, use the server’s fully qualified 
Internet host name.

10.1.6.1  Specifying Multiple Internet Domains
The text that follows illustrates how to specify the MX records for a single Lotus 
Domino Global Domain (for example, ITSOSMTP) with multiple Internet domain 
names (for example, notes.itsc.austin.ibm.com and itsc.austin.ibm.com).

Mail can be addressed to both Internet domains:

1. MX record: notes.itsc.austin.ibm.com IN MX ah1610g.itsc.austin.ibm.com

2. MX record: itsc.austin.ibm.com IN MX ah1610g.itsc.austin.ibm.com

Additionally MX records could be provided pointing to a (second) backup 
SMTP MTA server on ah1610f/ibm, such as:

3. MX record: notes.itsc.austin.ibm.com IN MX ah1610f.itsc.austin.ibm.com

In this case, if ah1610g.itsc.austin.ibm.com wasn’t operational, mail could be 
delivered to ah1610f and processed there.

Notes Domains and aliases:

Enter a list of Lotus Domino domains, which are part of this Global domain. In 
many cases this will be only the one Lotus Domino domain, which the MTA 
server is part of. If you need to specify any domain name containing 
non-ASCII characters, follow the special instructions in the Lotus Domino 
Administration Help database.

SMTP Address Conversion:

These variables specify for outgoing Lotus Domino mail into SMTP the way in 
which Lotus Notes addresses are converted (to allow an SMTP mail recipient 
to reply to your mail). Given the defaults also shown in Figure 241, in our 
environment a sender address of Notes User/ibm would convert into 
Notes_User/ibm%ibm@notes.itsc.austin.ibm.com. Note that the first item in the 
Internet domain suffix list is taken as the last part in the above address. You 
can change the composition of the address by deciding what part should be 

The first entry in the list will be used as part of the senders address for 
outbound mail from Lotus Domino to SMTP.
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used for the user name and the number and placement of included Lotus 
Notes domain names. For details of these settings and the possible usages, 
refer to the Lotus Domino Administration Help database.

As an example, the next figure shows the Global Domain document in our 
example environment:

Figure 241.  Global Domain Document

10.1.6.2  Other SMTP MTA Server Configurations
If you have an Intranet, or if you simply want to use more than one server to send 
outbound SMTP mail, you might want to create a separate Foreign SMTP Domain 
document for each outbound Internet domain. For example, you might create one 
Foreign SMTP document with an Internet domain of *.* and the_internet as the 
routing Domain Name. Additionally, you might create a second Foreign SMTP 
Domain document with an Internet domain of *.alfaskop.se and the_intranet as a 
routing Domain Name. The Lotus Domino Mail Router searches for SMTP mail 
messages in order from the most specific (for example, *.alfaskop.se) to the least 

Since no Space characters are allowed in SMTP addresses, in cases, such 
as the above, Lotus Domino SMTP MTA need to convert spaces into some 
other character, ’_’ is the default. The only other alternative is ’.’, which can 
be set through the Lotus Notes variable SMTPMTA_Space_Repl_Char. 
Since this can have several side effects, make sure to look into the 
corresponding sections of the Lotus Domino Administration Help database.
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specific (for example, *.*). It then matches outgoing Internet addresses in that 
order. For example, the outgoing address link.alfaskop.se matches *.alfaskop.se 
because it is more specific than *.*.

Other examples, including the configuration documents in the PAB, are described 
in the SMTP MTA Administration Guide.

10.1.6.3  Character Set Translation
The MTA tables database (mtatbls.nsf) is a preconfigured Lotus Notes database 
that provides file format and character set information for all MTAs during 
outbound and inbound message conversion processing. It is possible to extend or 
modify the content of the MTA tables database, if you have specific needs, for 
example, changing the default file extension that is assigned to inbound 
attachments when a file name is not specified.

But because updating the MTA tables is a sensitive operation that requires 
caution, be sure to read and understand all aspects of tables processing, before 
you undertake this task. For the necessary information, see Appendix C of the 
SMTP MTA Administration Guide.

10.1.6.4  Migration from the SMTP Gateway
SMTP MTA has more features than the older SMTP Gateway, runs only under 
Lotus Domino Release 4, and is the replacement for the SMTP Gateway.

The migration from an SMTP Gateway to an SMTP MTA can happen gradually, if 
you run both programs concurrently for a limited time (on different servers). A 
gradual approach means that you can migrate one group at a time from the old 
gateway-style addressing (for example, user@internet.address@SMTPGW) to 
the new MTA-style addressing (for example, user@internet.address).

If you have an existing SMTP Gateway set up as the Foreign Domain SMTPGW, 
you can proceed like this:

1. Install a new server as an SMTP MTA (or install the SMTP MTA on an existing 
Lotus Domino Release 4 server).

2. To enable users that are on Lotus Notes Release 3 mail servers to use the 
SMTP MTA, do the following:

a. Set up a Foreign Domain document on the Lotus Notes Release 3 server.

b. Enter an appropriate name for the Foreign Domain document, such as 
SMTPMTA.

c. Enter the Gateway Server Name. This is the name of the server that is 
running the SMTP MTA.

d. Enter the Gateway mail file name as SMTP.BOX.

Note that users, who have their mail files on Lotus Notes Release 3 servers, 
can’t use MTA-style addressing. After you configure the Foreign Domain 
document, users will still have to add the new foreign domain name to the end 
of addresses (for example, jdoe@acme.com@SMTPMTA).

3. If the Foreign Domain document for your SMTP Gateway is changed similar to 
the document in Step 2 by filling in Gateway Server and Mail file name, you 
can reroute all old style addresses, such as 
user@internet.address@SMTPGW, to the new SMTP MTA. After doing so, the 
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SMTP Gateway should not receive any messages from Lotus Notes users any 
more.

4. After making the corresponding changes in your Domain Name System 
(DNS), so that no more messages are routed from the SMTP side to the SMTP 
Gateway machine, but only to the SMTP MTA server, the SMTP Gateway 
machine can be switched off.

5. After all users have been educated not to use @SMTPGW in their addresses 
(and it is taken out of all Name and Address Books), the Foreign Domain 
SMTPGW is not necessary and can be removed.

10.1.7  Monitoring the SMTP MTA
To monitor the status of the SMTP MTA and its subtasks use:

 show tasks

on the server console of the MTA server. In idle state you should see the following 
six lines in the output of this command:

 SMTPMTA drt          Idle
 SMTPMTA isesctl      Listening on SMTP port 25
 SMTPMTA imsgcnv      Idle
 SMTPMTA osesctl      Idle
 SMTPMTA omsgcnv      Idle
 SMTPMTA              Idle

plus additional lines for in- and/or outbound session handlers, such as:

 SMTPMTA oseshlr0     Active SMTP session with  link.alfaskop.se

10.1.7.1  Statistics
The SMTP/MIME MTA automatically sends statistical information to Lotus 
Domino. To display the SMTP MTA statistics enter:

show stat mta.smtp.*

on the MTA’s server console.

A series of messages that begin with the text string MTA.Smtp appears on the 
console screen and is added to the Lotus Domino Log in the Miscellaneous 
Events view:

> show stat mta.smtp.*
  MTA.Smtp.Dead = 1
  MTA.Smtp.TotalKBTransferred = 189
  MTA.Smtp.TotalRouted = 0
  MTA.Smtp.TransferFailures = 19
  MTA.Smtp.Transferred = 162
  MTA.Smtp.Waiting = 2
  MTA.Smtp.WaitingRecipients = 0

For the detailed explanation of these statistics variables, see the SMTP MTA 
Administration Guide.
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The Delivery Report Task (drt) is responsible for collecting the statistics. 
Therefore, if the drt subtask is not running, statistics will not get updated. This 
also means that the statistics will not be updated at the point every message is 
processed, but will only be updated when drt processes the messages in the 
queues. The MTA.Smtp.Waiting statistic is first a snapshot of the inbound work 
queue count. Then the outbound work queue count is added to the inbound. If 
either queue is greater than 100, the count for that queue will only be 100.

10.1.8  Running the SMTP MTA
In this section, we will be discussing some of the useful commands for controlling 
the operations of the SMTP MTA.

10.1.8.1  Starting and Stopping the SMTP MTA
To start the SMTP MTA manually enter on the Lotus Domino Server console of 
the MTA server:

load smtpmta

Lotus recommends that you load the MTA manually the first time, and that 
whenever possible, you start the application from the server console rather than 
from the remote server console.

To start the SMTP MTA automatically at server startup add the task SMTPMTA to the 
ServerTasks= line in the notes.ini file, for example,

ServerTasks=SMTPMTA, REPLICA, ROUTER, UPDATE, ...

To completely shut down the SMTP MTA once all tasks have finished the current 
process, on the Lotus Domino Server console, enter the command:

tell smtpmta Quit

It is also possible to start or stop the subtasks of the SMTP MTA individually. For 
the respective commands, see the SMTP MTA Administration Guide.

10.1.8.2  Other Useful Commands for the SMTP MTA
You can get help about the SMTP MTA commands with:

 tell smtpmta help

You can display the current version of the MTA with:

 tell smtpmta show versios

To see the configuration of the SMTP MTA use:

 tell smtpmta show config

Obviously MTA.Smtp.Dead is an important statistics variable. If it is not zero, you 
will find messages with status dead in some of the MTA’s internal workqueues 
(SMTP.BOX, SMTPOBWQ.NSF, SMTPIBWQ.NSF). These dead messages 
must be handled manually. The SMTP MTA will try to inform the MTA 
Administrator, specified in the MTA’s server document, if mail goes into the 
status dead.
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To reload the configuration manually you can use:

 tell smtpmta refresh

This refresh command instructs the SMTP MTA to reload its configuration. It 
reloads the notes.ini setting that applies to the MTA and any changes in Public 
Address Book documents that apply to the MTA.

The command:

tell smtpmta compact

forces the SMTP MTA to compact the file smtp.box. The daily housekeeping (see 
the specification in the server document) will shut down the SMTP MTA once a 
day and compact the MTA databases (smtp.box, smtpobwq.nsf and 
smtpibwq.nsf).

10.2  POP and IMAP

There are two Internet protocols in wide spread use for e-mail message access. 
The Post Office Protocol, Version 3 (POP3) is a protocol that allows a client 
capable of POP3, such as Netscape Navigator, Eudora Pro, or Microsoft Internet 
Explorer to retrieve mail from a host server also capable of POP3. The Internet 
Message Access Protocol, Version 4 (IMAP4) is another protocol that allows for 
more advanced message manipulation. POP3 can only be used for off-line 
reading, where messages are downloaded from the POP3 server to the local 
host. IMAP4 allows for both off-line and on-line reading of messages. IMAP4 also 
permits manipulation of remote message folders in a way that is functionally 
equivalent to local message folders. Examples of IMAP4 clients are Netscape 
Navigator and Microsoft Outlook 98.

10.2.1  Lotus Domino and Internet Mail
Lotus Domino servers can now be host servers for Internet mail (POP3 and 
IMAP4) clients. These clients do not (necessarily) run Lotus Notes but have Lotus 
Notes mail files on the Internet mail server and they periodically connect to the 
server using TCP/IP to retrieve their mail.

To use a Lotus Domino Server as an Internet mail server:

  • Run the server task POP3 or IMAP respectively, or both.

  • Create a mail file on the server and a Person document in the Public Address 
Book for each client that will use the server as its Internet mail host (and is not 
already a Lotus Notes user).

An existing Lotus Notes user can access their mail file through an Internet mail 
client (and/or through the Lotus Notes client) as long as their mail database (or a 
replica of it) is located on the Internet mail server.

A Lotus Domino Internet mail server continuously listens for connection requests 
from e-mail clients on a TCP/IP port. For POP3 it is port number 110, and IMAP4 
uses the port 143. When a client establishes a connection, the Internet mail 
server authenticates the client using standard POP3 or IMAP4 authentication 
(with the HTTP password from the Person document in the PAB). If authentication is 
successful, the server gives the client access to the contents of the client's Lotus 
Notes mail file.
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Internet mail clients do not use Lotus Notes user IDs and their Person documents 
do not contain public keys if they are not also Lotus Notes users. Therefore they 
cannot receive encrypted mail. Authentication occurs through the standard POP3 
or IMAP4 user and password authentication mechanism. Authentication using the 
APOP command in POP3 is not implemented on Lotus Domino POP3 servers, 
but the whole session can use SSL for security.

A Lotus Domino Internet mail server only stores and enables retrieval of mail 
received by POP3 and IMAP4 clients. To implement a complete Lotus Domino 
mail system for Internet mail clients requires the Lotus Domino SMTP/MIME MTA 
for transporting outbound and inbound mail for the client and the Lotus Domino 
Mail Router for delivering inbound mail to Internet mail files on a Lotus Domino 
POP3/IMAP4 server. Therefore, in addition to setting up a Lotus Domino POP3 or 
IMAP4 server, you must also set up the SMTP/MIME MTA on at least one server 
at your site and set up Lotus Domino mail routing by creating the necessary 
Connection and Domain documents in the Public Address Book.

Internet mail clients can send e-mail to other Internet mail clients having their 
Lotus Notes mail files in the same domain or Lotus Notes mail users through a 
conversion from SMTP to Lotus Domino via the SMTP MTA.

For example, to send a message to another POP3 client in the same Lotus 
Domino Domain, the client addresses the mail using the Internet addressing 
format, astenmark@itsc.austin.ibm.com. The message goes directly to the 
SMTP/MIME MTA which finds the recipient’s name in the Lotus Domino Server’s 
Public Address Book and converts the message. From there, the Lotus Domino 
Mail Router delivers the message to the recipient’s mail file on the Lotus Domino 
Server running POP3 and on to the Lotus Domino mail server of the Lotus Notes 
mail user. It works the same way with IMAP4. It also does not matter if the sender 
and receiver use different protocols to read their mail.

If an Internet mail client sends mail to another Internet mail client that uses 
another mail system or any other SMTP mail address, the message goes to the 
SMTP/MIME MTA which begins the transfer of the message to the recipient’s 
remote server.

The software and hardware requirements for a Lotus Domino Internet mail server 
are the same as for a standard Lotus Domino Server, except for the following:

  • The Lotus Domino Server must be configured to use TCP/IP.

  • On at least one server of the site the SMTP/MIME MTA must be installed and 
the Connection and Domain documents for the mail routing must be set up to 
handle the transport of mail from Internet mail clients.

Even if the Lotus Notes mail database for an Internet mail client is able to hold 
mail messages with Rich Text formed bodies including pictures, and so on, by 
accessing this mail database through the Internet mail client, you lose all these 
capabilities and can see only the plain text of the message. Only attachments 
can be accessed through the Internet mail client.
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10.2.2  Starting and Stopping the POP3/IMAP4 Servers
There are three options for starting the Internet Mail servers:

  • If you selected POP and/or IMAP when you installed Lotus Domino, the 
respective server task(s) will be automatically activated.

  • If you did not select POP and/or IMAP when you installed Lotus Domino, you 
may start it manually using one of the following commands on the server 
console:

load pop3

for POP3, or

load imap

for IMAP4.

  • To start the POP and IMAP server tasks automatically at Lotus Domino Server 
startup, add POP3 and/or IMAP to the ServerTasks entry in notes.ini. For 
example:

ServerTasks=POP3, IMAP, REPLICA,...

You can verify that your Internet Mail server(s) are running by executing the 
command show tasks at the server console. The output should include a few lines 
similar to these:

POP3 Server          Listen for connect requests on TCP/IP port 110
POP3 Server          Control task
IMAP Server          Listen for connect requests on TCP Port:143 
IMAP Server          Control task

To shut down the Internet Mail servers, you have two options:

  • Shut it down manually by executing one of the following commands at the 
server console:

tell pop3 quit

for POP3, or

tell IMAP quit

for IMAP4.

  • Deactivate the automatic startup by removing POP3 and/or IMAP from the 
ServerTasks entry in notes.ini, and then restart the Lotus Domino Server.

10.2.3  Preparation for an Internet Mail Client
If you want to prepare for an Internet mail client, who is not already a Lotus Notes 
user, and therefore, has neither a Lotus Notes mail file nor a Lotus Notes Person 
document, you must create these manually:

1. Create a Lotus Notes mail file:

a. Log into the Lotus Notes Workspace as an administrative user.

b. Choose File - Database - New...

c. In the Server field, select a Lotus Domino Server which is running the 
POP3 or IMAP4 server.

d. In the title field, enter the title of the client's mail file, for example, Andreas 
Stenmark’s Mail
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e. In the File name field, enter a path name and file name for the mail file, for 
example, mail/astenmark.nsf.

f. Select the template Mail (R4.6).

g. Click on OK.

2. Create a Person document:

a. Open the Public Address Book

b. Choose Create - Person

c. Complete the Name section:

  • Enter a first name, middle initial, and last name. Lotus Domino uses this 
to display the user's name in the People view of the Public Address 
Book.

  • In the User name field, enter the hierarchical name for the client.

  • In the Short name field, enter a string (without spaces), which is unique 
in your domain (for example, not equal to any other First, Last or Short 
name in the PAB). This will be used as the Internet mail client user 
name. You may choose the first character of the First name followed by 
the Last name, for example, astenmark.

  • In the HTTP password field, enter the password the Internet mail client 
will use to log on to the server. Lotus Domino scrambles the password. 
This field is required.

d. Complete the Mail section:

  • In the Mail system field, select POP or IMAP.

  • In the Domain field, enter the Lotus Domino domain of the Internet mail 
server.

  • In the Mail server field, enter the name of the Internet mail server.

  • In the Mail file field, enter the path to the client's mail file on the Internet 
mail server relative to the Lotus Domino data directory. For example, 
enter mail/astenmark.

e. In the Encrypt incoming mail field in the Misc section, you must select No, 
since Internet mail clients cannot receive encrypted mail.

To make preparations to allow existing Lotus Notes mail users to access their 
mail from POP3 or IMAP4 clients, specify a password in the HTTP password field 
of their existing Person documents. Also configure the Internet mail clients so 
that mail is not automatically removed from the server, since otherwise, they 
cannot be read from the Lotus Notes client after retrieving them through the 
Internet mail client.

The Lotus Domino POP3 server does not copy messages to the POP3 client 
that have already been read through Lotus Notes. If you are viewing your 
messages online using IMAP4, you will see all messages. However, be aware 
that Lotus Notes and the IMAP server have separate flags for whether a 
message has been read or not. If you read a message in one system, it will not 
automatically show up as read in the other.
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10.2.4  Setting Up a POP3 Client
The steps to configure POP3 client software for mail are specific to each 
manufacturer, but the following information is required:

  • The TCP/IP Internet host name of the machine running the SMTP/MIME MTA, 
for example, ah1610f.itsc.austin.ibm.com.

  • The TCP/IP port number, if the POP3 server is using a non-standard port.

  • The TCP/IP Internet host name of the machine running the Lotus Domino 
POP3 server, for example, ah1610g.itsc.austin.ibm.com.

If the Lotus Domino POP3 server and the SMTA/MIME MTA run on the same 
machine, the host names are the same.

  • The POP3 client user name. The POP3 client user name must exactly match 
the Short name entry in the client's Person document in the Public Address 
Book.

In addition, we recommend that you do the following:

  • Set up the POP3 client so that mail is automatically deleted from the mail file 
on the POP3 server after the client copies it locally. If you do this, the client 
mail file takes up minimal disk space on the Lotus Domino Server. Do not 
select this option, however, if a user also continues to access mail from Lotus 
Notes.

  • Set up the POP3 client so that it checks for mail at most once every five 
minutes. If the client checks for mail more frequently than this, it's possible for 
server performance to suffer.

10.2.4.1  Setting up the Netscape Navigator POP3 Client Software
The following table, Table 11, shows the fields in the Netscape Navigator Mail and 
News Preferences dialog box that pertain to setting up a client for a Lotus 
Domino POP3 server.

Table 11.  Netscape Navigator Mail and News Preferences (POP)

Figure 242 on page 286 and Figure 243 on page 286 show screen shots of an 
example setup of the POP3 client in Netscape Navigator 4.

Mail and News
Preferences

Description Example

Outgoing Mail Server
(SMTP)

The TCP/IP hostname of the host
running the SMTP MTA.

ah1610f.itsc.austin.ibm.com

Incoming Mail Server
(POP3)

The TCP/IP hostname of the host
running the Lotus Domino POP3
Server.

ah1610g.itsc.austin.ibm.com

Mail Server User
Name

Short name field from the Person
document in the Lotus Domino
Public Address Book.

axel

Leave messages on
server after retrieval

Determines whether the client’s
messages remain on the Lotus
Domino POP3 Server after being
copied to the client.

Remove from server

Check for Mail: Every
x minutes or never

Determines how often the POP3
client checks for new mail.

Every 15 minutes
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Figure 242.  Netscape Navigator Setup (POP)

Figure 243.  Netscape Navigator Setup, More Options... (POP)

For another POP3 client, Eudora Pro, see the Lotus Domino Administration Help 
documentation database.

10.2.5  Setting Up an IMAP4 Client
The steps to configure IMAP4 client software for mail are specific to each 
manufacturer and is very similar to configuring POP3 client software. The 
following information is required:

  • The TCP/IP Internet hostname of the machine running the SMTP/MIME MTA, 
for example, ah1610f.itsc.austin.ibm.com.

  • The TCP/IP port number, if the IMAP4 server is using a non-standard port.
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  • The TCP/IP Internet hostname of the machine running the Lotus Domino 
IMAP4 server, for example, ah1610g.itsc.austin.ibm.com.

If the Lotus Domino IMAP4 server and the SMTA/MIME MTA run on the same 
machine, the hostnames are the same.

  • The IMAP4 client user name. The IMAP4 client user name must exactly match 
the Short name entry in the client's Person document in the Public Address 
Book.

In addition, we recommend that you do the following:

  • Set up the IMAP4 client so that it checks for mail at most once every five 
minutes. If the client checks for mail more frequently than this, it's possible for 
server performance to suffer.

10.2.5.1  Setting up the Netscape Navigator IMAP4 Client Software
The following table, Table 12, shows the fields in the Netscape Navigator Mail 
and News Preferences dialog box that pertain to setting up a client for a Lotus 
Domino IMAP4 server.

Table 12.  Netscape Navigator Mail and News Preferences (IMAP)

Figure 244 on page 288 and Figure 245 on page 288 show screen shots of an 
example setup of the IMAP4 client in Netscape Navigator 4.

Mail and News
Preferences

Description Example

Outgoing Mail Server
(SMTP)

The TCP/IP hostname of the host
running the SMTP MTA.

ah1610f.itsc.austin.ibm.com

Incoming Mail Server
(IMAP4)

The TCP/IP hostname of the host
running the Lotus Domino IMAP4
Server.

ah1610g.itsc.austin.ibm.com

Mail Server User
Name

Short name field from the Person
document in the Lotus Domino
Public Address Book.

axel

Check for Mail: Every
x minutes or never

Determines how often the POP3
client checks for new mail.

Every 15 minutes

Keep copies of
messages for offline
reading

Determines whether messages
should be copied to the local host,
as well as kept on the remote host.

Not checked

Move deleted
messages into Trash

Determines whether you want to
use a trash folder to delete
messages.

Checked
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Figure 244.  Netscape Navigator Setup (IMAP)

Figure 245.  Netscape Navigator Setup, More Options... (IMAP)

Eudora Pro can also act as an IMAP4 client. For more information on how to set it 
up, see the documentation that came with your copy of Eudora Pro.

10.3  NNTP

Network News Transfer Protocol (NNTP) is an Internet protocol for reading and 
distributing Network News, or newsgroups. It is used both for client-server 
connections and for communications between servers. It is an alternative to 
setting up a mailing list, using direct mail to distribute messages. Such remailing 
is inefficient when the number of subscribers grows beyond a dozen or so people. 
What you really want is efficient, centralized storage of messages that people can 
access if and when they need them. NNTP provides means for distribution, 
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inquiry, retrieval, and posting of news articles using a reliable stream client-server 
model. NNTP is designed so that news articles need only be stored on one host, 
while subscribers on other hosts may read news articles over TCP/IP 
connections, thereby minimizing the disk and CPU resources necessary on the 
client hosts.

10.3.1  Lotus Domino and NNTP
When you activate the Network News Transfer Protocol on your Lotus Domino 
Server, the server becomes a Lotus Domino NNTP Server. A Lotus Domino 
NNTP Server lets users participate in private discussion groups or public 
USENET newsgroups using a Lotus Notes client, a standard NNTP newsreader 
(such as Netscape Collabra or Microsoft Internet Explorer News), or a Web 
browser.

A Lotus Domino NNTP Server supports the following:

  • Users of Lotus Notes Release 4.6 clients, standard newsreader client and 
Web browser clients participating in the same discussion.

  • USENET newsgroups that are distributed across the Internet.

  • Private newsgroups for use within your organization.

  • Distribution of news articles using NNTP newsfeeds to and from other NNTP 
servers.

  • Server security: anonymous access, basic password authentication, and 
Secure Socket Layer encryption and authentication.

  • Archiving of newsgroup articles.

  • Personal interest profiles that notify you about articles of interest.

We will describe the most important tasks involved in setting up a Lotus Domino 
NNTP Server. It is beyond the scope of this book to describe every single feature 
of a Lotus Domino NNTP Server in detail. For more information on any particular 
subject concerning the NNTP server task, refer to the Lotus Domino 
Administration Help database or the printed manuals that came with your copy of 
Lotus Domino.

It is possible to use the Lotus Domino NNTP Server in a partitioned environment, 
if you have the Domino Advanced Services installed. See 11.3.6, “Considerations 
for Internet Server Tasks” on page 345 for details on how to run the NNTP server 
task on a partitioned server.

10.3.2  Installation and Configuration
When you install Lotus Domino Release 4.6, the NNTP server task is also 
automatically installed. There is no need to install additional software to enable 
Lotus Domino to be used as an NNTP server. There is also very little 
configuration to be done before you can start adding your own newsgroups to 
your Lotus Domino NNTP Server. How much work you need to do after this 
depends of course on how you intend to use the NNTP server. You may want a 
single stand-alone NNTP server, without any connections to other NNTP servers 
or the USENET. On the other hand, you might be looking for a large solution with 
many newsgroups, USENET news as well as private news, and many servers in 
different physical locations, each with one or more newsfeeds or replicated 
databases. Each installation of Lotus Domino NNTP will have its own 
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configuration and setup procedure, but here is a rough overview of the necessary 
steps included:

1. Start the NNTP server task on your Lotus Domino Server, if necessary.

2. (Optional) Connect to your Internet Service Provider (ISP) if you want to get a 
newsfeed from your ISP.

3. (Optional) Set up the Internet Port and Security Configuration section in the 
Server document for your Lotus Domino NNTP Server in the Public Address 
Book. If you do change the default settings in the Internet Port and Security 
Configuration section, you must restart your Lotus Domino NNTP Server task. 
To restart, type tell nntp quit and load NNTP at the server console.

4. Set up the NNTP Server section in the Server document for your Lotus 
Domino NNTP Server.

5. (Optional) Set up each newsfeed in a Connection document.

6. Create private or USENET newsgroups. If you want your Lotus Domino NNTP 
Server to host existing USENET newsgroups, which reside on a peer NNTP 
server, you can configure the NNTP server to create these newsgroups 
automatically during a newsfeed.

7. (Optional) Prepare for and set up a newsfeed to exchange articles with other 
NNTP servers on the Internet. You can use replication to exchange articles in 
newsgroups with other Lotus Domino NNTP servers within your organization.

8. Set up newreader clients to connect to your Lotus Domino NNTP Server.

In addition to this, you may want to think about security. It is possible with NNTP 
on Lotus Domino to control access to newsgroups. Maybe some users should 
have read-only access to some newsgroups. Maybe you are setting up 
newsgroups with sensitive information that you don’t want all employees to read, 
and so only some users should be able to read those newsgroups. If you don’t 
trust the network that the information will be travelling, you may want to set up 
SSL for your NNTP server. For more information on SSL and security, refer to 
8.6, “Secure Socket Layer (SSL)” on page 201.

10.3.3  Starting and Stopping the NNTP Server Task
There are three options for starting the NNTP server:

  • If you selected NNTP when you installed Lotus Domino, the NNTP server task 
will be automatically activated.

  • If you did not select NNTP when you installed Lotus Domino, you may start it 
manually using the following command at the server console:

load nntp

  • To start the NNTP server task automatically at Lotus Domino Server startup, 
add NNTP to the ServerTasks entry in notes.ini. For example:

ServerTasks=NNTP, REPLICA, ROUTER, UPDATE, ...

You can verify that the NNTP server is running by using the command show tasks 
at the server console. The output should include a few lines similar to these:

NNTP Server          Scheduler
NNTP Server          Listen for connect requests on TCP Port:119
NNTP Server          Control task
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To shut down the NNTP server, you have two options:

  • Shut it down manually by executing the command tell nntp quit at the server 
console.

  • Deactivate the automatic startup by removing NNTP from the ServerTasks 
entry in notes.ini, and then restart the Lotus Domino Server.

10.3.4  Creating a Private Newsgroup
To create a new private newsgroup you must be logged in as a user with the 
authority to create databases. A newsgroup is a Lotus Domino database, and 
each newsgroup is its own database. Follow these steps to create the newsgroup 
itso.redbooks.aix.domino on server ah1610g/ibm:

1. From the Lotus Notes Workspace, choose File -> Database -> New... to 
create the new newsgroup database.

2. In the server field, select ah1610g/ibm.

3. As the title of the database, enter itso.redbooks.aix.domino.

4. In the file name field, enter nntp/itso.redbooks.aix.domino.nsf.

5. Select server ah1610g/ibm as the template server, and highlight the template 
NNTP Discussion (R4.6). Your window should now look similar to the one in 
Figure 246.

Figure 246.  Create a New Newsgroup Database

6. Click OK to create the database. It might take a little while before you see the 
next window.

7. The next window you should see is the Database Profile window for the 
database you just created (see Figure 247 on page 292). There might also be 
an About... window popping up, but it is safe to close it down. Verify that the 
settings are the ones you entered when you created the database. The 
Database Profile Editor field will be filled in with the creator of the database. 
You might want to add people or groups to this field. When you’re done, click 
on Save and Close.
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Figure 247.  Edit the New Newsgroup Database Profile

Congratulations! Your newsgroup has been created, and you can start posting 
news articles to it. If the NNTP server task is running, NNTP clients can also 
connect and post news articles at this time.

It is also possible to create a new private newsgroup from the server console. 
See the Lotus Domino Administration Help database for details.

10.3.5  Removing a Private Newsgroup
Removing a private newsgroup is no more difficult than removing any other Lotus 
Domino database. Follow these instructions:

1. From the Lotus Notes Workspace, select the newsgroup database you wish to 
delete, and choose File -> Database -> Delete....

2. A window will appear, similar to the one in Figure 248 on page 293. Verify that 
the database name and the server are correct for the database you want to 
delete, and click Yes to delete it permanently. Click No if you do not wish to 
delete this database.

If you create the newsgroup from a Lotus Notes client and not on the server, 
the newsgroup may not be visible to NNTP clients and remote NNTP servers 
for up to two hours. To make the newsgroup immediately visible, type tell nntp 
quit and then load nntp to stop and then restart the NNTP server.

Note
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Figure 248.  Confirm or Deny Removal of Database

If you clicked Yes, the database will be removed from the workspace and from 
disk. NNTP clients can no longer use this newsgroup.

10.3.6  Configuring a Newsfeed
With Lotus Domino, there are four types of newsfeeds: Accept, Push, Pull, and 
Pull-Push. A push newsfeed allows your Lotus Domino Server to connect to a 
remote NNTP server and send new articles to that server. A pull newsfeed 
connects to a remote NNTP server and requests new articles from that server. A 
pull-push newsfeed will copy articles in both directions. If you want another NNTP 
server to be able to initiate a push newsfeed to your server, you need to set up an 
accept newsfeed. In this section, we will describe how to set up your Lotus 
Domino NNTP Server to do accept and push newsfeeds. Setting up the 
remaining newsfeed (pull and pull-push) is similar to setting up the push 
newsfeed. Refer to your Lotus Domino documentation for more information.

10.3.6.1  Accepting Incoming Newsfeeds
This example assumes that you have a direct connection, through a firewall or 
otherwise, to the remote NNTP server. If you are connecting to the remote server 
in any other way, please refer to the Lotus Domino Administration Help database 
for more details.

1. As an Lotus Domino administrator, open the Public Address Book and select 
the Server Connections view.

2. Click on the Add Connection button.

3. In the Connection Type field, select News/NNTP Feed.

4. In the Source server field, specify the Lotus Domino NNTP Server name, for 
example ah1610g/ibm.

5. In the Connect via field, select Direct connection.

6. In the Destination Server field, enter the fully qualified TCP/IP hostname or 
address of the remote NNTP server. For Accept newsfeeds, this field denotes 

Access control lists for newsgroups are not distributed through an NNTP 
newsfeed. If you include private newsgroups in a newsfeed, you must trust the 
remote NNTP server to enforce the access control policy. To enforce access 
control for private newsgroups within your organization, you should use Lotus 
Domino replication instead of an NNTP newsfeed.

Note
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the remote host that will be connecting to your NNTP server. In our case, the 
remote host is noteserv.itsc.austin.ibm.com.

7. In the Newsfeed type field, select Accept.

8. In the Authentication field, select None or Password. The default is None.

Select Password if you require the remote server to authenticate with a name 
and password to initiate the feed. This setting must be in sync with the 
authentication options that you select in the Internet Port and Security section 
of the Server document for your server. For example, if your server does not 
accept Name & Password authentication over the port that this remote server 
uses for the newsfeed, then Password authentication is not needed for this 
feed. If you use Password authentication, the Server document settings take 
precedence and can prohibit the feed.

9. In the Channel encryption field, select None or SSL. The default is None.

Select SSL if you require the remote server to connect over the SSL port that 
you have enabled in the Internet Port and Security section of your Server 
document. This setting must be in line with the authentication options that you 
select in the Internet Port and Security section of the Server Document for 
your server. For example, if your server does not enable an SSL port, then 
SSL encryption can be required for this feed. If you use SSL encryption, the 
Server document settings take precedence and can prohibit the feed.

10.In the Create newsgroups field, select Automatic or Manual.

The default is Automatic. Select Automatic if you want your Lotus Domino 
NNTP Server to create newsgroups for all groups included in this newsfeed 
that do not already exist on your server.

Select Manual if you want to manually create all newsgroups on your server.

11.In the Newsgroup subdirectory field, specify the subdirectory in which to store 
newsgroups created during the newsfeed, for example, nntp. This field only 
applies if you selected Automatic in step 10. We recommend that you organize 
your newsgroup databases in one or more subdirectories.

12.In the Connection time limit field, specify the maximum time in minutes this 
newsfeed can take to complete. Enter 0 for no timeout.

13.In the Newsgroups field, specify which newsgroups you want to send or 
receive during this feed. Separate multiple entries with commas. The feed 
includes all articles in each newsgroup specified. You can use wildcards 
(including *) to describe a set of newsgroups, for example, itso.* or *.

14.Verify that the connection is Enabled in the Schedule field.

15.Close and save the Connection document.

Figure 249 on page 295 shows an example of how you can fill out the document 
to accept newsfeeds from the NNTP server on noteserv.itsc.austin.ibm.com.
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Figure 249.  Create a Server Connection for Accepting a Newsfeed

10.3.6.2  Initiating a Push Newsfeed
To initiate a push newsfeed, follow these steps:

1. As an Lotus Domino administrator, open the Public Address Book and select 
the Server Connections view.

2. Click on the Add Connection button.

3. In the Connection Type field, select News/NNTP Feed.

4. In the Source server field, specify the Lotus Domino NNTP Server name, for 
example, ah1610g/ibm.

5. In the Connect via field, select Direct connection.

6. In the Destination Server field, enter the fully qualified TCP/IP hostname or 
address of the remote NNTP server. For Push newsfeeds, this field denotes 
the remote host that your Lotus Domino NNTP Server will be connecting to, to 
send new articles. Our remote host is noteserv.itsc.austin.ibm.com.

7. In the Newsfeed type field, select Push.

8. In the Authentication field, select None or Password. The default is None.

Select Password if the remote NNTP server requires you to login with a name 
and password. You are then prompted for a name and password.

9. If you selected Password in step 8 on page 295 above, you must enter the 
user name and password that are required to connect to the remote NNTP 
server.
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10.In the Channel encryption field, select None or SSL. The default is None.

Select SSL if the remote NNTP server requires SSL encryption over the 
specified NNTP port.

11.In the NNTP port field, select the port number on which the remote NNTP 
servers listens for connections. The default is 119 for non-SSL ports and 563 
for SSL ports.

12.In the Connection time limit field, specify the maximum time in minutes this 
newsfeed can take to complete. Enter 0 for no timeout.

13.In the Newsgroups field, specify which newsgroups you want to send during 
this feed. Separate multiple entries with commas. The feed includes all 
articles in each newsgroup specified. You can use wildcards (including *) to 
describe a set of newsgroups, for example, itso.* or *.

14.In the Schedule field, select Enabled.

15.In the Connect at times field, enter a range of time, for example, 8:00 - 22:00, 
or specific times (for example, 8:00, 12:00, 16:00) when you want the NNTP 
server to connect to the remote NNTP server. Separate multiple specific times 
with a comma.

16.(Optional) If you enter a range of time to connect, then in the Repeat interval 
of field, enter how soon after a successful connection the NNTP server 
attempts to connect again. For example, to exchange news once an hour, 
enter 60 minutes.

17.In the Days of week field, enter the days of the week that you want your Lotus 
Domino NNTP Server to connect to the remote NNTP server. In our example, 
we want the server to connect Sunday through Saturday.

18.Close and save the Connection document.

Figure 250 on page 297 shows an example of how you can fill out the document 
to connect to the NNTP server on noteserv.itsc.austin.ibm.com every hour 
between 8:00 AM and 10:00 PM, every day of the week.

If you are authenticating with a user name and a password, you should 
strongly consider encrypting this document with the public keys of the 
source server and at least one administrator. If you don’t, it is possible for a 
user on your system with read access to the database file to connect to the 
remote NNTP server and potentially read or destroy sensitive data. You may 
also want to consider using channel encryption to protect against people 
listening for the user name and password en route.

Note
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Figure 250.  Create a Server Connection for a Push Newsfeed

10.3.7  Control Messages
An NNTP client or newsfeed can send control messages to the Lotus Domino 
NNTP Server to help coordinate administrative functions, such as creating or 
removing newsgroups and removing specific news articles from existing 
newsgroups. You can decide whether or not to act according to the instructions in 
the control message.

A control message is stored in a unique newsgroup with the prefix "control." For 
example, control.qwerty, where qwerty is the type of control message. Three of 
these control groups are created automatically when you start the NNTP server 
task. Table 13 on page 298 shows these three control messages and their 
corresponding newsgroups.
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Table 13.  NNTP Control Messages and Corresponding Newsgroups

To receive, for example, new group messages through a newsfeed, you need to 
add control.newgroup to the Newsgroup field in the NNTP News Feed 
Parameters section of the Server Connection document. See Figure 251 for an 
example. A control message sent from a newsreader client is stored in the 
corresponding newsgroup if it exists. For example, if a newsreader client deletes 
an article, the delete message is stored in the control.cancel newsgroup.

Figure 251.  Adding the Control Newsgroups to the Accept Newsfeed

You should regularly review control messages received by your Lotus Domino 
NNTP Server. You can create an agent in a control newsgroup that sends you an 
e-mail notification when a control message is received. You can read more about 
how to set up an agent in the Lotus Domino Administration Help: Getting Started 
with Domino, "Chapter 7 Using Administraton Tools".

Responding to Newgroup Control Messages
When your Lotus Domino NNTP Server receives a newgroup control message, 
and you want to subscribe to that newsgroup, include the name of the newsgroup 
in the Newsgroups field under NNTP News Feed Parameters section in the 
Server Connection document.

Control Message Newsgroup Description

newgroup control.newgroup Broadcasts the creation of a
newsgroup

rmgroup control.rmgroup Broadcasts the removal of a
newsgroup

cancel control.cancel Broadcasts the removal of a
single article posted in a
newsgroup

If you delete one of the three automatically created control groups, it will be 
recreated the next time you start the NNTP server task.

Note
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Responding to Rmgroup Control Messages
When you Lotus Domino NNTP Server receives an rmgroup control message, 
you might want to manually delete that newsgroup. If you delete newsgroups 
using a Lotus Notes Designer client, make sure you have Manager with Delete 
documents access to delete the newsgroup.

10.3.8  Lotus Domino NNTP and USENET
Subscribing to USENET newsfeeds is not significantly different from subscribing 
to private newsgroups on another NNTP server. You use the same procedures to 
create connection documents, although you might have to contact your Internet 
Service Provider to get its permission to poll for news at their server. However, if 
you are planning on subscribing to many newsgroups, you should take into 
consideration that it can require significant system resources. You might want to 
have one or more Lotus Domino NNTP servers dedicated to USENET feeds. 
Consider the following before configuring a USENET newsfeed:

Disk space The Lotus Domino NNTP Server on which you download USENET 
newsgroups should have adequate disk space to handle your 
newsfeed. Consider the number of newsgroups in your feed and 
how often articles in the newsgroups are archived to free up 
space. The daily volume of a full USENET newsfeed is 
approximately 5 GB of data.

Throughput A USENET newsfeed can transfer gigabytes of data across the 
network. Ensure that your Internet connection has the bandwidth 
to accommodate newsfeeds without disrupting other traffic on the 
network.

Activity Consider the number of users you expect to access your Lotus 
Domino NNTP Server and configure adequate CPU and memory 
resources.

10.3.9  Setting Up an NNTP Client
The exact procedure to set up an NNTP client will of course depend upon which 
client you are setting up. They all differ slightly in how they are configured, but in 
this section, we will tell you the minimum amount of information that is required. 
We will also provide an example of setting up Netscape Navigator as a client for 
the Lotus Domino NTTP server.

10.3.9.1  Required Information
The following information is required when setting up an NNTP client:

  • The TCP/IP host name of the host running the Lotus Domino NNTP Server 
task, for example ah1610g.itsc.austin.ibm.com

  • The TCP/IP port number, if the NNTP server is using a non-standard port. The 
standard port number is 119, and for SSL it is 563.

  • Whether the NNTP server requires secure connections through SSL or not.

In addition, you may want to know the following:

  • The user name and password required to access the NNTP server, if the 
server is using access control.

  • The TCP/IP host name of the host acting as an SMTP server for outbound 
mail, in case you want to make personal follow-ups to news articles.
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10.3.9.2  Setting Up the Netscape Navigator NNTP Client Software
If you have all the information listed in the previous section, you have all you 
need to set up Netscape Navigator as an NNTP client:

1. From the main browser window, select Edit -> Preferences... to open the 
preferences window.

2. Expand the Mail & Groups subtree and select the Groups Server settings 
dialog.

3. In the Discussion groups server field, enter the TCP/IP host name of the Lotus 
Domino Server that will act as your NNTP server.

4. If you changed the port number settings in the Lotus Domino Server 
document, you also have to change the port settings in the Port field 
accordingly. Otherwise, you just accept the default number of 119.

5. If your Lotus Domino NNTP Server is set up to accept SSL connections, you 
may check the Security checkbox. If you do, Netscape Navigator will attempt 
to connect to the NNTP server over a secure SSL connection. Your window 
might look something like the one shown in Figure 252.

Figure 252.  Netscape Navigator Groups Server Preferences

6. When you are done filling out the form, click OK to exit the preferences 
window.

7. To test your new settings, make sure that the NNTP server task is running on 
your Lotus Domino Server, and then select Communicator - Collabra 
Discussion Groups.

8. Select your NNTP server and click on the Subscribe button to open the 
Subscribe window. From there, subscribe to all newsgroups that you want and 
click OK to get back to the Netscape Message Center.
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Figure 253.  Connection to the Lotus Domino NNTP Server Using Netscape Navigator

Depending on which and how many private newsgroups you are subscribed to, 
your Netscape Collabra window should look something like Figure 253.

10.4  LDAP

People and businesses are increasingly relying on networked computer systems 
to support distributed applications. These distributed applications might interact 
with computers on the same local area network (LAN), within a corporate intranet, 
or anywhere on the worldwide Internet. Information describing the various users, 
applications, files, printers, and other resources accessible from a network is 
often collected into a special database, sometimes called a directory. The 
Lightweight Directory Access Protocol (LDAP) is an Internet standard protocol 
that has evolved to meet the needs of sharing information in a directory between 
computers that might be on different networks, using different operating systems 
and different applications. LDAP is quickly gaining wide acceptance as the 
directory access method of the Internet and is, therefore, also becoming strategic 
within corporate intranets. It is being supported by a growing number of software 
vendors and included in a growing number of software applications.

10.4.1  Lotus Domino and LDAP
Beginning with Lotus Domino Release 4.6, Lotus Domino incorporates an LDAP 
service that allows any LDAP clients to access the information in the Public 
Address Book. Lotus Domino Release 4.6 supports LDAP version 2, and 
attributes defined by the Lightweight Internet Person Schema (LIPS), a related 
standard. Full search access is provided to the Groups and People parts of the 
address book. Update operations are supported from the Lotus Notes client only. 
The LDAP server in Lotus Domino supports SSL, storage of X.509v3 certificates 
and referrals. A Lotus Domino LDAP server can also act as a gateway for Lotus 
Notes clients to other (possibly not using Lotus Domino) LDAP services, perhaps 
on the intranet.
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In this section, we will describe the basic procedures to set up a Lotus Domino 
Server as an LDAP server, sharing the Groups and People parts of the Public 
Address Book. It is beyond the scope of this book to describe the LDAP protocol 
in detail, as well as describing the more advanced features of the Lotus Domino 
LDAP server. For more information on LDAP in general, please refer to the IBM 
Redbook Understanding LDAP, SG24-4986. If you need more details on how to 
configure LDAP on Lotus Domino, please refer to the Lotus Domino 
Administration Help database.

10.4.2  Installation and Configuration
The Lotus Domino LDAP server task is automatically installed when you install 
Lotus Domino Release 4.6. There is no need to install additional software to 
enable Lotus Domino to function as an LDAP server. There is also very little extra 
configuration needed. The following is a quick overview of the steps involved in 
turning Lotus Domino into an LDAP server:

1. Configure LDAP server security, including who is authorized to access the 
directory, and whether or not you want encrypted and signed transfers.

2. Edit or add the Server Domain Configuration document to configure client 
interaction with the LDAP server.

3. Specify a default Global Domain document, which the LDAP server can use to 
form Internet addresses.

4. (Recommended) Create a full-text index of the Public Address Book to 
facilitate quick LDAP client searches.

5. Load the LDAP server task.

6. Configure LDAP clients to connect to the LDAP server.

7. (Optional) Create Directory Assistance documents for LDAP servers in the 
Master Address Book. This step lets Lotus Notes users access the servers 
through a gateway or refer LDAP clients to these servers.

10.4.2.1  Configuring Anonymous Access and Client Interaction
This is how to configure the LDAP server to allow anonymous client access, as 
well as other parameters for the LDAP server.

1. Open the Public Address Book and choose View -> Server -> 
Configurations.

2. Do one of the following:

  • If a Domain Configuration document exists for all servers in the domain, 
select it and click Edit Configuration.

  • If a Domain Configuration document doesn't exist for all servers in the 
domain, choose Create -> Server -> Domain Configuration.

3. Locate the LDAP Configuration section.

4. Click Choose fields that anonymous users can query via LDAP, and select 
the fields in Person and Group documents that anonymous LDAP users can 
access. An LDAP client connecting anonymously can query and retrieve any 
of the selected fields, assuming the client supports them. By default, 
anonymous LDAP clients can access these fields:

  • Person document: FirstName, FullName, LastName, MailAddress, 
ShortName
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  • Group document: ListName, Members

5. In the Timeout field, specify the maximum time in seconds allowed for LDAP 
client queries. The default of 0 means that LDAP client queries can take an 
unlimited amount of time.

6. In the Maximum number of entries returned field, set the maximum number of 
field entries servers can return to LDAP clients. The default of 0 means that 
the LDAP server can return an unlimited number of entries.

7. In the Minimum characters for wildcard search field, specify the minimum 
number of characters that users must specify before the first wildcard in a 
search query. The default is 1.

8. Your document should look similar to the one in Figure 254 on page 304. Save 
the Domain Configuration document when you are done.

This is the procedure used to control access to the Public Address Book for 
LDAP clients. You do not use access control lists (ACLs).

Note

The settings in this document will affect all LDAP servers in the Lotus Domino 
domain.

Note
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Figure 254.  Server Domain Configuration, LDAP Settings

10.4.2.2  Specifying the Global Domain Document
You will need a Global Domain document for your Lotus Domino domain to allow 
the LDAP server to figure out the Internet mail addresses for the people in the 
address book. If you already configured an SMTP MTA for your domain as in 
section 10.1, “SMTP” on page 265, you already have a Global Domain document. 
If you have more than one Global Domain document, you need to specify one as 
the default, so that the LDAP server knows which one to use. We will not go into 
detail on how to configure the Global Domain document in this section. You can 
see one example of how to fill out the document in Figure 255. For a more 
detailed description, please refer to section 10.1.6, “Global Domain Document” 
on page 275 earlier in this chapter.
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Figure 255.  The Default Global Domain Document

10.4.2.3  Creating a Full-Text Index
Creating a full text index for the Public Address Book requires Designer access to 
that database.

1. From the server administration panel, click Database Tools.

2. In the Server box, select the server that stores the database, for example, 
ah1610g/ibm.

3. In the Databases box, select the Public Address Book from the list; in our 
case, it is called ibm’s Address Book.

4. In the Tool box, select Full Text Index.

5. (Optional) Select one or more of the following: Case sensitive index, Index 
attachments, Index encrypted fields, Exclude words in stop word file. See 
below for more information on what each one of these check boxes do:

Case sensitive index
When you create a case-sensitive index, Lotus Domino will 
distinguish between upper and lower case characters in a word, 
creating a new entry in the index for every different upper and 
lower case combination. For example, "computer" and "Computer" 
will appear in the index as two separate words.

Index attachments
This option allows you to index the text in attachments and OLE 
objects. Only ASCII text is indexed. Compressed attachments will 
not be indexed.
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Index encrypted fields
With this option selected, Lotus Domino will index encrypted fields. 
Note however that the full text index is unencrypted plain text, and 
anyone with access to the server can read the file. Be aware that 
encrypted text may become unencrypted.

Exclude words in stop file
If you use a stop file, you can exclude from the index words that 
you don’t want Lotus Domino to index. For example, you might 
want to exclude the words a, an, be and to. Choosing this option 
wisely can reduce the size of the full text index significantly.

6. Below Index breaks, select Word breaks only. Your window should now look 
similar to the one in Figure 256.

7. Click on Create.

Figure 256.  Creating a Full-Text Index for the Public Address Book

10.4.3  Starting and Stopping the LDAP Server Task
There are three options for starting the LDAP server:

  • If you selected LDAP when you installed Lotus Domino, the LDAP server task 
will be automatically activated.

  • If you did not select LDAP when you installed Lotus Domino, you may start it 
manually using the following command at the server console:

load ldap

  • To start the LDAP server task automatically at Lotus Domino Server startup, 
add LDAP to the ServerTasks entry in notes.ini. For example:

ServerTasks=LDAP, REPLICA, ROUTER, UPDATE, ...

You can verify that the LDAP server is running by using the command show tasks 
at the server console. The output should include a few lines similar to these:

LDAP Server          Listen for connect requests on TCP Port:389 
LDAP Server          Control task

To shut down the LDAP server, you have two options:
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  • Shut it down manually by executing the command tell ldap quit at the server 
console.

  • Deactivate the automatic startup by removing LDAP from the ServerTasks entry 
in notes.ini and then restarting the Lotus Domino Server.

10.4.4  Granting LDAP Server Access
There are three different access levels in the Lotus Domino LDAP server. Here is 
a description of them:

Anonymous connections
You can specify whether to allow LDAP clients to connect anonymously. 
Anonymous clients don't authenticate and you can restrict their access to specific 
fields in the Public Address Book. This is a way to provide the general public 
access to the LDAP server. The procedure to do this is described in 10.4.2.1, 
“Configuring Anonymous Access and Client Interaction” on page 302.

Basic password authentication
The Lotus Domino LDAP server supports basic password client authentication. To 
enable basic password authentication for an LDAP client, you create a Person 
document for the client which includes a user name and Internet password. The 
client then provides the user name and password to access the server. Clients 
that use basic password authentication can access all fields in Person 
documents, assuming they have at least Reader access to the Public Address 
Book.

Secure Sockets Layer
The Lotus Domino LDAP server supports Secure Sockets Layer (SSL) 
connections. SSL connections provide additional security by encrypting data 
transferred between client and server, detecting message tampering, and 
providing certificate authentication. LDAP users using SSL client certificate 
authentication to connect to the LDAP server can access all fields in Person 
documents, assuming they have at least Reader access to the Public Address 
Book. You must create a Person document in the Public Address Book for an 
LDAP user to use SSL client certificate authentication. Read more about 
activating SSL for LDAP in 8.6, “Secure Socket Layer (SSL)” on page 201.

10.4.5  Setting Up an LDAP Client
The exact procedure to set up an LDAP client will of course depend upon which 
client you are setting up. They all differ slightly in how they are configured. In this 
section, we will give you enough information to get started setting up any client 
software. We will also provide an example of setting up Netscape Navigator as a 
client to the Lotus Domino LDAP server.

10.4.5.1  Required Information
The following information is required when setting up an LDAP client:

  • The fully qualified TCP/IP hostname of the host running the Lotus Domino 
LDAP server task, for example, ah1610g.itsc.austin.ibm.com.

  • The TCP/IP port number, if the LDAP server is using a non-standard port. The 
standard port number is 389, and for SSL, it is 636.

  • The search root for your queries. For Lotus Domino address books, this is 
probably the top of the directory tree, for example, o=IBM,c=US.
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In addition, you may want to know the following:

  • The user name and password required to access the LDAP server, if the 
server is using access control.

10.4.5.2  Setting Up the Netscape Navigator LDAP Client Software
If you have all the information listed in the previous section, you have all you 
need to set up Netscape Navigator as an LDAP client.

1. From the main browser window, select Edit -> Preferences... to open the 
preferences window.

2. Expand the Mail & Groups subtree, and select the Directory settings dialog.

3. Click New... to add your Lotus Domino LDAP server to the list of directory 
services.

4. In the Description field, enter any phrase by which you can identify your 
directory server. For example, ITSO Lotus Domino LDAP Server.

5. In the LDAP Server field, enter the fully qualified host name of the Lotus 
Domino LDAP server, in our case, ah1610g.itsc.austin.ibm.com.

6. In the Search Root field, enter the search root that you want for your LDAP 
queries. Normally, you would enter a search root consisting of your 
organization name and country. In our case, we entered o=ibm,c=us.

7. If you are using a non-standard port number for your LDAP server, enter the 
correct number in the Port Number field. Otherwise accept the default. If the 
LDAP server requires clients to use SSL, make sure the Secure checkbox is 
checked.

8. Your dialog box should now look similar to the one in Figure 257. When you 
are done, click OK to add the server, and then OK again to close the 
Preferences window.

Figure 257.  Add a New Directory Server to Netscape Navigator

If you want to test your LDAP client setup, use the following instructions:

1. From the main browser window, select Edit -> Search Directory to open the 
directory search window.

2. In the Search for items drop-down list, select your newly added Lotus Domino 
LDAP server. (ITSO Lotus Domino LDAP Server)

3. Check that your search type and conditions are Name and Contains, and 
then enter a name, or part of a name, of a person that exists in the Public 
Address Book of the Lotus Domino LDAP server.

4. Click Search. If your LDAP server is up and running, you should get one or 
more hits depending on what you searched for. See Figure 258 for an example 
of LDAP search.
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Figure 258.  Searching an LDAP Server Using Netscape Navigator

10.5  Using X.PC for Client Connections

The following sections explain how to set up the AIX system so that the Lotus 
Domino Server can communicate with Lotus Notes clients using the X.PC 
protocol. These are the three steps required to allow a client to make a modem 
connection through the X.PC protocol:

  • Configuring AIX to allow modem connections, see 10.5.1, “Setting Up the 
Communication Port (TTY)” on page 309.

  • Configuring Lotus Domino to answer the incoming calls, see 10.5.2, “Setting 
Up the Modem on Lotus Domino” on page 312.

  • Installing a remote client, see 10.5.3, “Configuring the Windows 95 Client To 
Use X.PC” on page 319, for information on how to set up the Windows 95 
Lotus Notes client.

10.5.1  Setting Up the Communication Port (TTY)
The steps for the setup of a communication port (tty) are as follows:

1. Log on to the AIX host as root.

2. Make sure that there is at least one free serial port physically available 
(serial1, serial2).

3. Type smitty tty to get into the tty configuration menu (Figure 259 on page 
310).
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Figure 259.  smitty’s TTY Screen

4. Select Add a TTY (Figure 259) to add a new serial device to the system’s 
configuration and press Enter.

Figure 260.  smitty’s Select the TTY Port Type

5. Select with the cursor tty rs232 Asynchronous Terminal (Figure 260) for an 
asynchronous connection to the modem and press Enter.

Figure 261.  smitty’s Select the Serial Adapter

6. Select with the cursor sa0 Available 00-00-S1 Standard I/O Serial Port 1 
(Figure 261) and press Enter.

 TTY

Move cursor to desired item and press Enter

  List All Defined TTYs
  Add a TTY
  Move a TTY to Another Port
  Change / Show Characteristics of a TTY
  Remove a TTY
  Configure a Defined TTY
  Generate Error Report
  Trace a TTY

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do

 TTY Type

    Move cursor to desired item and press Enter.

      tty rs232 Asynchronous Terminal
      tty rs422 Asynchronous Terminal

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next

 Parent Adapter

    Move cursor to desired item and press Enter.

      sa0 Available 00-00-S1 Standard I/O Serial Port 1
      sa1 Available 00-00-S2 Standard I/O Serial Port 2

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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Figure 262.  Settings of the TTY

7. Enter the PORT number (you can press F4 for selection) and also the BAUD rate 
for the connection to the modem and press Enter. See Figure 262.

The smitty command will return the following COMMAND STATUS (Figure 
263) if the device was created successfully:

Note
You should select either serial port1 or serial port2. If you have a multi-IO 
adapter in your system, check if the serial device has full rs232 capability.

Add a TTY

Type or select values in entry fields.
Press Enter AFTER making all desired changes.                                 

[TOP]                                                   [Entry Fields]        
TTY type                                            tty
TTY interface                                       rs232
Description                                         Asynchronous Terminal
Parent adapter                                      sa0
* PORT number                                        [s1]
Enable LOGIN                                        disable                 +
BAUD rate                                          [38400]                  +
PARITY                                             [none]                   +
BITS per character                                 [8]                      +
Number of STOP BITS                                [1]                      +
TIME before advancing to next port setting         [0]                      +#
TERMINAL type                                      [dumb]
FLOW CONTROL to be used                            [xon]                    +
OPEN DISCIPLINE to be used                         [dtropen]                +
[MORE...28]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

The Enable LOGIN field must be set to disable, otherwise X.PC will not work 
correctly.

Note
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Figure 263.  Command Status OK of Creating a TTY

Alternatively, you can type the following command, for example, using serial 
port #1:

mkdev -c tty -t tty -s rs232 -p sa0 -w s1 -a speed=38400

8. Check if the device exists by typing:

ls -la /dev/tty<X>

/dev/tty<X> is the tty which will be returned after entering the previous 
command or noted by the COMMAND STATUS screen. For our system, X = 0. 
Enter:

ls -la /dev/tty0

Figure 264.  Output of the Command ls -la /dev/tty0

On the AIX platform, Lotus Domino communicates through the device file 
/dev/cua<N>, where <N> corresponds to the Lotus Domino port number.

9. If /dev/cua<N> does not exist on your system, link /dev/cua<N> to the previous 
configured asynchronous port. For example, to specify port number <N> = 1 
and using tty0, type:

ln -s /dev/tty0 /dev/cua1

10.Enter ls -la /dev/cua1 (Figure 265).

Figure 265.  Output of the Command ls -la /dev/cua1

10.5.2  Setting Up the Modem on Lotus Domino
The following steps are required to correctly set up a modem for use on a Lotus 
Domino Server for AIX:

1. Install the modem on the server’s communication port and make sure the 
operating system recognizes the port.

2. Turn on the modem - consult the documentation that came with the modem for 
more information on installing a modem.

 COMMAND STATUS

Command: OK            stdout: yes           stderr: no

Before command completion, additional instructions may appear below.

tty0 Available

F1=Help             F2=Refresh          F3=Cancel           F6=Command
F8=Image            F9=Shell            F10=Exit            /=Find
n=Find Next

crw-rw-rw-   1 root     system    16,  0 Feb 05 16:53 /dev/tty0

lrwxrwxrwx   1 root     system         9 Feb 05 16:54 /dev/cua1 -> /dev/tty0
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3. Log in as the server user, for example notes.

4. Shut down the Lotus Domino Server if it is running.

5. Start the Lotus Notes workspace by typing the command notes.

6. Choose File => Tools => User Preferences.

7. Select Ports icon (see Figure 266).

Figure 266.  User Preferences

8. Select Serial1 and click on Port Enabled (see Figure 267).

9. (Optional) Select Encrypt network data to secure data sent to or received by 
the server.
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Figure 267.  User Preferences, Serial1 Selected

10.Click on Serial1 Options....You should see a dialog similar to the one in 
Figure 268 on page 314.

Figure 268.  Additional Setup of Serial1

11.Select the Modem type. The default type is Auto Configure.

If you don’t know your modem type or if your modem is not on the list, try Auto 
Configure. The Auto Configure modem command file (auto.mdm) checks the 
modem’s speed and then selects the appropriate generic modem command 
file.

For more information, review the template.mdm file in the directory 
/usr/domino/lotus/notes/4613/common/data/nls/C/modems.

12.Select the maximum port speed (default is 19200). Be aware of the 
configuration of the TTY.
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  • The maximum port speed is the maximum speed at which the 
communication port on the computer sends data to the modem and 
receives data from the modem.

  • The modem carrier speed is the speed at which modems communicate 
with one another.

  • The modem carrier speed may be lower than the port speed.

  • When using a null modem, the maximum port speed selected on both 
computers must be identical.

13.Select a volume from the Speaker Volume field (default is Off). Selections are 
Low, Medium, or High.

14.Select a dial mode in the Dial mode field (default is Tone).

15.Log modem I/O (default is deselected).

Select Log modem I/O to record information about the modem connection in 
the Lotus Domino Log if you suspect a problem with the modem.

16.Log script I/O (default is deselected).

Select Log script I/O if you are using modem scripts and want to record 
asynchronous script file responses and replies in the Lotus Domino Log. Use 
this option if you suspect a problem with a modem script file.

17.Hardware flow control (default is selected for all operating systems except 
UNIX).

If you do not select Hardware flow control, the modem may generate cyclic 
redundancy check (CRC) errors and retransmissions. CRC is a form of error 
detection that Lotus Domino uses to ensure that data is transferred correctly. 
Deselect Hardware flow control if the modem doesn't support flow control.

18.Dial timeout field (default is 60 seconds).

19.Hang up if idle for (default is 15 minutes).

This field refers to the amount of time the modem waits before hanging up if 
there is no data passing through the connection. On a port that workstation 
users dial into, you might want to specify a longer idle time than the default 
since users may need more time to read or compose long documents. Lotus 
Domino uses the lower of the settings on the calling and answering 
computers.

20.Port number (default is the number 1 through 5, entered in the Communication 
Port field). On our AIX system, specify a port number N that matches the 
/dev/cuaN device file that you linked to the asynchronous port.

21.If you want to change the modem file, press Modem File..., and make any 
changes in the window that appears (see Figure 269). Click Done when 
finished.
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Figure 269.  Edit Modem Command File

Modem command files have the file extension mdm. If your modem, or if the 
default modem command file auto.mdm does not work, Lotus Domino 
provides the Generic All-Speed Modem file, gen_all.mdm, which you can 
modify. For information on modem command files and instructions on 
modifying them, please read the template.mdm file.

22.To associate an acquire script with the current port, select Acquire Script, 
select a script file to use, and click on OK.

23.Click OK in the Additional Setup dialog (see Figure 268 on page 314) to save 
the information you have entered.

24.To check the connection status, click on Show Status... in the dialog shown in 
Figure 267 on page 314. You will get output that looks similar to the dialog in 
Figure 270 on page 317. If you haven’t saved the port settings yet, your status 
output might look slightly different. When you’re done with this dialog, click 
Cancel.

All default modem files reside in 
/usr/domino/lotus/notes/4613/common/data/nls/C/modems. They will be 
copied for every Lotus Notes user into $HOME/notesr4/modems.

Note
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Figure 270.  Show Status of Connection

Lotus Domino also records the information for the communication port in the 
Miscellaneous Events and Phone Calls views of the Lotus Domino Log, 
log.nsf.

Table 14 explains these entries to the Lotus Domino Log:

Table 14.  Name and Description as Shown in the log.nsf Database 

Name Description

Bit per second connection (port speed) The speed at which the server’s port is 
communicating with the modem.

Bit per second connection (carrier speed) The speed at which the server’s modem is
communcating with the other modem.

Currently active sessions Number of users or servers currently 
connected to the server.

User messages sent Number of transmit requests issued by the 
user for one or more packets.

User messages received Number of transmit requests issued by the 
sender for one or more packets.

User bytes sent Number of bytes sent from this port.

User bytes received Number of bytes received on this port.

Retransmitted packets The number of packets retransmitted 
because of errors. Use this statistic to check 
remote transmissions. A high number (more 
than one per minute) indicates a problem 
that will adversely affect performance. Use 
Hardware flow control, if supported, or 
choose a lower port speed.
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25.Click on OK in the User Preferences window (see Figure 267 on page 314) to 
save the current port setup.

26.Restart the Lotus Domino Server so that it listens to incoming phone calls on 
the port.

You may get other messages after starting the server if Log modem I/O and 
Log script I/O (Figure 268 on page 314) are active:

Lotus Domino (c) Server, Release 4.6.1c (Intl), 4 May 1998
Copyright (c) 1985-1998, Lotus Development Corporation, All Rights Reserved

02/05/96 04:55:05 PM  Server entry in Name and Address database does not contain any 
information for port TCP/IP
02/05/96 04:55:10 PM  Database Replicator started
02/05/96 04:55:11 PM  Serial1: End of script file or END command reached
02/05/96 04:55:13 PM  Mail Router started for domain ibm
02/05/96 04:55:14 PM  Serial1: Send to Modem:  +++ (1200 bits per second)
02/05/96 04:55:16 PM  Serial1: Send to Modem:  ATE0V1 (1200 bits per second)
02/05/96 04:55:16 PM  Serial1: Receive from Modem:  ATE0V1
02/05/96 04:55:16 PM  Serial1: Receive from Modem:  OK
02/05/96 04:55:16 PM  Serial1: Send to Modem:  ATH0 (19200 bits per second)
02/05/96 04:55:17 PM  Serial1: Receive from Modem:  OK
02/05/96 04:55:17 PM  Serial1: Send to Modem:  AT&F0 (19200 bits per second)
02/05/96 04:55:17 PM  Serial1: Receive from Modem:  OK
02/05/96 04:55:17 PM  Serial1: Send to Modem:  ATE0V1 (19200 bits per second)
02/05/96 04:55:17 PM  Serial1: Receive from Modem:  ATE0V1
02/05/96 04:55:17 PM  Serial1: Receive from Modem:  OK
02/05/96 04:55:18 PM  Serial1: Send to Modem:  ATN1Q0W1X4&C1&D3 (19200 bits per second)
02/05/96 04:55:18 PM  Serial1: Receive from Modem:  OK
02/05/96 04:55:18 PM  Serial1: Send to Modem:  ATM1L2 (19200 bits per second)
02/05/96 04:55:18 PM  Serial1: Receive from Modem:  OK
02/05/96 04:55:18 PM  Index update process started
02/05/96 04:55:18 PM  Serial1: Send to Modem:  AT&K3&R0 (19200 bits per second)
02/05/96 04:55:19 PM  Serial1: Receive from Modem:  OK
02/05/96 04:55:29 PM  Agent Manager started
02/05/96 04:55:34 PM  Administration Process started
02/05/96 04:55:35 PM  Searching Administration Requests database for new and modified 
admin requests.
02/05/96 04:55:39 PM  AMgr: Executive ’1’ started
02/05/96 04:55:40 PM  Database Server started

and after a ring signal:

> 02/05/96 05:01:36 PM  Serial1: Receive from Modem:  RING
02/05/96 05:01:36 PM  Serial1: Send to Modem:  ATA (19200 bits per second)
02/05/96 05:01:46 PM  Serial1: Receive from Modem:  CARRIER 14400
02/05/96 05:01:47 PM  Serial1: Receive from Modem:  PROTOCOL: LAP-M
02/05/96 05:01:47 PM  Serial1: Receive from Modem:  CONNECT 19200
02/05/96 05:01:48 PM  Serial1: 19200  bits per second connection established

CRC errors detected The number of cyclic redundancy check 
(CRC) errors. The CRC errors mean that the 
CRC included in the frame is not consistent 
with the actual number of bits in the frame. 
Such errors slow transmission speed.

Port errors detected Port errors on this port indicates operating 
system port driver buffer overflow or 
possible parity errors.

Name Description

If a Lotus Notes Workstation is also running, these messages will be written 
to the Lotus Domino log file.

Note
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After an X.PC connection is established the icon in the lower left corner of the 
Lotus Notes Workstation screen will look like the one in Figure 271:

Figure 271.  X.PC Connection Established

If there is also a network connection active (TCP/IP, SPX/IPX), the icon will look 
like the one in Figure 272:

Figure 272.  Network Connection (TCP/IP, SPX/IPX) Active

10.5.3  Configuring the Windows 95 Client To Use X.PC
The first time, after installation, you launch the Lotus Notes Windows 95 client, 
you will see the Lotus Notes Workstation Setup screen (Figure 273):

Figure 273.  Workstation Setup for DOS/Windows Client

1. Select Remote connection (via modem) and click OK. Your next dialog is 
shown in Figure 274.
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Figure 274.  Remote Workstation Setup

2. Enter the complete user name in the Your user name field.

3. Enter the name for the Lotus Domino Server in the Home server name box, for 
example noteserv/ibm.

4. Enter the phone number of your server in the Home server phone number box.

5. If you are using dialing prefixes, enter them in the Phone dialing prefix box.

6. Select the port to which you have attached the modem.

7. Select the Modem type.

8. Click on OK.

The Workstation will dial up the server, connect, and ask for the password 
defined by the Lotus Domino administrator.

Figure 275.  Remote Workstation Setup Finished

9. After the setup process has finished, click OK (Figure 275 on page 320). The 
Lotus Notes Client setup is finished, and your workspace should appear on 
the screen, similar to Figure 276.
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Figure 276.  Screen Lotus Notes - Workspace on the Client

10.6  Using PPP for Client Connections

The asynchronous Point-to-Point Protocol (PPP) subsystem provides a standard 
method for transporting multiprotocol datagrams over point-to-point media, such 
as a serial link between two modems. If you already have TCP/IP configured for 
your Lotus Domino Server, you don’t need to do any additional setup on the Lotus 
Domino side to prepare for PPP. You do, however, need to set up PPP on the AIX 
side. Following the instructions in this section, you should be able to set up your 
AIX host as a PPP server with one or more modems.

An AIX system can act as both a client and a server. In this chapter, we only 
discuss the server part of PPP on AIX.

1. Log on to the AIX host as root.

2. Use the lslpp -l bos.net.ppp command to check if the following software is 
installed:

bos.net.ppp 4.3.1.0  COMMITTED  Async Point to Point Protocol

3. Create a TTY. Please refer to 10.5.1, “Setting Up the Communication Port 
(TTY)” on page 309, steps 1 on page 309 through step 7 on page 311. The 
only parameter you have to change is the Enable LOGIN field. This option 
must be set to share. Check also if the BAUD rate is correct.

4. Create a PPP user to give a PPP client access to your system by typing the 
following command: mkuser gecos="PPP client user" pppuser

You must have at least AIX version 4.1.4 or greater installed.
Note
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5. Define a password for user pppuser by issuing the command pwdadm pppuser

6. Confirm the password by typing:

login pppuser

and change the password requested.

7. Add the following line in the .profile file located in $HOME:

exec /usr/sbin/pppattachd server 2>/dev/null

8. Change user ID back to root by typing:

su - root

9. To configure the Asynchronous Point-to-Point Protocol, use the smit fastpath: 
smitty ppp (Figure 277).

Figure 277.  smitty’s PPP Screen

10.Select with the cursor Link Control Configuration to configure the link 
control stored in the file /etc/ppp/lcp_config and press Enter.

Figure 278.  smitty’s PPP Link Control Configuration Screen

You may add a separate user ID and password for each remote PPP client.
Note

PPP

Move cursor to desired item and press Enter.

Link Control Configuration
PPP IP Interfaces
PAP  Authentication
CHAP Authentication
Start PPP
Stop PPP

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do

                           Link Control Configuration

Move cursor to desired item and press Enter.

  Add a Link Configuration
  Change / Show a Link Configuration
  Remove a Link Configuration

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do
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11.To create a new /etc/ppp/lcp_config file select with the cursor Add a Link 
Configuration (as shown in Figure 278 on page 322) and press Enter.

Figure 279.  smitty’s PPP Link Configuration Screen

12.Enter a name without spaces into the PPP subsystem name field as shown in 
Figure 279. This name will identify the system to PPP and has no meaning to 
any other interface, such as IP. The first 20 bytes must be unique.

13.Enter the number of clients that can access this machine in the max server 
connections field.

14.Enter the maximum number of servers that can be accessed through client 
connections on this machine into the max client connections field.

15.Enter the maximum number of demand connections in the max demans 
connections field.

16.To define the maximum number of allowed TCP/IP interfaces enter a number 
not greater than the total maximum number of server and client connections 
into the field max ip interfaces.

17.Enter the maximum number of concurrent asynchronous PPP sessions, both 
client and server, that can be active into the max asynch hdlc attachments 
field. The value cannot be greater than the total maximum number of server 
and client connections.

18.All other fields on the LINK Configuration panel are optional. If you do not 
have a deeper knowledge of PPP and a complete understanding of the 
options, you can leave them set to the default.

19.Press Enter to create the link configuration file.

The file /etc/ppp/lcp_config in our example will look like this:

LINK Configuration

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
PPP subsystem name                                 [domino_ppp_entry]
max server connections                             [8]                       #
max client connections                             [2]                       #
max demand connections                             [8] #
max ip interfaces                                  [8]                       #
max async hdlc attachments                         [8]                       #
mru                                                []                        #
async character map                                []                        X
transmit async character map                       []                        X
negotiate MRU                                       yes                     +
negotiate magic number                              yes                     +
negotiate async map                                 yes                     +
negotiate protocol compression                      yes                     +

[MORE...8]|

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 280.  PPP Link Configuration File /etc/ppp/lcp_config

20.Press F3 twice to return to smitty’s first menu (Figure 277 on page 322).

21.To create the PPP IP Interfaces, select PPP IP Interfaces in (as shown in 
Figure 277 on page 322) with the cursor and press Enter.

Figure 281.  smitty’s PPP IP Interfaces Screen

22.To create a new server interface, select with the cursor Add a Server 
Interface in Figure 281 and press Enter. The file /etc/ppp/if_conf will be 
created for you.

Figure 282.  smitty’s PPP IP Configuration

23.Enter the IP address of your current system into the Local IP address field.

server_name domino_ppp_entry
lcp_server 8
lcp_client 2
lcp_demand 8
num_if 8
num_hdlc 8

PPP IP Interfaces

Move cursor to desired item and press Enter.

Add a Server Interface
Change / Show a Server Interface
Remove a Server Interface
Add a Demand Interface
Change / Show a Demand Interface
Remove a Demand Interface

F1=Help             F2=Refresh          F3=Cancel           F8=Image
F9=Shell            F10=Exit            Enter=Do

                              PPP IP Configuration

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Local IP address                                   [9.3.16.243]
  Starting Remote IP address                         [9.244.8.110]
  Number of addresses                                [8]
  Netmask                                            [255.255.255.0]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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24.Enter the first remote IP address into the Starting Remote IP address field. If 
you enter more than one into the Number of addresses field, this address will 
be the first IP address, and the following remote IP addresses will always be 
incremented by one.

25.As mentioned before, you can define more than one remote IP address. You 
may specify only one if you desire a single interface. The value of the Number 
of addresses field should not exceed the value specified in the 
/etc/ppp/lcp_config file for max server connections.

26.Press Enter to accept the settings.

The /etc/ppp/if_conf file in our example will look like this:

Figure 283.  PPP IP Configuration File (/etc/ppp/ip_conf)

27.To start PPP, return to smitty’s first menu by pressing F3 twice (Figure 277 on 
page 322). With the cursor, select Start PPP, accept the defaults and press 
Enter. The PPP subsystem will then be up and running, and clients should be 
able to connect.

Please be aware that all remote IP addresses must be unique for a given 
local (server) IP address.

Note

Do not specify 0 (zero) for this field.
Note

interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.110
netmask 255.255.255.0

interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.111
netmask 255.255.255.0
  .
  .
  .
interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.116
netmask 255.255.255.0

interface
server
local_ip 9.3.16.243
remote_ip 9.244.8.117
netmask 255.255.255.0
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Chapter 11.  Domino Advanced Services

This chapter describes the additional features of the Domino Advanced Services 
(DAS) License and outlines the configuration of those features. They have 
basically not changed since Lotus Domino version 4.5.

Domino Advanced Services is a collection of logically independent features that 
add special capabilities to the standard Lotus Domino Server.

These DAS features consist of:

  • Clustering: See 11.2, “Clustering” on page 328.

  • Partitioned Servers: See 11.3, “Partitioned Servers” on page 337.

  • Billing: See 11.4, “Billing” on page 346.

The Domino Advanced Server (DAS) enables sites to exploit Lotus Domino and 
Lotus Domino service providers to make their service more reliable and scalable, 
better manageable and secure, and allow for more detailed and customized 
usage tracking for billing their services.

For issues about scalability and reliability, see also Chapter 12, “High Availability, 
Scalability, RS/6000 SP” on page 351.

For a detailed discussion of Domino Advanced Services, you may want to refer to 
another new ITSO redbook, High Availability and Scalability with Domino 
Clustering on AIX, SG24-5163.

For the basic installation of the Domino Advanced Services License see 2.3, 
“Starting the Installation” on page 36.

11.1  Domino Advanced Services Environment

Figure 284 on page 328 illustrates the DAS environment that we set up in our lab. 
Our DAS environment is three physical machines, with one partitioned into the 
Lotus Domino servers itsosmp, ah1610f, and ah1610g.itsosmp, ah1610f, and 
ah1610g share the same token-ring interface. The Lotus Domino Servers 
ah1610f, noteserv, and ah1610c are configured as a cluster named democluster. 
Lotus Domino Server itsosmp is in a different domain ITSO than the other Lotus 
Domino Servers. 

Having multiple partitioned servers running on the same interface is common, for 
example, in the RS/6000 SP environment, when you are using the High 
Performance Switch (HPS) as a separate interconnect network between the 
servers. For showing the principles of operation, the setup in Figure 284 is quite 
sufficient, and it may be easier to be recreated than a setup with different network 
cards.
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Figure 284.  Domino Advanced Server Environment with Unique IP Addresses

11.2  Clustering

Up to six Domino Advanced Servers can be interconnected to provide high 
availability, scalability, and load balancing to Lotus Notes users (although not to 
browser clients). This is achieved by placing multiple replicas of some or all 
databases onto different servers within the cluster. Subsequently, transparent 
failover or load balancing can redirect the open request for a database on a 
broken or overloaded server to another server of the cluster. These clustered 
servers should be interconnected through a sufficiently high data transfer 
bandwidth network to allow for the tight synchronization between the databases 
in the cluster (T1 links, corresponding to 1.5 Mb/sec, or better, are 
recommended); in LAN environments, you find most often FDDI, ATM, 
FastEthernet; in RS/6000 SP environments, the SP switch is commonly used. 
The main advantages of clustering are:

  • High availability

See Chapter 12, “High Availability, Scalability, RS/6000 SP” on page 351 for a 
detailed discussion and the redbook, High Availability and Scalability with 
Domino Clustering on AIX, SG24-5163.

  • Scalability: Growing your cluster to accommodate more users

The clustering strategy also offers the advantage of gradual, scalable growth. 
It is easy to add a Lotus Domino Server to the cluster to share the growing 
workload. Clusters allow you to place a heavily used database on several 
servers within the cluster so many more users can access the database. The 
main difference to replication is the ability to direct users to a server with a 
smaller workload automatically and the propagation of changes immediately. 
As a cluster scales to contain more servers, clusters allow server 
administrators to migrate users from one system in the cluster to another. But 
keep in mind to plan your requirements carefully and do consider the 
overhead clustering causes as well as the additional administration effort.

ah1610c/ibm noteserv

itsosmp/itso ah1610f/ibm ah1610g/ibm

democluster

democluster democluster

9.3.1.96 9.3.1.150

9.3.1.27 9.3.1.71 9.3.1.85

9.3.1.0
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  • Load balancing within the cluster

Clustering allows you to achieve efficient use of server resources and better 
user response times. The administrator can balance the workload across all 
servers in the cluster by adjusting the availability threshold of each server. 
Through its load balancing and failover capabilities, the cluster software shifts 
users attempting to access a database on a loaded (busy) cluster member to a 
tightly synchronized replica on an available cluster member. It will not shift 
users that have already a database opened at that server.

11.2.1  Configuration of a Cluster
In our environment, the servers ah1610f/ibm, ah1610g/ibm, and noteserv/ibm are 
part of the cluster democluster. In this section, we will outline the process of how 
we created the cluster democluster and then added the servers to the cluster. For 
detailed descriptions about setting up a cluster, see the redbook, High Availability 
and Scalability with Domino Clustering on AIX, SG24-5163.

The steps required to implement the new cluster are:

1. Prepare for the cluster by ensuring consistent protocol usage on existing 
servers; only TCP/IP is supported in Version 4.6. There are no plans to 
support IPX/SPX later. Please check Lotus Domino Server Release Notes.

2. Determine database distribution in the cluster and acquire sufficient storage 
for the existing and new servers. You would replicate application databases 
for load balancing and/or high availability and mail databases only for high 
availability.

3. Install Domino Advanced Services data files on all servers of the cluster, as 
described in Chapter 2, “Installing a Lotus Domino Server” on page 23. All 
servers must have the same Lotus Domino version and be part of the same 
domain. Make sure that you specify an Administration Server in the Advanced 
section of the access control list of the Public Name and Address Book before 
you create a cluster.

4. Create replicas of existing databases as defined in step 2, following standard 
mechanisms, as described in 5.3, “Replication” on page 131, or using the 
database tools available from File->Tools->Server Administration.... For 
use of cluster commands from a server’s console, check with the most current 
Lotus Domino manuals.

5. Add each server to the cluster.

Open the Public Name and Address Book on one of the servers that will be part 
of the cluster, switch to the Server\Servers View. Then select the server that you 
want to add to the cluster and click on the Action button Add to Cluster. For the 
cluster to be added, accept the Create New Cluster selection and enter the 
name of the new cluster on the following request.
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Figure 285.  Server\Servers View

The request will now be added to the Administration Requests database and 
executed by the AdminP process. With Lotus Domino 4.6.1, the AdminP process 
is setup automatically; if you have setup your Lotus Domino domain properly, the 
AdminP request database, admin4.nsf, is handled and replicated properly.

On the server console of the admin server of the domain (noteserv/ibm in our 
case), you will see the following as soon as the AdminP requests get executed:

The two error messages about the missing cldbdir.nsf are to be expected this 
first time, since the cldbdir.nsf is created at this first start-up, as you can see in 
the above log.

Adding server af1610c/ibm and ah1610f/ibm to the cluster democluster works 
similarly to the above, but of course, you have to select the already existing 
clustername when asked to the select a cluster to add to.

You should now find in the Server\Clusters view of the Public Name and Address 
Book the cluster democluster with the three members noteserv/ibm, ah1610f/ibm, 
and ah1610g/ibm.

Additionally, the first time the cluster processes start on a server, the notes.ini 
setting for ServerTasks will be changed to include the two new cluster processes: 
the Cluster Database Directory Manager, CLDBDIR, and the Cluster Replicator, 
CLREPL, so that cluster processes will start up automatically during subsequent 
server starts.

03/08/98 14:57:58     Cluster Administration Process started
03/08/98 14:59:00     Adding server to cluster democluster
03/08/98 14:59:02     Cluster Database Directory started
03/08/98 14:59:05     Cluster Replicator was unable to configure using Cluster
Database Directory cldbdir.nsf: File does not exist
03/08/98 14:59:05     Cluster Replicator started
03/08/98 14:59:05     Cluster Replicator was unable to configure using Cluster
Database Directory cldbdir.nsf: File does not exist
03/08/98 14:59:10     Created database Cluster Database Directory: cldbdir.nsf
03/08/98 14:59:22     Finished initialization of Cluster Database Directory
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11.2.2  Overview of Cluster Components

11.2.2.1  Cluster Database Directory Manager CLDBDIR
The Cluster Database Directory, cldbdir.nsf, is a database residing on each 
cluster server, which contains information about all the databases and replicas 
within the cluster. When you add a server to the cluster, DAS creates cldbdir.nsf 
with the same Replica ID as on its cluster mates. The Cluster Database Directory 
is used by other components in the cluster to provide their functions. 

The Cluster Database Directory has to be initialized first either manually or by a 
scheduled replication with another member of the cluster before the cluster 
components will work correctly. This database is maintained and updated 
continuously by the Cluster Database Directory Manager task, CLDBDIR, that 
runs on each member of the cluster. As databases are added or removed from 
the Lotus Domino Server, the Cluster Database Directory Manager dynamically 
adds or removes the database from cldbdir.nsf. Changes to cldbdir.nsf are then 
replicated by the Cluster Replicator to other cluster members. 

11.2.2.2  Cluster Replicator CLREPL
The Cluster Replicator keeps the database replicas within the cluster in close 
synchronization. Different from the normal scheduled replication set up by 
connection documents, the Cluster Replication is event driven. The Cluster 
Replicator task, CLREPL, runs on each cluster server and continuously responds 
to changes to its server databases by pushing the changes to each of the other 
replicas within the cluster. It is this continuous transfer of changes that allows 
DAS to achieve closely synchronized databases.

More than one Cluster Replicator can be running at the same time. To start more 
than one instance of the Cluster Replicator, use the command load clrepl on the 
console of the server or add multiple clrepl statements to the ServerTasks 
variable in the notes.ini file. The following statement will start up three Cluster 
Replicator processes. The number of replicators you would start depends on the 
number of servers in the cluster and the load of the system. Lotus recommends 
that you start n-1 Cluster Replicators for a cluster of n servers. For more details, 
see the Lotus Domino 4.6.1 DAS Administration Guide, published by Lotus.

11.2.2.3  Cluster Manager
The Cluster Manager runs on each Lotus Domino Server in the cluster. It will 
track the state and the load of all cluster members. The Cluster Managers within 
the cluster exchange periodic messages, called keepalives or heartbeats, to do 
this monitoring. The Cluster Manager also triggers cluster events (failover, load 
balancing) when there is a change in the status of the cluster. Finally, the Cluster 
Manager will provide statistics and logging.

11.2.2.4  Cluster Administration Process CLADMIN
The Cluster Administration Process is responsible for the correct operation of all 
cluster components. On clustered servers, the process runs automatically at 
server start-up and whenever the cluster membership changes. 

11.2.3  Failover
If a database has more than one replica on different servers of the cluster, DAS 
can provide failover during the opening of this database. When a Lotus Notes 
client tries to open a database on a server in the cluster and the server is not 
Domino Advanced Services 331



available, the client fails over to a different replica within the cluster. As an 
example, assume that in our setup a user has replicas of his/her mail database 
on his/her mail server ah1610f/ibm and ah1610g/ibm, both members of the 
cluster democluster. If ah1610f/ibm is currently down and he tries to open his or 
her mail database, the Lotus Notes client fails over to the replica on 
ah1610g/ibm: DAS puts the icon for his or her mail database on ah1610g/ibm on 
top of the workspace icon stack and opens the database on ah1610g/ibm.

A Lotus Notes client keeps the information about different clusters in a special 
text file, cluster.ncf, in the Lotus Notes data directory. Our cluster.ncf is shown 
here:

The cluster.ncf file consists of a timestamp of this cache entry, the name of the 
cluster, and the canonical names of the members of this cluster. The contents are 
created on termination of the client, after a failover to a cluster replica.

For more details on failover, how and in which cases it will occur, consult the 
Lotus DAS Administration Guide, published by Lotus or the redbook High 
Availability and Scalability with Domino Clustering on AIX, SG24-5163.

11.2.4  Monitoring, Logging, and Statistics of the Cluster Processes
To find out whether a particular server is part of a cluster and get more 
information about the configuration, you can use the command show cluster on 
the server console. As an example, the following is the output of the command in 
our environment:

For a description of the availability index see 11.2.8, “Load Balancing” on page 
334. To monitor the status of the cluster processes use the command show tasks 
on the server console. You will find the following lines among others:

Time=03/08/98 16:25:11 (86256655:0075A9DC)
democluster
CN=ah1610c/O=ibm
CN=ah1610f/O=ibm
CN=noteserv/O=ibm

sh cluster
Cluster Information
 Cluster name: democluster, Server name: ah1610c/ibm
 Server cluster probe timeout: 1 minute(s)
 Server cluster probe count: 225
 Server availability threshold: 0
 Server availability index: 100 (state: AVAILABLE)
 Cluster members (3)...
        server: ah1610c/ibm, availability index: 100
        server: ah1610f/ibm, availability index: 100
        server: noteserv/ibm, availability index: 100

Database Server      Cluster Manager is idle
Cluster Replicator   Idle
Cluster Directory    Idle
Cluster Replicator   Idle
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11.2.4.1  Logging
To avoid the generation of a Replication Event log record for each (event driven) 
cluster replication, the Cluster Replicator maintains replication information in 
logging that can be forced manually at any time with the command:

tell clrepl log 

on the server console. This will immediately create a Replication Event log entry.

For details, see the redbook High Availability and Scalability with Domino 
Clustering on AIX, SG24-5163.

11.2.4.2  Statistics
Each server that is a member of a cluster maintains statistics that may be useful 
for monitoring its cluster related status. Refer to the Lotus Domino Administrator’s 
Guide for information about collecting Lotus Notes statistics and customizing 
reports. 

View the current values of cluster server and replicator statistics by typing the 
following commands at the Lotus Domino Server console:

 show statistics server
 show statistics replica

For a reference and explanation of the cluster related statistic variables see the 
Lotus DAS Administration Guide, published by Lotus.

11.2.5  Removing a Server From a Cluster
A Lotus Domino Server can be easily removed from a cluster from the Public 
Name and Address Book:

1. Open the Public Name and Address Book to the Server/Clusters view.

2. Select the server that should be removed from the cluster and click on the 
action Remove from Cluster.

3. After clicking Yes, a confirmation will come up.

The request to remove the server from the cluster will now be carried out by the 
Administration server of the Public Name and Address Book. After the server is 
removed from the cluster, the Cluster Manager will do the following:

  • Stop the cluster processes CLDBDIR and CLREPL.

  • Remove them from ServerTasks in notes.ini.

  • Remove the local databases from the Cluster Database Directory on the 
cluster server which is the least busy.

  • Finally, remove the local Cluster Database Directory, cldbdir.nsf.

If this is the last server of the cluster, the cluster will cease to exist.

11.2.6  Managing Databases On a Cluster
For information on using the Notes Workstation to create replicas, see 5.3, 
“Replication” on page 131. By setting the notes.ini variable Cluster_Admin_On=1, 
you could perform database management,such as the creation of clusters, also 
from the server console. But as normal administration is done from the GUI, we 
do not provide details here about the server console commands. You might have 
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a look at the document "About NOTES.INI settings for clusters" in the Lotus 
Domino Administration Help database helpadmn.nsf.

You can perform all administration tasks for databases in a cluster by selecting 
File->Tools->Server Administration from the Lotus Notes action bar, then 
select the server you would like to administer and select database tools. Of 
special interest are the pull-downs under Tool: Cluster Management, Create 
Replica, and Replication.

Of special interest are the cluster management settings, out of service, in service, 
and pending delete. Out of service restricts access to a database, in service is 
the default, and pending delete deletes a database as soon as all currently active 
users disconnect from that database.

11.2.7  Restricting Server Access
If you would like to test your cluster, use the notes.ini setting Server_Restricted. 
When you restrict access, the server accepts no new database open requests, 
but users with open databases are not affected. In this way, you do not disrupt the 
work of users with open databases.

To restrict server access while a server is running, enter the console command:

set config Server_Restricted=1

This restricts server access until it is restarted or Server_Restricted is set to 0. To 
permanently restrict server access, set Server_Restricted=2. While a server is in 
the RESTRICTED state, DAS’s failover capability shifts open requests by a Notes 
R4 client to another replica (if one exists) on another available server in the 
cluster.

11.2.8  Load Balancing
DAS’s load balancing feature allows you to balance the workload across the 
cluster by specifying, for each server, the acceptable level of available system 
resources. Each server in a cluster periodically determines its own workload, 
based on the average response time of requests recently processed by the 
server. The workload on the server is expressed as the server availability index, 
which is a value between 0 and 100, where 100 indicates a lightly loaded server 
(fast response times), and 0 is a heavily loaded server (slow response times). 
Despite the fact that the server availability index is a number between 0 and 100, 
it is not a percentage. Some people think that a server availability index of, say 
85, means that the server is 85% available. This is not the case. In fact, it is far 
from it. 

The server availability index is closely related to a common performance metric 
called the expansion factor. The expansion factor is simply the ratio of the 
response time for a function under the current load to the response time for this 
same function in an optimum (light load) condition. So, for example, if the system 
currently takes three seconds to perform a database open, but could perform the 
same database open in 0.3 seconds under optimum conditions, the expansion 
factor for this operation is 10. The expansion factor for a set of operations can be 
computed as a simple weighted average. To compute the server availability 
index, the Lotus Domino Server computes the expansion factor for a 
representative set of Lotus Notes RPC transactions over a recent time interval 
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(roughly the last minute). The server availability index is then set to 100 minus 
this expansion factor. 

Remember that the server availability index only considers the response time as 
measured at the server. So a server availability index of 90 does not indicate that 
the response time as seen by clients is ten times the optimal value. It only 
indicates that the server processing this request took ten times longer than the 
optimal value. 

So, there are three parameters that influence the load balancing between 
servers, being reflected by three notes.ini settings:

Server_Availability_Threshold
Defined as described above with a range between 0 and 100; 0 
disables load balancing, 100 keeps the server in the BUSY state 
regardless of load.

Server_MaxUsers
Defines the maximum number of users that may have an active 
session at a time. If MaxUsers are connected, the server reaches the 
MAXUSERS state.

Server_Restricted
As described in 11.2.7, “Restricting Server Access” on page 334, it 
puts the server in the RESTRICTED state.

11.2.9  Summary of the States of Cluster Members
The SHOW CLUSTER console command shows the specified value of the 
Server_Availability_Threshold, the computed value of the Server Availability 
Index, and the state of each server in the cluster. Possible server states are 
AVAILABLE, BUSY, RESTRICTED, and MAXUSERS. Unreachable is not a 
server state, but a symptom if a client wants to access a server which is actually 
down or not reachable over the network.

Failover occurs only when accessing a database for Lotus Notes R4 clients or for 
the mail router if the server is unavailable. A Lotus Notes R3 client would get 
access if the server is in the busy state, but access would be denied for 
RESTRICTED or MAXUSERS. For a detailed list, see "About failover" in the 
Lotus Domino Administration Help database. Server tasks, such as replication 
and cluster replication, are not inhibited by the server’s state.

11.2.10  Related Settings in notes.ini
The following notes.ini file settings are applicable to correctly setting up your 
clusters:

Cluster_Admin_On

Not set by default (equivalent to Cluster_Admin_On=0). 
Cluster_Admin_On=1 allows access to the cluster administrative console 
commands. To turn off access to the cluster administrative console 
commands, remove this setting from notes.ini or set it to 0. The cluster 

These settings are most often used in conjunction with clustering, but they can 
be set on every server, either standalone, partitioned, or clustered.

Important
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administrative console commands will then return the error: The 
requested function is not supported by the software on this server

Server_Cluster_On

Controls whether the Cluster Manager is enabled (1) or disabled (0) 
on a cluster server. This setting is updated by the CLUSTER ADD and 
CLUSTER REMOVE console commands. There is no reason for the 
administrator to change this setting.

MailClusterFailover

Enables the Mail Router request failover when set to 1 (default). If 
replicas of your mail file are located on multiple servers, mail from 
servers within the cluster and outside the cluster can be received even 
when your home server is down.

11.2.11  Cluster Replicator Caveats
As stated before, the Cluster Replication is event driven rather than scheduled. 
Because these events are stored in memory only, both the source and destination 
servers must be started in order for the Cluster Replicator to push changes to the 
destination. If the destination server is not available when the modification event 
occurs, the event will be kept in memory so that the Cluster Replicator can retry 
the replication. However, if the source server is shut down before the replication 
completes with all replicas, the modification event is lost. On restart of the source 
server and Cluster Replicator, modifications that were made in databases on the 
source server before the shutdown are not automatically replicated. This is one 
reason why it is necessary to set up a periodic scheduled replication with all 
members of the cluster in addition to the Cluster Replication.

Normally, private folders and their contents do not replicate between different 
replicas (except when replicating with the workstation of the folder owner). When 
replicating within a cluster, however, private folders are replicated to other 
replicas within the cluster. This ensures that the databases appear equivalent 
from the user’s perspective when failing over to other replicas within the cluster. 
The replication of private folders and their content within a cluster is supported by 
both the Cluster Replicator and the regular Lotus Notes replicator.

11.2.12  Use of Private LAN for Cluster Communication
One option to attain better performance is to direct the intra-cluster traffic (traffic 
within the cluster) to a private network. Each member of the cluster must be 
connected to two LANs. One LAN, the public LAN, is used for normal client 
access to the cluster. The second LAN, the private LAN, is used for all the 
communication within the cluster, such as heartbeat messages and Cluster 
Replication. Each LAN is a separate physical wire and may or may not be 
connected by a router. Note that all cluster members must be connected by the 

Private folders can be accessed only by the creator of the folder and by a 
server within the cluster. With Domino Advanced Server, only servers defined 
as User type: Server or Server Group in a database’s ACL can access and 
consequently replicate private folders within the database. Thus, servers 
accessing the database through an ACL entry defined with any other User 
type, especially the User type Unspecified, cannot replicate private folders.

Note
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private LAN (for cluster traffic) as well as the public LAN (for client failover). Each 
cluster member must use an identical set of ports. Ideally suited for that purpose 
would be an RS/6000 SP with a High Performance Switch (HPS) used as the 
private cluster LAN.

The following steps are required to set up a LAN for intra-cluster communication 
on every cluster server. The example has to be adjusted for each server:

  • Make sure you have the LANs set up correctly on the TCP/IP level (each 
cluster member can ping the private LAN port of the other cluster members 
and resolve the address to a valid hostname). Make sure that the client 
systems on the public LAN can still ping the cluster members. As an example, 
assume the following IP addresses:

 192.114.32.5 tree
 198.168.168.2 privateroot

  • Start up the Lotus Notes administrative client for the server and go into the 
File=>Tools=>User Preferences... dialog box. In this dialog box, choose the 
Ports section and add and/or enable the new private LAN port. For example, if 
you already have the TCP/IP port, select New... to add and enable the 
CLUSTER0 port.

  • Edit the server record in the Public Address Book. In the Network 
Configuration section add and enable the new port. For example, records for 
tree look like:

 TCPIP  Network1 tree Enabled
 CLUSTER0 Network2 privateroot Enabled

  • In the notes.ini file, put in the following line for each port:

 PORTx_TcpIpAddress=0,a.b.c.d:1352

(Substitute PORTx with the name of your ports. Substitute a.b.c.d with the 
appropriate IP address.) In our example, we would have:

 TCPIP_TcpIpAddress=0,192.114.32.5:1352
 CLUSTER0_TcpIpAddress=0,198.168.168.2:1352

  • Add the following line to the notes.ini file:

 Server_Cluster_Default_Port=CLUSTER0

  • Restart the server.

  • Enter the SHOW CLUSTER command at each server's console and look for the 
line:

 Server cluster probe port: CLUSTER0 

11.3  Partitioned Servers

This section covers the installation and set-up of the partitioned servers feature of 
Domino Advanced Services. This feature allows up to six Lotus Domino servers 
to run on a single computer You may want to have a look at the redbook High 
Availability and Scalability with Domino Clustering on AIX, SG24-5163, but as this 
is a commonly used method of installing Domino on RS/6000, we also covered 
the topic here.

Partitioning a single computer into separate Lotus Domino servers provides:

  • Full Lotus Domino security for users of different partitions
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  • A reduced number of computers to own and administer in order to support 
independent groups of users

Partitioned servers share the same Lotus Domino binaries but each has its own 
assigned Lotus Domino data directory containing the required set of system files, 
such as the Public Address Book, notes.ini, and database files associated with 
that particular Lotus Domino Server. This means partitioned servers have their 
own services and resources. The operation of one partition does not affect the 
other partitions. So, you can logically treat each partitioned server as a separate 
system.

Partitioned servers provide growth capabilities through migration. Initially you can 
assign a group of users to a partitioned server. If the group's resource 
requirements grow you can easily migrate them to their own system by using the 
clustering feature of the Domino Advanced Server.

Besides, partitioning is a performance issue on SMP systems. 

11.3.1  Planning a Partitioned Server Deployment
The following are basic guidelines to help you with your partitioned server 
deployment:

  • The maximum number of supported partitioned servers on one system is six.

  • Each additional partitioned server should get additional 128 MB of memory; 
depending on your setup, you should increase that value. If you are an IBM 
Business Partner qualified for the POWERNet program, or you are working at 
IBM itself, you could use the sizing tool available under 
http://www.rs6000.ibm.com/powernet to get an estimate for your environment.

  • As a rule of thumb, you could use one partition for each pair of Central 
Processing Units (CPUs), but not more partitions than CPUs in one system. 
Experience shows an advantage of having more partitions with lower 
registered numbers of users rather than one large server, since the Lotus 
Domino Server itself does not exploit SMP systems completely.

  • Use of the TCP/IP Network, as IPX, is not supported with Lotus Domino 4.6 for 
DAS.

  • Partitioned servers can share a single network interface card or can use 
multiple network interface cards. (see 11.3.2, “Configuring Partitioned 
Servers” on page 338.)

  • Each partitioned server requires disk space for its own Lotus Domino data 
directory filesystem.

  • A partitioned server may be a member of a cluster; however, it is 
recommended that the other Lotus Domino servers in the cluster be located 
on other systems.

11.3.2  Configuring Partitioned Servers
The steps for the installation, registration, and set-up of the first partitioned server 
are the same as for a standard non-partitioned Lotus Domino Server (refer to 
Chapter 2, “Installing a Lotus Domino Server” on page 23). For subsequent 
partitioned servers only the registration and set-up steps are required - all 
partitioned servers on a single computer share the same binaries (throughout this 
redbook, the files which have been installed under /usr/domino/lotus).
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In our environment, one machine is configured as three partitioned servers: 
itsosmp/itso, ah1610f/ibm, and ah1610g/ibm (refer to Figure 1 on page 22).

The following points should be noted to ease the administration of your 
partitioned servers:

1. Create a separate filesystem for each partitioned server’s data directories and 
mount the filesystems. Consider associating the name of the filesystem with 
the server name.

2. Create a separate AIX user account for ownership of the server’s data 
directory for each partitioned server. Consider associating each AIX user 
account name with the server name. You can use the same group name for all 
partitioned servers, for example:

Table 15.  Lotus Domino Partitioned Server and User Accounts

3. Ensure that each Lotus Domino database filesystem is owned by the 
corresponding AIX user and group account defined above in step 2. For 
example:

    chown ah1610f.notes /ah1610f

11.3.3  Configuring Partitioned Servers for TCP/IP
There are two ways to configure partitioned servers for TCP/IP network access. 
You can:

  • Use unique IP addresses--one unique IP address for each partitioned server.

  • Use unique TCP/IP port numbers--one unique port number for each 
partitioned server that shares an IP address (which is the most common and 
recommended method).

11.3.3.1  Using Unique IP Addresses
1. Assign a unique IP address to each partitioned server, as shown in Figure 284 

on page 328.

2. Make sure, that name resolution is set up properly, so that your planned 
server name can be resolved to one corresponding IP address.

3. Make sure that all addresses map to either the different network cards of your 
server or just to one card (as shown in Figure 202 on page 236).

4. Use the hostname of each server as its server name during Lotus Domino 
Setup. For example for the partitioned server with the hostname 
ah1610g.itsc.austin.ibm.com uses the server name ah1610g/ibm.

5. Edit the notes.ini file of each partitioned server to include

TCPIP_TcpIpAddress=0,IPaddress:1352

where TCPIP is the port name as specified in the server document of the Public 
Address Book in the Network Configuration section, and IPaddress is the 
TCP/IP address of the specific partitioned server.

Server Server’s data directory filesystem AIX user 
account

AIX group account

itsosmp/itso /itsosmp itsosmp notes

ah1610f/ibm /ah1610f ah1610f notes

ah1610g/ibm /ah1610g 1h1610g notes
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For example, for the server ah1610g/ibm:

TCPIP_TcpIpAddress=0,9.3.1.87:1352

6. Edit the server document in each partitioned server Public Address Book to 
include the host names defined in the previous step in the in the Network 
Configuration section of the server’s document.

11.3.3.2  Using Unique TCP/IP Port Numbers
You can use TCP/IP port mapping to configure multiple partitioned servers to 
share the same network interface card and the same IP address. TCP/IP port 
mapping requires that you assign a unique IP port number to each partitioned 
server that shares the IP address and assign one of these servers to be the port 
mapper server.

The port mapper server’s role is to dispatch (map) incoming IP requests to the 
appropriate server. It must be running for the partitioned servers that share its IP 
address to receive new connections from workstations. If the port mapper server 
is down, new sessions cannot connect. Existing sessions, however, remain 
connected. Also, each client maintains a cache of recent server connections, 
requiring redirection by the port mapper. This means the clients can still reach 
other partitioned servers if the requested server connection information is in the 
cache.

To provide higher availability for partitioned servers, you can set up the first 
partitioned server to function only as a listener/port mapper (not a customer 
server). This reduces the chance of failure by the first partitioned server, but 
causes additional overhead as you need one partition only for portmapping.

To reduce resource use for a dedicated port mapper server, you can remove all 
the ServerTasks from your notes.ini to minimize the number of server processes. 
You can also remove large databases (such as the help database from the data 
directory for this server). Do not remove the Public Address Book for this server.

For details of how to configure using TCP/IP port numbers refer to "Configuring 
partitioned servers using unique TCP/IP port numbers" in the Lotus Domino 
Administration Help database.

11.3.4  Starting and Stopping Partitioned Servers
Each partitioned server is started and stopped the same way as a single server 
would be. In the output of the show server console command, you will notice a 
partition number, which is unique for each server one physical system.The 
Partition number is obtained from the file .sgf.notespartition in the Notes data 
directory of the respective partitioned server. This file is updated from the file 
/opt/lotus/notes/latest/common/data/.sgf.lastpartition; content is incremented by 
one each time the Lotus Domino setup process is run. It may contain any integer 
value from 1 to 99, as long as the number is unique across all servers on a single 
system.

11.3.4.1  Administrative Clients
Each partitioned server has its own administrative client which shares its system 
resources and Lotus Notes data directory. The administrative client must be run 
from the respective partitioned server Lotus Domino data directory. You can run 
up to six administrative clients at one time.
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11.3.4.2  Handling a Partitioned Server Failure
Partitioned server shutdowns and failures do not affect other partitioned servers 
that run on the same computer. If one server shuts down, the others continue to 
run. The setting KillProcess=1 is added during installation into the notes.ini file of 
each partitioned server, enabling automatic clean up of all the processes 
associated with a partitioned server. With this default setting, you can restart a 
failed partitioned server without restarting the computer. But you have to make 
sure to clean up the interprocess communication resources (shared memory and 
semaphores) before restarting the server.

11.3.5  Starting the Server in the Background
It is quite obvious that you would not want to have one or more partitions running 
on one RS/6000 in foreground. Therefore, you have to implement scripts that 
start the server in the background, provide console facilities, and allow for proper 
cleanup. The following scripts are provided “as is”. You need one set of all scripts 
per server instance (partition).

11.3.5.1  Defining the Environment
This script simply defines essential parameters for use by the other scripts.

#!/bin/ksh
# Domino Application Server Environment Variable Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - env_domino
#
#      This script makes variable definitions that are common to 
#      the start_domino, stop_domino, and start_monitor scripts
########################################################################
 
# This script is provided "As Is".
 
# Script Environment variables.

NOTES_USER=notes# AIX userid for this server
NOTES_PATH=/server1/notesr4# Path for server data directory
NOTES_SERVER=noteserv# Name of Domino Server
OUTPUT_LOG=/tmp/$NOTES_SERVER.log# Output file for server console
INPUT_FILE=$NOTES_PATH/$NOTES_USER.input# Input file for server console
PATH=$NOTES_PATH:/opt/lotus/bin:$HOME/bin:$PATH# Ensure PATH is set for scripts

11.3.5.2  Starting the Server
This script actually starts a particular server in the background, redirecting the 
console to $OUTPUT_LOG and reading commands from $INPUTFILE. 

#!/bin/ksh -x
# Domino Server Start Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - start_domino
#
# This is a server startup script to start the Domino Server in background      
# that gets command input from a file and pipes the output to another which
# can be monitored by administrators by the start_monitor script.
#
# The INPUT file allows any command to be issued to the Domino Server so
# this file should be treated accordingly ...hidden with the appropriate
# permissions to prevent unauthorized access to the server
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########################################################################
 
# This script is provided "As Is".
 
# Set Script Environment variables.

. env_domino

# Script Logic

if ((‘id -u‘ == 0))
then
   print "Run the Domino Server as the $NOTES_USER user "
   exit
fi

#
# if you are using /etc/hosts for tcpip name resolution rather than a name 
# server or NIS, then uncomment the following line:     
#export NSORDER=bind,local,nis
# 

if [ ! -x /opt/lotus/bin/server ] ; then
     echo "Cannot access server command - exiting"
     exit 1
fi

if [ ! -d $NOTES_PATH ] ; then
     echo "Cannot access notes data directory - exiting"
     exit 1
fi

NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
if [[ -n $NOTES_RUNNING ]] ; then
     echo "Domino Server is already running - exiting"
     exit 1
fi

cd $NOTES_PATH
#
# Clean up if the Domino Server terminated abnormally earlier
#

rm -f ~notes.lck
mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print $2 }’ | awk ’{ 
print $1 }’‘ 
sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done

export Notes_SHARED_DPOOLSIZE=40000000
#
# For servers using Notes passwords,
# replace the previous line with the following two lines.
#
cat .secure_hidden_passwd > $INPUT_FILE
echo "show server" >> $INPUT_FILE

cp -p  $OUTPUT_LOG $OUTPUT_LOG.‘date +"%m%d%y_%H%M"‘
#cp -p  $OUTPUT_LOG $OUTPUT_LOG.backup
print "Starting Domino for AIX ($NOTES_SERVER)"
/opt/lotus/bin/server < $INPUT_FILE > $OUTPUT_LOG 2>&1 &

11.3.5.3  Stopping the Server
This script is used to stop a running server properly. If the server does not 
respond anymore, the script kills the server processes and cleans up system 
resources.

#!/bin/ksh -x
# Domino Server Stop Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
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# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - 
#
# This is the script to STOP the Domino Server which has been started using
# the corresponding script (start_domino).
# The script attempts to QUIT the server gracefully and waits 2 minutes.
#
# If Domino Server has not shut down by then, the plug is yanked.
# Depending on your environment, you may want to change this time-out period.
########################################################################
 
# This script is provided "As Is".
 
# Set Script Environment variables.

. env_domino

# Script Logic

print "Stopping Domino for AIX ($NOTES_SERVER)"
print " ... waiting for shutdown to complete"
echo " quit " >> $INPUT_FILE
#
#
#
count=0
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
while [[ -n $NOTES_RUNNING ]] ; do
sleep 10
count=‘expr $count + 1‘
echo " ... waiting "$count"0 seconds"
#
# Terminate Domino Server if still running
#
if [ $count -eq 13 ] ; then
   echo "Domino Server is still running after 2 minutes"
   echo " ... now for the ungraceful method"
   for i in ‘ps -fu $NOTES_USER | grep lotus | grep -v grep | awk ’{ print $2 }’‘; do
     kill -9 $i
   done
   mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
   sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
   for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
   for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done
   echo "Domino Server ($NOTES_SERVER) TERMINATED"
   exit
fi
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
done
#
echo "Domino for AIX ($NOTES_SERVER) shutdown completed"

11.3.5.4  Cleanup a Server That Would Not Respond
If you just want to clean up, knowing the server cannot be stopped gracefully, use 
this script.

#!/bin/ksh
# Domino Cleanup Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - kill_domino
#
# This script kills processes and cleans up shared memory and semaphores
########################################################################
 
# This script is provided "As Is".
 
# Script Environment variables.
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. env_domino

# Script Logic

print "Terminating Domino for AIX ($NOTES_SERVER)"
#
for i in ‘ps -fu $NOTES_USER | grep lotus | grep -v grep | awk ’{ print $2 }’‘; do
  kill -9 $i
done
mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print $2 }’ | awk ’{ 
print $1 }’‘
for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done
echo "Domino Server ($NOTES_SERVER) TERMINATED"
exit
#

11.3.5.5  Starting a Server’s Console Monitor
As the server runs in the background, you cannot use the tty console as usual. 
This script provides you with an interface very similar to the Lotus Domino Server 
console by reading the output logfile and passing commands to the server’s input 
file.

#!/bin/ksh
# Domino Monitor Start Script
# Licenced Materials - Property of IBM
# (C) COPYRIGHT International Business Machines Corp 1994,1998
# All Rights Reserved.
# US Government Users Restricted Rights - Use, duplication or disclosure
# restricted by GSA ADP Schedule Contract with IBM Corp.
########################################################################
# Description - 
#
# This script will start a virtual Domino Server console where it is issued.
# 
# The variables below must be set to point to the input and output files.
# Note that the CASE statement at the bottom also allows you to create your
# own custom server commands
########################################################################
 
# This script is provided "As Is".
 
# Set Script Environment variables.

. env_domino

CURRENT_TTY=‘tty‘

# Script Logic 

if [[ $# -gt 1 ]]; then
   echo "\nSyntax:\n start_monitor\n"
   echo "This program attaches to the Lotus Domino Server input and output"
   echo "streams so you may interact with the server."
   echo "\nUse Ctrl-c to exit the monitor.\n"
   exit 1
fi

function stop_monitor
{
   echo ""
   echo "Exiting notes monitor..."
   echo ""
   kill -9 $TAILPID
   exit 0
}

PCOUNT=‘fuser $OUTPUT_LOG 2>/dev/null | wc -w‘
if [ $PCOUNT -lt 1 ]; then
   echo ""
   echo "The Domino Server does not appear to be started.  Monitor terminating."
   echo ""
344 Lotus Domino Release 4.6 on IBM RS/6000



   exit 1
fi

trap "stop_monitor" 1 2 3

echo ""
echo "******************************************************************"
echo "     To exit this monitor enter a <CTRL>-C"
echo "******************************************************************"
echo ""

tail -f $OUTPUT_LOG >> $CURRENT_TTY &
TAILPID=$!

while [ 1 -eq 1 ]
do
  CMD=""
  OPT=""
  read CMD OPT
  case $CMD in
       "cls") clear
              echo "" >> $INPUT_FILE ;;
       "CLS") clear
              echo "" >> $INPUT_FILE ;;
     "clear") if [[ "$OPT" = "log" || "$OPT" = "LOG" ]]; then
                 echo "Log cleared on ‘date‘" > $OUTPUT_LOG
 echo "" >> $OUTPUT_LOG 
              fi
              echo "" >> $INPUT_FILE ;;
     "CLEAR") if [[ "$OPT" = "log" || "$OPT" = "LOG" ]]; then
                 echo "Log cleared on ‘date‘" > $OUTPUT_LOG
 echo "" >> $OUTPUT_LOG 
              fi
              echo "" >> $INPUT_FILE ;;
     "exit")  echo "Are you sure you want to EXIT the Domino Server ???" >> $OUTPUT_LOG
              echo "Enter the command ’shutdown’  if you really mean it" >> $OUTPUT_LOG
              echo  ">" >> $OUTPUT_LOG ;;
     "quit")  echo "Are you sure you want to EXIT the Domino Server ???" >> $OUTPUT_LOG
              echo "Enter the command ’shutdown’  if you really mean it" >> $OUTPUT_LOG
              echo  ">" >> $OUTPUT_LOG ;;
     "q")     echo "Are you sure you want to EXIT the Domino Server ???" >> $OUTPUT_LOG
              echo "Enter the command ’shutdown’  if you really mean it" >> $OUTPUT_LOG
              echo  ">" >> $OUTPUT_LOG ;;
     "shutdown") echo "quit" >> $INPUT_FILE ;;
     "EXIT")  echo "Are you sure you want to EXIT the Domino Server ???" >> $OUTPUT_LOG
              echo "Enter the command ’shutdown’  if you really mean it" >> $OUTPUT_LOG
              echo  ">" >> $OUTPUT_LOG ;;
     "QUIT")  echo "Are you sure you want to EXIT the Domino Server ???" >> $OUTPUT_LOG
              echo "Enter the command ’shutdown’  if you really mean it" >> $OUTPUT_LOG
              echo  ">" >> $OUTPUT_LOG ;;
     "Q")     echo "Are you sure you want to EXIT the Domino Server ???" >> $OUTPUT_LOG
              echo "Enter the command ’shutdown’  if you really mean it" >> $OUTPUT_LOG
              echo  ">" >> $OUTPUT_LOG ;;
     "SHUTDOWN") echo "quit" >> $INPUT_FILE ;;
     *)       echo $CMD $OPT >> $INPUT_FILE ;;
   esac
done
stop_monitor

11.3.6  Considerations for Internet Server Tasks
On a partitioned server, you have to specify additional parameters for the tasks 
HTTP, IMAP4, POP3, LDAP, NNTP and for the SMTP MTA.

11.3.6.1  Considerations for HTTP
If you plan to use the http task for multiple partitions, you have to specify the Bind 
to host name parameter, as described in 9.1.2.1, “Basics and Mapping” on page 
221.
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11.3.6.2  Considerations for IMAP4, POP3, LDAP, NNTP
These tasks are new since Release 4.6. The following entries must be added to 
the notes.ini file for these tasks to run in a partitioned server environment for the 
respective protocol:

  •IMAPAddress=<IP address or fully qualified hostname>
  •LDAPAddress=<IP address or fully qualified hostname>
  •NNTPAddress=<IP address or fully qualified hostname>
  •POP3Address=<IP address or fully qualified hostname>

11.3.6.3  Considerations for the SMTP MTA
The SMTP MTA is currently not certified to run on a partitioned environment. The 
current solution is to run a dedicated SMTP MTA server outside of the partitioned 
server environment. The UNIX sendmail must be disabled to run the SMTP MTA 
on any UNIX server.

A SMTP MTA notes.ini variable has been added in Lotus Domino 4.61 to change 
the SMTP MTA TCP/IP port (defaults to 25), so that this MTA can run on a 
partitioned server. This variable is unsupported on Lotus Domino 4.61; so check 
for official support in Lotus Domino Release 4.62. You would have to specify 
SMTPMTA_IPPORT=<portnumber>.

11.4  Billing

The Domino Advanced Services license is required to run Lotus Domino billing. 

Billing consists of two major components:

1. Lotus Domino Server enabled for billing: the server provides billing information 
according to seven billing classes, (see below).

2. The Lotus Domino billing  task collects the information provided by the server 
and generates billing records, stored either in a database (billing.nsf) or in a 
binary file (billing.nbf), or both.

The BillingClass setting in notes.ini controls which of the seven allowed billing 
classes are to be tracked:

Session 
Tracks when a Lotus Notes session starts or ends and when any 
ongoing activities, document editing, or replication occur during the 
session.

Database
Tracks when users or servers open and close a Lotus Notes database 
and the duration of use.

Document
Tracks read and write activity for specified documents only.

Replication
Tracks when a billing server initiates replication with another server or 
a workstation.

Mail 
Tracks when a billing server mail router transfers messages to another 
Lotus Domino Server.
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Agent
Tracks when users or servers run a scheduled agent on a server, and 
tracks the elapsed runtime of agents on a billing server.

HttpRequest
Tracks Web server requests.

The notes.ini setting BillingAddinWakeup=<n> specifies the interval after which 
the billing task should run, where n is the number of seconds. 
BillingAddinRuntime=<n> specifies the allowed runtime for the task in seconds to 
minimize the impact of billing on server performance: whereas 
BillingAddInOutput={1|8|9} defines the output file mentioned above 
{billing.nsf|billing.nbf|both}.

Let’s assume we want billing to be active for Mail, Replication and Web, starting 
generating records every 10 minutes for 2 minutes, logging to a binary file, we 
would specify in notes.ini:

ServerTasks=...,Billing,...
BillingClass=Mail,Replication,HttpRequest
BillingAddInWakeup=600
BillingAddInRuntime=120
BillingAddInOutput=8

11.4.1  Managing Billing
The same rules as for any other Lotus Domino task apply for billing. You may 
either modify notes.ini as described above, to start multiple billing tasks, or you 
can set billing parameters at the server’s console by issuing Set Config 
<paramter=xxx> commands.To disable server activity billing from within all 
components of the Lotus Notes server, that is, router, replicator, and so on, 
remove the BillingClass configuration variable from the notes.ini file.

11.4.2  Sample Billing Records
Below you find screen shots of sample billing records for each of the classes to 
givet you an idea of the information which is collected. They have been collected 
on different servers and do not have any relations. Document billing sample 
records are not included because this type of billing has to be enabled for specific 
documents by changing the design to include hidden charge fields in the 
document’s form. 

If you want to use billing in a production environment, you have to create an 
application which actually does the evaluation of the billing database or the billing 
binary file.

For more detailed information, see the Lotus Notes API 4.6 documentation, 
published by Lotus.

11.4.2.1  Session Billing
Session billing collects information of the data volume of a certain user session: 
Who has transferred how many bytes?
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Figure 286.  Session Billing

11.4.2.2  Database Billing
Database billing delivers two types of records (DBOpen and DBClose), which 
allow you to track how long a database has been in use by a certain user and 
how long it has taken to actually perform the open and close actions.

Figure 287.  Database Billing: Open and Close

11.4.2.3  Replication Billing
Replication billing offers information on which servers exchanged, how much 
data, for which replica, when.
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Figure 288.  Replication Billing

11.4.2.4  Mail Billing
Mail billing tells you which mail has been routed where and who has created it. It 
also tells you the size and the recipient.

Figure 289.  Mail Billing

11.4.2.5  Agent Billing
Agent billing allows you to keep track the time an agent consumed on your 
system, which database they acted on, and who started the agent.
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Figure 290.  Agent Billing

11.4.2.6  HTTP Request Billing
HTTP Request Billing provides you with extensive information about which 
objects have been retrieved from your web server, the time elapsed to fulfill the 
request, and the user who retrieved it, as well as the number of bytes retrieved 
and the IP address of the client system.

Figure 291.  HTTP Request Billing
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Chapter 12.  High Availability, Scalability, RS/6000 SP

This chapter provides an overview regarding the various high availability and 
scalability issues related to Lotus Domino and the RS/6000, as well as the 
RS/6000 SP. For information about the RS/6000 SP, refer to 12.3, “Scalability and 
RS/6000 SP” on page 355. It does not provide a detailed description regarding all 
these issues, but it is a good starting point for getting familiar with these topics.

In general, you have to cover different areas of availability to provide high 
availability for a Lotus Domino Server. Each area is addressed by certain features 
or solution packages.: 

1. System availability:

  • Addressed by hardware features, such as redundant components, fault 
tolerant components, service processor, service director.

2. Data availability:

  • Addressed by operating system or hardware (RAID, AIX LVM, Lotus 
Domino replication); if data is not available by these mechanisms, you 
have to take care about restoring from a backup.

3. Service availability:

  • Addressed by Domino Advanced Services (application failover and 
loadbalancing) for mail and application databases:

  • Focused on application errors.

  • Client view: Client does not reach their database.

  • Addressed by HACMP (restart of service in case the system is no longer 
available on another system):

  • Focussed on hardware or operating system errors.

  • Server view: System is not working properly.

12.1  RS/6000 and AIX Issues

This section addresses high availability issues related to the RS/6000.

12.1.1  RS/6000 and AIX Basics
Depending on the model you are using for your Lotus Domino Server, different 
areas of hardware availability are covered. Redundant components like fans and 
power supplies, hot plugable disks and the ability for remote maintenance by 
using a service processor (see 12.1.2, “Service Processor” on page 352) or the 
service director are features that make administration tasks a lot easier. For a 
closer look on these features, you might want to have a look at the system 
documentation books at http://www.rs6000.ibm.com/resource/pubs.html; another 
valuable source are the following redbooks:

  • RS/6000 SP Monitoring: Keeping it Alive, SG24-4873

  • RS/6000 Models E30, F40, F50 and H50 Handbook, SG24-5143

Within AIX, there are a couple of features that support the availability of the 
server and the application service. The most important regarding the Lotus 
Domino Server are:
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  • Dynamic kernel reconfiguration

  • Logical Volume Manager LVM

  • Journaled filesystems

  • automatic reboot after crash

The URL http://www.rs6000.ibm.com/resource/features/1998/aix_details may be 
a good starting point to get familiar with AIX, if you are not so far. You can also 
access the complete software documentation for AIX Version 4.3 at 
http://www.rs6000.ibm.com/resource/aix_resource/Pubs.

12.1.2  Service Processor
The service processor allows you to access your system remotely even without 
an active AIX. The service processor monitors the status of the system and sends 
a message to a remote site if a hardware or operating system problem is 
detected. The service processor enables remote power control, reset, and boot 
features. It also enables remote maintenance and diagnostic activities, including 
console mirroring. Using a RS/6000 with a service processor is ideal for 
customers with geographically distributed computing environments that need to 
be serviced and monitored remotely.

The service processor enables or contributes to the following RAS functions, 
among others:                                        

  • Integrated system environmental monitoring/alerting included as standard.

  • This includes AC/DC voltage, fan speed, and temperature sensing.

  • Early Power Off Warnings (EPOW) and error log analysis and alert.

  • Auto-dial out, call IBM Service Center capability. The system objective is to 
predict a potential component failure and automatically dispatch an IBM 
service representative to take preventive maintenance measures to avoid an 
outage. The system may also call the IBM Service Center in the event of a 
critical failure.

  • Integrated system monitoring enhances failure error logging, analysis, and 
alert. It can be programmed by the system administrator to re-boot after 
experiencing the following conditions:

  • AC power restored (after a power loss)

  • Hardware checkstop failures

  • Machine check interrupt

  • Operating system hang or failure

For a detailed description of a service processor, you might want to look at 
http://www.rs6000.ibm.com/resource/hardware_docs. There you will find the 
manuals for the models F50, H50 and S70. 

12.1.3  RS/6000 HA50 cluster server
The RS/6000 High Availability Cluster Server - HA50 is a special package-priced 
solution, with options for applications, services, and financing; it is not a new 
server model. The HA50 consists of currently marketed products:

  • H50 Enterprise Servers
352 Lotus Domino Release 4.6 on IBM RS/6000



  • 7133 Serial Disk System

  • HACMP cluster software

  • AIX operating system

Designated applications are featured solutions with the HA50. The applications 
(and the providers) are selected as focus segments. The featured application 
solutions include HA50 specific implementation guides and scripts, available from 
IBM, to simplify the planning and installation of an HA50 cluster. One of the 
applications currently featured is Lotus Domino Release 4.6.

The application scripts are executable “start/stop” failover scripts and are tested 
for compatibility with the specific application and the HA50. Implementation 
guides describe the scripts and provide assistance for planning and installation. 
The scripts and implementation guides are available from a central IBM 
repository and can be downloaded through the Internet by IBM Global Services 
(IGS), Business Partner, or customer service personnel from the IBM Web site at 
http://www.rs6000.ibm.com/HA50scripts.

12.2  Middleware Issues

On top of RS/6000 and AIX, you may apply some high availability solutions.

12.2.1  HACMP
HACMP works in conjunction with Lotus Domino and provides failover of service 
to another system. You can think of scenarios of two servers backing up each 
other, as available as a prepackaged solution HA50. Another common 
configuration in a Lotus Domino environment is to have three systems with an 
active Lotus Domino Server, and a fourth system standing by, providing for 
takeover in case one of the other three system fails.

For a detailed discussion, please refer to:

  • High Availability and Scalability with Domino Clustering and Partitioning on 
AIX, SG24-5163

Background information about HACMP for both RS/6000 single server and SP 
systems is provided by:

  • RS/6000 SP HA Infrastructure, SG24-4838

  • Implementing High Availability on RISC/6000 SP, SG24-4742

  • High Availability on the RISC System/6000 Family, SG24-4551

12.2.2  Lotus Notes Recovery Kit (NRK)
There has been an application specific recovery kit for the Lotus Notes server 
environment, available as Programming Request for Price Quotation (PRPQ) with 
program number: 5799-GBJ. As the currently available versions of Lotus Domino 
on AIX are running quite stable, this recovery kit is no longer maintained.

12.2.3  Lotus Domino Clustering
As we have seen in 11.2.3, “Failover” on page 331, Domino Advanced Services 
provides for high availability of your Lotus Domino service. This section provides 
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rough guidelines on how to use which solution. For a detailed discussion, please 
refer to the redbook High Availability and Scalability with Domino Clustering and 
Partitioning on AIX, SG24-5163.

The decision to use DAS or HACMP or a combination of both has to be made 
individually based on your specific needs.

The decision may be based on the technical restrictions or on your preference for 
one environment because you have the administration skills just for one 
environment and you do not want to invest in gaining the skills for the other 
environment. Some customers even do both.

For deciding based on the technical restrictions, you may want to have a look at 
the following table:

Table 16.  Selection of Technology for Availability 

From the implementation point of view, you should be aware of the main 
differences regarding the data handling:

  • HACMP would restart the defined services on the backup system, using the 
same data the original system used (by acquiring the volumegroup). In case of 
Lotus Domino, that means restarting the server and running fixup on all 
databases that were open at the time of the takeover.

  • DAS would care for cluster (real-time-) replication during normal operation to 
have replicas of the data available on another system. This replication is 
based on events kept in memory. In case of a crash on a heavily loaded 

Lotus Domino
Server
Function

Preferred
Availability Solution

Rationale

Mail Either HACMP or 
Domino Advanced 
Server

Domino Advanced Services will support mail user 
failover if a mail server is unavailable. However, 
shared mail is not yet supported and HACMP may 
be easier to implement for mail availability.

Mail Router HACMP Domino Advanced Services does not failover mail 
routing functions for outgoing mail. HACMP can 
failover/restart and recover this functionality.

Application Domino Advanced 
Server

Domino Advanced Services will load balance and 
failover users to a backup for properly replicated 
databases.

Out-of-Domain
Replication

HACMP Domino Advanced Services does not failover 
out-of-domain replication. Therefore, if it is required 
to keep a dedicated replication server available, 
use HACMP.

Internet HACMP or Domino 
Advanced Server 
combined with 
Interactive Network 
Dispatcher

Lotus Domino HTTP/IP addresses are not 
failedover by Domino Advanced Services as with 
HACMP. However, Interactive Network Dispatcher 
can balance load among HTTP servers and provide 
IP address “takeover.” Combined with standard 
Lotus Domino, this solution provides high available 
HTTP solutions.

InterNotes Domino Advanced
Server

InterNotes Servers are part of the advanced 
services functions/servers that can be failedover.
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system, you might not get all the data replicated in time before the crash. If 
that should happen, you would have slight differences between the databases 
on your original system and the replica databases, until the crashed server is 
on-line again and can schedule standard replication to get rid of these 
differences.

  • With HACMP, even if the end user is working in an already opened database 
at the time of the service outage, they will be able to save their work 
afterwards, transparently, as HACMP has taken over the original IP address. 
DAS failover occurs on opening a database.

12.3  Scalability and RS/6000 SP

The most important point about scaling in a Lotus Domino environment is, as 
always, the proper design of your implementation. As soon as you have identified 
your Lotus Domino topology in terms of server instances, you have different 
possibilities to scale your installation. Again, the detailed scalability issues for 
your environment have to be identified individually, and you have to pick the 
approach that is right for you.

Scaling in terms of faster hardware on the same server is possible by adding 
additional memory, and additional CPUs, additional network cards, depending on 
your scaling needs. Therefore, if you expect growth during the lifetime of your 
server, you should start with an SMP system or with a SMP node in a RS/6000 
SP. Remember that more than two CPUs are exploited best with more than one 
Lotus Domino Server instance on the system (Domino Advanced Services 
Partitioning). Therefore, start early with evaluating partitioning for your server.

If you reach the limits of your single server, you must add an additional system. 
You could either use Domino Advanced Services and/or HACMP to provide for 
high availability, as discussed in 11.2, “Clustering” on page 328 and 12.2.3, 
“Lotus Domino Clustering” on page 353.

If you need more systems, you should plan in time for a RS/6000 SP, since 
management of multiple servers would be much easier. If you know your scaling 
needs just from the start, it would be wise to start with a one- or two-node SP, 
instead of starting with single boxes. If you want to use clustering right from the 
start, think of the SP High Performance Switch as the proper connection solution 
for the servers, without the sharing of bandwidth you would get on another LAN 
environment. You would follow the same procedure as described in 11.2.12, “Use 
of Private LAN for Cluster Communication” on page 336, just using the IP 
address of the switch in setting up your port definitions.

If you would like to have a scalable Webserver solution, you could use the 
combination of Lotus Domino Advanced Services clustering plus the IBM 
Interactive Network Dispatcher (IND) for directing Web clients to an appropriate 
server. IND provides loadbalancing between servers for TCP/IP oriented 
protocols, such as HTTP. The redbook, Load-Balancing Internet Servers, 
SG24-4993, provides you with an overview about this product.

12.3.1  RS/6000 SP: Planning
If you are going to install a Lotus Domino Server in a SP system, you should 
know some specifics of the software and the hardware of the RS/6000 SP. For a 
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good starting point to get familiar with software and hardware of RS/6000 SP 
systems, refer to the new redbook Inside the RS/6000 SP, SG24-5145. As the 
Scalable Parallel (SP) system is one of the most successful products within the 
RS/6000 family, known by many extraordinary events, this redbook provides a 
comprehensive and detailed look at the different components that make up this 
system. It also includes the history and evolution of the SP.

In general running Lotus Domino on the SP is the same as on a cluster of distinct 
servers, from the application point of view. But you have to consider the system 
administration advantages of the RS/600 SP as a foundation for your Lotus 
Domino servers. You can also use all the information provided so far in this 
redbook about Lotus Domino on the RS/6000 SP. Major points to consider, 
especially for the combination of Lotus Domino and RS/6000 SP, are:

1. Use of the High Performance Switch as separate network for DAS cluster 
communications.

2. Use of the High Performance Switch as a network for backup/restore 
purposes. If you have a large number of registered mail users, or high 
volumes of application data, you must carefully plan your backup/restore to fit 
in the timeframe available at your site. Using the switch to eliminate network 
restrictions might help, compared to a setup with standard servers without the 
switch.

3. Use of the High Performance Switch in conjunction with a network routing 
node to gain network bandwidth advantages on connecting many clients, 
instead of multiple network adapters per node.

The central source of information about how to implement Lotus Domino servers 
using the RS/6000 SP is currently available at the IBM web site: 
http://www.rs6000.ibm.com/resource/technology/notesSPcfg

This location provides information about:

  • Planning the hardware.
  • Planning SP Lotus Domino servers.
  • Planning SP AIX users.
  • Planning disk space and configuration.
  • Planning networks for Lotus Domino.
  • Planning Lotus Domino High Availability on the RS/6000 SP.

Even if you are starting a small Lotus Domino implementation on your SP system, 
follow these recommendations. It will simplify the growth of your Lotus Domino 
environment in your SP system.

12.3.2  RS/6000 SP: Installation
After planning your installation, just install Lotus Domino on the SP as usual (see 
Chapter 2, “Installing a Lotus Domino Server” on page 23):

1. Make sure the hardware is installed correctly and each node meets the 
requirements for a Lotus Domino Server as described in 1.5, “Available 
Platforms” on page 14.

2. Make sure AIX and Parallel System Support Progress (PSSP) is installed on 
all nodes; see 1.5, “Available Platforms” on page 14 and check with the 
current release notes of Lotus Domino for the needed PTFs. Lotus Domino on 
a RS/6000 SP needs the same PTFs as a standalone server.
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3. Make sure the X11 runtime libraries are installed on the nodes. Otherwise, you 
cannot start Lotus Notes for installation and administration. They are not 
installed by default on an SP since there is normally no graphic adapter 
installed in a node. You could check by issuing the commands lslpp -L 
bos.rte.X11 and lslpp -L X11.compat.lib.X11R5 on the node 
(X11.compat.lib.X11R5 is only required if you have trouble with a Lotus Notes 
client on the node).

4. Make sure your network connectivity is setup correctly (multiple IP addresses 
for the switch interfaces if you use partitioning, network routes). The server 
names you are going to use must be resolvable both by the servers and the 
clients. For details about multiple IP addresses and partitioning, see 9.2.1, 
“Network Setup” on page 236 and 11.3.3, “Configuring Partitioned Servers for 
TCP/IP” on page 339. Basic network setup is described in 2.2.6, “Setting Up a 
Local Area Network (LAN)” on page 32.

5. Make sure paging space is large enough for your environment (not below 
installed memory, depending on the number of users and databases 
significantly larger); again, there are no special requirements as compared to 
a standalone server.

6. Make sure a user notes with group notes exists on every node where Lotus 
Domino is going to be installed. It does not have to be a login user, but it is 
used for file ownership of the server code. Details about creating a user can 
be found in 2.2.5, “The File System for the Lotus Domino Server Databases” 
on page 30.

7. For each server instance, create a user ID (preferable username=<domino 
server instance name>) part of group notes.

8. Create the filesystem /usr/domino on each node where the Lotus Domino 
Server code is to be installed, owned by user notes; see 2.2.2, “Create the 
Logical Volume for the Lotus Domino Server Binaries” on page 26 and 2.2.4, 
“The File System for the Lotus Domino Server Binaries” on page 29 for details.

9. Create Volume Groups and filesystems, as planned, for each server instance 
owned by the appropriate user from step 4. A good naming convention is to 
create the filesystem with the server instance name and install the instance in 
the subdirectory notesr4. So, each filesystem for each server instance will 
have a different name. See 2.2.3, “Create the Logical Volume for Lotus 
Domino Server Databases” on page 27 and 2.2.5, “The File System for the 
Lotus Domino Server Databases” on page 30.

10.Modify each user’s .profile as usual for a notes server user. Do not forget the 
specific environment variables for a UNIX system, such as NSORDER and 
Notes_SHARED_DPOOLSIZE. For details about these variables, see Chapter 
6, “Configuring Lotus Domino Servers on AIX” on page 143.

11.Install the Lotus Domino Server executable code on all nodes through the 
Lotus Domino installation process. If you have the installation CD on the SP’s 
control workstation, you can install to multiple hosts, as specified in 2.3.1, 
“Installing on Multiple Hosts” on page 49. You do not have to modify the file 
.rhosts, since the control workstation has access to the nodes anyway.

12.Install each server instance by performing the following steps:

a. Login as user <serverinstance> on the appropriate node.
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b. Export the DISPLAY environment variable to the graphical terminal you are 
working on; remember to allow access for the Xclient by issuing the xhost 
command before on your graphical terminal.

c. Type notes and proceed as usual with the Lotus Domino setup.

13.Perform further setup and administration of Lotus Domino as usual.

12.4  Further Information on High Availability and Scalability

As already pointed out several times, the redbook High Availability and Scalability 
with Domino Clustering and Partitioning on AIX, SG24-5163, provides valuable 
additional information on these topics. It gives a comprehensive explanation 
about the different ways of making a Lotus Domino Server highly available. It 
describes the Lotus Domino Clustering technology, which is part of the Advance 
Services offering of Lotus Notes servers, as well as the standard HACMP 
implementation for AIX and RS/6000 SP.

The redbook will help you to plan, install, and configure a highly available Lotus 
Domino Server using Lotus Domino Clustering and Partitioning, as well as 
HACMP technology, including the special version developed for the RS/6000 SP.

Within the six chapters of the book, you will find a good deal of information about 
what environment will better fit your needs for high availability and scalability, as 
well as detailed examples for implementing those different environments.
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Chapter 13.  Backup and Recovery

This chapter covers one of the most important tasks in Lotus Domino 
administration, backup and recovery. We will focus mainly on the tools that come 
with AIX, but we will also give a quick overview on other means of backing up 
your Lotus Domino system.

13.1  Introduction

Performing regular backups is critical. Back up Lotus Domino Servers often to 
protect from data loss. This is a very laborious task that needs your attention 
daily. For your assistance, there are many good tools that come with AIX.

We will present several ways to back up your Lotus Domino servers in this 
chapter. You are free to choose the one solution that will best suit your 
environment. When choosing your backup plan, remember that the goal of all 
backups is to minimize server downtime. When one or more servers are down, 
and you have hundreds, or maybe thousands, of users waiting for Lotus Domino 
to come back on-line, you will find that you don’t have time for lengthy recovery 
procedures or many mistakes. Make sure to have a good recovery plan written 
down on paper.

When setting up your backup environment it is also crucial to know for certain 
that it is functional. A backup is not a backup unless you have tested your 
recovery plan. It is a good idea to test out backup as well as recovery before 
taking the Lotus Domino Server into production. When in production, make sure 
to make a recovery test every six months or so.

Assuming that the server was installed as described in 2.2, “Preparing the 
Environment for the Installation” on page 24, you need to back up the following 
directories and files:

/usr/domino/lotus
This is the Lotus software file system. You need to back it up only 
before you install new Lotus software or an upgrade in this directory. If 
you are not extremely short on backup media and backup time, 
however, it is recommended that you include this file system in your 
regular backups.

/noteswrk
If you created this file system (see 6.3.3, “Distributing the Lotus Notes 
Software Directory” on page 160) you may back it up once. Note that 
you can repeat the procedure in 6.3.3.1, “Installing the Notes 
Workstation Software” on page 162, to restore this file system from the 
Lotus Notes UNIX Distribution CD-ROM.

/server1
This is the file system with the home directory for the user notes. It 
contains the Lotus Domino Server data directory (notesr4) with the 

Don’t make the mistake of storing your recovery plan in your Lotus Notes 
database. At the time you need it, it might be unavailable! Keeping an 
up-to-date hardcopy physically near the Lotus Domino Server is a good idea.

Note
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databases, the templates, the mail files, and others. This file system 
may require one or more daily backups if your organization produces a 
lot of data. Be aware that with the procedures described in this 
chapter, you must shut down your Lotus Domino Server software 
before you make a backup.

notes.ini, server.id, cert.id, user.id
Keep a copy of these files on a floppy disk in a secure place. You will 
find them in the Lotus Domino Server data directory 
(/server1/notesr4).

In this chapter, we discuss the following examples:

  • How to back up only one server
  • How to back up a server that contains users data
  • How to back up more than one server

For our examples, we will assume that a backup server exists with two identical 
tape units. In order to make examples easier to understand, the capacity of these 
tape units are assumed to be sufficient for all of our backup needs. These tape 
units may be 4 or 8 mm DAT, or maybe DLT, depending on the size of the data to 
be backed up. In our case, the device names will be /dev/rmt0 and /dev/rmt1.

Additionally, it is also assumed that you have installed the scripts from 11.3.5, 
“Starting the Server in the Background” on page 341 for starting the server in the 
background. This is normally required when running Lotus Domino on AIX in a 
production environment. In scripts and examples, we will assume that these 
scripts are installed in the directory /server1/bin.

All the examples here can be used in small organizations with some work and 
customization. For a larger organization, consider using a professional backup 
tool like the IBM ADSTAR Distributed Storage Manager Solution (ADSM). There 
is a redbook on using IBM ADSM to back up Lotus Notes; Using ADSM to Back 
Up Lotus Notes, SG24-4534.

13.2  Server Backup Using AIX Native Tools

The backup and restore commands are the native AIX tools for backups that will 
be used in this section. These tools are capable of incremental backup, but since 
a Lotus Notes database is one file, the modification of one document in a huge 
database will change the file, and, thereby, force a backup of the entire file. 
Obviously, it would be more economical to be able to make an incremental 
backup of the database saving only the modified documents. Refer to 13.5, 
“Advanced Backup Solutions” on page 374 for backup solutions that can make 
incremental backups of Lotus Notes databases on a document level.

Do not rely on replication as your only backup method. Corrupted, damaged, or 
accidentally changed databases can replicate, and all replicas may become 
damaged.

Note
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13.2.1  Stopping and Starting the Database Server
To ensure the integrity of a Lotus Domino Server backup using native AIX tools, 
the server should be stopped, and the file system where it resides preferably 
unmounted. It is not necessary to unmount the file system if you know that there 
are no users on the server and that no process will work with the server file 
system during the backup. If you are uncertain, unmount the file system before 
the backup.

The commands for stopping and starting the Lotus Domino Server depend on 
your installation. If you installed the start and stop scripts described in 11.3.5, 
“Starting the Server in the Background” on page 341, you would use the following 
procedures:

To stop a running server:

1. Log in as user root.

2. Execute the command /server1/bin/app_stopdomino.

To start a server that is not already running:

1. Log in as user root.

2. Execute the command /server1/bin/app_startdomino.

13.2.2  How to Back Up the Lotus Software File System
You have to back up the /usr/domino/lotus file system only after you install new 
Lotus software or perform an upgrade. You can also use the instructions in this 
section to back up the /noteswrk file system.

If you have a local tape on the system, you can use the backup command.

1. Insert a blank and unprotected media in the tape unit.

2. Log in as root.

3. Enter the following command to set the tape block size:

# /usr/sbin/chdev -l rmt0 -a block_size=1024

4. Before running a file system backup, you should check the file system 
integrity. Run the command:

# fsck /usr/domino/lotus

This command will report the problems you may have. If you have any 
problems, you must unmount the file system and run fsck again to correct the 
problem and then remount it. For additional information, please refer to the 
fsck AIX manual page by typing in the command: man fsck

Alternatively, you can also find relevant documentation, including a commands 
reference for AIX, at http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ 
on the World Wide Web.

 Change the rmt0 to your tape unit name; you can use other block sizes than 
1024. You can list your system's tape names with the following command:
lsdev -C -c tape

Note
Backup and Recovery 361



5. If the /usr/domino/lotus is a file system, enter:

# backup -u -0 -f /dev/rmt0 /usr/domino/lotus

This command will perform a level 0 file system backup by i-node.

If it is not a file system, you can use the following commands:

# cd /usr/domino/lotus
# find . -print | backup -i -v -f /dev/rmt0

This creates a backup by file name on the tape. Invoked this way, the backup 
command needs a list of files and directories to backup. The find command, 
as used above, lists the entire directory structure starting at the current 
directory.

6. If you need to copy the backup tape, just insert the target tape in the tape unit, 
rmt1, and enter the command:

# tcopy /dev/rmt0 /dev/rmt1

In this example, rmt0 is the source tape unit, and rmt1 is the target tape unit. 
Don’t forget to set the block size for rmt1, the same as for rmt0.

See 13.2.5.1, “Restoring Files with restore” on page 366 for information on 
restoring backups. See also the manual pages for a detailed explanation of the 
commands find, tcopy, backup, and restore. To get an explanation of any AIX 
commands, type: man <command>. For example, you can get an explanation of 
backup by typing in the command:

man backup

Alternatively, you can also find relevant documentation, including a commands 
reference for AIX, at http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on 
the World Wide Web.

13.2.3  How to Back Up Only One Server
It is very important to have a backup schedule. The AIX backup command offers 
10 different levels (0 through 9) of incremental backup. Level 0 is the full backup. 
On the other levels, all the files that have been changed since the last lower-level 
backup are backed up.

For our example, we will use the following backup schedule:

Weekly Full Backup (Level 0)
Performed every Wednesday. The full backup tape will be copied for security 
reasons. The second copy from this tape can be stored on a secure place in 
another building, for example.

Incremental Daily Backup (Level 5):
Performed on Monday, Tuesday, Thursday, Friday and Saturday.

  • Change rmt0 to the name of your tape unit.

  • To ensure the data integrity of the backup when performing a backup by 
i-node, you must unmount the file system before doing the backup. Don’t 
forget to remount it again after the backup.

Note
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To implement this schedule, we will use the script backtape (Figure 292 on page 
364) and the AIX crontab facility. The cron and crontab commands give you the 
ability to schedule commands to be executed at given times. Please refer to the 
crontab manual page if you are not familiar with crontab.

#!/bin/ksh
#@(#) backtape Lotus Notes backup procedure
#
# Usage: backtape [-copy] <level> <tape0> <tape1>
#
COPY=NO
FS=/server1

# Display error message and exits
Error () {
  echo "Usage: backtape [-copy] <level> <tape0> <tape1>"
  echo "Example: backtape 5 rmt0 rmt1" >&2
  exit 1
}

NARGS=$#
# Test for the copy option
[[ $1 = -copy ]] && { COPY=YES ; shift ; let NARGS=${NARGS}-1 ; }
# Test the number of flags, must be 3
[[ $NARGS -ne 3 ]] && Error

LEVEL=$1
TAPE0=$2
TAPE1=$3

echo "Backup level $LEVEL, tape0 $TAPE0, tape1 $TAPE1, copy=$COPY"
echo "Started on ‘date‘ on server ‘uname -n‘"

# These tape attributes applies to the 8mm 2.3/5GB tapes
# Check for the attributes that applies to your tape
echo "\nChanging the attributes of $TAPE0..."
/usr/sbin/chdev -l $TAPE0 -a block_size=1024 -a mode=yes -a extfm=yes

# We have to rewind the tape
echo "\nRewinding the tape $TAPE0..."
/bin/tctl -f /dev/$TAPE0 rewind

# Stop the Lotus Domino server
echo "\nStopping the Lotus Domino server..."
$FS/bin/app_stopdomino

# Make the system backup of the $FS
echo "\nMaking backup level $LEVEL of $FS on $TAPE0..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/$TAPE0 $FS

# Restart the Lotus Domino server
echo "\nRestarting the Lotus Domino server..."
$FS/bin/app_startdomino
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Figure 292.  Simple Script to Make the Lotus Notes Backup (backtape)

This script will back up the file system /server1 to the specified device (rmt0 or 
rmt1) using the backup command, then makes a copy of the backup tape, if 
specified (using the command tcopy), and finally ejects the backup tape(s) (using 
the command tctl).

To implement the backup schedule, you have to add the lines in Figure 293 to the 
root crontab. As root, run the command: crontab -e and add the lines at the end 
of the file.

The first line is only a comment to remember the crontab file fields. The second 
line implements the Monday, Tuesday, Thursday, and Friday daily incremental 
level 5 backup on rmt0. The third one implements the Saturday backup on rmt1. 
The last one is the weekly full backup that is made on rmt0 and copied to rmt1.

Figure 293.  Crontab for the backtape Script

# Making the tape copy...
if [[ $COPY = YES ]]
then
  # These tape attributes apply to the 8mm 2.3/5GB tapes
  # Check for the attributes that applies to your tape
  echo "\nChanging the attributes of $TAPE1..."
  /usr/sbin/chdev -l $TAPE1 -a block_size=1024 -a mode=yes -a extfm=yes

  # We have to rewind the tapes
  echo "\nRewinding the tape $TAPE0 for copy..."
  /bin/tctl -f /dev/$TAPE0 rewind
  echo "\nRewinding the tape $TAPE1 for copy..."
  /bin/tctl -f /dev/$TAPE1 rewind

  # Make the copy
  echo "\nMaking the copy of $TAPE0 on $TAPE1..."
  /bin/tcopy /dev/$TAPE0 /dev/$TAPE1

  # Ejecting the tape
  echo "\nEjecting $TAPE1..."
  /bin/tctl -f /dev/$TAPE1 offline
fi

# Ejecting the tape
echo "\nEjecting $TAPE0..."
/bin/tctl -f /dev/$TAPE0 offline

echo "\nEnd of the backup program..."

To use AIX with this form of the backup command, /server1 must be a valid file 
system.

Note

#minute  hour  day_of_month  month  weekday  command
0 23 * * 1,2,4,5 /server1/scripts/backtape 5 rmt0 rmt1 2>&1 | /bin/mail -s "Backup level 5" root
0 23 * * 6 /server1/scripts/backtape 5 rmt1 rmt0 2>&1 | /bin/mail -s "Backup level 5" root
0 23 * * 3 /server1/scripts/backtape -copy 0 rmt0 rmt1 2>&1 | /bin/mail -s "Full Backup" root
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The backup operator will need five tapes (one for each day of the week) for the 
level 5 backup. These five tapes may be labeled with the weekday name and 
reused weekly. So, for example, on Monday, the operator inserts the Monday 
tape in rmt0, and on Friday, the Friday tape is inserted in rmt0 and the Saturday 
tape in rmt1.

For each week, two tapes will be needed for the full backup. They have to be 
labeled with the backup date. On Wednesday, the operator will have to insert the 
backup tape in rmt0 and the copy tape in rmt1. On Thursday, the tapes must be 
backed up and the copy sent to another place. In Table 17, there is an example of 
the backup schedule and tape labels.

Table 17.  Backup Schedule and Tape Labels

Another decision that needs to be made is how long you want to keep these 
tapes. For example, you can keep the backup tapes for the last year. For the 
most recent three months, you keep all the weekly backups. For the previous 
nine months, older tapes can be reused.

13.2.4  Backing Up a Server that Contains User Data
If you have a file system that contains all of the user data directories on the Lotus 
Domino Server (with the configuration shown in Figure 131 on page 156), just 
replace the lines in Figure 294 in the script backtape (Figure 292 on page 364) 
with the lines in Figure 295 on page 366.

Figure 294.  Lines To Be Removed

Weekday Tape Labels

Tape rmt0 Tape rmt1

Monday Monday level 1

Tuesday Tuesday level 1

Wednesday MM/DD/YY level 0 MM/DD/YY level 0 copy

Thursday Thursday level 1

Friday Friday level 1 Saturday level 1

You must be careful when storing tapes for a long time because they maintain 
the data integrity only for a defined time period (generally one to two years). 
You also must be careful about reusing tapes.

Note

# Make the system backup of the $FS
echo "\nMaking backup level $LEVEL of $FS on $TAPE0..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/$TAPE0 $FS
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Figure 295.  Lines To Be Added

You will have the same backup schedule for the users’ data file system using the 
same tapes.

To restore the data of the /server1 file system, run the restore command (see 
13.2.5.1, “Restoring Files with restore” on page 366). To restore the data of the 
/home file system, you must use the tctl command to advance the tape. With the 
restore command, specify the -f flag to indicate a non-rewinding device. The 
commands below list the table of contents of the /home file system backup. They 
assume the backup tape is available at the unit rmt0.

# tctl -f /dev/rmt0 rewind
# tctl -f /dev/rmt0.1 fsf 1
# restore -T -f /dev/rmt0.1

13.2.5  Restoring Backup Data
To restore a whole file system, first ensure you have an empty and error-free file 
system before restoring the tape to it. Next, you will have to use the restore 
command.

To restore a database that is stored on tape or in a file, you must use the restore 
command. This command copies the database files you select from the tape to 
the hard disk. You can copy the backup file over the damaged file to restore the 
whole database or use one of the following tips to manage at the document level:

  • To preserve the new documents added since the last backup, restore the 
backup to a different directory, move it to the databases directory using a new 
file name, and copy the new documents from the live database to the backup. 
Delete the live database and rename the backup to the original name.

  • To restore a single damaged or deleted document, you must restore the 
backup of the whole database with a new file name and copy the document 
from the backup to the live database. Following this, delete the backup 
database from the hard disk.

13.2.5.1  Restoring Files with restore
The restore command extracts files from archives created with the backup 
command. To check a backup tape, you can use the restore command with the -T 
flag: restore -T -f /dev/rmt0. This command produces a list of all backed up 
files.

For example, you lost all the /server1 file system. To recover it on the last backup, 
you must take the appropriate actions (for example, remove the old files, remove 

# Make the system backup of the /server1
echo "\nMaking backup level $LEVEL of /server1 on ${TAPE0}.1..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/${TAPE0}.1 /server1
# Make the system backup of the /home
echo "\nMaking backup level $LEVEL of /home on ${TAPE0}.1..."
/usr/sbin/sync
/usr/sbin/sync
/usr/sbin/backup -u -$LEVEL -f /dev/${TAPE0}.1 /home
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the file system and create a new one, and so on) until you have an empty, 
mounted, and error-free file system in /server1. After that, as root:

1. Change directory to /server1. This is very important.

2. First restore the last full backup:

a. Make sure that your media (the tape or the file) is available.

b. Run the command:

# restore -x -v -f <device name>

If you are using the tape, use /dev/rmt0.1. You may need to run the tctl 
command. Use the tctl command when you have made more than one 
backup on a single tape, see 13.5.1.2, “Back Up Using rdump” on page 
379. If you are using a file archive, use its name.

c. When the system prompts with the message

Specify the next volume number:

press 1 and Enter, and the restoration proceeds.

d. When the system prompts with the message

Do you want to set the owner or the mode for the current
        directory? [ yes or no ]

answer yes to set the owner and the mode for the /server1 directory.

3. If you have performed incremental backups since the last full backup, restore 
only the last incremental one. Insert the correct tape, or specify the new file 
name, and run the same command as above. Be sure to be in the /server1 
directory, and run the same restore command.

If you want to restore only some files, restore them to a temporary directory and 
then move them into place using the mv command. For example, as root, do the 
following:

1. Create a temporary directory, /server1/restore.

2. Change the owner and group of this directory to notes.

3. Change the current directory to /server1/restore.

4. Make the archive media available as described above.

5. Run the command:

# restore -i -f <filename>

6. Use the -i flag subcommands to list the files. Select the ones you want and 
restore them.

In Figure 296 on page 368, you see an example. The file names.nsf (Address 
Book database) is restored. What you have to type is in bold.
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Figure 296.  Restoring the names.nsf File

For more information, refer to the restore manual page. Alternatively, you can 
also find relevant documentation, including a commands reference for AIX, at 
http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on the World Wide Web.

13.3  Backup and Recovery of the AIX System

It is very important to do a full system backup from the AIX server machine at 
least weekly. You will need to have a tape unit locally attached to each server you 
want to back up.

You can make a system backup to a file on a backup server, but you will need to 
set up a Network Install Manager (NIM) environment to be able to restore the AIX 

# mkdir -m 750 /server1/restore
# chown notes.notes /server1/restore
# cd /server1/restore
# restore -i -f /dev/rmt0.1
Please mount volume 1 on /dev/rmt0.1.
        Press the Enter key to continue.

restore > ls
.:
 .Xpdefaults    .sh_history    notesr4/
 .profile       log/           scripts/

restore > cd notesr4
restore > ls
./notesr4:
 .notes4000     certlog.ntf    doclibm4.ntf   mail/          readme.nsf
 admin4.nsf     cluster.ncf    events4.ntf    mail.box       reserve4.ntf
 admin4.ntf     dba4.ntf       help4.nsf      mail4.ntf      server.id
 alog4.ntf      dblib4.ntf     helplt4.nsf    mailbox.ntf    statrep.ntf
 approve4.ntf   desktop.dsk    journal4.ntf   modems/        unix/
 cache.dsk      discuss4.ntf   log.nsf        names.nsf      user.id
 catalog.nsf    doc/           log.ntf        notes.ini      web.ntf
 catalog.ntf    doclib4.ntf    loga4.ntf      pernames.ntf   ~console.tmp
 cert.id        doclibl4.ntf   lotusen1.dic   pubnames.ntf   ~notes.lck

restore > add names.nsf
restore > extract
You have not read any media yet.
Unless you know which volume your file or files are on, you should start
with the last volume and work towards the first volume.
Specify the next volume number: 1
Do you want to set the owner or the mode for the current
        directory? [ yes or no ] yes
restore > quit
# pwd
/server1/restore
# ls
notesr4
# cd notesr4
# ls
names.nsf
# mv names.nsf /server1/notesr4
# cd ..
# rmdir notesr4
#

368 Lotus Domino Release 4.6 on IBM RS/6000



machine from this file. To learn about the NIM, see AIX Version 4.1 Network 
Installation Management Guide and Reference, SC23-2627.

To make a system backup, you need the bos.sysmgt.sysbr fileset installed in your 
system. You can use the command lslpp -l bos.sysmgt.sysbr to see if this file set 
is installed on your system. Refer to the AIX Version 4.1 Installation Guide, 
SC23-2550, for more information about installing a fileset.

The mksysb command only backs up the rootvg volume group. If you have other 
Volume Groups, you can use the smitty savevg command.

13.3.1  Backing Up the AIX System
In this redbook, we show only the minimal procedure to do a system backup for 
the rootvg volume group. Please refer to the AIX Version 4.1 Installation Guide, 
SC23-2550, for more information about the system backup.

To backup the system:

1. Log in as root.

2. Mount all file systems (in the rootvg) you want to back up. Refer to the mount 
command for details.

3. Enter the smitty mksysb command. The Back Up the System screen, as shown 
in Figure 297 on page 369, appears.

Figure 297.  Back Up the System

The mksysb command does not back up file systems mounted across an 
NFS network.

Note

                               Back Up the System

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
    WARNING:  Execution of the mksysb command will
              result in the loss of all material
              previously stored on the selected
              output medium. This command backs
              up only rootvg volume group.

* Backup DEVICE or FILE                              [/dev/rmt0]              
  Create MAP files?                                   no                      
  EXCLUDE files?                                      no                      
  Make BOOTABLE backup?                               yes                     
     (Applies only to tape)
  EXPAND /tmp if needed?                              yes                     
     (Applies only to bootable tape)
  Number of BLOCKS to write in a single output       []                       
     (Leave blank to use a system default)

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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a. Press F4 in the Backup DEVICE or FILE field and choose the tape for the 
backup.

b. Select yes on the EXPAND /tmp if needed? field.

c. Insert the tape in the unit and press Enter.

13.3.2  Restoring the AIX System Backup
In this redbook, we show only the minimal procedure to restore the system from 
the backup tape. Please refer to the AIX Version 4.1 Installation Guide, 
SC23-2550, for more information about the system backup.

To restore the system:

1. Insert the backup tape (write protected) in the tape unit.

2. Shut down and power-off the system.

3. Put the system key in the Service position, if there is a key.

4. Power on the system.

5. After several minutes, c31 is displayed in the LED. Choose the system 
console.

After this, turn the key to the normal position (when asked), and follow the 
installation menus.

13.4  Other Native AIX Backup Tools

Instead of the commands backup and restore, you may choose between several 
other tools for backup. Each of these tools have advantages and disadvantages 
over the others. One reason to choose another tool might be that your site is 
already using tar or cpio for other backups. It might then make sense to look into 
using the same tool for your Lotus Domino Server as well. In this section, we will 
give a quick overview of the other tools you may choose from. If you need more 
information, please refer to the man pages of the respective command.

13.4.1  tar
Tar (Tape Archiver) is a traditional AIX tool, that has been around since the early 
days. As the name suggests, it archives files and puts them on a tape. The tar 
command works with the usual AIX files; so it is not really restricted to archiving 

  • The mksysb command will create a bootable tape on an ISA (Industry 
Standard Architecture)-bus machine, but not every ISA-bus machine will 
boot from tape. To determine if your system will boot from tape, run the 
command: bootinfo -e. If a 0 is returned, it will not boot from tape, and you 
must boot from CD-ROM to install your mksysb tape.

  • The mksysb tapes that are created on ISA-bus machines will not boot Micro 
Channel-based uniprocessor or Micro Channel-based symmetric 
multiprocessor machines, and mksysb tapes made from Micro 
Channel-based uniprocessor and Micro Channel-based symmetric 
multiprocessor machines will not boot on ISA-bus machines.

Note
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to tape. You can put your archives on almost anything that is a file in AIX. 
Basically, it is a very simple tool. All it really does is to take one or more files and 
directories and archives them into one single file. Nothing more, nothing less. 
There is no compression or encryption involved as in some other tools. If you 
want compression for instance, you have the option of adding that after the 
archive is created.

It is possible to exchange the backup and restore commands that we have used 
so far with tar. This might be preferable if there is a mixed environment at your 
site and the other hosts on your network don’t support the backup and restore 
commands. If you choose to do this, there are a few things to be aware of. First of 
all, unlike backup, tar can only back up files by file name. This is not really a 
problem, just different. Also, tar does not read files to back up from standard 
input. You must add the files and the directories to the command line when 
invoking tar. However, if you specify directories on the command line, tar will 
search those directories recursively; so, normally, you only need to specify one or 
a few. Finally, tar has some restrictions on file names, sizes, and attributes. For 
example, tar does not back up ACLs.

If you want to back up the directory (or file system) /usr/domino/lotus to tape 
device /dev/rmt0 using tar, you could use the following sequence of commands 
(note that the tar command ends with a space and a period):

To list the entire archive you would use tar -tvf /dev/rmt0, and to extract the 
entire archive to the current directory, tar -xvf /dev/rmt0. Be advised that when 
extracting files, tar will overwrite any existing files with the archived version, if a 
file with the same name exists.

The tar command isn’t really able to create archives on remote hosts, but if your 
file system is on one host and the tape device on another and they can talk to 

The tar command does not normally perform any translations of file and 
directory names. Therefore, if you specify absolute path names when you back 
up files or directories, they will also appear at the very same location if you 
extract them later, potentially overwriting an old file. A good rule of thumb is to 
always try to use relative path names with tar. A relative path name is a path 
name that does not begin with the character /.

Note

# cd /usr/domino/lotus
# tar -cvf /dev/rmt0 .
a .
a ./notes
a ./notes/4613
a ./notes/4613/ibmpow
a ./notes/4613/ibmpow/Notes.jar 401 blocks.
a ./notes/4613/ibmpow/icsclass.jar 447 blocks.
a ./notes/4613/ibmpow/getgroup 67 blocks.
a ./notes/4613/ibmpow/amgr 357 blocks.
a ./notes/4613/ibmpow/chronos 68 blocks.
a ./notes/4613/ibmpow/notes 28984 blocks.
...
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each other over a network, you can use the following little trick to copy your 
archive to the remote host. First of all, the root user on the local host must be 
trusted as root on the remote host, that is, the local machine name must be in the 
file /.rhosts on the remote host. See 13.5.1.2, “Back Up Using rdump” on page 
379, for more information. Then, to back up the local directory /usr/domino/lotus 
to the remote tape unit /dev/rmt0, you would use the following commands. In this 
example, the remote host with the tape unit is called noteserv.

# cd /usr/domino/lotus
# tar -cvf - . | remsh noteserv "dd bs=1024 of=/dev/rmt0"

The tar command has many more options worth exploring that are beyond the 
scope of this book. For more information, refer to the tar manual page. 
Alternatively, you can also find relevant documentation, including a commands 
reference for AIX, at http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on 
the World Wide Web.

13.4.2  cpio
The name cpio comes from the intended use of the command: CoPy files In and 
Out of archives. Just like tar, cpio has been around since the beginning of AIX. 
The cpio command differs from backup and tar by only working with the standard 
input and output of the shell. You must use shell redirection to send a cpio archive 
to permanent storage. To specify the files to be archived or extracted, you must 
supply them on the standard input of cpio. It may sound difficult, but it really isn’t. 
It also gives you great flexibility in how you want to list filenames and where to 
store the archive. Just like tar, cpio does not compress or encrypt the archived 
files, but it is very easy to add with other commands.

You may want to choose cpio for your backups if you are on a mixed environment 
network, or if your site already uses cpio for regular backups. The cpio command 
has similar restrictions on file name, size, and attributes to tar. The main 
difference is that cpio takes file names on standard input instead of the command 
line.

If you want to back up the directory (or file system) /usr/domino/lotus to tape 
device /dev/rmt0 using cpio, you could use the following sequence of commands:

  • This trick will only work with a remote host running AIX or some other 
version of UNIX.

  • Depending on the OS and the tape unit on the remote host, you might need 
to give a different block size. See the user manuals for the OS in question.

Note

The cpio command does not normally perform any translations of file and 
directory names. Therefore, if you specify absolute path names when you back 
up files or directories, they will also appear at the very same location if you 
extract them later, potentially overwriting an old file. A good rule of thumb is to 
always try to use relative path names with cpio. A relative path name is a path 
name that does not begin with the character /.

Note
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To list the entire archive, you would use cpio -itvB < /dev/rmt0, and to extract the 
entire archive to the current directory, cpio -idumvB < /dev/rmt0. Be advised that 
when extracting files, cpio will overwrite any existing files with the archived 
version, if a file with the same name exists.

For storing the archive on a remote tape unit, it is possible to use a trick similar to 
the one we used for tar in 13.4.1, “tar” on page 370. The same restrictions on 
network connectivity and trust relationship applies to cpio. For example, to back 
up the local directory /usr/domino/lotus to the remote tape unit /dev/rmt0 you 
would use the following commands. In this example, the remote host with the 
tape unit is called noteserv.

# cd /usr/domino/lotus
# find . -print | cpio -ovC2 | remsh noteserv "dd bs=1024 of=/dev/rmt0"

The cpio command has many more options worth exploring that are beyond the 
scope of this book. For more information, refer to the cpio manual page. 
Alternatively, you can also find relevant documentation, including a commands 
reference for AIX, at http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on 
the World Wide Web.

13.4.3  savevg/restvg
If you followed the installation instructions in Chapter 2, “Installing a Lotus 
Domino Server” on page 23, you have a good setup for using the commands 
savevg and restvg to back up your Lotus Domino Server. These two commands 
are significantly different from the ones we’ve described so far, since they back 
up an entire volume group, not just files or filesystems. However, this also means 
that you can’t perform incremental backups, nor can you backup or restore 
individual files or filesystems. (It is, however, possible to recover single files from 
a savevg backup using the restore command. See 13.2.5.1, “Restoring Files with 
restore” on page 366 for more information.) These tools make it really quick for 
you to restore your system after a disk crash. They do not, however, provide very 

# cd /usr/domino/lotus
# find . -print | cpio -ovB > /dev/rmt0
.
notes
notes/4613
notes/4613/ibmpow
notes/4613/ibmpow/Notes.jar
notes/4613/ibmpow/icsclass.jar
notes/4613/ibmpow/getgroup
notes/4613/ibmpow/amgr
notes/4613/ibmpow/chronos
...

  • This trick will only work with a remote host running AIX or some other 
version of UNIX.

  • Depending on the OS and the tape unit on the remote host, you might need 
to give a different block size. See the user manuals for the OS in question.

Note
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good help if you’ve accidentally removed a file and want to recover just that 
single file.

With savevg and restvg you have the option, just like with tar and cpio, to save the 
backup to tape, a regular file on disk, or any other AIX supported file. It is not, 
however, possible to use the remote “remsh” trick above with savevg. Your only 
option, if you can’t save the backup locally, is to save the backup file to an NFS 
server or some other shared file system.

If you have a volume group dominovg that contains the logical volumes noteslv 
and notesdatalv, then you can use the following command to back up both your 
server file system and your Lotus Domino software file system. It is assumed that 
the directory or file system /backup exists and can hold dominovg in its entirety. 
Remember to shut down your Lotus Domino Server before starting the backup.

To restore the backup in the previous example, you would use:

# restvg -f/backup/savevg-dominovg-980731 -q

to restore dominovg to the same physical volume that it came from, or

# restvg -f/backup/savevg-dominovg-980731 -q hdisk1

to restore it to the physical volume hdisk1. You can specify more than one 
physical volume if you wish.

The commands savevg and restvg have many more options worth exploring that 
are beyond the scope of this book. For more information, refer to the savevg and 
restvg manual pages. Alternatively, you can also find relevant documentation, 
including a commands reference for AIX, at 
http://www.rs6000.ibm.com/resource/aix_resource/Pubs/ on the World Wide Web.

13.5  Advanced Backup Solutions

If you have a large installation of Lotus Domino with many hosts, and/or high 
demands of availability, you may want to consider using a more advanced backup 
solution. Some of these solutions can give you easier administration, on-line 

# savevg -f/backup/savevg-dominovg-980731 -v dominovg

Creating list of files to back up.
Backing up 2366 filesBacking up to /backup/savevg-dominovg-980731.
Cluster 51200 bytes (100 blocks).
Volume 1 on /backup/savevg-dominovg-980731
a           70 ./tmp/vgdata/vgdata.files
a         2569 ./tmp/vgdata/dominovg/filesystems
a         2707 ./tmp/vgdata/dominovg/dominovg.data
a            0 ./server1
a            0 ./server1/lost+found
a          391 ./server1/.profile
a          654 ./server1/.sh_history
a            0 ./server1/notesr4
a            0 ./server1/notesr4/unix
a          406 ./server1/notesr4/unix/123.bmp
a           28 ./server1/notesr4/unix/123.mac
...
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backup of your databases, and shorter recovery time, in case of a system failure. 
They may also give you the opportunity to use multiple tape devices and tape 
libraries on several servers throughout your network.

13.5.1  Backup of More Than One Server
If you have a small number of servers, you can implement local backups for each 
of them, as described in 13.2.3, “How to Back Up Only One Server” on page 362.

Another idea is to make the backups in a host with enough disk space or to use 
the rdump command to back up to a remote tape. You will find a simple 
implementation of these two methods in the following subsections.

13.5.1.1  Backup on Disk
If you have a host with enough disk space and tape units, you can make it a 
backup server. First, you have to create the file system(s) for backups and, after 
that, export it/them through NFS or AFS. Refer to 6.3, “Lotus Domino and NFS” 
on page 154, for information about creating, exporting, and mounting file systems 
using NFS.

Next, mount the backup file system on the servers you want backed up and 
change the script backtape to make the backups to files instead of on tapes. The 
updated script is presented in Figure 298.

On the backup server, you need to back up the backup file system(s) to one or 
more tapes. This can be done using the backup command.

This sample environment will be used for our discussion on backup:

  • The backup server will be called noteserv. This also is a Lotus Domino Server. 
The /backup is the backup file system.

  • Two other Lotus Domino Servers, called ah1610a and ah1610b. Both use NFS 
to mount the /backup file system from noteserv.

The new version of the backtape script is in Figure 298. It is called backfile.
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Figure 298.  Modified Script to Back Up on Files (backfile)

This script makes the backup on the file 
/backup/<hostname>/backup.<level>.<date>.<weekday> where:

<hostname> is the machine host name.
<level> is the level of the backup. In our example, it will be 0 or 5.
<date> is the date of the backup in the format: YYMMDD (year, month, 

day).
<weekday> is the number of the weekday, beginning with 0 (Sunday) and 

ending with 6 (Saturday).

It also removes the old backup files for the same weekday. The backup operator 
must be sure that the copy to the tapes is working well. This is a critical part of 
this backup environment.

In order to set up the backup environment, the following steps are required:

1. Create the /backup file system on noteserv. Remember, it must be large 
enough to hold all the backup files. Running smitty crjfs, you can create the 
file system. The smit menu is in Figure 138 on page 163. You have to specify 
the size of the file system, specify the mount point name (/backup), and ask 
for the automatic mount after the system restart. If you want, you can use a 
compressed file system.

2. Mount the new file system: mount /backup.

#!/bin/ksh
#@(#) backfile Lotus Notes backup procedure
#
# Usage: backfile <level>
#
FS=/server1
LEVEL=$1
FILE=/backup/‘/bin/uname -n‘/backup.$LEVEL.‘/bin/date ’+%y%m%d.%w’‘

echo "Backup level $LEVEL, file $FILE"
echo "Started on ‘date‘ on server ‘uname -n‘"

# Remove the old file for the last week.
echo "\nRemoving old backup files..."
/bin/ls -la /backup/‘/bin/uname -n‘/backup.$LEVEL.*.‘/bin/date ’+%w’‘

/bin/rm -f /backup/‘/bin/uname -n‘/backup.$LEVEL.*.‘/bin/date ’+%w’‘

# Stop the Lotus Domino server
echo "\nStopping the Lotus Domino server..."
$FS/bin/app_stopdomino

# Make the system backup of the $FS
echo "\nMaking backup level $LEVEL of $FS on $FILE..."
/usr/sbin/backup -u -$LEVEL -f $FILE $FS

# Restart the Lotus Domino server
echo "\nRestarting the Lotus Domino server..."
$FS/bin/app_startdomino

echo "\nEnd of the backup program."
376 Lotus Domino Release 4.6 on IBM RS/6000



3. Export this file system to the machines you want to back up and do one of the 
following:

a. Give the client machines write access to the backup file system.

b. Export the file system and allow the hosts to have root access to the client 
machines.

c. Give 1777 permission to the directories that the client machines must write 
to.

The smit fastpath for exporting a file system is mknfsexp, and the menu can be 
seen in Figure 140 on page 165.

4. Create a directory for each machine you want to back up. In our example, the 
directories /backup/noteserv, /backup/ah1610a, and /backup/ah1610b have to 
be created. These directories need permissions 1777 if you haven’t exported 
the /backup file system with the hosts allowed root access option to the client 
hosts.

5. Copy the script backfile to the /server1/scripts directory of all hosts.

6. Mount the /backup file system on ah1610a and ah1610b. Use smitty mknfsmnt 
and complete the fields as follows:

Figure 299.  Mount the Remote /backup File System Using smitty

7. Create the crontab entries in Figure 300 on all hosts:

Figure 300.  Crontab for the backtape Script

In this case, the level 5 backup is done every day except Wednesday, when 
the full backup is done. This script must be present in the /server1/scripts 
directory for all the servers you want to back up. Also, the crontab lines must 

Add a File System for Mounting

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

[TOP]                                                   [Entry Fields]
* PATHNAME of mount point                            [/backup]                 /
* PATHNAME of remote directory                       [/backup]
* HOST where remote directory resides                [noteserv]
  Mount type NAME                                    []
* Use SECURE mount option?                            no                      +
* MOUNT now, add entry to /etc/filesystems or both?   both                    +
* /etc/filesystems entry will mount the directory     yes                     +
   on system RESTART.
* MODE for this NFS file system                       read-write              +
* ATTEMPT mount in foreground or background           background              +
  NUMBER of times to attempt mount                   []                        #
  Buffer SIZE for read                               []                        #
  Buffer SIZE for writes                             []                        #
  NFS TIMEOUT. In tenths of a second                 []                        #
[MORE...21]

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do 

#minute  hour  day_of_month  month  weekday  command
0 23 * * 0,1,2,4,5,6 /server1/scripts/backfile 5 2>&1 | /bin/mail -s "Backup level5" ro
0 23 * * 3 /server1/scripts/backfile 0 2>&1 | /bin/mail -s "Full Backup" root
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be present. Note, the backup server needs to run this script because it is a 
Lotus Domino Server, too.

8. The backup server needs another script (See Figure 301 on page 378) to 
handle the backup files and copy them to the tapes. Put this script in 
/server1/scripts on noteserv.

Figure 301.  Script to Dump Backup Files to Tape (dumpfiles)

9. Create the crontab entry in Figure 302 on noteserv:

Figure 302.  Crontab for the dumpfiles Script

The script dumpfiles copies all the data in the /backup file system to a tape. It 
must end before the Thursday backup begins.

To recover a file, if it is an old backup that is on tape, you have to copy it back to 
the hard disk and then use the restore command, as described in 13.2.5.1, 
“Restoring Files with restore” on page 366. To copy it to your hard disk, create a 
temporary directory, for example, /backup/tmp, and make it your current directory 
(using cd /backup/tmp). Then, use the restore command to extract the files you 
want.

To list the contents of the tape you can use the following:

#!/bin/ksh
#@(#) dumpfiles:  Dump the backup files to
the tape.
# It must run on thursday night, after the operator confirm
# the success of the full backup from wednesday.
# Usage: dumpfiles
#

echo "dumpfiles: started on ‘date‘ on server ‘uname -n‘"

# These tapes attributes applies to the 8mm 2.3/5GB tapes
# Check for the attributes that applies to your tape
echo "\nChanging the attributes of rmt0..."
/usr/sbin/chdev -l rmt0 -a block_size=1024 -a mode=yes -a extfm=yes

# We have to rewind the tape
echo "\nRewinding the tape rmt0..."
/bin/tctl -f /dev/rmt0 rewind

#
# Make the backup of the /backup file system
#
cd /backup
find . -print | backup -q -f/dev/rmt0

# Ejecting the tape
echo "\nEjecting rmt0..."
/bin/tctl -f /dev/rmt0 offline

echo "End of the backup..."

#minute  hour  day_of_month  month  weekday  command
0 17 * * 4 /server1/scripts/dumpfiles 2>&1 | /bin/mail -s "Dumpfiles" root
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To extract the level 0 file from 2/21/96:

13.5.1.2  Back Up Using rdump
Using the rdump command, you can use another machine tape for performing 
backups. The host with the tape will be called tape server, and the others will be 
called clients.

To use this command, the client machines must have root .rhosts access to the 
tape server machine. In our example, the tape server will be noteserv, and the 
clients will be ah1610a and ah1610b. The /.rhosts file for noteserv is shown in 
Figure 303:

Figure 303.  The /.rhosts File for the Tape Server noteserv

The group and other users can’t have any access to this file.

Let’s again modify the backtape script (See Figure 292 on page 364).

# restore -T -q -f/dev/rmt0
./noteserv
./noteserv/backup.5.960215.4
./noteserv/backup.5.960216.5
./noteserv/backup.5.960217.6
./noteserv/backup.5.960218.0
./noteserv/backup.5.960219.1
./noteserv/backup.5.960220.2
./noteserv/backup.0.960214.3
./noteserv/backup.0.960221.3
...

# cd /backup/tmp
# restore -x -q -f/dev/rmt0 ./noteserv/backup.0.960221.3
x ./noteserv/backup.0.960221.3

ah1610a.itsc.austin.ibm.com root
ah1610b.itsc.austin.ibm.com root
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#!/bin/ksh
#@(#) backhosts Lotus Notes backup procedure
#
# Usage: backhosts [-copy] <level> <tape0> <tape1>
#
COPY=NO
FS=/server1
SERVER=noteserv
HOSTS="noteserv ah1610a ah1610b"

# Display error message and exits
Error () {
  echo "Usage: backhosts [-copy] <level> <tape0> <tape1>"
  echo "Example: backhosts 5 rmt0 rmt1" >&2
  exit 1
}

NARGS=$#
# Test for the copy option
[[ $1 = -copy ]] && { COPY=YES ; shift ; let NARGS=${NARGS}-1 ; }
# Test the number of flags, must be 3
[[ $NARGS -ne 3 ]] && Error

LEVEL=$1
TAPE0=$2
TAPE1=$3

echo "Backup level $LEVEL, tape0 $TAPE0, tape1 $TAPE1, copy=$COPY"
echo "Started on ‘date‘ on server ‘uname -n‘"

# These tapes attributes applies to the 8mm 2.3/5GB tapes
# Check for the attributes that applies to your tape
echo "\nChanging the attributes of $TAPE0..."
/usr/sbin/chdev -l $TAPE0 -a block_size=1024 -a mode=yes -a extfm=yes

# We have to rewind the tape
echo "\nRewinding the tape $TAPE0..."
/bin/tctl -f /dev/$TAPE0 rewind

# Stop the Lotus Domino server
echo "\nStopping the Lotus Domino server"
$FS/bin/app_stopdomino

for HOST in $HOSTS
do
  if [[ $HOST != $SERVER ]]
  then
    # Make the system backup of the $HOST:$FS
    echo "\nMaking backup level $LEVEL of $HOST:$FS on $TAPE0..."
    rsh $HOST /usr/sbin/sync
    rsh $HOST /usr/sbin/sync
    # The values of density (-d 6250) and tape length (-s 33000)
    # refers to the 8mm 2.3GB
    rsh $HOST /usr/sbin/rdump -d 6250 -s 33000 -u -$LEVEL \
        -f ${SERVER}:/dev/${TAPE0}.1 $FS
  else
    /usr/sbin/sync
    /usr/sbin/sync
    # Make the system backup of the $HOST:$FS
    echo "\nMaking backup level $LEVEL of $HOST:$FS on $TAPE0..."
    /usr/sbin/backup -u -$LEVEL -f /dev/${TAPE0}.1 $FS
  fi
done
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Figure 304.  Script to Back Up Several Hosts (backhosts)

This script performs a remote shell on the client machines to do the remote 
backup. On the client machines, you will need the /.rhosts file (Figure 305) to 
permit noteserv to perform the remote shell.

Figure 305.  /.rhosts File for the Clients

The crontab entry on the tape server (noteserv) is shown in Figure 306:

Figure 306.  Crontab for the backtape Script

Note that only one tape is required to perform all the backups. This can be done 
with the non-rewinding device; the tape name ends with a .1.

In order to restore the files, you will need to run the tctl command to position the 
tape on the right backup. In our case, to restore the noteserv files, you don’t need 

# Restart the Lotus Domino server
echo "\nRestarting the Lotus Domino server..."
$FS/bin/app_startdomino

# Making the tape copy...
if [[ $COPY = YES ]]
then
  # These tape attributes apply to the 8mm 2.3/5GB tapes
  # Check for the attributes that apply to your tape
  echo "\nChanging the attributes of $TAPE1..."
  /usr/sbin/chdev -l $TAPE1 -a block_size=1024 -a mode=yes -a extfm=yes

  # We have to rewind the tapes
  echo "\nRewinding the tape $TAPE0 for copy..."
  /bin/tctl -f /dev/$TAPE0 rewind
  echo "\nRewinding the tape $TAPE1 for copy..."
  /bin/tctl -f /dev/$TAPE1 rewind

  # Make the copy
  echo "\nMaking the copy of $TAPE0 on $TAPE1..."
  /bin/tcopy /dev/$TAPE0 /dev/$TAPE1

  # Ejecting the tape
  echo "\nEjecting $TAPE1..."
  /bin/tctl -f /dev/$TAPE1 offline
fi

# Ejecting the tape
echo "\nEjecting $TAPE0..."
/bin/tctl -f /dev/$TAPE0 offline

echo "\nEnd of the backup program."

noteserv.itsc.austin.ibm.com root

#minute  hour  day_of_month  month  weekday  command
0 23 * * 1,2,4,5 /server1/scripts/backhosts 5 rmt0 rmt1 2>&1 | /bin/mail -s "Backup level 5" root
0 23 * * 6 /server1/scripts/backhosts 5 rmt1 rmt0 2>&1 | /bin/mail -s "Backup level 5" root
0 23 * * 3 /server1/scripts/backhosts -copy 0 rmt0 rmt1 2>&1 | /bin/mail -s "Full Backup" root
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to run tctl because it is the first backup. To restore the ah1610a backup, you 
need to advance to the second backup:

# tctl -f /dev/rmt0 rewind
# tctl -f /dev/rmt0.1 fsf 1

The first command rewinds the tape. On the second, it is very important to put the 
.1 at the end of the tape name. This command advances the tape to the second 
backup. To access the ah1610b backup:

# tctl -f /dev/rmt0 rewind
# tctl -f /dev/rmt0.1 fsf 2

The restore command is described in 13.2.5.1, “Restoring Files with restore” on 
page 366.

13.5.2  ADSM
ADSTAR Distributed Storage Manager (ADSM) is an IBM product that can give 
you much more than the native AIX tools. Together with the ADSMConnect Agent 
for AIX, the “Notes Agent”, you get access to the following features:

  • Perform incremental backups of Lotus Notes databases on the document 
level, backing up only those documents that have changed since the previous 
backup.

  • Recover individual documents in a database that have previously been 
backed up by the Notes Agent.

  • Recover individual documents that have been deleted from a Lotus Notes 
database.

  • Recover an entire Lotus Notes database.

  • Perform an incremental restore function by merging changed documents into 
a previously restored database.

  • On-line backup of a Lotus Notes database, that is, you can still use the 
database while backing it up.

  • Backup and recovery of access control lists.

  • Point in time recovery, meaning that you can restore your Lotus Domino 
Server to the state at a certain point in time.

  • Centralized backup of all Lotus Domino Servers.

When ADSM and the Notes Agent is installed, performing a backup is very 
simple. The following is a transcript of a sample backup session:
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Recovery is also very simple. For example, this is the command that you would 
type on the command line to recover a single database that already exists on 
your server: dsmnotes restore /server1/notesr4/names.nsf -merge=yes

Using the graphical Lotus Notes Workspace, it is also possible to restore single 
documents from a database backup.

For detailed installation and usage instructions, please refer to the Redbook on 
using ADSM with Lotus Notes, Using ADSM to Back Up Lotus Notes, SG24-4534. 
There is also a spot on the IBM Web site for ADSM.You find it at the following 
address: http://www.storage.ibm.com/storage/software/adsm/adsmhome.htm.

13.5.3  Legato NetWorker
If you are currently using Legato NetWorker for backups on your system you 
might be interested in using the Legato NetWorker BusinesSuite Module for Lotus 
Notes to back up your Lotus Domino Server (the "Notes Module"). You will need 
to have the Legato NetWorker server software already installed on your system. 
With the Notes Module, you gain the following features in addition to what 
NetWorker normally offers:

  • Perform incremental backups of Lotus Notes databases on the document 
level, backing up only those documents that have changed since the previous 
backup.

# dsmnotes incr \*
ADSTAR Distributed Storage Manager
ADSMConnect Agent for Lotus Notes - Version 2.1.7
(C) Copyright IBM Corporation, 1990, 1997, All Rights Reserved.
Backing up database: /server1/notesr4/busytime.nsf
Documents sent: 40
Documents sent: 80
Documents sent: 96
Documents deleted: 5
Backing up database: /server1/notesr4/catalog.nsf
Documents sent: 29
Backing up database: /server1/notesr4/log.nsf
Documents sent: 15
Documents deleted: 5
Backing up database: /server1/notesr4/names.nsf
Documents sent: 40
Documents sent: 53
Documents deleted: 5
Summary:
Database: /server1/notesr4/busytime.nsf
Documents backed up: 96, documents deleted: 5
Database: /server1/notesr4/catalog.nsf
Documents backed up: 29, documents deleted: 0
Database: /server1/notesr4/log.nsf
Documents backed up: 15, documents deleted: 5
Database: /server1/notesr4/names.nsf
Documents backed up: 53, documents deleted: 5
Total number of documents backed up: 193
Total number of documents deleted: 15
Total number of bytes sent: 2210.5 KB
ANS09001 dsmnotes completed
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  • Recover individual documents in a database that have previously been 
backed up by the Notes Module.

  • Recover individual documents that have been deleted from a Lotus Notes 
database.

  • Recover an entire Lotus Notes database.

  • On-line backup of a Lotus Notes database, that is, you can still use the 
database while backing it up.

  • Point in time recovery, meaning that you can restore your Lotus Domino 
Server to the state at a certain point in time.

  • Centralized backup of all Lotus Domino servers.

It is beyond the scope of this book to describe installation and operation of 
Legato NetWorker and the Notes Module. For more information on these 
products, contact Legato Systems, Inc., or see their Web site at 
http://www.legato.com/.
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Chapter 14.  System Performance Considerations

This chapter explains how to monitor the system performance and tune the 
various resources to achieve maximum throughput of the system. AIX provides a 
powerful set of performance monitoring and tuning tools. The available tools give 
performance information for different components on the system and on various 
parameters that affect performance.

14.1  Performance Monitoring

A performance bottleneck is the slowest component in a computer environment. 
This can either be a system resource, such as the CPU, memory, or disk, or it 
could be the network. There is always a bottleneck because some resource will 
always be slower than the others. Although there is no cookbook for performance 
monitoring, there are some guidelines that should be followed. The sequence of 
measuring system performance is extremely important. One should always follow 
the specified path, which is described in the performance monitoring flowchart 
shown in Figure 307.

Figure 307.  Performance Monitoring Flowchart
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We would strongly recommend that you follow this path, else you might overlook 
a bottleneck. For instance, if a system is paging a lot, you might see a heavy 
usage of the disks. Not looking at the memory statistics before looking at the I/O 
statistics could mislead you to the assumption that there is an I/O bottleneck.

We explain below some of the important AIX performance monitoring tools that 
are usually used for monitoring the system performance.

You can refer to the redbook RS/6000 Performance Tools in Focus, SG24-4989 
to get further details.

14.1.1  The vmstat Command
The first tool to use is vmstat which provides very quick and compact information 
about various system resources and their related performance problems. The 
vmstat command reports statistics about kernel threads in the run and wait queue, 
memory, paging, disks, interrupts, system calls, context switches, and CPU 
activity. The reported CPU activity is a percentage breakdown of user mode, 
system mode, idle time, and waits for disk I/O.

The vmstat command allows to look for three probable performance problems on 
the system: CPU bound, memory bound, and I/O bound.

14.1.1.1  CPU Bound
In the following vmstat output, a CPU-bound program was started.

# vmstat 2 10

kthr     memory             page              faults        cpu 
----- ----------- ------------------------ ------------ -----------
r  b   avm   fre  re  pi  po  fr   sr  cy  in   sy  cs us sy id wa 
0 0  3269 10342   0   0 0 0   0  0 130   36  20  0  0 99  0
0 0  3275 10336   0   0   0   0    0   0 132   40  26  0  1 99  0
0 0 3282 10326   0   0   0   0    0   0 128 6996  27  3  8 90  0
2 0  3282 10326   0   0   0   0    0   0 121 80064 20 15 85  0  0
2 0  3282 10326   0   0   0   0    0   0 126 79579 21 22 78  0  0
2 0  3282 10326   0   0   0   0    0   0 124 79662 19 20 80  0  0
2 0  3282 10326   0   0   0   0    0   0 121 79686 20 16 84  0  0
0 0  3275 10336   0   0   0   0    0   0 128 30305 24 8 30 62  0
0 0  3275 10336   0   0   0   0    0   0 123   36  20  0  0 99  0
0 0  3275 10336   0   0   0   0    0   0 122   36  20  0  0 99  0

In this example, the CPU was idle for 99 percent of the interval until, as can be 
seen in the third row of cpu headings, a CPU-bound program was started and 
absorbed the CPU idle time with no I/O wait time consumed. After the program 
was stopped, the CPU use went back to the initial values.

If the vmstat command is used without any options or only with the interval and, 
optionally, the counter parameter, such as vmstat 5, then the first line of 
numbers is an average since system reboot.

This line should, therefore, be ignored.

Note
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To check if the CPU is the bottleneck, consider the four cpu columns (us, sy, id, wa) 
and the two kthr (kernel threads) columns (r, b)

14.1.1.2  Memory Bound
The following vmstat output is an example for a memory-bound system.

# vmstat 1 8
kthr memory             page              faults        cpu
----- ----------- ------------------------ ------------ -----------
r  b   avm   fre re  pi  po  fr   sr  cy  in   sy  cs us sy id wa
1  1 17264   127 0   0  14 296  818   0 233  172 120 90 10  0  0
2  0 17264   121 0   0  10 384  871   0 282  486 282 78 14  0  9
 3  0 17264   117 0   0  38 328 1128   1 290  257 156 83 17  0  0
 2  0 17264   119 0   0  67 136  512   0 272  209  94 84 14  0  2
 1  2 17264   115 0   0  69 176 1476   0 300  232  99 85 15  0  0
 2  0 17264   121 0   0  18  24   88   0 186  340 132 84  7  2  7
2  0 17264   125 0   0  71 160  682   0 282  137  69 94  6  0  0
 2  0 17264   124 0   0  74 160  412   0 262  112  64 85 15  0  0

In this example, the size of the free list (fre) is already low, and pages are being 
scanned (sr), freed (fr), and paged out (po). The CPU utilization is around 85 
percent in user mode (us), and the user application continues to allocate memory. 
In the third row of numbers, the fre number drops under the minimum value for 
this count; therefore, the system starts to free up more pages, until the high water 
mark for fre is reached. This is the reason for the high numbers of page outs (po), 
freed pages (fr), and scanned pages (sr). In the sixth row, a process finished and 
its memory is freed, requiring fewer page outs.

To see if the system has performance problems with its VMM, look at the columns 
of memory and page.

Memory is over-committed when the ratio of fr to sr (fr:sr) is high. An fr:sr 
ratio of 1:4 means that for every page freed, four pages had to be examined. It 
is difficult to determine a memory constraint based on this ratio alone, and 
what constitutes a high ratio is workload/application dependent. In this case, 
having taken a baseline measurement of the system, when all is fine, may 
help a lot.

14.1.1.3  I/O Bound
To prove that the system is I/O bound, it is better to use the iostat command. 
However vmstat could point to that direction by looking at the wa column, as 
discussed earlier in this chapter. Other indicators for I/O bound are:

  • The disk xfer part of vmstat

To display a statistic about the logical disks (a maximum of four disks is 
allowed), use the following command:

# vmstat hdisk0 hdisk1 1 4
kthr     memory             page              faults        cpu disk xfer
---- ---------- ----------------------- ------------ ----------- ------
r b   avm   fre re  pi  po  fr sr  cy  in   sy  cs us sy id wa 1 2 3 4
0  0  3456 27743   0   0   0   0 0   0 131  149  28  0  1 99  0 0 0
0  0  3456 27743   0   0   0   0 0   0 131   77  30  0  1 99  0 0 0
1  0  3498 27152   0   0   0   0 0   0 153 1088  35  1 10 87  2 0 11
0  1  3499 26543   0   0   0   0 0   0 199 1530  38  1 19  0 80 0 59

The disk xfer part provides the number of transfers per second to the 
specified physical volumes that occurred in the sample interval. One to four 
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physical volume names can be specified. Transfer statistics are given for each 
specified drive in the order specified. This count represents requests to the 
physical device. It does not imply an amount of data that was read or written. 
Several logical requests can be combined into one physical request.

  • The in column of the vmstat output

Number of device interrupts per second observed in the interval.

# vmstat 1 4
kthr     memory             page              faults        cpu 
----- ------------ ------------------------ ------------- -----------
 r  b   avm   fre  re  pi  po  fr   sr  cy  in   sy  cs us sy id wa 
 0  0  3544 28065   0   0   0   0    1   0 120   90  21  0  0 99  0
0  0  3544 28065   0   0   0   0    0   0 125   64  26  0  0 99  0
 0  1  3586 26866   0   0   0   0    0   0 184 2529  51  5 22 11 62
 0  1  3586 26297   0   0   0   0    0   0 186 1257  28  0 16  0 84

This column shows the number of hardware or device interrupts (per second) 
observed over the measurement interval. Examples of interrupts are disk request 
completions and the 10 millisecond clock interrupt. Since the latter occurs 100 
times per second, the in field is always greater than 100. 

14.1.2  The iostat Command
The iostat command is the fastest way to get a first impression, whether the 
system has an I/O-bound performance problem or not. The tool reports CPU 
statistics and I/O statistics for TTY devices, disks, and CD-ROMs. It is used for 
monitoring system I/O device use by observing the time the physical disks are 
active in relation to their average transfer rates. The iostat command is useful to 
determine whether a physical volume is becoming a performance bottleneck and 
if there is a way to improve the situation. The generated reports can be used to 
change system configurations to better balance the I/O load between physical 
disks. For multiprocessor systems, the CPU values are global averages among 
all the processors. The I/O wait state is also defined system wide, and not per 
processor.

The following example shows a part of an iostat output. The first stanza shows 
the summary statistic since system startup. During the report, there was a copy 
command started.

# iostat 2 2

tty:      tin         tout   avg-cpu:  % user    % sys     % idle    % iowait
          0.0         13.3               0.2      0.2       99.4       0.2

Disks:        % tm_act     Kbps      tps    Kb_read   Kb_wrtn
hdisk0 0.2       2.4       0.2 1192730    706531
hdisk1 0.0       0.3       0.0 60479    190316
cd0 0.0       0.0       0.0 0 0

tty:      tin         tout   avg-cpu:  % user    % sys     % idle    % iowait
          0.0        208.0               0.0     11.5        0.0      88.5     

Disks:        % tm_act     Kbps      tps    Kb_read   Kb_wrtn
hdisk0 35.5     848.0      76.0       1696         0
hdisk1 74.5     790.0      58.0          4      1576
cd0 0.0       0.0       0.0          0         0
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Since the CPU use statistics are also available with the iostat report, the 
percentage of time the CPU is in I/O wait can be determined at the same time.

The iostat command adds little overhead to the system. It uses about 20 
milliseconds of CPU time for each report generated.

14.1.3  The sar Command
The sar command is a standard UNIX command used to gather statistical data 
about the system. Though it can be used to gather some useful data regarding 
system performance, the sar command is somewhat intrusive and can increase 
the system load, which will exacerbate a pre-existing performance problem. 

With its numerous options, sar provides queuing, paging, TTY, and many other 
statistics. One important new feature of the sar command on RS/6000 is that it 
reports either system-wide (global among all processors) CPU statistics (which 
are calculated as averages for values expressed as percentages, and as sums 
otherwise), or it reports statistics for each individual processor. Therefore, this 
command is particularly important on SMP systems.

Some of the most useful options for sar are:

sar -P
The -P option reports per-processor statistics for the specified processor or 
processors. By specifying the ALL keyword, statistics for each individual 
processor and an average for all processors are reported. Of the flags which 
specify the statistics to be reported, only the -a, -c, -m, -u, and -w flags are 
meaningful with the -P flag.

The following example shows the per-processor statistic while a CPU-bound 
program was running on processor number 0:

# sar -P ALL 2 3

AIX itsosmp 2 4 00045067A000    02/23/97

17:30:50 cpu    %usr    %sys    %wio   %idle
17:30:52 0        8      92       0 0

If the iostat command is used without interval and, optionally, count, then the 
output is a summary since startup. If the command is used with an interval and 
count parameter, such as iostat 2 5, then only the first stanza is an average 
since system reboot; the trailing stanzas are interval statistics.
The first stanza should be ignored when doing real-time measurements 
because the history is usually not of interest in this case.

Note

The sar command reports only on local activities; no statistics about network 
activities are included. The execution is limited to the root user. All data types 
that sar supports are collected; however, only the data types specified by 
options are reported.

Note
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1        0       4       0 96
2        0       1       0 99
3        0       0       0     100
- 2 24 0 74

17:30:54 0 12      88 0 0
1        0       3       0 97
2        0       1       0 99
3        0       0       0 100
- 3 23 0 74

17:30:56 0 11      89       0 0
1        0       3       0      97
2        0       0       0     100
3 0       0       0     100
- 3 23 0 74

Average 0       10      90       0 0
          1        0       4       0 96
2        0       1       0 99
          3        0       0       0 100
          -        3      24       0 74

The last line of every stanza, which starts with a dash (-) in the cpu column, is 
the average for all processors. There is only an average (-) line if the -p ALL 
option is used. It is removed if processors are specified. The last stanza, 
labeled with the word Average instead of a time stamp, keeps the averages for 
the processor specific rows over all stanzas. If the ALL keyword is used, its last 
row, starting also with a dash (-), represents the average over all processors 
for the investigated period.

sar -A
To display all possible statistics, use the -A option. Without the -P flag, this is 
equivalent to specifying -a, -b, -c, -k, -m, -q, -r, -u, -v, -w, and -y. With the -P 
flag, this is equivalent to specifying -a, -c, -m, -u, and -w (which are the useful 
options for SMP systems).

sar -b
Reports buffer activity for transfers, accesses, and cache (kernel block buffer 
cache) hit ratios per second. Access to most files in AIX V3 and AIX V4 
bypasses kernel block buffering, and therefore, does not generate these 
statistics. However, if a program opens a block device or a raw character 
device for I/O, traditional access mechanisms are used, making the generated 
statistics meaningful.

These values are usually zero. If they are not zero, then the "Maximum 
number of pages in block I/O BUFFER CACHE" (maxbuf) should be tuned. This 
can be done under the following path in smit or with the fast path smit chgsys:

-> System Environments
-> Change/Show Characteristics of Operating System
-> Maximum number of pages in block I/O BUFFER CACHE

14.1.4  The tprof Command
The tprof command is an AIX-specific profiler and is based on the trace facility. 
By using this profiler, one can identify the heaviest processes on the machine, the 
heaviest subroutines in the programs, and the time spent in each subroutine.
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The tprof command is a very versatile AIX profiler that provides a detailed profile 
of CPU usage for every AIX process ID and name. The tprof command is a 
trace-driven profiler and provides a global and a detailed view. It profiles at the 
application level, routine level, and even at the source-statement level. It can 
profile any program produced by one of the following compilers: C for AIX, C 
Set++ for AIX, and XL FORTRAN, but does not work with COBOL or PASCAL 
programs at the statement level.

The raw data for tprof is obtained through the trace facility. When a program is 
profiled, the trace facility is activated and instructed to collect data from the trace 
hook that records the contents of the instruction address register.

The distribution of ticks is roughly proportional to the CPU time spent in each 
program (10 milliseconds per tick). Once the programs that use a lot of CPU time 
have been identified, the programmer can take action to restructure the hot spots 
in the program or minimize their use.

14.1.5  The svmon Command
The svmon command is an AIX-specific tool that provides global, process-level, 
and segment-level reporting of memory use. The svmon command gives a more 
in-depth analysis of memory usage. It is more informative but also more intrusive 
than the vmstat command. The svmon command captures a snapshot of the 
current state of memory. The displayed information can be analyzed using four 
different reports:

Global (-G) Displays statistics describing the real memory and paging 
space in use for the whole system.

Process (-P) Displays memory usage statistics for active processes.

Segment (-S) Displays memory usage for a specified number of 
segments or the top ten.

Detailed Segment (-D) Displays detailed information on specified segments.

The svmon command can be run in intervals with the -i option. The -G and -P 
options are the most useful.

The svmon command is not a true snapshot because it runs at the user level with 
interrupts enabled. If no command line argument is present, the -G is taken as the 
default. If an interval is used, statistics will be displayed until the command is 
killed or until the number of intervals, which can be specified right after the 
interval, is reached.The overhead to run svmon is substantial, but the information 
is very valuable.

14.1.6  The filemon Command
The filemon command collects and presents trace data on the various layers of 
file system use, including the logical file system, virtual memory segments, LVM, 
and physical disk layers. Data can be collected on all the layers, or on specific 
layers by specifying the -O layer option. The default is to collect data on the VM 
segments, LVM, and physical layers. Both summary and detailed reports are 
generated. 
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The filemon command uses the trace facility to obtain a detailed picture of I/O 
activity during a time interval. Since it uses the trace facility, filemon can be run 
only by root or by a member of the system group, and it cannot be executed in 
parallel with other trace-based commands like tprof and netpmon. Tracing is 
started by the filemon command, optionally suspended with trcoff, resumed with 
trcon, and terminated with trcstop. As soon as tracing is terminated, filemon 
writes its report to stdout.

14.1.7  The netpmon Command
The netpmon command is an AIX performance tool used to measure network 
device-driver I/O, CPU usage, Internet socket calls, and NFS I/O. To improve 
performance, one can use the no (network options), nfso, chdev, and ifconfig 
commands.

The netpmon command uses the trace facility to obtain a detailed picture of 
network activity during a time interval. Since it uses the trace facility, the netpmon 
command can only be run by root or by a member of the system group. Also, the 
netpmon command cannot run together with any of the other trace-based 
performance commands like tprof and filemon. In its normal mode, netpmon runs 
in the background while one or more application programs or system commands 
are being executed and monitored. Tracing is started by the netpmon command, 
optionally suspended with trcoff, resumed with trcon, and terminated with 
trcstop. As soon as tracing is terminated, the netpmon writes its report to stdout.

14.1.8  The Performance Toolbox
The Performance Toolbox (PTX) is a comprehensive tool for monitoring and 
tuning system performance. PTX uses the client/server model to monitor local 
and remote system performance with several graphical windows that are fully 
user configurable. It is a Motif-based toolbox that includes 2D and 3D views of 
performance statistics. Analysis and tuning facilities incorporate existing 
performance tools into a menu-driven environment.

PTX for AIX consists of two major components: the agent and the manager. The 
agent consists of programs that run on the machine or machines you want to 
monitor, and its role is to obtain and filter performance statistics. The manager 
has the tools to manipulate the data providing meaningful statistics, such as:

  • Monitoring of system resource statistics

  • Analysis of system resource statistics

  • Tuning of the systems performance parameters to balance the use of fixed 
resources

The client/server implementation of PTX is an excellent aid to monitor and tune 
the performance of various UNIX systems in a network environment from a single 
graphics workstation.

The filemon command will only collect data for those files opened after filemon 
was started unless you specify the -u flag.

 Note
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While you run the manager and the agent on the same machine, it is highly 
recommended that the manager not run on the system to be monitored. This will 
minimize the impact of running PTX on the system load and will give a true 
indication of system performance. Be aware that the manager puts a significant 
load on the system.

PTX major features are:

  • Separately installable manager and agent components that allow a manager 
to monitor multiple agents and an agent to supply data to multiple managers.

  • Application programming interfaces (API) that allow programmers to access 
local or remote data as well as to register custom data with the local agent.

  • Ability to respond to simple network management protocol (SNMP) requests 
and to send traps to an SNMP manager (AIX agents only).

  • Support for RS/6000 SP systems using the Performance Toolbox Parallel 
Extensions Feature of the Parallel System Support Programs (PSSP) for 
AIX/6000.

Performance Toolbox Parallel Extensions (PTPE) is a feature of PSSP (2.2 and 
higher) and is used in conjunction with PTX to simplify the performance analysis 
and reduce RS/6000 SP administrative overhead by organizing your SP nodes 
into reporting groups. Each node sends performance data to a manager node, 
which performs the administrative tasks for the group. It also provides the utilities 
to monitor, store, and retrieve performance data collected on RS/6000 SP nodes 
about their resources, such as the switch, virtual shared disk, and LoadLeveler.

There are a number of benefits derived from using PTX, including:

Monitoring System Performance
PTX/6000 provides an easy way of monitoring your local as well as your remote 
systems, including the performance of the network, which is very important in the 
SP environment. In network client/server environments, the performance of sets 
of systems working together can be as important as the performance of an 
individual system. Likewise, the performance of multiple applications working 
together can be as important as that of an individual application. Therefore, it is 
very important to be able to get the “big picture” by graphically viewing many 
correlated parameters concurrently across multiple nodes in a network. 
PTX/6000 allows a user to concurrently visualize the live (near real time) 
performance characteristics of the clients and server applications across the 
network.

Analysis and Control of System Performance
By providing an umbrella for tools that can be used to analyze performance data 
and control system resources, the manager program xmperf assists the system 
administrator in keeping track of available tools and in applying them in 
appropriate ways. This is done through a customizable menu interface. Tools can 
be added to menus, either with fixed sets of command line arguments to match 
specific situations or in a dialog window. The menus of xmperf are preconfigured 
to include most of the performance tools shipped as part of the tools option of the 
agent component.

All performance-related tools already available in AIX can be accessed through 
this interface. In addition, the ability to record load scenarios and play them back 
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in graphical windows at any desired speed provides ways of analyzing a 
performance problem.

Features for analyzing a recording of performance data are provided by the azizo 
program and its support programs. Recordings can be produced from the 
monitoring programs xmperf and 3dmon during monitoring, or can be created by the 
xmservd daemon. The xmservd daemon allows for recording with a minimum of 
overhead. This makes constant recording possible so that you can analyze 
performance problems after they occurred.

Finally, using the agent component filter filtd, you can define conditions that, 
when met, could trigger any action you deem appropriate, including alerting 
yourself and/or initiating corrective action without human intervention. This facility 
is entirely configurable so that alarms and actions can be customized to your 
installation.

Capacity Planning
If you can make your system simulate a future load scenario, xmperf can be used 
to visualize the resulting performance of your system. By simulating the load 
scenario on systems with more resources, such as more memory or more disks, 
the result of increasing the resources can be demonstrated.

Network Operation
The xmservd data supplier daemon can provide consumers of performance 
statistics with a stream of data. Frequency and contents of each packet of 
performance data are determined by the consumer program. Any consumer 
program can access performance data from the local host and one or more 
remote hosts. Any data supplier daemon can supply data to multiple hosts.

SNMP Interface
By entering a single keyword in a configuration file, the data supplier daemon can 
be told to export all its statistics to a local snmpd SNMP agent. Users of an SNMP 
manager, such as IBM NetView, see the exported statistical data as an extension 
of the set of data already available from snmpd.

14.1.9  Monitoring Lotus Notes Servers Using Performance Toolbox
The PTXNOTES Agent can be used to graphically monitor AIX Lotus Notes 
servers from a single graphical console. The Agent runs as a background 
daemon from a Lotus Notes Add-In task and consumes very little system 
resources (< 1% CPU). It provides real-time statistics on a variety of Lotus Notes 
and operating system metrics. The tool could be very useful for a Lotus Notes 
system administrator for monitoring and optimizing a Lotus Notes network and for 
troubleshooting potential problems. It also has the capability to record data for 
later playback and analysis. Alarms and triggers can be set to warn an operator 
when certain preset levels are reached.

The following types of statistics can be monitored:

  • Lotus Notes Web_retreiver Stats
  • Lotus Notes Database Stats
  • Lotus Notes Mail Stats 
  • Lotus Notes Server Stats 
  • Lotus Domino Server Stats
  • Lotus Notes Memory Stats 
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The following is a list of supported statistics for PTXNOTES. This is in addition to 
the standard suite of operating system and network statistics that are also 
available.

Notes Web_retreiver Stats
WebAccessFtp            Number of FTP retriever accesses
WebAccessGopher         Number of Gopher retriever accesses
WebAccessHttp           Number of HTTP retriever accesses
WebBytesReceived        Number of retriever bytes received
WebBytesSent            Number of retriever bytes sent
WebImageCacheHits       Number of successful hits on the image cache
WebImageCacheMiss Number of misses on retriever image cache
WebActiveProcess        Number of active web retriever processes
WebBusyProcess          Number of busy web retriever processes
WebIdleProcess          Number of idle web retriever processes
WebTimeDuration         Elapsed time since retriever started
WebUrlFail              Number of retriever URL’s that have failed
WebUrlRequested         Number of retriever URL’s that have been requested
WebUrlSucceeded         Number of retriever URL’s succesfully accessed.
Notes Database Stats
BufCtlPoolPeak          Size of buffer control pool
BufCtlPoolUsed          Number of bytes used in buffer control pool
BufPoolPeak             Number of bytes allocated from buffer pool
BufPoolMax              Maximum size of buffer pool
BufPoolUsed             Number of used buffers from buffer pool
BufPoolPerCReads        Percentage of buffer pool reads
BufPoolReads            Number of database buffer pool reads
BufPoolWrites           Number of database buffer pool writes
NSFPoolPeak             Size of NSF pool
NSFPoolUsed             Amount of space used in NSF pool
NIFPoolPeak             Size of database NIF pool
NIFPoolUsed             Number of database NIF pools
Notes Mail Stats 
DeadMail                Number of dead (undeliverable) mail messages
DeliveredMail           Number of messges received by router
TotalMailFail           Total number of routing failures
TotalRoutedMail         Total number of mail messages routed
TransfMail              Number of messages router attempted to transfer
WaitingMail             Number of mail messages waiting to be routed
NumWaitingRecp          Number of pending mail messages awaiting local delivery
AvgMailDlvTime          Average time for mail delivery in seconds
AvgMailSrvHops          Average number of server hops for mail delivery
AvgMailSizeDlv          Average size of mail messages delivered in bytes
MaxMailDlvTime          Maximum time for mail delivery in second
MaxMailSrvHops          Maximum number of server hops for mail delivery
MaxMailSizeDlv          Maximum size of mail delivered in bytes
MinMailDlvTime          Minimum time for mail delivery in seconds
MinMailSrvHops          Minimum number of server hops for mail delivery
MinMailSizeDlv          Minimum size of mail delivered in bytes
TotalKBTransf           Total mail transferred in Kilobytes
MailTransfFail          Mail messages the router was unable to transfer
Notes Server Stats 
Open.MaxUsers           Attempts to open MAXUSER server
Open.PreV4Client        Attempts to open server by pre V4 clients
Open.V4Client           Attempts to open server by post V4 client
Open.Restricted         Attempts to open restricted server
Dropped_Sessions        Number of dropped sessions
TransPerMin             Average number of transactions per minute
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TransPerMinPeak         Peak number of transactions n given minute
TransPerMinPeakT        Date and time for TransPerMinPeak
TransTotal              Total number of transactions the server has serviced
ServerUsers             Number of users with sessions open on the server
UsersPeak               Peak number of concurrent users with open sessions
UsersPeakTime           Date and time for UsersPeak
Domino Server Stats
DomReqMin               Number of Domino requests in the last minute
DomReqMinPeak           Peak number of Domino requests per minute
DomReqMinPeakT          Time at one minute peak requests
DomReq5Min              Number of Domino requests in the last 5 minutes
DomReq5MinPeak          Peak number of Domino requests in 5 minutes
DomReq5MinPt            Time at one five minute peak requests
DomReqHour              Number of Domino requests in the last hour
DomReqHourPeak          Peak number of Domino requests in one hour
DomReqHourPeakT         Time at one hour peak requests
DomReqDay               Number of Domino requests in the last day
DomReqDayPeak           Peak number of Domino requests in one day
DomReqDayPeakT          Time at one day peak requests
DomReqTotal             Total Domino requests since the Domino server stats
Notes Memory Stats 
MemTotal                Total memory allocated
MemProcess              Total process-private memory allocated by ALL
MemShared               Total shared memory allocated
MemAvailability*        Availability of memory on this server
MemFree*                Free memory as reported by OS
MemSwapSize             Size of swap file

For more information on the PTXNOTES Agent, refer to the IBM intranet page at 
http://ncpdt.austin.ibm.com. Customers should contact their IBM sales 
representative to get the program.

14.2  Performance Tuning

After monitoring the system performance and getting a fair idea on the bottleneck 
resource, the next step is to tune the resource to improve the system 
performance.

You can refer to the redbooks AIX Performance Monitering and Tuning Guide, 
SC23-2365 and RS/6000 Performance Tools in Focus, SG24-4989, for further 
details.

14.2.1  CPU Related Tuning Tools
This part deals with techniques for minimizing the effect on performance that 
runaway or CPU-intensive programs may cause.

14.2.1.1  The nice Command
With the nice command, the user can specify a value to be added to or subtracted 
from the current priority of a process. By using nice, the priority of the process 
does not get fixed; only its nice value is changed. The priority value is still 
recalculated periodically based on the CPU usage, the nice value, and the default 
user-process-priority value. The nice command can only set the nice value for a 
process at the creation time of the process.
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There are several ways to change the nice value, when creating a thread:

Favoring Processes
The following two commands execute a program with higher priority:

# nice --15 program

or better:

# nice -n -15 program

The nice command subtracts 15 from the default nice value (20) and the program 
will start with a priority of 45 because the user-priority-level is 40.

Disfavoring Threads
The following two commands execute a program with lower priority:

# nice -10 program

or better:

# nice -n 10 program

The nice command adds 10 to the default nice value (20) and the program will 
start with a priority of 70 because the user-priority-level is 40.

14.2.1.2  The renice Command
With the renice command, the user can specify a value to be added to or 
subtracted from the priority of one or more running processes. The modification is 
done to the nice values of the processes. The priority of these processes is still 
non-fixed.

The renice command modifies the nice value of one or more processes that are 
already running. The processes are identified either by process ID, process group 
ID, or the name of the user who owns the processes. It cannot be used on 
fixed-priority processes.

For AIX V4, the syntax of renice has been changed to complement the alternative 
syntax of nice, which uses the -n flag to identify the nice-value increment. 

The following examples show the different usages of the renice command. The 
xclock command is started by a staff user in background:

# ps -lu mike

Any user can run a command at a lower priority than normal by using nice. 
Only the root user can use nice to run commands at higher than normal priority.

Note

If you do not have root user authority, you can only change the priority of 
processes you own and can only increase their priority value within the range 
of 0 to 20, with 20 giving the lowest priority. If you have root user authority, you 
can alter the priority of any process and change the priority value within the 
range of -20 to 20.

Note
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       F S UID   PID  PPID   C PRI NI ADDR    SZ    WCHAN    TTY  TIME CMD
 8200011 A 201 7746 20540   0  64 24 6898   192           pts/5  0:00 xclock
  200001 A 201 20540 22352   0  60 20  5a0 360  5a9b844  pts/5  0:00 ksh
# renice -8 7746
# ps -lu mike
       F S UID   PID  PPID   C PRI NI ADDR    SZ    WCHAN    TTY  TIME CMD
 8200011 A 201  7746 20540   0  52 12 6898   192           pts/5  0:00 xclock
  200001 A 201 20540 22352   0  60 20  5a0   360  5a9b844  pts/5  0:00 ksh

In the previous example, the renice command is used without the -n option. This 
alters the nice value from the default value of 20. The renice -<Increment> 
command always uses the default nice value (20) for the calculation, not the 
current value. If you want to use the current value for the calculation, you need to 
use the following commands:

# ps -lu mike
       F S UID   PID  PPID   C PRI NI ADDR    SZ    WCHAN    TTY  TIME CMD
  200001 A 201  7778 20540   0  64 24 6898   192           pts/5  0:00 xclock
  200001 A 201 20540 22352   0  60 20  5a0   360  5a9b844  pts/5  0:00 ksh
# renice -n -8 7778
# ps -lu mike
       F S UID   PID  PPID   C PRI NI ADDR    SZ    WCHAN    TTY  TIME CMD
  200001 A 201  7778 20540   0  56 16 6898   192           pts/5  0:00 xclock
  200001 A 201 20540 22352   0  60 20  5a0   360  5a9b844  pts/5  0:00 ksh

In the previous example, the renice command subtracts eight from the current 
nice value.

14.2.1.3  The schedtune Command
The schedtune command can be used to set the parameters for CPU scheduler 
and Virtual Memory Manager (VMM) processing. The executable and source for 
schedtune can be found in the /usr/samples/kernel directory. In AIX V3, these files 
are located in the /usr/lpp/bos/samples directory.

The schedtune command can only be executed by the root user. Changes made 
by this tool last until the next reboot of the system. If a permanent change is 
needed, an appropriate entry should be put in the /etc/inittab. For example:

schedtune:2:wait:/usr/samples/kernel/schedtune -m 6

Executing the schedtune command with no options shows the current settings for 
the parameters:

The schedtune command is in the samples directory because it is 
VMM-implementation dependent. The schedtune code that accompanies each 
release of AIX is tailored specifically to the VMM of that release. This command 
is not supported under smit, nor has it been tested with all possible 
combinations of parameters. Misuse of this command can cause performance 
degradation or operating-system failure. If execution of schedtune causes a 
system to crash with flashing 888, then the appropriate level of schedtune for 
that release of AIX needs to be installed. Be sure that you have studied the 
appropriate tuning sections before using schedtune to change system 
parameters.

Note
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# schedtune
THRASH           SUSP       FORK             SCHED

-h    -p    -m      -w    -e      -f       -d       -r        -t
SYS  PROC  MULTI   WAIT  GRACE   TICKS   SCHED_D  SCHED_R  TIMESLICE
 6   4     2        1      2      10 5 16 2

The first five parameters specify the thresholds for the memory load control 
algorithm: -f defines a wait time value used by the fork() routine, the -d and -r 
options are used in the scheduling policy algorithm, and -t defines the maximum 
amount of time a thread can spend on the processor. Each one of them will be 
discussed in detail in the next sections.

The -D option can be used to restore the default settings:

# schedtune -D
THRASH           SUSP       FORK             SCHED

-h    -p    -m      -w    -e      -f       -d       -r        -t
SYS  PROC  MULTI   WAIT  GRACE   TICKS   SCHED_D  SCHED_R  TIMESLICE
 6   4     2        1      2      10       16       16         1

14.2.2  Memory Related Tuning Tools
An optimum amount of memory should be allocated on the server to service your 
workload. A rough rule of thumb is 400 K / user (a little higher to be on the safe 
side). If your system runs out of memory, performance can suffer a multiple 
punch, first, since it starts using the disk, which looks like "slow memory" to the 
system, and second, since your CPU enables all this activity rather than just 
servicing the active workload.

14.2.2.1  The mkps Command
It is recommended to configure enough paging space on the system so that the 
paging space used does not approach 100 percent. For systems up to 256 MB of 
memory, the paging space should be twice the size of real memory. For memories 
larger than 256 MB, the following is recommended:

total paging space = 512 MB + (memory size - 256 MB) * 1.25

The paging space size cannot be less than 16 MB and not greater than 20 
percent of total disk space. 

When fewer unallocated pages than the npskill value of the vmtune command 
remain on the paging device, the system will begin to kill processes to free some 
paging space.

Use the command lsps -a to list the sizes and percentage use of the paging 
spaces in the system. For example, lsps -a shows the following output on our 
system:

In case the paging space approaches 100 percent and we need to add an 
additional paging space, you can use the smitty mkps command.

Page Space  Physical Volume   Volume Group    Size   %Used  Active  Auto  Type
paging00    hdisk0            rootvg         128MB      58     yes   yes    lv
hd6         hdisk1 dominovg 128MB      71     yes   yes    lv
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For example, to add an additional paging space of 128 MB in the volume group 
dominovg, use the following commands:

smitty mkps

Select the volume group as dominovg and press Enter.

Press Enter to create the additional paging space.

You can optionally use the following command to do the same activity:

mkps -s’32’ -n’ ’ -a’ ’ dominovg

14.2.2.2  The vmtune Command
The vmtune  command can be used to modify the VMM parameters that control the 
behavior of the memory-management subsystem. Some options are available to 
alter the defaults for other AIX components. The executable for vmtune  is found in 
the /usr/samples/kernel directory.

Prior to AIX V4.2, a copy of the source code for vmtune  was also shipped along 
with the executable. But to recompile the program, a kernel header file that is 
needed is not available. So you are not able to make changes to vmtune , although 
you have the source code.

 VOLUME GROUP name                             x
      x                                                                        
      x Move cursor to desired item and press Enter.                           
      x                                                                        
      x   rootvg                                                               
      x   dominovg                                                             
      x                                                                        
      x F1=Help                 F2=Refresh              F3=Cancel              
      x F8=Image                F10=Exit                Enter=Do               
      x /=Find                  n=Find Next 

 Add Another Paging Space

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Volume group name                                   dominovg
  SIZE of paging space (in logical partitions)       [32]                         
  PHYSICAL VOLUME name                                                            
  Start using this paging space NOW?                  yes                         
  Use this paging space each time the system is       yes                         
          RESTARTED?

 
 
F1=Help               F2=Refresh            F3=Cancel             F4=List         
F5=Reset              F6=Command            F7=Edit               F8=Image        
F9=Shell              F10=Exit              Enter=Do 
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The vmtune command can only be executed by the root user. Changes made by 
this tool last until the next reboot of the system. If a permanent change is needed, 
an appropriate entry should be put in the /etc/inittab. For example:

schedtune:2:wait:/usr/samples/kernel/vmtune -P 50

Executing the vmtune command with no options:

# vmtune
vmtune:  current values:
  -p       -P        -r          -R         -f       -F       -N        -W
minperm  maxperm  minpgahead maxpgahead  minfree  maxfree  pd_npages maxrandwrt
3072    12288       2          8        120      128     524288        0

  -M       -w       -k       -c         -b          -B          -u
maxpin   npswarn  npskill  numclust  numfsbufs   hd_pbuf_cnt  lvm_bufcnt
  13108     1280      320        1       93           64           9

number of valid memory pages = 16384    maxperm=75.0% of real memory
maximum pinable=80.0% of real memory    minperm=18.8% of real memory
number of file memory pages = 3004      numperm=18.3% of real memory

The output shows the current settings for the parameters.

14.2.3  Network Related Tuning Tools
The optimal setting of the tunable communications parameters vary with the type 
of LAN as well as with the communication I/O characteristics. The following 
describes two commands that can be used to adjust these parameters.

14.2.3.1  The no Command
The no command can be used to configure network attributes. It sets or displays 
current network attributes in the currently running kernel. Therefore, the 
command must be run again after each startup or after the network has been 
configured. For more information on how the network attributes interact with each 
other, refer to the AIX Version 4 System Management Guide: Communications 
and Networks, SC23-2526.

The vmtune command is in the samples directory because it is 
VMM-implementation dependent. The vmtune code that accompanies each 
release of AIX is tailored specifically to the VMM in that release. Running 
vmtune from one release on a system with a different VMM release might result 
in an operating system failure. It is also possible that the functions of vmtune 
may change from release to release. It takes know-how and experience to set 
vmtune parameters properly. Be sure that you have studied the appropriate 
tuning sections before using vmtune to change system parameters.

Note

The no command performs no range checking. If used incorrectly, the no 
command can cause your system to become inoperable.

Note
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The no parameters and their values can be displayed by using no -a:

You can choose to tune either for maximum throughput or for minimum memory 
use. Some recommendations apply to one or the other; some apply to both. In 
this section, only some performance relevant parameters are described:

thewall
This is one of the most important parameters because it limits the memory that is 
assigned to the networking subsystem.

After expanding the mbuf pools, verify using the vmstat command that paging 
rates have not increased. If you cannot expand the pools to necessary levels 
without adversely affecting the paging rates, additional physical memory may be 
required.

sb_max
The sb_max value sets the absolute upper bound on the size of TCP and Universal 
Datagram Protocol (UDP) socket buffers, such as setsockopt(), udp_sendspace, 
udp_recvspace, tcp_sendspace, and tcp_recvspace. The recommended size for this 
parameter is twice the size of the largest socket buffer. Remember to set rfc1323 
to one, if the buffer size crosses 64 KB.

14.2.3.2  The nfso Command 
The nfso command can be used to configure Network File System attributes. It 
sets or displays network options in the currently running kernel. Therefore, the 
command must run after each system startup or network configuration.

The nfso parameters and their values can be displayed by using nfso -a:

# nfso -a
portcheck= 0
udpchecksum= 1
nfs_socketsize= 60000
nfs_setattr_error= 0
nfs_gather_threshold= 4096
nfs_repeat_messages= 0
nfs_duplicate_cache_size= 0
nfs_server_base_priority= 0
nfs_dynamic_retrans= 1
nfs_iopace_pages= 32

Before AIX V4.2, the thewall value was usually set in the /etc/rc.net file, and 
any value specified by the Object Database Manager (ODM) was overwritten. 
But in AIX V4.2, the highest instance for setting the thewall value after system 
start-up is the ODM. The value set in the /etc/rc.net file is overwritten. So if 
there are any problems with the value of the thewall parameter after start-up, 
check the /etc/rc.net file, and also check the ODM by using lsattr -El sys0 and 
look for the maxmbuf parameter.

Note

The nfso command performs no range checking. If used incorrectly, the nfso 
command can make your system inoperable.

Note
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Most NFS attributes are runtime attributes that can be changed at any time, with 
the exception of nfs_socketsize, which needs NFS to be stopped first and 
restarted afterwards.

To display or change a specific parameter, use the nfso -o command:

# nfso -o portcheck
portcheck= 0
# nfso -o portcheck=1

The parameters can be reset to their default value by using the -d option.

14.3  Optimal File System Performance for the Lotus Domino Server

To achieve optimal performance from the AIX file system, we must look at how 
AIX manages the data logically and physically. By controlling the physical 
allocation of data on the disk and the distribution of data between disks, you can 
tune the storage system to get the highest possible performance.

14.3.1  Performance Considerations for the Logical Volume Manager
  • Intra-Disk Allocation Policy

The placement of the data on the disk surface itself affects the performance of 
the subsystem. The closer a given physical partition is to the center of a 
physical volume, the lower the average seek time is, but for large, sequential 
files, it's better to put them on the edge of the disk because the sequential 
performance is better there (there are more blocks per track at the edge than 
there are farther in).

  • Inter-Disk Allocation Policy

The inter-disk allocation policy specifies the number of disks on which a 
logical volume's physical partitions are located. The Range option (minimum, 
maximum) determines the number of disks used for a single physical copy of 
the logical volume. To enhance the availability, the physical partitions should 
be assigned to the logical volume and then located on a single disk (Range = 
minimum). For maximum performance, the maximum number of physical 
volumes available should be used (Range = maximum). It will spread the 
physical partitions of the logical volume as evenly as possible over as many 
physical volumes as possible but with the risk that, if one disk fails, all data in 
this logical volume may get lost.

  • Size of Logical Volume

To ensure that the file system does not become fragmented, assign enough 
free space to the files system in advance. If you have to re-size the file system 
at a later time because you run out of space, the physical volumes may not be 
continuous, that is, they will get fragmented.

  • Mirroring

For maximum performance, mirroring should generally be disabled. If it is a 
must on your system, then the scheduling policy should be set to parallel and 
the allocation policy to strict. Write-Verify Policy and mirror write consistency 
should then be set to no or the LVM will need extra time to read back the data 
for validity and to verify that all writes to copies have succeeded.
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14.3.2  Creating the Volume Group
Assume there are four hard disks available in your system and disk one, by 
default, represents the volume group rootvg.

Now, we want to add a second volume group with the name datavg containing the 
other three disks, hdisk1, hdisk2 and hdisk3:

1. Log on to the AIX machine as root.

2. Check to see if all disks you want to use are available by typing:

lsdev -Cc disk

3. Enter smitty mkvg.

Figure 308.  smitty’s Add a Volume Group

1. Type a unique name into the field VOLUME GROUP name (Figure 308).

2. Type the names of all physical volumes that should be part of the new volume 
group into the PHYSICAL VOLUME names field, or press F4 to get a selection 
list.

3. Press Enter.

4. Exit smitty and enter lsvg -p datavg and lsvg datavg to make sure the volume 
group was added correctly.

14.3.3  Creating the Logical Volume
To create a logical volume, follow these steps:

1. Enter smitty mklv.

The mklv command creates a new logical volume within the volume group.

                               Add a Volume Group

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  VOLUME GROUP name                                  [datavg]
  Physical partition SIZE in megabytes                4                       
* PHYSICAL VOLUME names                              [hdisk1 hdisk2 hdisk3]   
  Activate volume group AUTOMATICALLY                 yes                     
    at system restart?
  Volume Group MAJOR NUMBER                          []                       

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 309.  smitty’s Add a Logical Volume

2. Press F4 to get the list of all available volume groups.

3. Select the volume group onto which you want to add the logical volume and 
press Enter (Figure 309).

                              Add a Logical Volume

Type or select a value for the entry field.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
* VOLUME GROUP name                                  []                       

                               VOLUME GROUP name

    Move cursor to desired item and press Enter.

      rootvg
      datavg

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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Figure 310.  smitty’s Add a Logical Volume (Continued)

4. Enter the Logical volume NAME (Figure 310).

5. Enter the Number of LOGICAL PARTITIONS; Figure 308 on page 404 shows 
a predefined partition size of 4 MB.

6. Enter jfs for the Logical volume TYPE.

7. Enter the POSITION on physical volume and the RANGE of physical 
volumes, as described in 14.3.1, “Performance Considerations for the Logical 
Volume Manager” on page 403.

8. Set the field Number of COPIES of each logical partition to 1 for no mirroring.

9. The fields Mirror Write Consistency?, Allocate each logical partition and 
SCHEDULING POLICY are valid only if mirroring is active.

10.Set RELOCATE the logical volume during reorganization? to yes to allow 
the physical partitions to be moved during reorganization if it is required at a 
later time for performance reconsiderations.

11.For performance considerations, the parameter Enable WRITE VERIFY? 
should be set to no.

12.You can also use an ALLOCATION MAP to exactly define which physical 
partitions, on which disks, will contain the logical partitions.

13.Press Enter to create the logical volume.

                              Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Logical volume NAME                                [notesdatalv]
* VOLUME GROUP name                                   datavg
* Number of LOGICAL PARTITIONS                       [20]                     
  PHYSICAL VOLUME names                              [hdisk1 hdisk2 hdisk3]   
  Logical volume TYPE                                [jfs]
  POSITION on physical volume                         edge                    
  RANGE of physical volumes                           maximum                 
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 [3]                      
    to use for allocation
  Number of COPIES of each logical                    1            +
    partition
  Mirror Write Consistency?                           no                      
  Allocate each logical partition copy                no                      
    on a SEPARATE physical volume?
  RELOCATE the logical volume during                  yes          +
    reorganization?
  Logical volume LABEL                               []
  MAXIMUM NUMBER of LOGICAL PARTITIONS               [128]
  Enable BAD BLOCK relocation?                        yes                     
  SCHEDULING POLICY for writing logical               parallel                
    partition copies
  Enable WRITE VERIFY?                                no           +
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]            

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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14.Exit smit, and enter: lslv lvnotes to ensure that the logical volume was added 
correctly.

14.3.4  Performance Considerations for the File System
  • Fragment size

Use a fragment size of 4096 bytes. For file systems with small fragment sizes, 
this is the primary performance hazard. Space fragmentation and the 
performance of accessing large files will suffer because of too many allocation 
operations.

  • Compression

Using compression increases the number of processor cycles; it also 
generates additional writes and reads to the file system. Therefore, for 
maximum performance, disk compression should not be used.

  • Log devices

A file system log is a formatted list of file system transaction records. A 
dedicated log device is created on hdisk8 for rootvg when the system is 
installed. For performance improvements, you can add other log devices (or 
use a separate disk, if it is available) for other file systems.

14.3.5  Creating a New Log Device
In this procedure, the new file system log for the file system /notes will be 
created on the volume group datavg on hdisk1.

Note: For best performance, this file system log should reside on a 
less-frequently-used hard disk.

1. Enter smitty mklv, and select the datavg as the dedicated volume group 
(Figure 311), and see 14.3.1, “Performance Considerations for the Logical 
Volume Manager” on page 403.
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Figure 311.  smitty’s Add a New File System Log File

2. Enter parameters as shown in Figure 311.

3. Press F10 to exit smitty, and enter the following command to format the new 
JFS-log logical volume:

/usr/sbin/logform /dev/fsnoteslog

4. Answer y to the following prompt: logform: destroy /dev/fsnoteslog (y)? and 
press Enter.

14.3.6  Creating the New File System for the Lotus Notes Databases
A logical volume, lvnotes, was created in 14.3.3, “Creating the Logical 
Volume” on page 404. Now, we create a file system using the previously 
created logical volume, lvnotes, and the new file system log file, fsnoteslog.

1. Type in the command:

crfs -v jfs -d notesdatalv -m /server1 -A yes -a frag=4096 -a 
logname=/dev /fsnoteslog

and press Enter.

2. To verify that you have set up the file system and log file correctly, use the 
following command: lsvg -l datavg (Figure 312).

                              Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Logical volume NAME                                [fsnoteslog]
* VOLUME GROUP name                                   datavg
* Number of LOGICAL PARTITIONS                       [1]
#
  PHYSICAL VOLUME names                              [hdisk1]   +
  Logical volume TYPE                                [jfslog]
  POSITION on physical volume                         center                  
  RANGE of physical volumes                           minimum                 
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []
#
    to use for allocation
  Number of COPIES of each logical                    1                       
    partition
  Mirror Write Consistency?                           no                      
  Allocate each logical partition copy                no                      
    on a SEPARATE physical volume?
  RELOCATE the logical volume during                  yes                     
    reorganization?
  Logical volume LABEL                               []
  MAXIMUM NUMBER of LOGICAL PARTITIONS               [128]
  Enable BAD BLOCK relocation?                        yes                     
  SCHEDULING POLICY for writing logical               parallel                
    partition copies
  Enable WRITE VERIFY?                                no                      
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [Not Striped]            

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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Figure 312.  lsvg -l datavg

3. You can also use the command: lspv -p hdisk<N> to check the location of the 
physical partitions.

4. Mount the file system with the command: mount /server1.

14.4  Creating a Striped File System for Maximum Database Performance

Striped logical volumes are very efficient if used for large sequential file systems 
that are frequently accessed and performance-sensitive.

In a striped logical volume, data is accessed using addresses that follow the 
sequence of stripe units. A complete stripe consists of one stripe unit on each of 
the dedicated physical devices. The Logical Volume Manager schedules the 
necessary I/O operations for all drives simultaneously. The stripe unit can be any 
power of 2 from 4 KB through 128 KB.

The following principles should be followed when using striped file systems:

  • For best performance, you should divide the workload of a striped logical 
volume between as many disks as possible.

  • Create a logical volume containing only these disks you want to use for disk 
striping.

  • Use as many disk drive adapters as possible.

  • Use high-performance disk drive adapters, such as Small Computer System 
Interface (SCSI) Fast/Wide or better, or use Serial Storage Architecture (SSA) 
technology.

14.4.1  Creating the Striped Logical Volume
Assume we have four hard disks in our system. The first hard disk (hdisk0) 
holds the default volume group rootvg. The other three disks are unused and 
are attached to different SCSI adapters.

1. Log on to the AIX machine as root.

2. To see if all disks you want to use are available type:

lsdev -Cc disk

3. Enter smitty mkvg.

datavg:
LV NAME             TYPE       LPs   PPs   PVs  LV STATE      MOUNT POINT
notesdatalv jfs        20    20    1    open/syncd    /server1
fsnoteslog          jfslog     1     1     1    open/syncd    N/A

1. Since mirroring is not supported when striping is applied, the availability of 
the striped logical volume is low when compared with a mirrored logical 
volume.

2. For striping, at least two physical drives are required. The drives used 
should have little or no other activity.

Note
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Figure 313.  smitty’s Add a Volume Group for Disk Striping

4. Type a unique name into the VOLUME GROUP name field (Figure 313).

5. Type the names of all physical volumes that should be part of the new striped 
file system into the PHYSICAL VOLUME names field, or press F4 to get a 
selection list.

6. Press Enter.

7. Exit smit and enter lsvg -p stripevg and lsvgstripevg to make sure the 
volume group was added correctly.

14.4.2  Creating the Logical Volume for Disk Striping
Select a stripe unit size of 64 KB and a logical volume size of 30 partitions (each 
has the previously defined size of 4 MB):

1. Enter smitty mklv.

The mklv command creates a new logical volume within the volume group.

Figure 314.  smitty’s Add a Logical Volume for Disk Striping

2. Select the volume group on which you want to add the logical volume and 
press Enter (Figure 314).

                               Add a Volume Group

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  VOLUME GROUP name                                  [stripevg]
  Physical partition SIZE in megabytes                4                       
* PHYSICAL VOLUME names                              [hdisk1 hdisk2 hdisk3]   
  Activate volume group AUTOMATICALLY                 yes                     
    at system restart?
  Volume Group MAJOR NUMBER                          []                       

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

                               VOLUME GROUP name

    Move cursor to desired item and press Enter.

      rootvg
      stripevg

    F1=Help                 F2=Refresh              F3=Cancel
    F8=Image                F10=Exit                Enter=Do
    /=Find                  n=Find Next
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Figure 315.  smitty’s Add a Logical Volume for Disk Striping (Continued)

3. Enter the Logical volume NAME (Figure 315).

4. Enter the Number of LOGICAL PARTITIONS; the partition size was already 
set in Figure 308 on page 404 at 4 MB.

5. Enter the POSITION on physical volume and the RANGE of physical 
volumes, as described 14.3.1, “Performance Considerations for the Logical 
Volume Manager” on page 403.

6. Set RELOCATE the logical volume during reorganization? to yes to allow 
the physical partitions to be moved during reorganization if it is required at a 
later time for performance reconsiderations.

7. For performance considerations, the parameter Enable WRITE VERIFY? 
should to be set to no.

8. Press Enter to create the logical volume.

9. Exit smit and enter lslv strnotes to make sure the logical volume was added 
correctly.

                              Add a Logical Volume

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Logical volume NAME                                [stnotes]
* VOLUME GROUP name                                   stripevg
* Number of LOGICAL PARTITIONS                       [30]
#
  PHYSICAL VOLUME names                              [hdisk1 hdisk2 hdisk3]   
  Logical volume TYPE                                []
  POSITION on physical volume                         outer_middle            
  RANGE of physical volumes                           minimum                 
  MAXIMUM NUMBER of PHYSICAL VOLUMES                 []
#
    to use for allocation
  Number of COPIES of each logical                    1                       
    partition
  Mirror Write Consistency?                           no                      
  Allocate each logical partition copy                no                      
    on a SEPARATE physical volume?
  RELOCATE the logical volume during                  yes                     
    reorganization?
  Logical volume LABEL                               []
  MAXIMUM NUMBER of LOGICAL PARTITIONS               [128]
  Enable BAD BLOCK relocation?                        yes                     
  SCHEDULING POLICY for writing logical               parallel                
    partition copies
  Enable WRITE VERIFY?                                no                      
  File containing ALLOCATION MAP                     []
  Stripe Size?                                       [64k]            +

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do
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14.4.3  Creating a Striped File System for Lotus Notes Databases
A logical volume, strnotes, was created in 14.4.2, “Creating the Logical 
Volume for Disk Striping” on page 410. You should also create a new file 
system log file; refer to 14.3.5, “Creating a New Log Device” on page 407. 
Now, we can create a file system using the previously created logical volume, 
strnotes.

  • Type the command:

crfs -d strnotes -m /server1 -A yes -a logname=/dev/fsnoteslog

and press Enter.

14.4.4  Performance Tuning Using Disk Striping
Be aware that there are many different factors which need to be considered when 
tuning a striped logical volume for best performance. Changing some parameters 
may impact the performance of other processes in the system, and you should 
know what you are doing. In this chapter, we will only talk about the possible 
parameters that you might change:

In benchmarking situations, the following techniques have yielded the highest 
levels of sequential I/O throughput:

  • Stripe unit size of 64 KB.

  • max_coalesce of 64 KB (the default). Equal to the stripe unit size.

max_coalesce specifies the maximum size, in bytes, of requests that the SCSI 
device driver will coalesce from the requests in its queue. Its range is from 64 
KB to 2 GB. If you want to change the value, you must have a stanza in the 
ODM database PdAt. Use the command odmget PdAt to display the value. Use 
odmdelete, odmadd, and bosboot to change max_coalesce.

  • minpgahead of 2 (the default). It defines the number of pages the Virtual 
Memory Manager (VMM) reads ahead when it first detects sequential access. 
Its range is from 0 to 16. Use vmtune to display and change the value.

  • maxpgahead of (16 times the number of disk drives). This causes page-ahead 
to be done in units of the stripe unit size (64 KB) times the number of disk 
drives, resulting in the reading of one stripe unit from each disk drive for each 
read-ahead operation. The range of maxpgahead is 0 to 16. The default 
setting is 8. Use vmtune to display and change the value.
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  • I/O requests for (64 KB times the number of disk drives). This is equal to the 
maxpgahead value.

  • Modify maxfree to accommodate the change in maxpgahead.

14.5  Lotus Domino Server Tuning

One can tune the parameters that alter the behavior of the Lotus Domino Server 
to improve its performance. We give below some of the parameters that can be 
tuned to improve Lotus Domino performance.

14.5.1  The NSF_BUFFER_POOL_SIZE Parameter
This parameter controls the allocation of memory to the NSF entry cache. 
Memory elements allocated to this cache help to keep the Lotus Notes data in 
memory without having to make extra access to disk.

14.5.2  The NIF_POOL_SIZE Parameter
This parameter controls allocation of memory to the NIF entry cache and 
improves performance for large views.

14.5.3  The MEMORY_QUOTA Parameter
If you are using the Lotus Domino Server for other applications also, you can use 
this parameter to prevent Lotus Notes from using all the memory on the system. If 
you do not specify a limit, Lotus Notes will consume all available memory and so 
the demands on another application (for example, a file server) may result in 
paging to disk to accommodate file server requests. This, in turn, would result in 
poor performance.

 If you are contemplating changing these values, keep in mind:

The values should be from the set: 0, 1, 2, 4, 8, 16. The use of other 
values may have adverse performance or functional effects.

Values should be powers of 2 because of the doubling algorithm of the 
VMM.

The value for maxpgahead > 16 can be used in systems where the 
sequential performance of striped logical volumes is of paramount 
importance. If you use only one adapter, please be aware that a value 
greater than 16 (64 KB read-ahead) may exceed the capabilities of some 
disk device drivers.

A minpgahead value of 0 effectively defeats the mechanism. This may 
have serious adverse consequences for performance.

The default maxpgahead value of 8 yields the maximum possible 
sequential I/O performance for currently supported disk drives.

The ramp-up of the read-ahead value from minpgahead to maxpgahead 
is quick enough that, for most file sizes, there would be no advantage to 
increasing minpgahead.

Note
System Performance Considerations 413



14.5.4  Multiple Name and Address Books
You can either partition the users into multiple domains with a single address 
book or can have multiple address books in the same domain. Many times, 
having multiple domains is not an option, so the alternative is to cascade NABs.

Having multiple Name and Address Books requires a careful analysis of the user 
community. You should place entries in the appropriate address books. With this 
approach, you can partition your NAB entries into multiple smaller NABs. The 
advantage is better performance if most of the hits are to the first NAB since it is 
smaller and more efficient to look up. The disadvantage is that if the system is 
designed improperly, the lookups take longer because each NAB is searched in 
the order in which it is cascaded on the server.

14.6  Lotus Notes Configuration Tips

You can enable configuration related parameters by editing the notes.ini file. The 
notes.ini file contains a set of variables for controlling parameters that can be 
used to optimize the functioning of the Lotus Domino Server.

14.6.1  Reducing ServerTasks 
This line in the notes.ini file specifies which server tasks must be started at server 
startup time. Starting too many unwanted tasks at startup time is not desirable. 
Active server tasks take up system resources even if they are not servicing an 
active workload. So one should remove the unnecessary tasks from the 
ServerTasks list.

14.6.2  Reducing Mail-Polling Intervals (MinNewMailPoll)
This parameter specifies the polling interval to check for new mail messages. By 
reducing the frequency of queries, you can improve the system performance 
significantly. MinNewMailPoll is expressed in minutes, and for a large system, the 
optimal setting is about 30 to 45 minutes. The parameter MinNewMailPoll=45 
changes the minimum polling interval for mail and overrides more frequent polling 
requested by users.

14.6.3  Increasing the MailMaxThreads Value
The performance of the mail router can be improved by increasing the number of 
worker threads that start up with the Lotus Notes Mail Router. A good rule of 
thumb for the number of such threads is the number of Lotus Notes Mail servers 
in the domain. For example, if you have four servers in your domain, all of which 
have mail users, specify MailMaxThreads=4 in the notes.ini file for all the Domain 
servers. This setting ensures routing of mail to all four servers in parallel, thereby 
increasing the performance of mail routing. The MailMaxThreads setting affects 
only the routing component and has no affect on the delivery component.

14.6.4  Dropping Idle Sessions
Setting Server_Session_timeout=15 drops idle sessions automatically after 15 
minutes of the session’s being idle. Recycling sessions by timeout is done in the 
background as opposed to creating sessions in demand. In some cases, 
dropping idle sessions may result in higher throughput.
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14.6.5  Enabling Full-Text Indexes
Ensure that you have full-text indexes and searching capabilities enabled on 
databases on which the users execute searches.This will make the search 
operation faster and won’t put a lot of load on the Lotus Domino Server.

14.6.6  Partitioning Data on Servers
This is a big topic in itself, and we will cover only one important technique here. In 
case you have a mix of dial-in users (who mostly replicate changes from the 
databases) and LAN users (online users who actively use and view databases 
interactively), an effective technique is to partition users to two servers based on 
usage. This way, you can cut the replication time for the dial-in users significantly 
because system resources on the dial-in server are dedicated. A further 
optimization is to delete indexes on the dial-in server and shut down all server 
tasks other than scheduled replication. Performance on the server supporting the 
online users also improves since that server does not have to suffer interruptions 
caused by dial-ins.

14.7  Conclusion

When you begin to tune your Lotus Domino IBM RS/6000 system, change only 
one thing at a time. Then re-evaluate the performance of your system to see if it 
has resulted in a performance improvement or a performance degradation. If you 
make many changes at one time, it is much harder to assess your resulting 
performance.
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Chapter 15.  Troubleshooting

Some potential problems and solutions are presented in this chapter. Please also 
take a careful look at "Things you need to know->Platforms and requirements" in 
Release Notes: Domino Server 4.6.1, supplied on the Lotus Domino Server CD.

A good source for known problems regarding Lotus Domino is the Lotus 
Knowledge Base. It is used by Lotus Support to collect known problems. If you 
work for IBM, you can access it on the intranet at http://w3.ncs.ibm.com/lkb.nsf. 
If you are a Lotus Business Partner, please check with Lotus on how to access it. 
In general, you might want to go to http://www.support.lotus.com and perform a 
search.

For RS/6000 related topics, it is worth visiting http://www.rs6000.ibm.com/support.

15.1  Performing Copy and Paste

To perform a copy from a Lotus Notes Client screen, you must select the text you 
want to copy with the left mouse button and perform the copy operation as you 
would do on a PC operating system (Windows NT, OS/2). That is, pressing 
Ctrl-C, choosing Edit->Copy, or using the "Copy"-Smarticon. To paste, press 
the central mouse button, as normally done in the X-Windows environment, or the 
appropriate menu action if you are pasting to another field of the client.

If you want to copy something from an aixterm to, for example, a Lotus Notes 
Client screen, select the text with the left mouse button (you don’t need to press 
Ctrl-C) and paste with the central mouse button. If you are running CDE, you can 
also perform a PC-style copy operation (Edit->Copy from the dtterm action bar).

15.2  Multiple Lotus Notes Clients on the Same AIX System

If you intend to run multiple clients on one UNIX workstation (think of a Network 
Station environment), Lotus recommends that you set the Notes_ISOLATION 
environment variable in the UNIX shell of every UNIX account that is running the 
Lotus Notes client. This environment variable allows multiple Lotus Notes clients 
to run on the same workstation in a way that isolates one Lotus Notes client 
termination from affecting the other Lotus Notes clients on the same workstation. 
If you do not set this environment variable, one Lotus Notes client termination 
hangs other Lotus Notes clients on that workstation. 

Set the Notes_ISOLATION environment variable in your .cshrc, .profile, or .kshrc 
file so that you always run Lotus Notes with the environment variable set.

If you run the C Shell, add this line to your ~/.cshrc file: 

setenv Notes_ISOLATION 1

If you run the Bourne Shell, add this line to your ~/.profile file:

All Lotus Notes Clients started on a single system must have the variable set 
for Notes_ISOLATION to work.

 Note
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Notes_ISOLATION=1; export Notes_ISOLATION

If you run the Korn Shell, add this line to your ~/.kshrc file: 

export Notes_ISOLATION=1

Note that these environment variables are case sensitive. You must set this 
variable before running the Lotus Notes clients or the server programs. This can 
be done by using the profile or login files, or in the server’s startup script.

15.3  Cleaning Lotus Domino Processes

In general, the current version of Lotus Domino runs quite well without server 
hangs. If a server or a client should crash, you may have trouble restarting them. 
This is caused by corrupted shared memory and semaphores that the program 
does not clean. Even if you do not have trouble after a crash, it is a good practice 
to clean up before restarting any process. In order to clean up after a crash, you 
basically have three steps to perform:

1. Kill all processes of the server or the client, whichever failed.

2. Remove the associated Inter-Process Communication (IPC) resources, which 
are:

  • Shared memory segments

  • Semaphores

3. Remove the file ~notes.lck (located in the notes data directory).

How do you do it manually?

Assume the Lotus Domino Server and/or the client have been running with the 
userid notes:

1. Identify the processes to kill by issuing:

ps -ef | grep notes

2. Do a kill -9 on all suspicious processes either as user root or user notes.

The following screen shot shows an example of a list of processes you might get 
on issuing the ps command. Obviously, you should preferably use scripts to do 
the cleanup (see below). The sample shows how to end the first Lotus Domino 
process.

Be careful when you are using the kill command. In general, the notes 
processes have the path /opt/lotus/notes/latest/ibmpow. If you are absolutely 
sure that only the Lotus Domino processes have been run under the userid 
notes, you could do the following:

su - notes
kill -9 -1

Note
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Figure 316.  Sample Process Screen

After killing the processes, you have to remove the corrupted shared memory and 
semaphores. With the command ipcs, you can list them. With ipcrm, you can 
remove them. You have to identify the items to remove by looking at those 
belonging to the appropriate user (OWNER=notes in our example) and having the 
KEY started with 0xf80 (with release 4.0 and 4.1, it usually started with 0xfff). 
See Figure 317 for a sample of output and Figure 318 on how to remove the IPC 
resources with their ID.

Figure 317.  Output of ipcs Command

$ ps -ef | grep notes
   notes 22706  3886   0 10:26:55  pts/1  0:00 -ksh 
   notes 23736 22706   0 10:27:09  pts/1  0:00 sh /usr/domino/lotus/bin/server 
   notes 23814 23736   0 10:27:16  pts/1  0:04 /opt/lotus/notes/latest/ibmpow/server 
   notes 24280 23814   0 10:27:31  pts/1  0:02 /opt/lotus/notes/latest/ibmpow/router 
   notes 24524 23814   1 10:27:41  pts/1  0:00 /opt/lotus/notes/latest/ibmpow/update 
   notes 24790 23814   1 10:27:36  pts/1  0:01 /opt/lotus/notes/latest/ibmpow/replica 
   notes 25026 23478   0 10:27:11  pts/3  0:00 -ksh 
   notes 25292 23814   0 10:27:46  pts/1  0:01 /opt/lotus/notes/latest/ibmpow/stats 
   notes 25558 23814   1 10:27:51  pts/1  0:02 /opt/lotus/notes/latest/ibmpow/amgr 
   notes 25800 25558   1 10:27:52  pts/1  0:02 /opt/lotus/notes/latest/ibmpow/amgr -e 1 
   notes 26058 23814   0 10:27:56  pts/1  0:00 /opt/lotus/notes/latest/ibmpow/sched 
   notes 26316 23814   0 10:28:01  pts/1  0:00 /opt/lotus/notes/latest/ibmpow/calconn 
   notes 26574 23814   1 10:28:06  pts/1  0:01 /opt/lotus/notes/latest/ibmpow/adminp 
   notes 26832 23814   0 10:28:11  pts/1  0:00 /opt/lotus/notes/latest/ibmpow/report 
   notes 27090 23814   0 10:28:16  pts/1  0:01 /opt/lotus/notes/latest/ibmpow/event 
   notes 27348 23814   0 10:28:21  pts/1  0:00 /opt/lotus/notes/latest/ibmpow/billing 
   notes 27606 23814   1 10:28:26  pts/1  0:02 /opt/lotus/notes/latest/ibmpow/http 
   notes 27870 25026   1 10:31:00  pts/3  0:00 -ksh 
   notes 28128 27870  14 10:31:10  pts/3  0:00 ps -ef 
   notes 28380 27870   3 10:31:10  pts/3  0:00 grep notes 
$ kill -9 23736

$ipcs
IPC status from /dev/mem as of Thu Jul 23 11:15:28 CDT 1998
T     ID     KEY        MODE       OWNER    GROUP
Message Queues:
q      0 0x4107001c -Rrw-rw----     root   printq
Shared Memory:
m   4096 0x580518e2 --rw-rw-rw-     root   system
m      1 0x00001a4c --rw-------     root   system
m      2 0x00000001 --rw-r--r--     root   system
m      8 0xf8000200 --rw-rw----    notes    staff
m      9 0xf8000201 --rw-rw----    notes    staff
Semaphores:
s   4096 0x580518e2 --ra-ra-ra-     root   system     1
s   4097 0x440518e2 --ra-ra-ra-     root   system     2
s   4098 0x00001a4c --ra-------     root   system     2
s      3 0x620520e3 --ra-r--r--     root   system     1
s      4 0x00000002 --ra-r--r--     root   system     1
s      5 0x00000003 --ra-ra-ra-     root   system     1
s     10 0x0105206f --ra-------     root   system     1
s     11 0xf8000200 --ra-ra----    notes    staff    16
s     12 0xf8000201 --ra-ra----    notes    staff    16
s     13 0xf8000202 --ra-ra----    notes    staff    16
s     14 0xf8000203 --ra-ra----    notes    staff    16
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Figure 318.  Removing of IPC Resources

Figure 319 shows a sample script that tries to kill all Notes processes and remove 
the semaphores and shared memory. It is only provided to show the principles; 
use at your own risk. More detailed scripts, as a basis for production, use are 
available under http://powernet.austin.ibm.com (Section Software, Software 
downloads; at time of writing this book the documents were "HA50 and Domino" 
and "Domino scripts".

Be sure to adjust the environment variables at the beginning to suite your 
environment.

Figure 319.  Clean Lotus Notes Processes Script - killnotes

15.4  File System Full

Assume your Lotus Domino Server is installed in the filesystem /server1. You can 
monitor the filesystem use with the command df. Other file systems that must be 
verified are /, /var,/tmp, and /usr.

$ ipcrm -s 14
$ ipcrm -s 13
$ ipcrm -s 12
$ ipcrm -s 11
$ ipcrm -m 8
$ ipcrm -m 9

#!/bin/ksh
NOTES_USER=notes # AIX userid for this server
NOTES_PATH=/server1/notesr4 # Path for server data directory
PATH=$NOTES_PATH:/opt/lotus/bin:$HOME/bin:$PATH # Ensure PATH is set for scripts

count=0
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
while [[ -n $NOTES_RUNNING ]] ; do
sleep 10
count=‘expr $count + 1‘
echo " ... waiting "$count"0 seconds"
#
# Terminate Domino Server if still running
#
if [ $count -eq 13 ] ; then
   echo "Domino Server is still running after 2 minutes"
   echo " ... now for the ungraceful method"
   for i in ‘ps -fu $NOTES_USER | grep lotus | grep -v grep | awk ’{ print $2 }’‘; do
     kill -9 $i
   done
   mems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"m" ’{ print $2 }’|\

awk ’{ print $1 }’‘
   sems=‘ipcs | grep $NOTES_USER | awk ’{ print $1 $2 }’ |  awk -F"s" ’{ print $2 }’ |\

awk ’{ print $1 }’‘
   for j in $mems;do if [ -n "$j" ] ; then ipcrm -m $j;fi;done
   for j in $sems;do if [ -n "$j" ] ; then ipcrm -s $j;fi;done
   echo "Domino Server 4.6.1 TERMINATED"
   exit
fi
NOTES_RUNNING=‘ps -fu $NOTES_USER | grep /opt/lotus | grep -v grep ‘
done
#
echo "Domino for AIX ($NOTES_SERVER) shutdown completed
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When you receive a file system full message, or when you want to increase the 
file system size before this error occurs, do the following as root:

1. Verify if you have space in the volume group that contains the file system you 
want to increase. Checkout the volume group by issuing lslv notesdatalv.

In this case, we have 632 MB available in the dominovg volume group.

2. Run the command smitty chjfs.

3. Select the file system you want to increase in size, in our example, /server1

4. Type the new size (you can only increase the size) in the SIZE of file system 
(in 512-byte blocks) field. For example, the /server1 file system would be 
changed to 150 MB by entering 300000 in that field.

5. Instead of step 2 to 4, you could just type

crfs -a size=300000 /server1

or

crfs -a size=+54240

[54240 = (300000 - (128880*2); 128880 from df -k above]

If you need more space than is left in the volume group, you can acquire a 
new hard disk for the server and add it to the volume group. All this filesystem 
handling is standard business with AIX, but may be new to somebody used to 
PC-based operating systems.

15.5  Increasing Paging Space

Paging space may affect the performance of your Lotus Domino Server. If paging 
space runs low, you may loose processes or cause a system panic. The size of 
the paging space is by default the size of the physical memory plus 16 MB. If you 
want to increase the size of the default paging space (you can’t decrease), do the 
following as root:

1. Run the command smitty chps and select hd6.

$ df -k /server1
Filesystem    1024-blocks      Free %Used    Iused %Iused Mounted on
/dev/notesdatalv      122880     12036   91%      750     3% /server1

This is screen.$ lslv notesdatalv
LOGICAL VOLUME:     notesdatalv            VOLUME GROUP:   dominovg
...
$ lsvg dominovg
VOLUME GROUP:   dominovg                 VG IDENTIFIER:  00382642cf3bb9d7
VG STATE:       active                   PP SIZE:        4 megabyte(s)
VG PERMISSION:  read/write               TOTAL PPs:      258 (1032 megabytes)
MAX LVs:        256                      FREE PPs:       158 (632 megabytes)
LVs:            4                        USED PPs:       100 (400 megabytes)
OPEN LVs:       4                        QUORUM:         2
TOTAL PVs:      1                        VG DESCRIPTORS: 2
STALE PVs:      0                        STALE PPs:      0
ACTIVE PVs:     1                        AUTO ON:        yes
MAX PPs per PV: 1016                     MAX PVs:        32
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Figure 320.  Change/Show Characteristics of a Paging Space

2. Enter the NUMBER of additional logical partitions you want (Figure 320). Be 
sure to enter the right number of partitions based on your volume group’s 
Physical Partition (PP) SIZE. With the lsvg command, you can see the logical 
partition size:

In the example, the hd6 paging space size will be increased by 16 MB.

Alternatively, you can add another paging space to the system either in a different 
volume group or just on a different disk for performance reasons, or on the same 
disk if you think of decreasing paging space again later on. A paging space can 
be added by doing the following steps:

1. Run the command smitty mkps and make appropriate selections or just enter 
mkps -s’4’ -n -a dominovg

This would add an additional paging space of 4 partitions size in dominovg for 
immediate use.

2. To list the total paging space, you can use the command lsps -a

Figure 321.  List Paging Space

To remove an active paging space, change its characteristics so that it is not 
configured at subsequent system restarts (smitty chps or chps command). On the 
next system restart, the paging space is not active, and it can be removed.

                Change / Show Characteristics of a Paging Space

Type or select values in entry fields.
Press Enter AFTER making all desired changes.

                                                        [Entry Fields]
  Paging space name                                   hd6
  Volume group name                                   rootvg
  Physical volume name                                hdisk0
  NUMBER of additional logical partitions            [4]                      
  Use this paging space each time the system is       yes                     
          RESTARTED?

F1=Help             F2=Refresh          F3=Cancel           F4=List
F5=Reset            F6=Command          F7=Edit             F8=Image
F9=Shell            F10=Exit            Enter=Do

# lsvg rootvg | grep SIZE
VG STATE:       active                   PP SIZE:        4 megabyte(s)

# lsps -a
Page Space  Physical Volume   Volume Group    Size   %Used  Active  Auto  Type
paging00    hdisk1            dominovg        16MB       1     yes   yes    lv
hd6         hdisk0            rootvg         256MB      42     yes   yes    lv
422 Lotus Domino Release 4.6 on IBM RS/6000



15.6  Always Start with the Lotus Notes Setup Screen

If, after you have configured the Lotus Notes client, you always get the Lotus 
Notes setup screen again instead of the Lotus Notes Workplace, check to see if 
the notes.ini file is in a directory that is in your PATH.

Normally, the notes.ini is in your $HOME/notesr4 directory if you are using just 
the client. If you are using the admin client of a server, the PATH must point to the 
server’s data directory (for example: /server1/notesr4). To check the PATH, type: 
echo $PATH.

If you are using a Korn Shell, you may need to add these lines in your profile:

PATH=$HOME/notesr4:$PATH
export PATH

If you are using CDE, uncomment the line:

DTSOURCEPROFILE=true

in your .dtprofile file for the AIX Common Desktop Environment (CDE) to pick up 
the respective profiles.

15.7  Accessing a Server in a Different TCP/IP Domain

If you are a client of a Lotus Domino Server in a different TCP/IP domain, your 
Lotus Notes client (for example, mars.itsc.austin.ibm.com) needs to be able to 
translate the Lotus Domino Server name (for example, Jupiter/Acme Corp) into a 
valid TCP/IP address (for example jupiter.acme.com).

If we have a client and a server, you need to be able to resolve the TCP/IP name 
of the server with the names described in Table 18.

Table 18.  Client and Server Names

The following sections explain two different methods of achieving this either from 
within Lotus Notes or from within the network layer.

15.7.1  Setup within Lotus Notes
Open your Personal Name and Address Book on the client, select the 
Server/Connections view and add a new connection, as shown in Figure 322 on 
page 424.

TCP/IP Name Lotus Notes Name

Client mars.itsc.austin.ibm.com

Server jupiter.acme.com jupiter/Acme
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Figure 322.  New Server Connection

Select the Connection type Local Area Network and the correct LAN port. Enter 
the Lotus Domino Server name to which you want to connect (Jupiter/Acme Corp) 
and the TCP/IP name (or its numeric IP address) into the Destination server 
address field in the Advanced section (jupiter.acme.com). Save and exit the 
document.

If you are specifying the server name Jupiter/Acme Corp now, for example, in the 
Open Database dialog, Lotus Notes uses this Connection document to find the 
TCP/IP address of this server and connect to it. Of course, AIX has still to be able 
to resolve jupiter.acme.com to an IP address. Otherwise, you could enter the IP 
address of jupiter.acme.com directly in the Destination server address field.

15.7.2  Setup on the Network Layer
If you are not using a connection document, you must have an alias for the server 
name in question (jupiter), which can be resolved by TCP/IP name resolution. If 
you are using the /etc/hosts file, you have to add to it a line like the one in Figure 
323:

Figure 323.  Host Names Line

If you are using NIS, ask your NIS administrator to add a line (like the one in 
Figure 323) to the host’s file. He/she should add the address line to his/her host’s 
file and propagate it to the NIS hosts map.

9.179.1.220       jupiter.sumare.ibm.com   jupiter
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If you are using Domain Name Server (DNS), you can ask your DNS 
administrator to add to the local Name server an alias for your Lotus Domino 
Server name pointing to your TCP/IP complete server name. If you don’t have a 
machine with the same name as your server name in your domain (in our 
example, if the machine jupiter.itsc.austin.ibm.com does not exist), you can add a 
search tag to the /etc/resolv.conf file of your client machine. Note that if you have 
a search tag, you have to remove the domain tag.

In our example, the original /etc/resolv.conf would look like this:

The new resolv.conf would look like this:

You can have up to eight domains added to the search list.

15.8  Unable to Create the Data Directory during Setup

If, when undertaking Lotus Domino setup and clicking on the Install button, the 
error message:

Unable to create the data directory.  Please specify a new directory

is displayed, you need to insure the permissions on your Lotus Domino data 
directory filesystem are correct.

For example for the Lotus Domino data directory /server1 installed with AIX user 
notes (group notes) you would enter the following:

chown notes:notes /server1

15.9  "Directory is not empty" Error on Installing from CD

If you create a new filesystem, you will have a subdirectory called lost+found 
automatically. Lotus Domino does not accept that. So make sure that you created 
the filesystem /usr/domino for the Lotus Domino code, but specify 
/usr/domino/lotus as the target directory during initial installation.

15.10  Partitioning: File .sgf.notespartition and HACMP

The file .sgf.notespartion contains an integer number, which has to be unique 
across a cluster. So if you installed a mutual takeover scenario, make sure you 
edit this file for each server and enter a unique number (preferablly starting with 
number 1)

domain itsc.austin.ibm.com
nameserver 9.36.81.174

search itsc.austin.ibm.com sumare.ibm.com
nameserver 9.36.81.174
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15.11  TCP/IP Listener Error without TCPIP_TcpipAddress

If multiple servers are running on one system, make sure each has within 
notes.ini a line containing:

TCPIP_TcpipAddress=0,<ip address of domino server>,1352

Assuming an IP address of 9.3.4.5, the line would read:

TCPIP_TcpipAddress=0,9.3.4.5,1352

Otherwise, the first server coming up would listen on port 1352, and the next one 
would get a bind error at startup. You would get an error like this appearing in the 
Lotus Domino Server’s console output:

15.12  Errors at Startup of http Task

If you are running partitioned servers and more than one has the http Task active, 
edit the server document in the Public Address Book, section HTTP Server, and 
modify the fields, as shown, (replace hostname with your installation name) to 
contain the fully qualified hostname and binding being enabled:

Figure 324.  HTTP Server Basics

Afterwards, stop the http Task from the server console (tell http quit) and 
restart it (load http). You may want to have a look at the file domino.cnf in the 
servers data directory afterwards; it now contains two lines like this:

bindspecific yes
hostname itsosmp.itsc.austin.ibm.com

This combination allows each servers http Task to listen on the specific port built 
by hostname:port without the need to have different port numbers per server.

28/07/98 14:39:09     Error on Listen function: The TCP/IP port used by the
Notes server is still in use on this system.
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15.13  Lotus Notes Clients Freezing

If your Lotus Notes client freezes after you encountered problems on selecting 
buttons or similar things, it may help to change your LIBPATH statement to use 
the X11R5 libraries instead the X11R6 libraries. We encountered that problem 
with AIX 4.3.1 and Lotus Notes 4.6.1c International. You should export your 
LIBPATH before staring notes: LIBPATH=/usr/lpp/X11/lib/R5:/usr/lib:/lib

See /usr/lpp/X11/README for details about X11R6 compatibility issues.

The error you get on startup of Lotus Domino’s http Task, if another http 
daemon is already running, normally looks like:

[202cb3d8]: BIND........ Error in Privileged Port Call Failed.

Followed by:

27/07/98 16:14:21 HTTP Server Initialization error. Could not bind port 80.
Port may be in use
27/07/98 16:14:28     HTTP Web Server shutdown

Note
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Appendix A.  Using UNIX’s vi Editor

For those new to UNIX’s vi editor, below is a list of useful commands to help when 
using vi:

Table 19.  Useful vi Commands 

Command What Does It Do?

0 (zero) Move to the beginning of line.

$ Move to end of line.

/search_string Search forward for next line containing search_string.

?search_string Search backward for next line containing search_string.

a Append text, in insert mode,after current cursor position.

^b Move up one screen.

B Move to previous space-delimited word.

b Move to previous word.

Backspace Move left one character.

^d Move down half a screen.

D Delete until end of line.

dw Delete word.

dd Delete line.

ESC Leave insert mode and return to command mode.

^f Move forward on screen.

G Move to the last line of the file.

nG Move the the nth line of the file.

h Move left one character.

i Insert text before the current character.

j Move down one line.

k Move up one character.

l Move right one character.

n Repeat last search.

O Open new line for insertion above current line.

Return Move to start of next line.

^u Move up half a page.

U Undo any changes to current line.

u Undo last changes made to file.

W Move foward one space delimited word.

w Move forward one word.
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x Delete the current character.

:q Quit vi and return to the shell.

:q! Quit vi and return to the shell without saving any changes
made to the file.

:w Write the changed file to disk.

Command What Does It Do?
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Appendix B.  Special Notices

This publication is intended to help the Lotus Notes systems administrator to 
install, set up, and administer Lotus Notes Release 4.6 in an AIX operating 
system environment. The information in this publication is not intended as the 
specification of any programming interfaces that are provided by Lotus Notes. 
See the PUBLICATIONS section of the IBM or Lotus Programming 
Announcement for Lotus Notes Release 4 for more information about what 
publications are considered to be product documentation.

References in this publication to IBM products, programs, or services do not 
imply that IBM intends to make these available in all countries in which IBM 
operates. Any reference to an IBM product, program, or service is not intended to 
state or imply that only IBM’s product, program, or service may be used. Any 
functionally equivalent program that does not infringe any of IBM’s intellectual 
property rights may be used instead of the IBM product, program, or service.

Information in this book was developed in conjunction with the use of the 
equipment specified and is limited in application to those specific hardware and 
software products and levels.

IBM may have patents or pending patent applications covering subject matter in 
this document. The furnishing of this document does not give you any license to 
these patents. You can send license inquiries, in writing, to the IBM Director of 
Licensing, IBM Corporation, 500 Columbus Avenue, Thornwood, NY 10594 USA.

Licensees of this program who wish to have information about it for the purpose 
of enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information that has been exchanged, should contact IBM Corporation, Dept. 
600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal 
IBM test and is distributed AS IS. The information about non-IBM ("vendor") 
products in this manual has been supplied by the vendor and IBM assumes no 
responsibility for its accuracy or completeness. The use of this information or the 
implementation of any of these techniques is a customer responsibility and 
depends on the customer’s ability to evaluate and integrate them into the 
customer’s operational environment. While each item may have been reviewed 
by IBM for accuracy in a specific situation, there is no guarantee that the same or 
similar results will be obtained elsewhere. Customers attempting to adapt these 
techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of these 
Web sites.

The following document contains examples of data and reports used in daily 
business operations. To illustrate them as completely as possible, the examples 
contain the names of individuals, companies, brands, and products. All of these 
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names are fictitious and any similarity to the names and addresses used by an 
actual business enterprise is entirely coincidental.

The following terms are trademarks of the International Business Machines 
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

C-bus is a trademark of Corollary, Inc.

Java and HotJava are trademarks of Sun Microsystems, Incorporated.

Microsoft, Windows, Windows NT, and the Windows 95 logo are trademarks
or registered trademarks of Microsoft Corporation.

PC Direct is a trademark of Ziff Communications Company and is used
by IBM Corporation under license.

Pentium, MMX, ProShare, LANDesk, and ActionMedia are trademarks or
registered trademarks of Intel Corporation in the U.S. and other
countries.

UNIX is a registered trademark in the United States and other
countries licensed exclusively through X/Open Company Limited.

Other company, product, and service names may be trademarks or
service marks of others.

ADSTAR AIX
AT Current
ExecJet IBM 
InfoExplorer LoadLeveler
Micro Channel NetView
Operating System/2 OS/2
RISC System/6000 RS/6000
SP Workplace
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Appendix C.  Related Publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this redbook.

C.1  International Technical Support Organization Publications

For information on ordering these ITSO publications see “How to Get ITSO 
Redbooks” on page 435.

  • Lotus Notes Release 4 in a Multiplatform Environment, SG24-4649

  • Lotus Notes Release 4.5: A Developer’s Handbook, SG24-4876

  • Using ADSM to Back Up Lotus Notes, SG24-4534

  • RS/6000 Performance Tools in Focus, SG24-4989

  • Understanding LDAP, SG24-4986

  • Load-Balancing Internet Servers, SG24-4993

  • RS/6000 SP Monitoring: Keeping It Alive, SG24-4873

  • Inside the RS/6000 SP, SG24-5145

  • Developing Web Applications Using Lotus Notes Designer for Domino 4.6, 
SG24-2183

  • RS/6000 SP High Availability Infrastructure, SG24-4838

  • High Availability on the RISC System/6000 Family, SG24-4551

  • RS/6000 Models E30, F40, F50 and H50 Handbook, SG24-5143

  • High Availability and Scalability with Domino Clustering and Partitioning on 
AIX, SG24-5163

  • Implementing High Availability on RISC/6000 SP, SG24-4742

C.2  Redbooks on CD-ROMs

Redbooks are also available on CD-ROMs. Order a subscription and receive 
updates 2-4 times a year at significant savings.

CD-ROM Title Subscription 
Number

Collection Kit 
Number

System/390 Redbooks Collection SBOF-7201 SK2T-2177
Networking and Systems Management Redbooks Collection SBOF-7370 SK2T-6022
Transaction Processing and Data Management Redbook SBOF-7240 SK2T-8038
Lotus Redbooks Collection SBOF-6899 SK2T-8039
Tivoli Redbooks Collection SBOF-6898 SK2T-8044
AS/400 Redbooks Collection SBOF-7270 SK2T-2849
RS/6000 Redbooks Collection (HTML, BkMgr) SBOF-7230 SK2T-8040
RS/6000 Redbooks Collection (PostScript) SBOF-7205 SK2T-8041
RS/6000 Redbooks Collection (PDF Format) SBOF-8700 SK2T-8043
Application Development Redbooks Collection SBOF-7290 SK2T-8037
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C.3  Other Publications

These publications are also relevant as further information sources:

Lotus documentation is available online after the product has been installed. The 
database name is listed in parenthesis after the title of the documentation.

  • Notes 4.5 Release Notes, (readme.nsf)

  • Notes Help Lite, (helpt4.nsf)

  • Notes Help, (help4.nsf)

  • Notes Installation Guide for Servers, (doc/srvinst.nsf)

  • Workstation Install Guide, (doc/wrkinst.nsf)

  • Notes Administration Help, (doc/migrate.nsf)

  • Notes Migration Guide, (doc/migrate.nsf))

  • NPN Administrator’s Guide, (doc/npn_admn.nsf)

  • Release Notes-NPN R4, (doc/npn_rn.nsf)

  • Web Navigator Admin Guide, (doc/webadmin.nsf)

  • Web Navigator User’s Guide, (doc/webuser.nsf)

  • DAS Administration Guide, (doc/npn_admn.nsf)

  • SMTP MTA Administration Guide, (smtpag.nsf)

  • Lotus Notes Internet Cookbook for Release 4, 
http://NS.notes.net/cookbook/cbook.htm

  • AIX V4.1 Installation Guide, SC23-2550

  • AIX 4.2 Installation Guide, SC23-1924

  • AIX V4.3 Installation Guide, SC23-4112

  • AIX V4.3 Guide to Printers and Printing, SC23-4130

  • IBM Internet Connection Server for AIX, Users Guide, SC31-8194

  • AIX Performance Tuning Guide, SC23-2365

  • AIX Version 4 System Management Guide: Communications and Networks, 
SC23-2526

  • AIX Version 4.1 Network Installation Management Guide and Reference, 
SC232627
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How to Get ITSO Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, CD-ROMs, 
workshops, and residencies. A form for ordering books and CD-ROMs is also provided.

This information was current at the time of publication, but is continually subject to change. The latest information 
may be found at http://www.redbooks.ibm.com/.

How IBM Employees Can Get ITSO Redbooks
Employees may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about 
redbooks, workshops, and residencies in the following ways:

  • Redbooks Web Site on the World Wide Web

http://w3.itso.ibm.com/

  • PUBORDER – to order hardcopies in the United States

  • Tools Disks

To get LIST3820s of redbooks, type one of the following commands:

  TOOLCAT REDPRINT
  TOOLS SENDTO EHONE4 TOOLS2 REDPRINT GET SG24xxxx PACKAGE
  TOOLS SENDTO CANVM2 TOOLS REDPRINT GET SG24xxxx PACKAGE (Canadian users only)

To get BookManager BOOKs of redbooks, type the following command:

  TOOLCAT REDBOOKS

To get lists of redbooks, type the following command:

  TOOLS SENDTO USDIST MKTTOOLS MKTTOOLS GET ITSOCAT TXT

To register for information on workshops, residencies, and redbooks, type the following command:

  TOOLS SENDTO WTSCPOK TOOLS ZDISK GET ITSOREGI 1998

  • REDBOOKS Category on INEWS

  • Online – send orders to: USIB6FPL at IBMMAIL  or   DKIBMBSH at IBMMAIL

For information so current it is still in the process of being written, look at "Redpieces" on the Redbooks Web Site 
(http://www.redbooks.ibm.com/redpieces.html). Redpieces are redbooks in progress; not all redbooks become 
redpieces, and sometimes just a few chapters will be published this way.  The intent is to get the information out 
much quicker than the formal publishing process allows.

Redpieces
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How Customers Can Get ITSO Redbooks
Customers may request ITSO deliverables (redbooks, BookManager BOOKs, and CD-ROMs) and information about 
redbooks, workshops, and residencies in the following ways:

  • Online Orders – send orders to:

  • Telephone Orders

  • Mail Orders – send orders to:

  • Fax – send orders to:

  • 1-800-IBM-4FAX (United States) or (+1) 408 256 5422 (Outside USA) – ask for:

Index # 4421 Abstracts of new redbooks
Index # 4422 IBM redbooks
Index # 4420 Redbooks for last six months

  • On the World Wide Web

In United States
In Canada
Outside North America

IBMMAIL
usib6fpl at ibmmail
caibmbkz at ibmmail
dkibmbsh at ibmmail

Internet
usib6fpl@ibmmail.com
lmannix@vnet.ibm.com
bookshop@dk.ibm.com

United States (toll free)
Canada (toll free)

1-800-879-2755
1-800-IBM-4YOU

Outside North America
(+45) 4810-1320 - Danish
(+45) 4810-1420 - Dutch
(+45) 4810-1540 - English
(+45) 4810-1670 - Finnish
(+45) 4810-1220 - French

(long distance charges apply)
(+45) 4810-1020 - German
(+45) 4810-1620 - Italian
(+45) 4810-1270 - Norwegian
(+45) 4810-1120 - Spanish
(+45) 4810-1170 - Swedish

IBM Publications
Publications Customer Support
P.O. Box 29570
Raleigh, NC 27626-0570
USA

IBM Publications
144-4th Avenue, S.W.
Calgary, Alberta T2P 3N5
Canada

IBM Direct Services
Sortemosevej 21
DK-3450 Allerød
Denmark

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-800-267-4455
(+45) 48 14 2207 (long distance charge)

Redbooks Web Site
IBM Direct Publications Catalog

http://www.redbooks.ibm.com
http://www.elink.ibmlink.ibm.com/pbl/pbl

For information so current it is still in the process of being written, look at "Redpieces" on the Redbooks Web Site 
(http://www.redbooks.ibm.com/redpieces.html). Redpieces are redbooks in progress; not all redbooks become 
redpieces, and sometimes just a few chapters will be published this way.  The intent is to get the information out 
much quicker than the formal publishing process allows.

Redpieces
436 Lotus Domino Release 4.6 on IBM RS/6000



IBM Redbook Order Form

Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries.  Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name
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Address
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List of Abbreviations

ACL Access Control List

ADSM ADSTAR Distributed Storage 
Manager

AFS Andrew File System

AIX Advanced Interactive 
eXecutive

APA All Points Addressable

APAR Authorized Program Analysis 
Report

ASCII American Standard Code for 
Information Interchange

ATM Asynchronous Transfer Mode

CAPI Common ISDN Application 
Programming Interface

CDE Common Desktop 
Environment

CGI Common Gateway Interface

CPU Central Processing Unit

CRC Cyclic Redundancy Check

DAS Domino Advanced Services

DAT Digital Audio Tape

DCE Distributed Computing 
Environment

DLT Digital Linear Tape

DNS Domain Name System

DOS Disk Operating System

DRT Delivery Report Task

ECL Execution Control List

FDDI Fiber Distributed Data 
Interface

FTP File Transfer Protocol

GID Group ID

GIF Graphical Interchange Format

HACMP High Availability Clustered 
Multi-Processing

HPS High Performance Switch

HTML Hypertext Markup Language

HTTP Hypertext Transfer Protocol

IBM International Business 
Machines Corporation

I/O Input/Output

IGS Information Gateway Service
© Copyright IBM Corp. 1998
IMAP Internet Message Access 
Protocol

IND Interactive Network 
Dispatcher

I/O Input/Output

IP Internet Protocol

IPC Inter-Process Communication

IPX Internetwork Packet 
eXchange

ISA Industry Standard 
Architecture

ISDN Intergrated-Services Digital 
Network

ISP Internet Service Provider

ITSO International Technical 
Support Organization

JPEG Joint Photographic Experts 
Group

LAN Local Area Network

LDAP Lightweight Directory Access 
Protocol

LIPS Lightweight Internet Person 
Schema

LVM Logical Volume Manager

MIME Multipurpose Internet Mail 
Extensions

MTA Message Transfer Agent

MX Mail Exchanger

NAB Name and Address Book

NIC Network Interface Card

NIF Not in File

NIM Network Install Manager

NIS Network Information System

NFS Network File System

NLM NetWare Loadable Module

NNTP Network News Transfer 
Protocol

NRK Notes Recovery Kit

ODBC Open Database Connectivity

ODM Object Data Manager

OLE Object Linking and 
Embedding

OU Organizational Unit
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PAB Public (Name and) Address 
Book

POP3 Post Office Protocol Version 3

PCL Printer Control Language

PP Physical Partition

PPP Point-to-Point Protocol

PRPQ Programming Request for 
Price Quotation

PSSP Parallel System Support 
Programs

PTF Program Temporary Fix

PTX Performance Toolbox

PTPE Performance Toolbox Parallel 
Extensions

RAID Redundant Array of 
Inexpensive Disks

RAM Random Access Memory

RAS Reliability, availability, 
serviceability

RDBM Relational Database Manager

RFC Request For Comments

RISC Reduced Instruction Set 
Computing

RPC Remote Procedure Call

SACL Server Access Control Lists

SCSI Small Computer system 
Interface

SLIP Serial Line Internet Protocol

SMIT System Management 
Interface Tool

SMTP Simple Mail Transfer Protocol

SMP Symmetric Multi-Processing

SNMP Simple Network Management 
Protocol

SP Scalable Parallel

SPX Sequenced Packet eXchange

SSA Serial Storage Architecture

SSL Secure Sockets Layer

TCP/IP Transmission Control 
Protocol/Internet Protocol

TCB Trusted Computing Base

TTY Teletypewriter

UDP User Datagram Protocol

UID User ID

URL Uniform Resource Locator

USENET USErs’ NETwork

VM Virtual Memory

VMM Virtual Memory Manager

WAN Wide Area Network

WWW World Wide Web
440 Lotus Domino Release 4.6 on IBM RS/6000



Index

Symbols
.dtprofile   84
.profile   84
.sgf.notespartition   425
/.rhosts File   379
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CLREPL   330, 331
Cluster
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Cluster_Admin_On   335
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MailClusterFailover   336
Managing Databases   333
MAXUSERS   335
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Processes   332
Removing   333
RESTRICTED   335
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Restricting Server Access   334
Server_Availability_Threshold   335
Server_Cluster_On   336
Server_MaxUsers   335
Server_Restricted   334, 335
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Creating Replicas   134
Creating Volume Group for Notes Binaries   25, 76
Crontab   364, 377, 378, 381
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tell web quit   250

Domino Virtual Server
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Data Availability   351
Service Availability   351
Serviceprocessor   352
SP   351
System Availability   351

HTTP   345
http-Task   426

I
I/O BUFFER CACHE   390
IMAP   281

Overview   281
Preparation for an IMAP Client   283
Setting Up an IMAP4 Client   286
Setting Up Netscape Navigator   287
Starting   283
Stopping   283

IMAP4   346
Increasing

File System Size   420
Paging Space Size   421

Indicator for Network Traffic   319
Installation

Change Destination Path   44
Configuration   47
Configuration Summary   47
Destination Host   43
Destination Path   44
Group ID   46
Host Name   43
Install to One Computer   43
Kit, UNIX Installation
 443



Copy to Disk   158
Distributing   157
Mounting from NFS   160

kit, UNIX Installation
Exporting to NFS mounts   159

More than One Computer   43, 50
Network Resource   42
NFS Possibilities   157
Notes Software as Network Resource   162
Server   39
Server Information   116
User ID   46
User Information   102
Workstation   39
Workstation Software as Network Resource   162

Installing a Printer on AIX
Add a Local Print Queue   174
Add a Remote Print Queue   176
Local Attached Printer   171
mkpq   171, 176
Printer Type   172, 174
Remote Attached Printer   175

Installing AIX Printer Support   173
Installing Domino Servers   116
Installing Lotus Domino Server on AIX

Disk-Space Requirements   23
Install Domino Server or Notes Workstation   39
Installing to Multiple AIX Hosts   49, 50
Network Setup   32
Notes Binaries   29, 80
Notes Databases   30, 81
Preparing for the Installation   24, 75
Software Requirements   23
Starting the Installation   36

Installing Lotus Notes Workstation on AIX
Disk Space Requirements   84

Inter-Disk Allocation Policy   403
Internet Mail

IMAP   281
POP   281
SMTP   265

Internet Message Access Protocol (IMAP)   281
Internet Protocols   243

FTP   243
Gopher   243
HTTP   243
Notes RPC   244
SOCKS   244
SSL Security   244

iostat Command   388
ipcrm Command   419
ipcs Command   419
IPX and SPX Protocol Stacks   34
IPX/SPX   19

K
kernel Parameters for AIX

I/O requests   413
max_coalesce   412
maxpgahead   412

minpgahead   412
Stripe Unit Size   412

Killing Processes   419

L
LDAP   301, 346

Access Control   302, 307
Configuration   302
Creating a Full-Text Index   305
Global Domain Document   304
Overview   301
Setting Up an LDAP Client   307
Setting Up Netscape Navigator   308
Starting   306
Stopping   306

Lightweight Directory Access Protocol (LDAP)   301
Load Balancing   329, 332, 334
Local Area Network   32
Log Device

Create   407
Log devices   407
Logical Volume

Create   26, 80, 404
Disk Striping   410
Performance Considerations   403

Lotus Domino and the World Wide Web   217
Domino Server Web Navigator   217
Domino Virtual Server   217, 235

Configuring domcfg.nsf   236
domcfg.nsf   235

Domino Web Server   217
Personal Web Navigator   217
Support for Internet Protocols   217
Web Administration Tool   217

Lotus Domino Server   1, 5
Release 4.5   5
Release 4.6   2

Lotus Notes   1, 9, 14
Available Platforms   14
Description   1
Release 4   9
System Requirements   14

Lotus Notes Server
Release 4   9

Lotus Notes Workstation   1
lsdev Command   361
lslpp Command   33, 34
lsvg Command   421

M
Mail Routing   121, 131

Introduction   122
Setting Up   122

MailClusterFailover   336
Maintenance of an AIX Printer Subsystem

Give User Permission to Change Printer   184
Xpdefaults   185

MAXUSERS   335
Memory Related Tuning Tools   399
444 Lotus Domino Release 4.6 on IBM RS/6000



MEMORY_QUOTA   413
Middleware Issues   353
Migration from the SMTP Gateway   278
Mirroring of AIX File System   403, 405, 406
mkitab   146
mkps Command   399
mksysb Command   369
Modem Connections Using PPP

Configure a Link Control   322
Configure a PPP Interface   324
Setup   321
Starting PPP   325

Modem Connections Using X.PC
Additional Setup for a Serial Port   314
Edit Modem File   316
Log File, Description   317
mkdev   312
Modem Files   314
Modem Setup   312
Setup   309
Setup a Communications Port (TTY)   309
Setup of a Windows 95 Client   319
User Preferences   313

Modem Files   314
Default   316

Monitoring
Lotus Notes Servers   394

Monitoring the SMTP MTA   279
mount Command   32
mounting the CD-ROM   159
Multiple Hosts

/.rhosts   50
/tmp/notes_install_hostlist   49, 51
Hostlist File   50
Installing On   49

Multiple Internet Domains (SMTP)   276
Multiple Passwords   190

N
Name and Address Book Database

Access   116
Security   116

Giving Access   116
Name Server   425
netpmon Command   392
Netscape Navigator

IMAP Client Configuration   287
LDAP Client Configuration   308
NNTP Client Configuration   300
POP Client Configuration   285
SMTP Client Configuration   285, 287

Network
.rhosts File   49
/etc/hosts   62
Hostlist File   50
Setup SPX/IPX   33
Setup TCP/IP   33
Supported Protocols   19

Network Layer   424
Network News Transfer Protocol (NNTP)   288

Network Operation   394
Network Protocols   72

Additional Network Protocol   73
Network Setup   236

/etc/rc.net   236
ifconfig Commands   236

Network Traffic Indicator   319
News   288
NFS   42

Advantages   155
Change mount Point   168
Data Directory, Notes   166
Disadvantages   154
Exporting

home/data File System   167
Installation Kit   159
read/write   165
Read-only   159
Workstation File System   165

Fileset Pequisites   155
Installation Kit, UNIX   157
Installing Workstation Software   162
Kit, UNIX Installation   157
mounting

home/data Directory   168
Installation Kit   160
Workstation Software   165

Notes Data Directory   166
Notes Software Directory   160
Security   214
Software Directory, Notes   160
Starting NFS   159
UNIX Installation Kit   157

nfso Command   402
nice Command   396, 397
NIF_POOL_SIZE   413
NIS   424
NNTP   288, 346

Configuration   289
Configuring a News Feed   293
Control Messages   297
Creating a Private Newsgroup   291
Overview   288
Removing a Private Newsgroup   292
Setting Up an NNTP Client   299
Setting Up Netscape Navigator   300
Starting   290
Stopping   290

no Command   401
nohup Command   146
Notes Clients

Installing   102
Notes Recovery Kit   353
Notes User

Change User Permissions   184
Create AIX Group for Notes   32, 82
Create AIX User for Notes   32, 82
Create AIX User on Workstation   84
Login   52, 84

Notes user
 445



AIX group-ID   46
Notes_ISOLATION   417
Notes_SHARED_DPOOLSIZE   357
NSF_BUFFER_POOL_SIZE   413

O
odmad Command   412
odmdelete Command   412
odmget PdAt Command   412
Online Documentation   42

P
Page Minder   247

Enabling   247
Running the Page Minder Agent   248

Paging Space, Increasing   421
Partitioned Servers   337

$INPUTFILE   341
$OUTPUT_LOG   341
Administrative Clients   340
Configuring   338

TCP/IP   339
Environment   341
http task   345
IMAP   346
LDAP   346
NNTP   346
Planning   338
POP3   346
Portmapping   340
Server Failure   341
SMTP MTA   346
Starting   340, 341
Starting in the Background   341

Console Monitor   344
Stopping   340, 342
Unique IP Addresses   339
Unique TCPIP Port Numbers   340

Password File, UNIX
Change User Home Directory   168
Convert to Notes Registration File   109
Example   109

Paste   417
Performance Considerations AIX File System

Allocation Map   406
Compression of File Systems   407
File System   407
Fragment Size   407
Inter-Disk Allocation Policy   403
Intra-Disk Allocation Policy   403
Logical Volume Manager   403
Mirroring of AIX File System   403

Performance Management of the AIX File System
Create Another File System Log   407
Create the File System   408
Create the Logical Volume   403, 404
Create the Logical Volume for Disk Striping   410
Create the Striped File System   412
Create the Striped Logical Volume   409

Create the Volume Group   404
Disk Striping   409
kernel Parameters   412
Logical Volume NAME   406
Logical Volume TYPE   406
Mirroring   406
Number of LOGICAL PARTITIONS   406
Performance Tuning Using Disk Striping   412
POSITION on Physical Volume   406
RANGE of Physical Volumes   406

Performance Tuning   396
Personal Web Navigator   242

Managing Database Size   247
Setting up   243

Location document   243
Point to Point Protocol (PPP)   321
POP   281

Overview   281
Preparation for a POP Client   283
Setting Up a POP3 Client   285
Setting up Netscape Navigator   285
Starting   283
Stopping   283

POP3   346
Post Office Protocol (POP)   281
Postmaster   272
PPP   321

Configuration   321
Printer Commands on AIX

lpstat   175, 176, 177, 184
qadm   184
qcan   184

Printer Installation and Setup
See Installing a Printer on AIX
See Maintenance of an AIX Printer Subsystem
See Setting up AIX Printers in Lotus Notes

Private Newsgroup
Creating   291
Removing   292

PTX (Performance Toolbox)   392
Agent   392
Manager   392

Publishing a Database   242
Purge Agent   253
Purge agent   256

R
rdump Command   379
Refresh Agent   255
Refresh agent   253
Registering Additional Servers   112

Details   113
Server Title   115

Registering users from a Text File   102
Examples   103

Registering Web Users   109
Allowing Anonymous Users   110
Anonymous Users   110
Authenticated Users   111

Registration
446 Lotus Domino Release 4.6 on IBM RS/6000



Multiple New Users from a File   103
Multiple Users Input File

Example   109
Format   103

New Server   113
New User   96
Register Person Screen   99, 101
Register Server Screen   114, 115
Server   112
User   95
Users from UNIX Password File   108

Remote Console   150
Remove a Printer on AIX   175
Removing a Private Newsgroup   292
renice Command   397
Replica IDs   141
Replication   131, 142

Access Control Lists   141
Creating a Replica   134
Creating Replication Connection Documents   131
Introduction   131
Non-replicating Features   141
Replica Ids   141
Replication Formulas   139
Required Authorizations in Server Document   133
Selective Replication   136

Database Features   139
Destination and Source   136
Specifying Documents   138

Stacking Replica Icons   136
Requirements   23

Hardware   23
Software   23

restore Command   366
RESTRICTED   335
rmitab   146

S
Safe ID   127
sar Command   389
Scalability   328
schedtune   398
schedtune Command   401
Secure Socket Layer   201, 230

Certification Authority   201, 202, 203
certsrv.nsf   203
Client certificates   201
Create Server Certificate Request   205
Enabling   202
Key Ring   201, 204, 233
Self-Certified Certificate   232
Server Certificate Administration   203
SSL Security   244
SSL Settings (Web Server)   225, 231

Secure Sockets Layer   236
Security

Access Control List Screen   117
Access to Certifier ID File   118
chmod Command   212
Data Directory, Notes   212

End User   189, 193
NFS   214
Password, UNIX   211
Software Directory, Notes   212
umask Command   212

Semaphores   418
Server   196

alog Command   146
See also alog Command

Backup
See Backup

Cleaning Notes Processes   418
Installation Information   116
Not Responding   143, 153, 418
Operating System Platforms   24
Registration   112, 116

See also Registration
Remote Console   150
server.alog File   147
server.log File   146
Start Up

Background   144
Boot Time   146
Get a Console   143

Typical UNIX Configuration   156
Server Access Control List (SACL)   197
Server Connection   423
Server Document   271
Server Security   196

Keyboard Lock   197
Restricting Physical Access   196

Server Web Navigator   249, 252, 257
Connecting   250
End User   257
Managing Database Size   256
Providing Access   257
Setting Up   249
Web Retrieval   251
Web Retriever Management   251

Server_Availability_Threshold   335
Server_Cluster_On   336
Server_MaxUsers   335
Server_Restricted   334, 335
Service availability   351
Serviceprocessor   352
Set Secure   197
Setting up AIX Printers in Lotus Notes

Add Printer   179
Assign a Printer to an AIX Printer Queue   182
Create a Site-Specific System Printer Setup File   183
Remove Printer   182
Remove Printer Queues   181
Xpdefaults   179, 183

Setting up Lotus Notes Workstation on AIX
PATH Variable   84
Preparation   83
Workstation Setup Finished   87
Workstation Setup Program   88

Setup Lotus Domino Server on AIX
Adding an Additional Network Protocol on AIX   73
 447



Additional Server   65
Final Settings   73
First Server   57
PATH Variable   52
Preparation   51
Rerun Setup   52
Server Setup Program   56

Setup Screen, Notes   423
$PATH   423

Shared Memory
Cleaning   418
Killing Processes   419
Killnotes script   420
Notes_ISOLATION   417

Shell Script
Backfile   375
Backtape   363
configure.alog   147
Dumpfiles   378
Startup   146
startup.alog   148

Simple Mail Transfer Protocol (SMTP)   265
SMTP   265

Address Conversion   276
Character Set Translation   278
Configuration   269
Connection Document   270
Foreign SMTP Domain Document   269
Global Domain Document   275
How the SMTP MTA Works   266
Migration from the SMTP Gateway   278
Monitoring   279
Multiple Internet Domains   276
Other Configurations   277
Overview   265
Server Document   271
Starting the SMTP MTA   280
Stopping the SMTP MTA   280
Tunnelling Lotus Notes Messages   273
Useful Commands   280

SMTP MTA   346
SNMP Interface   394
Software Directory, Notes

Backup   361
Configuring Client   165
Distributing   160
Exporting to NFS mounts   165
Installing   162
Link, Creating   166
mounting from NFS   165
Security   212
Soft Link, Creating   166
VIM Applications Link   166

SP   351, 393
High Performance Switch   355, 356
Installation   356
Interactive Network Dispatcher   355
Planning   355
PSSP   356
Scalability   355

Start Up
Background   144
Boot Time   146
Get a Console   143

Striping of Disks   409
Sun Solaris

setuid-root   41
Supported Workstations   24
svmon Command   391
Symbols

/.rhosts   50
/etc/environment   24
/etc/hosts   62
/etc/netware/NPSConfig   34
/opt/lotus   29, 36, 42, 44, 84
/tmp/notes_install_hostlist   49, 51
/usr/lpp/lotus   32
/usr/sbin   24
@RefreshEcl   193

System availability   351

T
tar Command   362
tcopy Command   362
TCP/IP   19, 32, 33

Client Support   33
TCP/IP host name   423
TCPIP_TcpipAddress   426
tctl Command   366, 382
Terminology of a Domino Server   56
Thunderbolt Sign   319
tprof Command   390
trace Command   391
Traffic Light Sign   319
Troubleshooting

.sgf.notespartion   425
Client Freezing   427
Data Directory   425

Unable to Create   425
Directory is not empty   425
HACMP   425
http-Task   426
TCPIP_TcpipAddress   426

Tunnelling Lotus Notes Messages Through SMTP   273

U
umask Command   212, 213
UNIX File Permissions   212

chgrp   212
chmod   212
chown   212

USENET   299
User

ID File   95
Installation Information   102
Profile   99
Registration   95, 112

See also Registration
User Name Tips   103
448 Lotus Domino Release 4.6 on IBM RS/6000



User Environment   214
grpck   214
pwdck   214
usrck   214

User ID
Backup of the User ID File   190
Locking User IDs

Automatic   190
Manual   190

Passwords   189
Protection   189
Securing the User ID File   189

User ID File
Create   95

User Profile   99, 101
User Registration   95

Certifier ID   98
Details   96
Internet Password   99
Mail   100
Other   101
Registration Server   98

V
vmstat Command   402
vmtune Command   399, 400
Volume Group

Create   25, 76
Creating   404

volume group, creating   76

W
Web Administration Tool   259
Web Ahead   246

Enabling   246
Running the Web Ahead Agent   246

Web Navigator   242
What is it?   242

Workstation
Mount File System   80, 81
Operating System Platforms   24
Preparation   83
Setup Finished   87
Setup Program   88

Workstation Security
ECL   192

X
X.PC   309

Configuration   312
xhost   83
xmperf   393
xmservd   394
Xpdefaults   179, 183, 185
Xstation   83
 449



450 Lotus Domino Release 4.6 on IBM RS/6000



© Copyright IBM Corp. 1998 451

ITSO Redbook Evaluation

Lotus Domino Release 4.6 on IBM RS/6000: Installation, Customization and Administration
SG24-4694-02

Your feedback is very important to help us maintain the quality of ITSO redbooks. Please complete this
questionnaire and return it using one of the following methods:

  • Use the online evaluation form found at http://www.redbooks.ibm.com
  • Fax this form to: USA International Access Code + 1 914 432 8264
  • Send your comments in an Internet note to redbook@us.ibm.com

Which of the following best describes you?
_ Customer _ Business Partner _ Solution Developer _ IBM employee
_ None of the above

Please rate your overall satisfaction with this book using the scale:
(1 = very good, 2 = good, 3 = average, 4 = poor, 5 = very poor)

Overall Satisfaction __________

Please answer the following questions:

Was this redbook published in time for your needs? Yes___ No___

If no, please explain:

What other redbooks would you like to see published?

Comments/Suggestions: (THANK YOU FOR YOUR FEEDBACK!)



S
G

24
-4

69
4-

02

P
ri

n
te

d
 in

 t
h

e 
U

.S
.A

.

Lotus Domino Release 4.6 on IBM RS/6000: Installation, Customization and Administration SG24-4694-02


	Contents
	Figures
	Tables
	Preface
	The Team That Wrote This Redbook
	Comments Welcome

	Chapter 1. Introduction
	1.1 What is Lotus Domino Server and Notes Workstation?
	1.2 What’s New in Lotus Domino Server and Notes Client R4.6?
	1.2.1 Administration
	1.2.2 Performance Features
	1.2.3 Internet Features
	1.2.4 Mail, Calendar, & Scheduling
	1.2.5 Advanced Server Features
	1.2.6 Application Development
	1.2.7 Database Management Features
	1.2.8 Document Authoring Features
	1.2.9 Ease-of-Use Features
	1.2.10 Mail And Calendar Features
	1.2.11 Internet and Network Features
	1.2.12 Security Features

	1.3 What's New in Lotus Domino Server and Notes Workstation R4.5?
	1.3.1 Administration
	1.3.2 Performance Features
	1.3.3 Security Features
	1.3.4 Database Maintenance Features
	1.3.5 Internet Features
	1.3.6 Mail, Calendar, & Scheduling
	1.3.7 Advanced Server Features
	1.3.8 Application Development
	1.3.9 Database Management Features
	1.3.10 Document Authoring Features
	1.3.11 Ease-of-Use Features
	1.3.12 Mail and Calendar Features
	1.3.13 Internet and Network Features
	1.3.14 Security Features

	1.4 What's New in Lotus Notes Release 4?
	1.4.1 Ease-of-Use Features
	1.4.2 Mail Features
	1.4.3 Mobile Features
	1.4.4 Document Authoring Features
	1.4.5 Network Features
	1.4.6 Printing Features
	1.4.7 Replication Features
	1.4.8 Search Features
	1.4.9 Security Features
	1.4.10 Workspace Features
	1.4.11 Application Development/Programming Features
	1.4.12 Database Management Features

	1.5 Available Platforms
	1.5.1 AIX
	1.5.2 OS/2 Warp (32-bit)
	1.5.3 Windows 95 (32-bit)
	1.5.4 Windows NT (32-bit)

	1.6 Our Lotus Domino Server and Notes Workstation Environment

	Chapter 2. Installing a Lotus Domino Server
	2.1 Hardware and Software System Requirements
	2.1.1 Lotus Domino Servers
	2.1.2 Notes Workstation Clients

	2.2 Preparing the Environment for the Installation
	2.2.1 Create a New Volume Group for the Lotus Domino Server Binaries
	2.2.2 Create the Logical Volume for the Lotus Domino Server Binaries
	2.2.3 Create the Logical Volume for Lotus Domino Server Databases
	2.2.4 The File System for the Lotus Domino Server Binaries
	2.2.5 The File System for the Lotus Domino Server Databases
	2.2.6 Setting Up a Local Area Network (LAN)

	2.3 Starting the Installation
	2.3.1 Installing on Multiple Hosts

	2.4 Setting Up the Lotus Domino Server on AIX
	2.4.1 Lotus Notes Setup Options

	2.5 Server Setup Program
	2.5.1 Starting the Server Setup Program
	2.5.2 Setting Up the First Server in Your Organization
	2.5.3 Setting Up an Additional Server in Your Organization

	2.6 Setting Up Network Protocols
	2.6.1 Setting Up an Additional Network Protocol

	2.7 Final Settings

	Chapter 3. Installing a Notes Workstation
	3.1 Installation of Lotus Notes R4.6 Workstation on AIX
	3.1.1 Preparing the Environment for the Installation
	3.1.2 New Volume Group on the Workstation for the Installation Software
	3.1.3 The Logical Volume on the Workstation for the Installation Software
	3.1.4 Create the Logical Volume for the User Database
	3.1.5 Create and Mount the File System on the Workstation
	3.1.6 The File System for the User Database on the Workstation
	3.1.7 Setting Up the Lotus Notes R4.6 Workstation on AIX
	3.1.8 Workstation Setup Program


	Chapter 4. User and Server Registration
	4.1 User Registration
	4.1.1 Certification Log
	4.1.2 Creating the Certification Log
	4.1.3 Registering New Lotus Notes Users
	4.1.4 Creating a User Profile
	4.1.5 Installing Lotus Notes Clients
	4.1.6 Registering Multiple Users From a File
	4.1.7 Examples of Registering a Group of Users
	4.1.8 Registering Multiple Users from a Text File

	4.2 Registering Web Users
	4.2.1 Anonymous Users
	4.2.2 Allowing Anonymous Users
	4.2.3 Authenticated Users

	4.3 Registering Additional Servers
	4.3.1 Registering New Lotus Domino Server
	4.3.2 Installing Lotus Domino Servers

	4.4 Giving Access to Address Book Database
	4.5 Giving Access to the Certifier ID File

	Chapter 5. Connecting Lotus Domino Servers
	5.1 Choosing a Topology for Replication and Mail Routing
	5.2 Mail Routing
	5.2.1 Introduction to Mail Routing
	5.2.2 Setting Up Mail Routing Connection Documents
	5.2.3 How Cross Certification Works
	5.2.4 Cross Certification and Authentication

	5.3 Replication
	5.3.1 Introduction to Replication
	5.3.2 Creating the Connection Document for Replication
	5.3.3 Required Authorizations in Server Document
	5.3.4 Creating the Replica on the Spoke Server

	5.4 Selective Replication
	5.4.1 Features That Will Not Replicate
	5.4.2 Database Replica IDs
	5.4.3 Access Control Lists and Replication


	Chapter 6. Configuring Lotus Domino Servers on AIX
	6.1 Lotus Domino Server Startup
	6.1.1 Lotus Domino Server Startup from AIX Command Line
	6.1.2 Starting the Lotus Domino Server using a Startup Script
	6.1.3 Starting the Lotus Domino Server Automatically
	6.1.4 Using the AIX alog Facility

	6.2 Lotus Domino Server Shut Down
	6.2.1 Shutting Down Lotus Domino Server on Server Console
	6.2.2 Shutting Down Lotus Domino Server on Remote Console
	6.2.3 Shutting Down Lotus Domino Server Using AIX Command
	6.2.4 Shutting Down Lotus Domino Server Using Shell Script

	6.3 Lotus Domino and NFS
	6.3.1 Combined Lotus Domino Server and Note Client Hosts
	6.3.2 Distributing the UNIX Installation Kit
	6.3.3 Distributing the Lotus Notes Software Directory
	6.3.4 Distributing the Clients Data Directories

	6.4 Environment Variables
	6.4.1 Notes_SHARED_DPOOLSIZE
	6.4.2 NSORDER
	6.4.3 DEBUG_ENABLE_CORE


	Chapter 7. Setting Up Printers
	7.1 Installation and Setup of Printers on AIX
	7.1.1 Add/Configure a Local Attached Printer
	7.1.2 Add/Configure a Remotely Attached Printer

	7.2 Setting Up AIX Printers in Lotus Notes
	7.3 Create a Site-Specific System Printer Setup File
	7.4 Maintenance of an AIX Printer Subsystem
	7.4.1 Give a User the Right to Maintain the AIX Printer Subsystem
	7.4.2 Useful Printer Commands

	7.5 Understanding the Xpdefaults Printer Setting of Lotus Notes

	Chapter 8. Security and Lotus Domino
	8.1 User Security
	8.1.1 User IDs and Passwords
	8.1.2 Locking User IDs
	8.1.3 Local Database Encryption

	8.2 About Workstation Data Security
	8.3 Remote User Security
	8.4 Mail Security
	8.5 Server Security
	8.5.1 Restricting Physical Access to Lotus Domino Servers
	8.5.2 Restricting Access to Lotus Domino Server Consoles
	8.5.3 Server Access Control Lists (SACL)
	8.5.4 Certification

	8.6 Secure Socket Layer (SSL)
	8.6.1 Enabling SSL on a Server

	8.7 AIX Security
	8.7.1 Security Concepts
	8.7.2 UNIX Passwords
	8.7.3 Security Logs
	8.7.4 UNIX File Permissions
	8.7.5 File System Security
	8.7.6 Validating the User Environment
	8.7.7 Documenting Security Policy and Setup
	8.7.8 NFS Export Security
	8.7.9 AIX Security Checklist


	Chapter 9. Lotus Domino and the World Wide Web
	9.1 Lotus Domino Server
	9.1.1 How the Lotus Domino Web Server Works
	9.1.2 Specify HTTP Settings for the Lotus Domino Web Server
	9.1.3 Specify Internet Port and Security Settings for the Web Server
	9.1.4 Starting and Stopping the Lotus Domino Web Server
	9.1.5 Accessing the Lotus Domino Web Server from a Browser
	9.1.6 Restricting Access to the Lotus Domino Web Server
	9.1.7 Sample SSL Setup Session

	9.2 Lotus Domino Virtual Server
	9.2.1 Network Setup
	9.2.2 Configuring domcfg.nsf

	9.3 Web Navigator
	9.3.1 Personal Web Navigator
	9.3.2 Setting Up the Personal Web Navigator
	9.3.3 Web Ahead - Automatically Following Links on Web Pages
	9.3.4 Managing Database Size (perweb.nsf)
	9.3.5 Using Page Minder to Keep Track of Changes to Web Pages

	9.4 Server Web Navigator
	9.4.1 Setting Up the Server Web Navigator
	9.4.2 Connecting the Server Web Navigator to the WWW
	9.4.3 Specifying Web Retrieval Settings
	9.4.4 Customizing Basic Settings in the Administration Document
	9.4.5 Managing the Server Web Navigator Database
	9.4.6 Providing Access to the Server Web Navigator Database
	9.4.7 Installing the Server Web Navigator for the Lotus Notes End User

	9.5 Server Web Administration Tool
	9.6 New WWW Features in Lotus Domino Release 4.6.1
	9.6.1 Improving Web Server Performance Using the Command Cache


	Chapter 10. Connectivity and Internet Communications
	10.1 SMTP
	10.1.1 How the SMTP MTA Works
	10.1.2 Configuration of the SMTP MTA
	10.1.3 Foreign SMTP Domain
	10.1.4 SMTP Connection Document
	10.1.5 Server Document
	10.1.6 Global Domain Document
	10.1.7 Monitoring the SMTP MTA
	10.1.8 Running the SMTP MTA

	10.2 POP and IMAP
	10.2.1 Lotus Domino and Internet Mail
	10.2.2 Starting and Stopping the POP3/IMAP4 Servers
	10.2.3 Preparation for an Internet Mail Client
	10.2.4 Setting Up a POP3 Client
	10.2.5 Setting Up an IMAP4 Client

	10.3 NNTP
	10.3.1 Lotus Domino and NNTP
	10.3.2 Installation and Configuration
	10.3.3 Starting and Stopping the NNTP Server Task
	10.3.4 Creating a Private Newsgroup
	10.3.5 Removing a Private Newsgroup
	10.3.6 Configuring a Newsfeed
	10.3.7 Control Messages
	10.3.8 Lotus Domino NNTP and USENET
	10.3.9 Setting Up an NNTP Client

	10.4 LDAP
	10.4.1 Lotus Domino and LDAP
	10.4.2 Installation and Configuration
	10.4.3 Starting and Stopping the LDAP Server Task
	10.4.4 Granting LDAP Server Access
	10.4.5 Setting Up an LDAP Client

	10.5 Using X.PC for Client Connections
	10.5.1 Setting Up the Communication Port (TTY)
	10.5.2 Setting Up the Modem on Lotus Domino
	10.5.3 Configuring the Windows 95 Client To Use X.PC

	10.6 Using PPP for Client Connections

	Chapter 11. Domino Advanced Services
	11.1 Domino Advanced Services Environment
	11.2 Clustering
	11.2.1 Configuration of a Cluster
	11.2.2 Overview of Cluster Components
	11.2.3 Failover
	11.2.4 Monitoring, Logging, and Statistics of the Cluster Processes
	11.2.5 Removing a Server From a Cluster
	11.2.6 Managing Databases On a Cluster
	11.2.7 Restricting Server Access
	11.2.8 Load Balancing
	11.2.9 Summary of the States of Cluster Members
	11.2.10 Related Settings in notes.ini
	11.2.11 Cluster Replicator Caveats
	11.2.12 Use of Private LAN for Cluster Communication

	11.3 Partitioned Servers
	11.3.1 Planning a Partitioned Server Deployment
	11.3.2 Configuring Partitioned Servers
	11.3.3 Configuring Partitioned Servers for TCP/IP
	11.3.4 Starting and Stopping Partitioned Servers
	11.3.5 Starting the Server in the Background
	11.3.6 Considerations for Internet Server Tasks

	11.4 Billing
	11.4.1 Managing Billing
	11.4.2 Sample Billing Records


	Chapter 12. High Availability, Scalability, RS/6000 SP
	12.1 RS/6000 and AIX Issues
	12.1.1 RS/6000 and AIX Basics
	12.1.2 Service Processor
	12.1.3 RS/6000 HA50 cluster server

	12.2 Middleware Issues
	12.2.1 HACMP
	12.2.2 Lotus Notes Recovery Kit (NRK)
	12.2.3 Lotus Domino Clustering

	12.3 Scalability and RS/6000 SP
	12.3.1 RS/6000 SP: Planning
	12.3.2 RS/6000 SP: Installation

	12.4 Further Information on High Availability and Scalability

	Chapter 13. Backup and Recovery
	13.1 Introduction
	13.2 Server Backup Using AIX Native Tools
	13.2.1 Stopping and Starting the Database Server
	13.2.2 How to Back Up the Lotus Software File System
	13.2.3 How to Back Up Only One Server
	13.2.4 Backing Up a Server that Contains User Data
	13.2.5 Restoring Backup Data

	13.3 Backup and Recovery of the AIX System
	13.3.1 Backing Up the AIX System
	13.3.2 Restoring the AIX System Backup

	13.4 Other Native AIX Backup Tools
	13.4.1 tar
	13.4.2 cpio
	13.4.3 savevg/restvg

	13.5 Advanced Backup Solutions
	13.5.1 Backup of More Than One Server
	13.5.2 ADSM
	13.5.3 Legato NetWorker


	Chapter 14. System Performance Considerations
	14.1 Performance Monitoring
	14.1.1 The vmstat Command
	14.1.2 The iostat Command
	14.1.3 The sar Command
	14.1.4 The tprof Command
	14.1.5 The svmon Command
	14.1.6 The filemon Command
	14.1.7 The netpmon Command
	14.1.8 The Performance Toolbox
	14.1.9 Monitoring Lotus Notes Servers Using Performance Toolbox

	14.2 Performance Tuning
	14.2.1 CPU Related Tuning Tools
	14.2.2 Memory Related Tuning Tools
	14.2.3 Network Related Tuning Tools

	14.3 Optimal File System Performance for the Lotus Domino Server
	14.3.1 Performance Considerations for the Logical Volume Manager
	14.3.2 Creating the Volume Group
	14.3.3 Creating the Logical Volume
	14.3.4 Performance Considerations for the File System
	14.3.5 Creating a New Log Device
	14.3.6 Creating the New File System for the Lotus Notes Databases

	14.4 Creating a Striped File System for Maximum Database Performance
	14.4.1 Creating the Striped Logical Volume
	14.4.2 Creating the Logical Volume for Disk Striping
	14.4.3 Creating a Striped File System for Lotus Notes Databases
	14.4.4 Performance Tuning Using Disk Striping

	14.5 Lotus Domino Server Tuning
	14.5.1 The NSF_BUFFER_POOL_SIZE Parameter
	14.5.2 The NIF_POOL_SIZE Parameter
	14.5.3 The MEMORY_QUOTA Parameter
	14.5.4 Multiple Name and Address Books

	14.6 Lotus Notes Configuration Tips
	14.6.1 Reducing ServerTasks
	14.6.2 Reducing Mail-Polling Intervals (MinNewMailPoll)
	14.6.3 Increasing the MailMaxThreads Value
	14.6.4 Dropping Idle Sessions
	14.6.5 Enabling Full-Text Indexes
	14.6.6 Partitioning Data on Servers

	14.7 Conclusion

	Chapter 15. Troubleshooting
	15.1 Performing Copy and Paste
	15.2 Multiple Lotus Notes Clients on the Same AIX System
	15.3 Cleaning Lotus Domino Processes
	15.4 File System Full
	15.5 Increasing Paging Space
	15.6 Always Start with the Lotus Notes Setup Screen
	15.7 Accessing a Server in a Different TCP/IP Domain
	15.7.1 Setup within Lotus Notes
	15.7.2 Setup on the Network Layer

	15.8 Unable to Create the Data Directory during Setup
	15.9 "Directory is not empty" Error on Installing from CD
	15.10 Partitioning: File .sgf.notespartition and HACMP
	15.11 TCP/IP Listener Error without TCPIP_TcpipAddress
	15.12 Errors at Startup of http Task
	15.13 Lotus Notes Clients Freezing

	Appendix A. Using UNIX's vi Editor
	Appendix B. Special Notices
	Appendix C. Related Publications
	C.1 International Technical Support Organization Publications
	C.2 Redbooks on CD-ROMs
	C.3 Other Publications

	How to Get ITSO Redbooks
	How IBM Employees Can Get ITSO Redbooks
	How Customers Can Get ITSO Redbooks
	IBM Redbook Order Form

	List of Abbreviations
	Index
	ITSO Redbook Evaluation

